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Introduction

The FactorSoft Reports module is used to generate business and system reports and then view or deliver
those reports to yourself, another FactorSoft user, or one of your clients through a variety of methods such
as printing and email.

Access to specific reports within the Reports module is set using Security Roles. More information about
setting security and user roles can be found in the Administration Guide, however we have included some
Security Roles in this guide as a reference.

The guide contains information about how to generate and distribute reports. This guide only contains
information about the standard reports available to all clients. It does not contain information about any
“custom” reports we may have developed for your company.

l To access the Reports module, click the Reports icon in the Application Manager.

NOTE
If the Reports icon does not appear it means you do not have the needed Security Role needed to
access the module.
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Setting Up Reports

Overview

There are several tasks that can (or must) be performed in order for some Reports features and func-
tionality to work properly. Some of these tasks may have already been done by Jack Henry™ when your
system was first implemented, while other tasks can be performed by you periodically to manage your
Reports options and database.

l Faxing Setup – Used to set up the third-party faxing solution you want to use to fax reports.

l Printing Setup – Used to set up network printers where reports can be printed.

l Client Printing Preference – Defines the default destination preference for the client. You can select
email, print, fax, and folder.

l SQL Report Folder Setup – Used to specify which folder you want to use to save copies of all gen-
erated SQL reports. You can also edit, delete, or browse an existing folder.

Managing SQL Report Folders

Each time a SQL report is generated by the engine, a copy of that report is saved in one of the report
folders defined in the Admin module. By default, reports are saved in the “primary” folder unless another
folder is specified when the report is defined. You can have only one primary report folder.

The Report Folder Maintenance screen is where you can create and manage folders where scheduled SQL
reports generated by the Engine are saved.

To access the Report Folder Maintenance screen:

1. In the Admin module, on the System menu, select Database Maintenance, and then click Report
Folder Maintenance. The Report Folder Maintenance screen appears showing a list of all the folders
that have been defined (if any).

l The Key is automatically assigned to the folder by FactorSoft and is used by the system to
identify the folder.

l The Folder column shows the path to the folder.

l The Status column indicates if the folder is the primary folder. You can double-click on a
report folder to make it the primary. The primary folder is where all scheduled reports gen-
erated by the engine are saved unless another folder is defined for the report when it is sched-
uled. You can have only one primary folder.
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Creating a New Folder

1. Click the New button.

2. The field below the button, enter the full path to the folder.

3. Click the Create button.

Modifying a Folder

1. Select the folder in the list you want to modify.

2. Click the Modify button.

3. Modify the folder path in the field as needed.

4. Click Update to save the changes you have made.

Testing a Folder

1. Select the folder in the list you want to test.

2. Click the Modify button.

3. Click the Test button. The system verifies the location of the folder. If any issues locating or con-
necting to the folder occur, an error will appear. If the test fails, verify the folder path and make sure
the computer you are using has access to the folder.
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Browsing to a Folder

1. Select the folder in the list you want to browse to.

2. Click the Browse button. An explorer window from which you can navigate to the folder location
appears.

Setting Up Faxing

To use fax output option for reports and notices, a third party fax software solution for sending faxes must
be configured. Typically, these solutions require a fax server application be deployed, as well as a fax cli-
ent that must be deployed on each FactorSoft user's computer.

Fax solutions currently supported in FactorSoft are:

l Equisys ZetaFax®

l GFI FaxMaker®

l Sagem-Interstar LightningFAX®

You can configure FactorSoft to automatically produce fax output when reports and/or statements are
generated from Preference-enabled-reports.

To configure FactorSoft to automatically produce faxes:
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1. In User Preferences, select the installed fax software solution in the Report fax driver and Prefer-
ence fax driver fields on the Print/Faxing Parameters tab of the User Preferences screen in the Fact-
orSoft Systems menu.

2. Select Fax in the Preference field in the upper fields of the Client Information and Debtor inform-
ation screens for the clients and debtors to be included in automatic fax distribution of reports
and/or statements.

NOTE
FactorSoft gives you the option to include more than one fax number or email address when dis-
tributing reports and statements. To email or fax reports to several contacts within the client’s
company, open each contact’s Add New Contact Screen, fill in any appropriate fields, and
check the Attention box to include the contact in the client’s report distribution list. FactorSoft
automatically includes the contact’s fax numbers when generating outgoing reports. See "Set-
ting Printing Preferences" below for more information.

3. Ensure that each client and debtor to be included in automatic fax distribution have a valid fax num-
ber in the Address panel.

NOTE
Contacts with Attention must also have a valid fax number recorded in the Contact Information
screen.

Setting Printing Preferences

FactorSoft’s print preference option allows you to distribute reports and statements according to a client
or debtor's individual needs.

Use the Client Information Screen (Upper Fields) and the Debtor Information Screen to define client and
debtor preferences respectively, and choose from the following options:

l Select Print to print reports and statements and mail them to the client or debtor.

l Select Fax to fax reports and statements to the client or debtor directly from FactorSoft. For more
information about faxing reports, see "Setting Up Faxing" on the previous page.

l Select Email to email reports and statements to the client or debtor directly from FactorSoft.

l Select Folder to save the report or statement in PDF format to a user-specified disk folder.

In addition, clients must be assigned client codes to be able to use the folder preference feature. (Once
saved, the PDF file uses the following name format: Client#_ReportID_YYMMDD_SSS.PDF, where Client# is
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the user-assigned client code, Report ID is a system-defined report name, and SSS is a system-defined
sequence).

NOTE
FactorSoft gives you the option to include more than one fax number or email address when dis-
tributing reports and statements. To email or fax reports to several contacts within the client’s com-
pany, open each contact’s Add New Contact Screen, fill in any appropriate fields, and check the
Attention box to include the contact in the client’s report distribution list. Depending on the client’s
report preferences, FactorSoft automatically includes the contact’s email address or fax numbers
when generating outgoing reports.

When generating reports and statements, FactorSoft always gives you the option to preview the doc-
uments before printing, faxing, or emailing them.

System Preferences

The following system preferences for this function are located in the Administration module, System Prefer-
ences, Data entry behavior, Imaging folder.

Preference Description

Maximum images
per email

Set the number of images to allow per email that is reasonable based on the
average size of your images

The following system preferences for this function are located in the Administration module, System Prefer-
ences, Identification/system constants, Interface parameters, Preference folder printing folder.

Preference Description

Folder for saved
reports

Enter the name and location of the folder in which you want to save the client’s
PDF reports.

The following system preferences for this function are located in the Administration module, System Prefer-
ences, Identification/system constants, System constants folder.

Preference Description

Emailed reports
should be sent using

Select SMTP or MAPI as the preferred way to send email.

SMTP Hostname Enter your SMTP host address, e.g. mail.your company.com.

SMTP default sender
email address

Enter the address that will show as the "From" address on the email. This can be
set here as a system default.
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Preference Description

SMTP default sender
display name

Specify the name that will show up as the sender. Some users may want the
company name to show as the system default.

SMTP host requires
authentication

Specify whether the host expects you to supply a username and password. If
true, you must supply those in the user preferences.

User Preferences

The following user preferences must be configured in the Email Parameters tab of the User Preferences
screen.

Preference Description

From email address Set the email address to override the system default from
address. An email address must be entered either at the
user or system level for an email to send correctly.

From display name Enter a name to override the system default from display
name if supplied for the user. If one is not entered the
from address is displayed.

Username and pass-
word

These are only enabled if the system preference says
authentication is required. If it is required, you must sup-
ply both of these credentials to correctly send an email.

Printing

Setting Up Printing

The FactorSoft Print Service Admin - Settings screen is accessed on the FactorSoft Print Workstation to cre-
ate printer associations for that workstation that will be saved in the Print Store.

The Print Service Admin application is the application used on the Print Workstation to configure named
destinations for network printers. These named destinations will then be accessible in FactorSoft Report-
ing Services Reports templates, or when the user generates a "Print/Engine" request ad hoc for a report.

When Print is installed, at least one print destination (whether a folder or network printer) will be set up at
that time. To add additional printer destinations:
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1. From the Windows Start menu, select All Programs, FactorSoft Print, FactorSoft Print Admin. If this link
does not exist, you can double click the BBS.Services.Administration.Print.exe file in the C:\Program
Files (x86)\ Bayside Business Solutions, Inc.\FactorSoft Print Service folder

If an older version of FactorSoft is being used, the path may be displayed with a
FactorSoft or CADENCE folder instead of a FactorSoft folder.

2. On the Main screen, click Open Settings. The Print Service Admin - Settings screen appears.

Field Description

Web Service URL Contains the address of the Web Service. This is the URL to the Web Service with
which the Print Windows Service on the remote system will communicate.

Server Name The computer name on which this instance of the Print Workstation is running.

Password Displays the password that was manually established for the customer at Print
installation.

Contact Email Enter a valid email address to which messages generated from Print Service
are delivered. This functionality is not currently implemented.

Windows Service Port The port that the Print Service uses for communications. Click the Get new port
number link to populate this field with the next open port.

Destinations Displays the printer associations set up for the Print Workstation.
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Field Description

Remove Highlight a printer association in the Destinations list and click this button to
delete the association for the Print Workstation.

Add Click this link to open the Add Destination screen to add a new printer asso-
ciation.

Edit Highlight a printer association in the Destinations list and click this link to open
the Edit Destination screen to change the type, folder or printer of a printer asso-
ciation.

Test Click this button to test the validity of the web service setup and credentials for
the printer destination.

Cancel Click this button to close the Print Service Admin - Settings screen without sav-
ing unsaved changes.

Save Click this button to save changes or additions to the Print Service Admin - Set-
ting screen.

Creating a Destination

The Print Service Admin application is the application used on the Print Workstation to configure named
destinations for network printers. These named destinations will then be accessible in Reporting Services
Reports templates, or when the user generates a "Print/Engine" request ad hoc for a report.

When Print is installed, at least one print destination (whether a folder or network printer) will be set up at
that time. To add additional printer destinations:

1. Open the Print Service Admin application. From the Start menu, access All Programs, Print, Print
Admin. If this link does not exist, you can double click the BBS.Services.Administration.Print.exe file in
the C:\Program Files (x86)\ Bayside Business Solutions, Inc.\FactorSoft Print Service folder.

Note: If an older version of FactorSoft is being used, the path may be displayed with a FactorSoft
or CADENCE folder instead of a FactorSoft folder.

2. On the Main screen, click Open Settings. The Print Service Admin - Settings screen opens.
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3. Click Add. The Add Destination screen opens.

4. Complete the screen as described below.

Field Description

Destination
Alias

Enter a name to be used to identify the remote printer or folder in the Destination tab
of the Reporting Services reports.

Type Select the destination type.

l Printer

l Folder

Printer/Folder If Type is set to Printer, this field is a list the printers attached to the network print
server.
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Field Description

If Type is set to Folder, this field is a text box in which you can enter the fully qualified
folder path. Alternately, click the ellipsis button to display a browser screen, which can
be used to browse to the desired folder.

5. Click OK to save the destination. The Add Destinations screen closes and the new destination is
added to the Destinations list on the Service Admin Settings screen.

6. Click Save to save the new destination.The destination is now available in the Destination tab when
generating reports.

How Print for SQL Reports Works

Print is a base feature of FactorSoft that enables you to print Reporting Services Reports to any network-
attached printer defined to the Engine, whether connected to a local user’s machine or a remote network
location.

Print is base FactorSoft functionality. However, initial set up of the module is only avail-
able through Jack Henry™ support. Contact your Jack Henry™ representative for more
information.

In addition, Print is not compatible with all printer drivers. Please contact Jack Henry™
support for further information.
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Print requires configuration on each computer functioning as a print server for a physical printing device,
and a new task type in the Engine. When a printing device is thus defined, you can create a template for
the SQL Reporting Services Report, selecting the printer from the Report Request Printer Delivery screen of
the Destination tab. When you schedule the report, the Engine detects the print job at the defined interval
and sends the print job to the printer.

Three major components make up Print:

Reports User Guide
Setting Up Reports

51 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



1. Print Workstation: this component contains both:

l Print Windows Service: a Windows service that communicates with the Print Web Service
through the Internet to 1) update the Webservice of available printers and 2) download avail-
able print jobs (as PDF documents) and prints to the appropriate network printer.

l Print Service Admin: this is an executable application used to uniquely name available net-
work printers to the Print Print Store. This application also allows the user to exercise control
over the print queue (delete, reprint, and prioritized print jobs).

2. Print Webservice. The webservice responds to requests from the Print Windows Service to 1) define
printers in the Print Store, and 2) get the next report to queue for printing (updating individual printer
tables in the FactorSoft database). The webservice also responds to print queue control requests
from the Print Service Admin module to delete, reprint, or prioritize jobs in the print queue.

3. Print Store. The Print Store refers to FactorSoft database tables in which the unique network printer
names and configurations created in the Print Service Admin application are stored. These defin-
itions are used to 1) send the appropriate location for a print job to the Print Webservice and also as
a failsafe in the event that a Print Workstation experiences a failure.

In addition, a Engine task must be defined to respond to print requests from the Reports module,
writing the request to the FactorSoft Database printer tables, where they are detected and pro-
cessed by Print.
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Generating Reports

Generating Reports

There are many different types of reports you can generate depending on the type of information you
want to view. The reports you have access to is determined by the Security Roles you have been assigned.
If you do not see the report you want to generate in the Reports menus, contact our Support Team for
help.

NOTE
Each report contains many format options and system preferences which can affect the type of data
and columns displayed. The sample reports reflected in this guide may not match your reports
exactly.

To generate a report, simply click the name of the report you want to generate from one of the menus in
the Reports module. Keep in mind that there are two different types of reports listed on the menus: SQL
reports (below the line) and Crystal/Legacy reports (above the line).

SQL vs. Legacy (Crystal) Reports

When viewing a menu in the Reports module, the reports shown above the line are Crystal (also called
Legacy) reports. The reports shown below the line are SQL reports. The two types are often similar in what
they report but SQL reports are newer and more robust.
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Legacy (Crystal) reports were the first generation of reports
developed for FactorSoft. They were developed using Crystal
Reporting technology, and will eventually be decremented
and completely replaced by SQL reports. Crystal reports can
be generated in a variety of formats and then printed,
emailed, or faxed. Some reports can also be saved as a tem-
plate for later use and some templates can be set up to be
run by the Engine at a specified time.

SQL reports are created using Microsoft SQL Reporting Ser-
vices (often abbreviated MSSRS or SSRS) . SQL Reporting Ser-
vices offers better functionality and compatibility with the
FactorSoft infrastructure than the Crystal Reporting tech-
nology. SQL reports offer more features and flexibility in how
reports are generated and delivered.

Note: As we continue to enhance and develop SQL reports
the Crystal versions will be removed or no longer supported.
We recommend using the SQL version of a report whenever
available.

Generating SQL Reports

Generating SQL Reports

The following outlines the basic steps to generate a SQL report. The specific steps will vary depending on
the report you are creating, when you want to report to generate, and how you want to deliver or access
the report.

Basic steps to generate a SQL report:
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1. In the Reports module, select the report you want to generate from one of the menus. Remember,
SQL reports are the reports listed below the line in the menus.

2. If a template has been created for the report, it will appear in the Report Template list. If you want to
use a template for the report, select it from the list. Or, if you want to create a new template, click
New.

You can manage (modify or delete) templates that have already been created for the report on the
Templates tab. See "Using the Templates Tab" on page 77 for more information.

3. Define the type of data you want to appear in the report on the Parameters tab. Each report has a
unique set of parameters you can define, however some parameters are common across different
reports. Tip: Use the tab key to move through each parameter option quickly.

To learn more about the parameters for a specific type of report, see the topic for that specific
report in the later sections of this document.

4. Define where or how you want to access the report on the Destination tab. This is where you can
email the report, provide the report to other users, print the report, and so on. See "Using the Destin-
ation Tab" below for more information.

5. Define when you want the report to generate on the Scheduling tab. There are many options for
scheduling, see "Using the Scheduling Tab" on page 75 for more information.

6. If you want to view a previously generated report, use the History tab. See "Using the History Tab" on
page 78 for more information.

Generating Custom SQL Reports

If you are a dedicated hosted customer, you may have the ability to define custom reports that are only
visible to you. This feature is not available to all customers and requires special setup from Jack Henry™.
Contact our Support Team to learn more.

Using the Destination Tab

Using the Destination Tab

The Destination tab is used to select a previously created destination or define a new destination for the
delivery of a report. Destinations that have already been created for the report template will appear in a
list on the tab.
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l To use an existing destination with the report, select the destination in the list. Continue defining the
report on the other tabs as needed.

l To modify an existing destination before using it, select the destination in the list and click the
Modify button. Use the information below to help you modify an existing destination.

l If delete a destination, select the destination and click the Delete button. The destination will be per-
manently deleted.

If the destination you want to use has not already been created you can define a new one using the steps
below. There are several destinations available (desktop, printer, email/fax, and so on) that are further
defined on other screens.

Note: The destinations you can use vary by the Security Roles you have been assigned.

Defining (or Modifying) a Destination

To define a new destination (or modify an existing one), use these steps:
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1. Select the destination options:

l From the Output list, select the format for the report.

l If you have Multi-lingual ClientWeb implemented for your company, the Translate list is used
to select a language for the report. The languages that appear in the list are the language
packs have been purchased.

l Select the Write XML instead of calling SRS check box to produce an XML output file instead
of printed output for the selected parameters. This option is used for custom report building
and has no function in day-to-day FactorSoft reporting. If you select this option, the Path field
is used to enter the fully qualified path to the folder in which the XML file will be written.

2. Click the button for the destination type you want to use. A new window will open (depending on the
button clicked) where you can further define aspects of the destination. The following lists the but-
tons that may be available, depending on the Security Roles you have been assigned:

l FTP – Send the report to an FTP destination. See "Defining a FTP Destination" on page 63 for
more information. The availability of this option is controlled by System Preference Iden-
tification/system constants, Performance, Reporting Services, Requests, Allow FTP des-
tinations. Based on Security Role settings, this button may be unavailable.

l Desktop – Provide yourself or other users access to this report in the Report Queue. See "Defin-
ing a Desktop Destination" below for more information.

l Preference – Use the preference set for the client to deliver the report. which you can define a
preference printing destination. See "Defining a Preference Destination" on page 64 for more
information. Based on Security Role settings, this button may be unavailable.

l Email/Fax – Email or fax the report. See "Defining an Email/Fax Destination" on page 60 for
more information. Based on Security Role settings, this button may be unavailable.

l Printer – Print the report. See "Defining a Printer Destination" on page 66 for more information.

l Folder – Send the report to a specific folder. This option can only be used with PDF reports. See
"Defining a Folder Destination" on page 62 for more information.

l Web – Send the report to ClientWeb. See "Defining a Web Destination" on page 67 for more
information. Based on Security Role settings, this button may be unavailable.

Defining a Desktop Destination

The Report Request Desktop Delivery screen is used to define a Desktop destination for a report. A Desktop
destination provides certain FactorSoft users access to the report through the Report Queue in the
Reports module (see "Using the Report Queue" on page 1149 for more information).
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1. From the Deliver To list, select how you want to choose who will get the report in the Report Queue.

l Current User – Select this option to deliver the report to your Report Queue (Reports module >
File > Report Queue).

l Specific User – Select this option to deliver the report to a user that you select. Then, use the
Specific User list to select the user who will get the report.

l Security Role – Select this option to deliver the report to users that have the role you select.
Use the Specific Role list to select the role for delivery. Any FactorSoft user with this Security
Role receive the report in their queue.

2. From the Show list, select the rule that determines how long reports are displayed in the Report
Queue for the user(s) you have defined. (Optional) In the Plus Days field, enter the number of days
past the selected Show option to show the report in the Report Queue.

l Until purged

l Until viewed

l Until replaced

l Fixed Days

3. From the Archive Rule list, select the rule that determines whether reports are archived for the tem-
plate. (Optional) In the Plus Days field next to the list, enter the number of days past the Archive
Rule to keep the report in archive.

l None (do not archive) – If you select this option, the History Rule list becomes unavailable. You
must select an Archive Rule to also keep History for a report template.

l Until deleted

l Fixed days

l Until viewed

l Until replaced

4. From the History Rule list, select the rule that determines whether run history is saved for the tem-
plate. This option is not available if the Archive Rule is set to None. (Optional) In the Plus Days field
next to the list, enter the number of days past the History Rule to keep the run history for the report.
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l None (delete with archive)

l Until deleted after archive

l Fixed days after archive

Defining an Email/Fax Destination

The Report Request Email/Fax Delivery screen is used to define an Email/Fax destination, which delivers
report to users, clients, or others via email address or fax number.
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1. From the Deliver By list, select the delivery method:

l Email – Select this option to email the report to the address(es) you enter.

l Fax – Select this option to fax the report.

l Rpost – Select this option to use an rpost method to deliver the report.

2. If the Email or Rpost delivery method is being used, in the Address field, enter the email address(es)
to which the email is to be sent.

When email requests are processed in FactorSoft, the logic for Top-level Domains (or TLD's, the por-
tion of the email address after the domain name, e.g., .com, .org, .us, etc.) first edits the TLD against
the "standard" names. If the TLD is not found, then, based on System Preference, the system edits
against a domain name text file (provided by ICANN - Internet Corporation for Assigned Names and
Numbers) in the production data folder, which will be updated and patched as new names come
on line.

Set System Preference Identification/system constants, System constants, Email domain edit
rule to determine how TLDs are edited to the desired value:

l Validate against original top-level domains & table of ICANN-era domains (this value is
the default)

l Validate against original top-level domains only

l Do not edit top-level domains

3. In the Subject field, enter the subject to appear in the subject line of the email or fax. By default, the
report title appears in this field.

4. From the Cover Page/Email Text Parameters list, select the document that contains the cover
page and/or text to be included with the report. This list contains the items created in the Smart
Word Document Control Table in the Administration module (see Smart Word Document Control
Table for more information).

5. From the Archive Rule list, select the rule that determines whether reports are archived for the tem-
plate. (Optional) In the Plus Days field next to the list, enter the number of days past the Archive
Rule to keep the report in archive.
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l None (do not archive) – If you select this option, the History Rule list becomes unavailable. You
must select an Archive Rule to also keep History for a report template.

l Until deleted

l Fixed days

l Until viewed

l Until replaced

6. From the History Rule list, select the rule that determines whether run history is saved for the tem-
plate. This option is not available if the Archive Rule is set to None. (Optional) In the Plus Days field
next to the list, enter the number of days past the History Rule to keep the run history for the report.

l None (delete with archive)

l Until deleted after archive

l Fixed days after archive

Defining a Folder Destination

The Report Request Folder Delivery screen is used to define a Folder destination which saves the report (in
PDF format) in a network folder that you choose.
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1. In the Folder URL field, enter the full folder path (location) where you want the report delivered, or
click the Browse button to open a window where you can navigate to the desired report.

2. From the Archive Rule list, select the rule that determines whether reports are archived for the tem-
plate. (Optional) In the Plus Days field next to the list, enter the number of days past the Archive
Rule to keep the report in archive.

l None (do not archive) – If you select this option, the History Rule list becomes unavailable. You
must select an Archive Rule to also keep History for a report template.

l Until deleted

l Fixed days

l Until viewed

l Until replaced

3. From the History Rule list, select the rule that determines whether run history is saved for the tem-
plate. This option is not available if the Archive Rule is set to None. (Optional) In the Plus Days field
next to the list, enter the number of days past the History Rule to keep the run history for the report.

l None (delete with archive)

l Until deleted after archive

l Fixed days after archive

Defining a FTP Destination

The Report Request FTP Delivery screen is used to define an FTP destination, which saves the report to an
FTP site that you define.
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1. Select the Secure FTP check box if you want to use secure FTP.

2. In the FTP URL field, enter the full URL for the FTP site.

3. In the FTP User Name field, enter the user name used with the FTP site. You must enter the user
name exactly as you enter it when you log on to the FTP site.

4. In the FTP Password field, enter the password used with the FTP site. You must enter the password
exactly as you enter it when you log on to the FTP site.

5. In the FTP Sub-Folder field, enter the target folder name on the FTP site.

6. From the Archive Rule list, select the rule that determines whether reports are archived for the tem-
plate. (Optional) In the Plus Days field next to the list, enter the number of days past the Archive
Rule to keep the report in archive.

l None (do not archive) – If you select this option, the History Rule list becomes unavailable. You
must select an Archive Rule to also keep History for a report template.

l Until deleted

l Fixed days

l Until viewed

l Until replaced

7. From the History Rule list, select the rule that determines whether run history is saved for the tem-
plate. This option is not available if the Archive Rule is set to None. (Optional) In the Plus Days field
next to the list, enter the number of days past the History Rule to keep the run history for the report.

l None (delete with archive)

l Until deleted after archive

l Fixed days after archive

Defining a Preference Destination

The Report Request Preference Printing screen is used to define a Preference destination, which delivers
the report to the group of individuals at the client company (called the Contact Group) that you select.
The group you select will get the report in the format (email, fax, print, or folder) that has been set for the
client preference on the at the Client Information screen (see Entering Client Information for more inform-
ation about setting this preference).
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1. From the Contact Group list, select the group at the client organization that you want to get the
report. The contacts at the client company that have been assigned to that group will get a copy of
the report (see Defining Client Contacts for more information).

2. If the client’s communication preference is set to email or fax:

a. In the Subject field, enter a subject description in this field to appear in the subject line of the
email or fax. The report title is displayed in this field by default.

b. From the Cover Page/Email Text Parameters list, select the document that contains the
cover page and/or text to be included with the report. This list contains the items created in
the Smart Word Document Control Table in the Administration module (see Smart Word Docu-
ment Control Table for more information).

3. From the Archive Rule list, select the rule that determines whether reports are archived for the tem-
plate. (Optional) In the Plus Days field next to the list, enter the number of days past the Archive
Rule to keep the report in archive.

l None (do not archive) – If you select this option, the History Rule list becomes unavailable. You
must select an Archive Rule to also keep History for a report template.

l Until deleted

l Fixed days

l Until viewed

l Until replaced

4. From the History Rule list, select the rule that determines whether run history is saved for the tem-
plate. This option is not available if the Archive Rule is set to None. (Optional) In the Plus Days field
next to the list, enter the number of days past the History Rule to keep the run history for the report.

l None (delete with archive)

l Until deleted after archive

l Fixed days after archive

Defining a Printer Destination

The Report Request Printer Delivery screen is used to select a printer where you want to print the report.
The report will print to the printer you select based on what you define on the Scheduling tab (see "Using
the Scheduling Tab" on page 75 for more information).

Note: The printers you can select on this screen are ones that have been set up in the Print Service Admin
(see "Setting Up Printing" on page 46 for more information).
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1. From the Printer (Server) list, select the printer to which you want to print the reports.

2. From the Archive Rule list, select the rule that determines whether reports are archived for the tem-
plate. (Optional) In the Plus Days field next to the list, enter the number of days past the Archive
Rule to keep the report in archive.

l None (do not archive) – If you select this option, the History Rule list becomes unavailable. You
must select an Archive Rule to also keep History for a report template.

l Until deleted

l Fixed days

l Until viewed

l Until replaced

3. From the History Rule list, select the rule that determines whether run history is saved for the tem-
plate. This option is not available if the Archive Rule is set to None. (Optional) In the Plus Days field
next to the list, enter the number of days past the History Rule to keep the run history for the report.

l None (delete with archive)

l Until deleted after archive

l Fixed days after archive

Defining a Web Destination

The Report Request Web Delivery screen is used to define a Web destination, which distributes the report
to users via ClientWeb and/or Web Portal. For more information about using the Web destination, see Con-
figuring Reports for ClientWeb and/or Web Portal.
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1. From the Show list, select the rule that determines how long the report is shown on ClientWeb.
(Optional) Then, in the Plus Days field, enter the number of days past the selected Show rule to dis-
play the report in ClientWeb.

l Until purged

l Until viewed

l Until replaced

l Fixed days

2. From the Notice Rule list, select the rule that determines when (if) users are notified when reports
are available in ClientWeb. (Optional) Then, in the Plus Days field, enter the number of days past
the selected Notice Rule to produce the notification.

l No notification

l Notify when created only

l Notify when created and if not viewed in X days

l Notify if not viewed in X days

3. In the Subject field, enter a subject description in this field to appear in the subject line of the noti-
fication in ClientWeb. The report title is displayed in this field by default.

4. From the Cover Page/Email Text Parameters list, select the document that contains the cover
page and/or text to be included with the report. This list contains the items created in the Smart
Word Document Control Table in the Administration module (see Smart Word Document Control
Table for more information).

5. From the Archive Rule list, select the rule that determines whether reports are archived for the tem-
plate. (Optional) In the Plus Days field next to the list, enter the number of days past the Archive
Rule to keep the report in archive.

l None (do not archive) – If you select this option, the History Rule list becomes unavailable. You
must select an Archive Rule to also keep History for a report template.

l Until deleted

l Fixed days

l Until viewed

l Until replaced
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6. From the History Rule list, select the rule that determines whether run history is saved for the tem-
plate. This option is not available if the Archive Rule is set to None. (Optional) In the Plus Days field
next to the list, enter the number of days past the History Rule to keep the run history for the report.

l None (delete with archive)

l Until deleted after archive

l Fixed days after archive

Configuring Reports for ClientWeb and/or Web Portal

FactorSoft reports can be configured to be delivered to the ClientWeb and/or Web Portal when they are
generated by the Engine at the interval specified on the Scheduling tab. This is referred to as pushing
reports to the ClientWeb and/or Web Portal. Alternately, you can configure FactorSoft reports to be pro-
duced on demand by your client from the ClientWeb and/or Web Portal. This is referred to as pulling
reports from the ClientWeb and/or Web Portal. Each method is described in this topic.

Pushing Reports

For reports that you do not want your clients to print on demand, use the push report method. A good
example of a report that would not be desirable to allow pulling is the Classic Aging Report, which must
read every invoice in the timer period for the client to build the aging, and is therefore a much better can-
didate for off-hour processing when the database I/O will not negatively impact daytime operations.

To push a report, you simply create a template, add the parameters to push the report to the desired cli-
ent(s), group, Account Executive, etc., set the scheduling for the report, and then configure the Web des-
tination for the report. These tasks are explained in detail below:
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1. Create a Report Template:

l Open the report screen for the desired report in the Reports module.

l Click New adjacent to the Report Template field.

l The Report Template field is transformed from a list to a data entry field.

l Enter a descriptive name for the template and click Create.

l Click Save to save the template. A confirmation message appears. You can now select the
template from the Templates tab of the report should you wish to modify, delete, or print the
report on demand.

2. Add parameters.

l Select the Parameters tab for the template and complete any of the parameter fields to limit
report distribution as required. See the Help file or Reports Guide for specific Parameter tab
descriptions for each report.

l Click Save to save the parameter updates to the template.

3. Set the report scheduling frequency.
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l Select the Scheduling tab and configure the frequency at which the report is pushed to Cli-
entWeb and/or Web Portal. See "Using the Scheduling Tab" on page 75 for further details.

l Click Save to save the scheduling updates to the template. When the report is due to be gen-
erated, the Engine picks up the report job, generates the report, and the report is added to the
Report Queue in ClientWeb and/or Web Portal for the client's that qualified in the report para-
meters.

Pulling Reports

Configure reports that you want to make available to clients to print on demand from the ClientWeb
and/or Web Portal to pull from the Report Queue page.

To configure reports to pull from ClientWeb and/or Web Portal, create a template, add the parameters to
display in either the Report Queue page or Documents screen for the desired client(s), group, Account
Executive, etc., and set the report as a Web Request report. These tasks are explained in detail below:
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1. Create a Report Template:

l Open the report screen for the desired report in the Reports module.

l Click New adjacent to the Report Template field. The Report Template field is transformed
from a list to a data entry field.

l Enter a descriptive name for the template and click Create.

l Click Save to save the template. A confirmation message appears. You can now select the
template from the Templates tab of the report should you wish to modify, delete, or print the
report on demand.

2. Add parameters.

l Select the Parameters tab for the template and complete any of the parameter fields to limit
the clients that can request the report from ClientWeb Report Queue page and/or Web Portal
Documents screen. See the Help file or Reports Guide for specific Parameter tab descriptions
for each report.

l Click Save to save the parameter updates to the template.

3. Set as Web Request report.
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l Select the Scheduling tab.

l Select Web Request.

l In the adjacent Description field, enter a description for the report to appear in the Report
Queue page of the ClientWeb.

l Click Save to save the updates to the template.

The pushed report is listed in the Request Report section of the Report Queue page in ClientWeb for the cli-
ent, as shown below.

The pushed report is listed in the drop-down of the Request Report form on the Documents screen in the
Web Portal, as shown below.
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Using the Scheduling Tab

The Scheduling tab to used to define when you want the report to be run by the Engine. The options you
define on this tab determine when the report template is run and then delivered in the output you defined
(print, email, folder, and so on) on the Destination tab.
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Defining the Schedule

Tip: Use the This Template is Private check box if you do not want other users (who use the selected data-
base) to see this report template on the Templates tab when generating the same report. If you do not
select this option, any user with access to the database with view and/or update access to the report will
be able to see and edit the report template (view and/or update access is determined by Security Roles).

No Schedule

l Use the Template Only option to not define a scheduled polling time. The Engine will not run report
templates if you select this option. This option is most commonly used when creating a “master”
template for others (or yourself) to use and modify later.

Every (Minutes/Hours/Days/Weeks)

l Select the Every option and then enter an interval number in the first field and select an interval
from the list (Minutes, Hours, Days, Weeks) to have the report run on a precise schedule. For
example, enter “12” in the field and select “Weeks” from the list to have the report run every 12 weeks.

Day of the Week

l Select the Day of the Week option to have the report run on specific day(s) of the week. Then,
select the specific day(s) on which you want to run from the area that appears on the right.

l Use the Time of Day field to enter the specific time when you want the report to run. You can use
AM/PM format or military time, as desired. You can also use “Noon” or “Midnt” to have the report run
at 12:00PM or 12:00AM, respectively.

l If you schedule a template for Day of the week, but do not specify Time of Day, a message appears
when you save prompting you to confirm that you do not want to schedule the report at a specific
time.Click Yes when the message appears to have the Engine run the report on the first poll after
12:00 AM on the specified day(s) of the week.
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Week of the Month

l Select the Week of the Month option to have the report run on a specific week of the month. Then,
select the type of week(s) from the area that appears on the right, and select the day when it
should run from the Day list.

l Use the Time of Day field to enter the specific time when you want the report to run. You can use
AM/PM format or military time, as desired. You can also use “Noon” or “Midnt” to have the report run
at 12:00PM or 12:00AM, respectively.

Same Day Every Month

l Select the Same Day Every Month option to have the report run on a specific day each month.
Then, enter the day on which you want the report to run in the field next to the option. For example,
enter “15” in the field to have the report run on the 15th of each month.

l Use the Time of Day field to enter the specific time when you want the report to run. You can use
AM/PM format or military time, as desired. You can also use “Noon” or “Midnt” to have the report run
at 12:00PM or 12:00AM, respectively.

Schedule for ClientWeb

l If available, select the Web Request option to have the report run and then be available for users to
print from ClientWeb. This option will only be available if you have the correct Security Role. Cli-
entWeb is an add-on feature that also requires a specific Security Role to access.

Using the Templates Tab

The Templates tab lists the saved templates (if any) for a report.You can select a template to open it and
then work with it, delete a template you no longer need, or place a scheduled template on hold.

The list on this tab shows the following details about each report template:
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l Name – Name given to the report template when it was created.

l Interval – The Repeat Interval set for the scheduled report on the Scheduling tab when the tem-
plate was created.

l Status – Indicates the status for the most recent run attempt for the report job.

l Waiting – Template is waiting to be run by the Engine.

l Running – Template is currently being run by the Engine.

l Complete – Template has successfully been run by the Engine.

l Held – Template has been put on hold. To remove a hold, select the template and click
Unhold.

l Failed/Unknown – Template has failed to run. Select the template and click Retry to try again.

l Next Run – Indicates the next scheduled run date and time, if applicable.

Using the Tab Controls

l Click the Refresh button to update the list with the most recent information.

l To hide reports that were set up as Template Only on the Scheduling tab when they were defined,
select the Show Scheduled Templates Only check box.

l To show templates created by other users and marked as “private” on the Scheduling tab when
they were defined, select the Show Other's Private Templates check box.

l To place a template on hold so that the report template job will not be run by the Engine, select the
template in the list and click the Hold button. The template will then have the “Held” status and will
not be run by the Engine until the hold is removed. To remove the hold status, select the item in the
list and then click the Unhold button.

l To delete a template, select the template in the list and click the Delete button. The report template
(and job) will be permanently deleted.

l To view or modify a report template, select the report template in the list and click the Select button.
You can then modify the fields and options on the Parameters and Scheduling tabs as needed.

Using the History Tab

The History tab lists each report that has been generated for the selected template and shows the fol-
lowing for each generated report template:
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l Date/Time – Date and time when the template was executed by the engine.

l Status – Status for the template. If the Status column is blank it means the template was com-
pleted. Other possible statuses are Pending, Waiting, and Errored.

l Description – Description entered for the template (if the template has completed). If the template
has a Status of “Waiting” this column shows the date and time when the template will begin to pro-
cess.

l To refresh the history list, click the Refresh button.

l To delete an item from the history list, select the item and click the Delete button.

l To view the report that was generated, select the item and click the View button.

l To email or fax the report that was generated, select the item and click the Email/Fax button. See
"Defining an Email/Fax Destination" on page 60 for more information about emailing and faxing
reports.

System Preferences

The following system preferences for the Report History are set in the Administration module, System
Preferences > Identification/System Constants > CLMS|Reporting Services > Requests

Preference Description

Default number of days for report
files to be archived before pur-
ging

Enter number of days to archive Report Files before purging.

Default number of days for report
history to be archived before pur-
ging

Enter number of days to archive Report History before purging. Pur-
ging will occur only if:
1) the report failed-- or
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Preference Description

2) the report succeeded and the output file was previously purged.

If the preference is not set, then the new Report History record purge will be
skipped entirely. If the preference is set but is less than the value in “Default
number of days for report files to be archived before purging”, then the
greater value will be used.

Generating Crystal Reports

Generating Crystal (Legacy) Reports

The following outlines the basic steps to generate a Crystal report. The specific steps will vary depending
on the report you are creating, when you want to report to generate, and how you want to deliver or
access the report. Note that some Crystal reports cannot be scheduled

Basic steps to generate a Crystal report:

1. In the Reports module, select the report you want to generate from one of the menus. Remember,
Crystal reports are the reports listed above the line in the menus.

Note: If the report you select cannot be scheduled you only see a single screen and not the three
tabs described in the steps below, however the information about the parameters for that report
will help you generate the report.

2. Define the type of data you want to appear in the report on the Parameters tab. Each report has a
unique set of parameters you can define, however some parameters are common across different
reports.

l To learn more generating specific reports, see the topic for that report in the later sections of
this document.

3. If available, use the Scheduling tab to define when you want the report to generate. There are many
options for scheduling, see "Using the Scheduling Tab" on page 82 for more information.

4. If available, use the Templates tab

Using the Templates Tab

The Templates tab lists the saved templates (if any) for the report. These are the reports that have been
scheduled to be run by the engine.
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On this tab you can select a template to open it and then work with it, delete a template you no longer
need, place a scheduled template on hold, retry a template job that has failed, or view the history for a
template report.

The list shows the following information for each template.
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l Description – Name given to the template when it was created (or last modified).

l Interval – The interval defined for the template (on the Scheduling tab).

l Status – Indicates the status of the scheduled template.

l Waiting – Report is waiting to be run by the engine.

l Running Complete – Report is running or completed.

l Held by user – Report was put on hold. If a report is on hold, select it and click the Retry but-
ton to release the hold.

l Failed/Unknown – The scheduled report has failed or the status is unknown.If the report has
failed, select it and click the Retry button to reset the report and have the system try again
(based on the interval).

l Next Run – Shows when the report will next run, if applicable.

Use the buttons defined in the table below to work with the templates in the list.

Button Use To:

Refresh Updates the list to show the most recent information.

Hold Places the scheduled template on hold. Templates that are on hold are not run
by the engine until the hold is released (use the Retry button).

Delete Permanently deletes the template from the system.

Retry Retries a template that has failed (Failed/Unknown status) or releases the hold
on a template (Held status).

History Shows the history for the template which details when the template Report
Detail history for the selected report job.

Select Click this button to modify the Parameters and/or Scheduling options for the
template.

Using the Scheduling Tab

The Scheduling tab to used to define when you want the report to be run by the Engine. Tthe schedule you
define on this tab determines when the report template is run and delivered in the output you selected
(print, email, folder, and so on) for the Output option on the Parameters tab.
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Defining the Schedule

No Schedule

l Use the Template Only option to not define a scheduled polling time. The Engine will not run report
templates if you select this option. This option is most commonly used when creating a “master”
template for others (or yourself) to use and modify later.

Every (Minutes/Hours/Days/Weeks)

l Select the Every option and then enter an interval number in the first field and select an interval
from the list (Minutes, Hours, Days, Weeks) to have the report run on a precise schedule. For
example, enter “12” in the field and select “Weeks” from the list to have the report run every 12 weeks.
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Day of the Week

l Select the Day of the Week option to have the report run on specific day(s) of the week. Then,
select the specific day(s) on which you want to run from the area that appears on the right.

l Use the Time of Day field to enter the specific time when you want the report to run. You can use
AM/PM format or military time, as desired. You can also use “Noon” or “Midnt” to have the report run
at 12:00PM or 12:00AM, respectively.

l If you schedule a template for Day of the week, but do not specify Time of Day, a message appears
when you save prompting you to confirm that you do not want to schedule the report at a specific
time.Click Yes when the message appears to have the Engine run the report on the first poll after
12:00 AM on the specified day(s) of the week.

Week of the Month

l Select the Week of the Month option to have the report run on a specific week of the month. Then,
select the type of week(s) from the area that appears on the right, and select the day when it
should run from the Day list.

l Use the Time of Day field to enter the specific time when you want the report to run. You can use
AM/PM format or military time, as desired. You can also use “Noon” or “Midnt” to have the report run
at 12:00PM or 12:00AM, respectively.

Same Day Every Month

l Select the Same Day Every Month option to have the report run on a specific day each month.
Then, enter the day on which you want the report to run in the field next to the option. For example,
enter “15” in the field to have the report run on the 15th of each month.

l Use the Time of Day field to enter the specific time when you want the report to run. You can use
AM/PM format or military time, as desired. You can also use “Noon” or “Midnt” to have the report run
at 12:00PM or 12:00AM, respectively.

Entering Email/Fax Info

If you selected an ouput of email or fax (or preference), enter information in the following fields:

1. In the Fax/Email Subject field, enter a subject for the email.

2. (Email Only) In the Email Address field, enter the email address where you want the report sent. .

3. (Fax Only) In the Fax # field, enter the fax number where you want the report sent.

4. (Email Only) In the Email Message field, enter the message you want to send with the report.
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SQL Reports

Accounting Menu

Accounting Reports

The Accounting menu group contains reports relating to earnings, collections, balances, and financial
summaries.

BAI Import Report

The BAI Import Report provides information on the data included on the Banking Administration Institution
(BAI) file that is imported via the Engine. The information included on this report are specific details
related to Account balances and activity at the banking institution on behalf of the Lender. This report can
be scheduled via the Engine.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Reports User Guide
SQL Reports

85 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Report Parameters

Field Description

Date range Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Reporting
Services > Requests > Use last business day instead of yesterday in date range
to True. The Yesterday option in the Date Range field is replaced with Last Busi-
ness Day, and reports printed on Monday will print Friday’s data (assuming Fri-
day was the last business day) instead of Sunday’s. Set System Preference
Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date
range is set to True.

Show zero amounts in
summary

If checked, the report will include any Codes with zero dollar transactions in the
Summary Balances and Totals section of the report.

Reports User Guide
SQL Reports

86 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Report Sample
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Report Details

Column Description

Header Row

Originator ID Unique ID assigned to the Lender by the banking institution

Bank Name Name of the banking institution who transmitted the file

Bank Statement As of
Date

The bank statement date will always be one (1) day prior to the current date

Acct # Unique account number assigned to the Lender by the banking institution. The
report could contain multiple account numbers for the same banking insti-
tution.

Summary Balances and Totals
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Column Description

Transaction Transaction Code and Description that are standard BAI codes provided by the
banking institution

Amount Amount of the activity provided in the BAI Import file

Count Item count for the specific transaction code included in the BAI Import file

Detail Credits and Debits

Transaction Transaction Code and Description that are standard BAI codes provided by the
banking institution

Amount Amount of the activity provided in the BAI Import file

0 Day Amount of the activity included in the 0 Day float column on the BAI Import file

1 Day Float Amount of the activity included in the 1 Day float column on the BAI Import file

2+ Day Float Amount of the activity included in the 2+ Day float column on the BAI Import file

Bank Ref Unique reference number provided by the banking institution in the BAI Import
file

Buyout Calculation Report

This report provides a buyout summary of open invoices for selected clients over a specified date range.
The summary includes invoice dates, aging, amount, balances, escrow (rebate), fees, and a total buyout
amount.

Report format options exist for the Buyout Calculation Report to separate monies from “other sources”
(e.g., Carrier Payments) from invoice balances. These other monies are shown in the Other Loan Amount
column. To use this format for the Client summary only, Breakout fees and escrow reserves report options,
set System Preference Reports, Buyout report, Crystal report module (with breakout and with summary) to
BUYOUTBS1. To use this format for the Client summary only report option only, set System Preference
Reports, Buyout report, Crystal report module (without breakout and with summary) to BUYOUTS1.

Note that the original BUYOUT-S and BUYOUT-BS formats include the “loans from other sources” in the
invoice balance totals.

The default report definition for this report is Buyout.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Sort cli-
ent

Select the sort format for the results. You can sort the results by:

l Client name

l Client code

l A/E

l Group value

Group Selecting Group value in the Sort client field enables the Group field. Select the group value
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Field Description

by which to sort the results.

Print cli-
ent sum-
mary
only

Select this check-box to print summaries by client only, without specific invoice detail. If this
option is not selected, each invoice is listed per client.

Breakout
fee and
reserve
escrow

Select this option to print Fee Escrow and Reserve Escrow as separate columns on the
report.

Ignore cli-
ent non-
accrual
date

Select this option to calculate buyout based on payment date when the client has a non-
accrual date set in the Termination panel of the Client Information screen.

Report Samples

Without Breakout Fee or Without Summary Format

With Breakout Fees and without Summary Format
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Without Breakout Fees and with Summary Format

Report Details

Column Description

Buyout A and Buyout-B A

Debtor Displays Debtor Name.

Invoice Number Displays Invoice number.

Invoice Date Date for the invoice.

Sch# Displays the batch # that Invoice was purchased on .

Funded Date Displays the date the Invoice was purchased/funded.

Invoice Amount Displays the Invoice Amount .

Age Displays the age of the invoice as determined by System Preference to be cal-
culated by Invoice Date, Purchase Date, or Due Date.
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Column Description

Balance Displays the Invoice balance.

Fee Escrow Displays the amount in Fee Escrow for the Invoice; calculated as the Invoice
Amount x Fee rate % in Client Terms.

Note: This is only calculated if the “Escrow fees?” box is checked.

Reserve Escrow Displays the amount in Reserve Escrow for the Invoice; calculated as the Invoice
Amount x Reserve Rate % in Client Terms.

Note: This is only calculated if the “Escrow fees?” box is checked.

Earned Fee Displays any calculated fee on the Invoice that is not a fee earned at the time of
purchase; this is typically a fee that is calculated based on Client Terms > Col-
lection Fee Table

Additional Fee Displays any calculated fee on the Invoice that is not a fee earned at the time of
purchase; this fee would be calculated based on Client Terms > Additional
fees and Additional Fee Type = Charge at collection.

Buyout Amount Displays the calculated buyout amount for each Invoice The Buyout Amount is
calculated as the Invoice Balance + (Earned Fee - Reserve Escrow)

Buyout-S A and Buyout-BS A

Client Displays Client Name.

Balance Displays the Invoice balance.

Rebates Displays the amount in Reserve Escrow for the Invoice; calculated as the Invoice
Amount x Reserve rate % in Client Terms

Note: This is only calculated if the “Escrow fees?” box is checked.

Earned Fee Displays any calculated fee on the Invoice that is not a fee earned at the time of
purchase; this is typically a fee that is calculated based on Client Terms > Col-
lection Fee Table

Additional Fee Displays any calculated fee on the Invoice that is not a fee earned at the time of
purchase; this fee would be calculated based on Client Terms > Additional
fees and Additional Fee Type = Charge at collection.

Invoice Buyout
Amount

Displays the calculated buyout amount for each Invoice The Buyout Amount is
calculated as the Invoice Balance + (Earned Fee - Reserve Escrow)
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Column Description

Statement Fee Displays the accrued statement fees as of the date the Buyout report is run
through based on the system preference Do not show statement fees below.

Cash Reserves Displays the balance in the Cash Reserves as of the date the Buyout report is
run through

Actual Buyout
Amount

Actual Buyout Amount = Invoice Buyout Amount - Cash Reserves

Security Roles

To generate the Buyout Calculation Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Accounting Reports > Print Buyout Calculation Report

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Buyout report folder.

Preference Description

Always show grand
total

Set this option to True to include grand total in the totals section of the report.

Crystal Reports mod-
ule name

There are four Crystal Report module name preferences used to assign the
Crystal Reports module for the report.

l without breakout and without summary

l with breakout and without summary

l without breakout and with summary

l with breakout and with summary

Do not include float
days

Set this option to True to exclude float days from age and fee calculations.

Do not show cash
reserves

Set this option to True to exclude the display of cash reserves from the totals
section of the report.

Do not show state-
ment fees

Set to True and the Accrued Statement fees will not be included on the Buyout
Report and Buyout report will only account A/R Advance Balance + Total Loan
Balances - Cash Reserves.
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Preference Description

Set to False and the Buyout Report will include accrued statement fees and will
use the calculation below:

(Facility’s Reserve Interest Fees) + Statement Interest Amt + ((Stmt Other Fee
Amount - Stmt InterestAmt) / Days In Cycle) * Days Into Cycle

Note: Days in Cycle = # of days from StartDate to Last Day In Current Month

Include escrow trans-
fers

Set to True to include escrow transfers (invoice escrow - ledger escrow) on the
report.

Use old (non-API)
module

Old, out of date function will be used if this option is set to True.

Cash Posting Report

This report allows the user to print a summary of the Cash posted for a given date range.

The default report definition for this report is PostReportNf. The POSTREPTD format includes the debtor as
well as the payor, so that the user can determine any discrepancies in payouts.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Cash
Account

Select the Cash Account to which to limit the report, or leave this field blank to include all
Cash Accounts.
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Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.
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Field Description

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Source Select a check source to which to limit the report, or leave this blank to include all defined
sources.

Batch Select a specific batch to which to limit the report, or leave this blank to include all batches.

Select Choose the format for the Cash Report:

l Pending – Cash that is currently pending will be printed in the report.

l Updated – Cash that has been updated/processed will be printed in the report

Report Select the report format to be printed.

l Detail

l Summary

Sequence Select how you want the date in the report to group/subtotal in the report

l Amount – Group by amount of payment lowest to highest.

l Check# – Group by check number.

l Check batch – Group by payment batch number.

l Client – Group by client name.

l Entry – Group in the order that the checks were input into the system.

l Payor – Group by payor name.

l None – Do not group/sub-total the data by any of the above criteria.

Bank # Select this checkbox to display the bank number of the check, if available.

Client Select this checkbox to display the client name to whom the payment applies.

Date Select this checkbox to display the check date.

Summary Select this checkbox to include a summary section at the end of the detail report that sums
the Amount of Checks and Count of Checks for each Source, and provides the percentage
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Field Description

of the grand total that Source represents.

Report Samples

Format: Detail Report

Format: Summary Report
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Report Details

Column Description

Detail Report

Client Displays the Client’s name

Check Source Displays the Check Source

Check# Displays the Check number

Payor Displays the Payor on a Check

Batch# Displays payment batch number

Amount Displays the Amount of the check

Summary Report

Check Batch # Displays payment batch number

Source Displays the Check Source

Amount Displays the Amount of the check

Security Roles

To generate the Cash Posting Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Accounting Reports > Print Cash Posting Reports
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System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Cash Posting Report folder.

Preference Description

Date on detail report
is

Select date option to appear on the Detail Report

l Check Date - Date of the check

l Post Date - Date the Payment Batch was Processed

Date on summary
report is

Select date option to appear on the Detail Report

l Check Date - Date of the check

l Post Date - Date the Payment Batch was Processed

Detail Crystal Reports
module name

Used to assign the crystal reports module a name for the Cash Posting Report,
Detail report format.

Summary Crystal
Reports module
name

Used to assign the crystal reports module a name for the Cash Posting Report,
Detail Summary format.

Use Report Version Set to True to enable the older version of the report.

Fees and Interest Report

The Fees and Interest Report is accessed from the Accounting Menu of the Reports module. The report dis-
plays the total of interest accrued at collection, purchase fees, collection fees, additional fees, and other
fees by client. The fees reflect the activity in the fee accounts assigned in the G/L Account Group for the cli-
ent within the date range.

This report was written for a specific Lender and will only run if specific GL Accounts are debited or cred-
ited. This report will not run for any other Lenders. Therefore, it is recommended that the following security
role be set to False at Security > Mange Roles > Reports > Accounting reports > Fees and Interest
reports to prevent this Report from displaying in the Accounting Menu.

The default report definition for this report is FeeInterest.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
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Field Description

day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.
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Field Description

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Report Sample

Hold Account Detail Report

The Hold Account Detail report lists checks and journals that move funds from hold accounts, lists the
underlying invoice/washed items detail for the journals, and include the user who moved the hold
account funds using the Manage Hold Accounts screen, the hold account reason code, and account to
which the washed funds were applied.

The default report definition for this report is HoldDetail.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set
to True.

Select the magnifying glass icon to open the Search window and begin typ-
ing the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report,
or leave blank to include all users. When a user is selected, the report is limited to clients
that have that user selected in the A/E field on the Control panel of the Client Inform-
ation screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To
access this table, on the File menu, click Tables. Then, on the Client & Debtor menu,
click Client Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Cli-
ent Groups are defined in the Group Code Table.

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of
the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services >
Requests > Use last business day instead of yesterday in date range to True. The Yes-
terday option in the Date Range field is replaced with Last Business Day, and reports
printed on Monday will print Friday’s data (assuming Friday was the last business day)
instead of Sunday’s. Set System Preference Identification/system constants > CLMS|Re-
porting Services > Requests > Saturday is a business day to True to consider Saturday a
business day when the Date Range is set to Last Business Day. This function is only valid
for Reporting Services reports when Use last business day instead of yesterday in date
range is set to True.

Report Sample
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Report Details

Column Description

Journal # Journal # that is assigned by the system when an entry is created via the Man-
age Hold Account screen.

Date Data entry is created.

Payee/Reason Client Name.

Invoice# Invoice Number.

Amount Net amount of the entry. In most cases, this is 0.00 because it is a washed item.

NF Indicator for non-factored Invoice.

Washed By Displays User.

Washed To Account Displays the G/L Account to which the money was transferred, if funds trans-
ferred to a G/L account.

Customers Debtor name.

Invoice Date Invoice Date.

Invoice Amount Invoice Amount.

Payment Post Date Post date when the original payment was posted in FactorSoft.

Payment Check # Check # entered at the time of cash posting.

Payment Amount Check amount entered at the time of cash posting.

Security Roles

To generate the Hold Account Detail Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Accounting Reports > Hold Account Detail Report

Hold Account Ledger Report

The Hold Account Ledgers Report displays details of selected client’s Hold Accounts, including item and
batch details, within a specified date range.

The default report definition for this report is HoldLedgerD.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Account
(blank
for all)

Select the account to which to limit the report. Only accounts marked as Hold Account on the
Hold Account tab of the Account Table screen are listed here. Leave this field blank to include
all accounts.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Format Select the report format to produce:

l Details in date range

l Open items thru date

l Summary
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Field Description

Sort Cli-
ents By

Select the option to determine the order in which the report is sorted on clients:

l Client name

l Client code

Sort
Detail By

Select the sort option that determines the order in which to sort the Open items thru date
format within client:

l Post Date

l Paid to/by

Include
unpaid
checks

Select this option to include unpaid checks in the results. If this option is not selected, unpaid
checks are excluded from the results.

Each cli-
ent
starts on
a new
page

Select this option to print each client on a separate page(s). If this option is not selected, the
results can contain more than one client per page.

Wash
items
against
same
invoice

Select this option to close multiple items for the invoice to equal zero. This option is only avail-
able for the Open items thru date format.

Exclude
Inactive
Clients

Select this check box to exclude inactive clients from the report.

Report Samples

Format: Open Items Thru Date
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Format: Details in Date Range

Format: Summary
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Report Details

Column Description

Client The name of the Client

Note: Only displays if more than one client appears on the report and Each client starts
on a new page is unchecked.

Account The GL Account designated as a Hold Account that the entry was applied to during cash
posting

Note: Only displays if more than one Hold Account exists.

Post Date Displays the date the item was added to the Hold Account via the cash posting screen

Batch # Displays the batch number in which the entry to the Hold Account was included

Invoice # Displays the Invoice number associated to the Hold Account entry

Check # Displays the check number associated to the Hold Account entry

Type Displays the type of transactions that is relevant to the Hold Account entry

Paid to/by Displays the value of the Debtor/Customer associated to the Hold Account entry

Dispute
Code

Displays the dispute code associated to the Hold Account entry

Description Displays the explanation entered on the Hold Account entry at the time of cash posting

Amount Displays the amount of the Hold Account entry

Security Roles

To generate the Hold Account Ledger Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Accounting Reports > Print Hold Account Ledgers

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Hold Account Ledgers folder.

Preference Description

Include unclaimed cash Set to True to include unclaimed cash from non-factoring collaterals on
the report results.
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Preference Description

Reverse signs on report Set to True to have the signs agree with the accounting report instead of
showing hold account balances.

Show age of item on report Set to True to include the age of the open item on the report.

Use older wash logic Set to True to count one-sided checks as washed even if the other side
cannot be found.

Show dispute code on report Set to True to show dispute codes above the explanation.

Letters of Credit Report

This report provides information on the Letters of Credit that are imported in to the FactorSoft database
via the Capital One import file. This report can be scheduled via the Engine.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

DateSent The drop-down options will be the date associated to when the file was sent
from Capital One and processed by the FactorSoft Engine.

Include CIF with No
Activity

Select this box to include Clients with an associated CIF # that have no Letter of
Credit activity.

Report Sample

Report Details

Column Description

Client# The Client# as displayed on Client Information > Client Code

Client The Client as displayed on Client Information > Client Name

LC# The LC# is included in the import file also located at Facility Information > Let-
ter of Credit > LOC Number

Type The Type is included in the import file also located at Facility Information > Let-
ter of Credit > LOC Type

The Letters of Credit Type values are defined in the system preference: Facil-
ity/Collateral Rules (formerly Asset Based Lending) > Rules > Letters of
Credit
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Column Description

S/T Site or Time Code; this value will be passed from Capital One in the import file

Related LOC# If there is a related LOC#, this value will show in this column.

Issue Date Date LOC is issued. This value will be passed in the import file and store under
Facility Information > Letter of Credit > Effective.

Previous Balance This value will be passed in the import file but it is not displayed in the UI.

Exp Date This is the expiration date for the Letter of Credit. Located atFacility Information
> Letter of Credit > LOC Expire.

Balance This is the balance of the Letter of Credit. Located at Facility Information > Let-
ter of Credit > Balance.

Total Fee If the import file contains Fees assessed on the Letter of Credit, the Total Fee
field will show the value of all the fees assessed in that file.

Total Payments If the import file contains Payments on the Letter of Credit, the Total Payments
field will show the value of the payments in that file.

Security Roles

To generate the Letters of Credit Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Accounting Reports > Print Letter Of Credit Report

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Facility/Collateral Rules (formerly Asset Based Lending) > Rules > Letters of Credit folder.

Preference Description

Name for LC Type 1-12 Define the Letter of Credit Type. Users can define up to 12 Types of LOC.

Percentage for LC
Type 1-12

Define the default percentage for each Letter of Credit Type. Users can define
one percentage for each Type of LOC.

Minimum Commission Report

The Minimum Commission Report provides information on the Minimum Commission Plans that are set
up in the system as well as the current balance and/or carry over for each Plan. This report can be sched-
uled via the Engine.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.
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Field Description

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office
to which they are restricted will be selected in the Office field by default and the user will
not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Plan Type Options are Blank(---), Monthly, Quarterly, Semi Annual, Yearly, Annually.

The report will generate data for those Clients who are set up with the associated Min-
imum Commission plan that is defined on Client Information > Minimum Commission >
Plan Type field.

Selecting Blank (---) will enable the Client field to allow you to run the report on a specific
client.

Statement
Dates

Choose the particular posted statement date.

If no Statement Date is chosen, then the report will generate all posted statements for the
client/all clients(if no client is selected).
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Field Description

Format Select the format for the report:

l Detail By Client: Provides the Minimum Commission details by Client separated by
page.

l Detail By Group: Provides the Minimum Commission details by Group separated by
page. The Minimum Commission Groups are defined under Client Information >
Minimum Commission > Included Clients tab.

l Summary By Client: Provides the Minimum Commission information at the sum-
mary level by Client separated by page.

l Summary By Group: Provides the Minimum Commission information at summary
level by Group separated by page. The Minimum Commission Groups are defined
under Client Information > Minimum Commission > Included Clients tab.

l Excluded Entries: Provides the excluded amounts from Minimum Commission
detailed by Client separated by page.

Note: If the only parameter chosen is Format type, the report will render data for all Clients
who have a Minimum Commission Plan.

Include
Pending
State-
ments

If box is unchecked, then the report reflects only posted statements.

If box is checked and the User did not choose a specific Statement Date, the report will
reflect all statements (Posted, Pending and Active statements) for the Client chosen . If
user selects a statement date from the drop-down, the Include pending check box will not
be available.

Report Sample

Detail by Client

Detail by Group
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Summary by Client

Summary by Group

Report Details

Column Description

Header Row

Start Date Displays Contract Start date. The Contract Start date is found under Client
Information > Minimum Commission > Plan > Start Date.

The following security role must be set to view the Minimum Commission panel:
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Column Description

Security Roles > Client Information > Minimum Commission > View the min-
imum commission panel on the client information screen

End Date Displays the Fiscal Year Ending date. The Fiscal Year Ending date is found under
Client Information > Minimum Commission > Plan > End Date.

The following security role must be set to view the Minimum Commission panel:
Security Roles > Client Information > Minimum Commission > View the min-
imum commission panel on the client information screen

Detail Fields

Month Displays the month and year that was included in the Minimum Commission
calculation; if the plan was a Monthly plan, all twelve months that included com-
mission data would show on the report.

Actual Charge Displays the total commission charged in that month.

Monthly Charge Displays the total commission that should be charged based on the plan.

Monthly Min Avg Displays the value of the Minimum Commission divided the number of months
included in the plan.

Adjustment Displays the value of the Actual Charge minus the Month Min Avg.

Charge Displays the value of the Monthly Min Avg minus the Actual Charge. This column
would only be populated if the Client fell short of the Monthly Min Avg with their Actual
Charge.

Previous Balance Displays the balance that was carried over from a previous period if the plan is
set to Carry Forward.

Credit Balance Displays the total Amount in the Adjustment column plus any carry over Adjust-
ments from previous months if the plan is set to Carry Forward.

Adj Comm Amt Displays the value in the Adjustment column.

Excluded Entries Format

Account # Displays the check detail account number associated to the payment

Account Displays the account description

Check # Displays the check number associated to the payment

Date Displays the check date

Reports User Guide
SQL Reports

124 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Column Description

Source Displays the source (C-MISC)

Debit Amount Displays the check amount when greater than 0

Credit Amount Displays the check amount when less than 0

Security Roles

To generate the Minimum Commission Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Accounting Reports > Print Minimum Commission Report

Monthly Revenue Report

The Monthly Revenue Report, which is accessed from the Accounting Menu of the Reports module, lists 12
months of revenue by client, facility within client, or client within account. Each report can be generated
as either a summary or detail report.

The default report definition for this report is MthRev.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

As-of
date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

Inactive clients can be included if the system preference Reports, Monthly Revenue Report,
Show Inactive Clients in Client drop-down is set to True.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:
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Field Description

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Account Select the account to which to limit the report. The accounts available are those defined in
the Accounts table with Earning account selected on the Standard tab.

Report Select the report format to be printed. Each report format displays revenue for each of the
preceding 12 months from the As-of date in a columnar format.

l Client Summary: reports total revenue by client

l Client Detail: reports revenue by account within client

l Facility Summary: reports revenue by facility within client

l Facility Detail: reports revenue in accounts by facility within client

l Account Summary: reports revenue by client within account

l Account Detail: reports revenue in facilities by client within account
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Report Sample

Format: Client Summary

Format: Client Detail

Format: Facility Summary

Format: Facility Detail

Format: Account Summary and Detail
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Security Roles

To generate the Monthly Revenue Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Accounting Reports > Monthly Revenue Report

Purchase Order Report

The Purchase Order Report, which is accessed from the Accounting Menu of the Reports module, lists pur-
chase orders by client along with the order date, order amount, advance amount, advance fee amount,
settlement amount and fees, and total accrued fees. The report is totaled by client as well as a portfolio
level grand total.

The default report definition for this report is PoBuyout1.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

As-of
date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE
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Field Description

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Selection Select the option to limit the results to open purchase orders only, or report all purchase
orders for active clients.

l Every Purchase Order

l Open Purchase Orders

Report Sample

Selection: Every Purchase Order - Shows all Purchase Orders; Open or Settled/Closed
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Selection: Open Purchase Orders - Only Open Purchase orders that have not been settled
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Report Details

Column Descriptions

PO Number Purchase Order Number

Order Date Purchase Order Date

Order Amount Purchase Order Amount

Total Advances Total Advances made on a Purchase Order

Total Advance Fees Total Advance Fees charged at Disbursement of the
Purchase Order Advance

Purchase Disbursement Fees are set at Client Terms >
P.O. Finance Rates Panel > Disbursement Rate

(See Client Terms in User Guide for more information)
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Column Descriptions

Total Settlements Total amount settled against the Purchase Order

Total Settlements Fees Total Settlement Fees charged at the Settlement of the
Purchase Order Advance

Settlement Fees are set at Client Terms > P. O. Fin-
ance Rates Panel or the P.O. Finance Table

(See Client Terms in User Guide for more information)

Accrued Fees Accrued Fees against an advanced Purchase Order

Security Roles

To generate the Purchase Order Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Accounting Reports > Purchase Order Report

Trial Balance Report

The Trial Balance is a summary of daily transactions that affect the General Ledger. There are a number of
feature variations to print this report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
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Field Description

the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests
> Use last business day instead of yesterday in date range to True. The Yesterday option
in the Date Range field is replaced with Last Business Day, and reports printed on
Monday will print Friday’s data (assuming Friday was the last business day) instead of
Sunday’s. Set System Preference Identification/system constants > CLMS|Reporting Ser-
vices > Requests > Saturday is a business day to True to consider Saturday a business
day when the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date range is set
to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.
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Field Description

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.
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Field Description

Account Select the account to which to limit the report. The accounts are defined in the Accounts
table.

Format Select the report format to be printed:

l Detail as Account/Date/Check#

l Detail as Account/Check#/Date

l Summarize to Account

l Summarize to Account/Client

l Summarize to Account/Date/Source

l Summarize to Date/Account/Source

G/L Group Select a G/L Account Group to which to limit the report.

Convert to
native cur-
rency

Select this option to convert amounts from the base currency to the native currency (the
currency of the transaction). The conversion occurs on a client-by-client basis. If the cli-
ent has a currency type set and the currency type is different from the default currency,
FactorSoft looks up the conversion rate using the As of date in the currency table for the
client's currency.

For example, if client ABC Company has a currency type of Canadian Dollars and the
daily conversion rate for Canadian dollars is 1.5, the report increases all of the client's
amounts by a factor of 1.5.

Include
Facility

Select this option to include the facility.

Do Not
Show Zero
Balance
Accounts

Select this option to exclude accounts with a zero balance and no activity for the date
range.

NOTE
This option is only available when Include Facility is not checked for the following
formats:

l Summarize to Account

l Summarize to Account/Client

Exclude Select this option to filter out transactions that do not have a check number assigned.
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Field Description

Trans-
actions with
Pending
Checks

Sample Reports

Format: Detail as Account/Check#/Date

Format: Detail as Account/Date/Check#
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Format: Summarize to Account
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Format: Summarize to Account/Client
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Summarize to Account/Date/Source
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Summarize to Date/Account/Source

Report Details

Column Description

Detail Formats

Account# Displays the value of the G/L Account #

Check# Displays the check # assigned to the transaction

Date Displays the value of the check date

Payee Displays the payee assigned to the transaction (this is likely the Client Name)

Client# Displays the Client Code (if applicable)

Source Displays the transaction source
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Column Description

Reference Displays the batch # assigned to the transaction

Beginning Bal-
ance

Displays the beginning balance of that account based on the date range of the
report

Debit Amount Displays the debit amount to the account based on the date range of the report

Credit Amount Displays the credit amount to the account based on the date range of the report

Ending Balance Displays the ending balance of that account based on the date range of the report

Column Description

Summary Formats

Account# Displays the value of the G/L Account #

Beginning Bal-
ance

Displays the beginning balance of that account based on the date range of the
report

Debit Amount Displays the debit amount to the account based on the date range of the report

Credit Amount Displays the credit amount to the account based on the date range of the report

Ending Balance Displays the ending balance of that account based on the date range of the report

Security Roles

To generate the Trial Balance Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Accounting Reports > Print Trial Balance Reports

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Trial balance folder.

Preference Description

Do not include client number with client
name

Set to True to exclude the client number from the report res-
ults.

Get cash reserves starting balance
from client

Set to True to take initial client cash reserve balances from Cli-
ent record instead of Client Account record.

Include inactive clients in drop-down Set to True to include inactive clients in the Client report cri-

Reports User Guide
SQL Reports

145 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Preference Description

list teria selection list.

Non-balance sheet accounts are year-
to-date

True or False

Show zero amounts in the report
column

Set to True to show zero amounts in columns. Set to False to
replace the “$0.00” displayed in columns cells that have no
balance with blanks.

Use old trial balance function Set this option to True to use the old format Trial Balance
Report screen.

Use account summary balances not cli-
ent balances

True or False

WF Rec Mngr Report

The WF Rec Mngr (which stands for Wells Fargo Receivable Manager) report provides data provided by
Wells Fargo for payments received at the bank in the form of an ACH or Wire. These payments are
assumed to be payments for Invoices in the FactorSoft database or non-funded Invoices.

The data is included on an import file that Wells Fargo transmits to the FactorSoft database and is pro-
cessed by the Engine. To see further details on the import file, please refer to the Import Guide. This report
can be scheduled via the Engine.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-

Reports User Guide
SQL Reports

146 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Check Batch Key Unique key associated to the Check Batch created from the import file

Sample Report

The report is grouped by Batch. The batches are included in the Import file but are not created as sep-
arate batches in FactorSoft. Each Batch will have a Batch Total and the last page of the report will provide
a File Total.

Report Details

Column Description

File Date Date passed in Import file and stored in WFRecMgrFile.FileDate column

File # File number passed in Import file and stored in WFRecMgrFile.FileNumber column

Pmt Type Payment Type code passed in Import file and stored in WFRecMgrPmt.PmtType column

Payor Name Payor Name passed in Import file and stored in WFRecMgrAddr.Name column
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Column Description

Originator to
Beneficiary
Info

Originator to Beneficiary Info passed in Import file and stored in WFRecM-
grPmt.OrigToBeneInfo1, WFRecMgrPmt.OrigToBeneInfo2, WFRecMgrPmt.OrigToBeneInfo3,
WFRecMgrPmt.OrigToBeneInfo4 columns

Pmt Amt Payment Amount passed in Import file and stored in WFRecMgrPmt.Amount column

Analysis Menu

Analysis Reports

The Analysis reports group contains reports that summarize or detail statistical reports by client or debtor.

CPT Codes Report

The CPT Codes Report lists all CPT codes as well as the codes selected by client. This report is used in con-
junction with the CPT codes functionality of invoice purchasing in FactorSoft.

The default report definition for this report is CptList.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.
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Field Description

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Sample Report

Report Details

Column Description

CPT Code Displays CPT Code

CPT Codes are defined in Tables Module > Data Entry > CPT Codes

Description Displays CPT Code Description

Inactive Displays Inactive, if CPT Code is inactive

Last Change User Displays User name that made last change to the CPT Code

Last Change
Date/Time

Displays Date/Time when the last change was made to the CPT Code

Security Roles

To generate the CPT Codes Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > CPT Codes Report

Exception Report

This report lists exceptions returned by the Engine for specified message processes and date parameters.

The default report definition for this report is CadExceptRept.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
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Field Description

dates of the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Reporting
Services > Requests > Use last business day instead of yesterday in date range
to True. The Yesterday option in the Date Range field is replaced with Last Busi-
ness Day, and reports printed on Monday will print Friday’s data (assuming Fri-
day was the last business day) instead of Sunday’s. Set System Preference
Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date
range is set to True.

Message Type Select the message process for which to list exception message.

All Message Types Select this option to generate the report for all message processes.

Reports User Guide
SQL Reports

152 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Report Sample

Report Details

Column Description

Subject Displays the Message Header Subject

Error Message Displays the Message Header Status Text

Attempted Date Displays the Message Header Date Modified

Recipients Displays the Message Address Recipient(s)

Attachments Displays the Message Attachment(s)

Security Roles

To generate the Exception Report, the following Security Role needs to be set to YES:

Reports User Guide
SQL Reports

153 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



l Security Roles > Reports > Analysis Reports > Exception Report

Client Analysis Report

This report displays a summary of a client’s monthly numbers, including averages of sales, invoices, bal-
ance, funds, earnings, yield, dilution, and days turn. The client’s top five debtors are included also, with a
breakdown of the debtor’s percentage to the client’s outstanding balance.

The default report definition for this report is CliAnalysis.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As Of
Date

Select the beginning date of the date range for the report.
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Field Description

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Thru
date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Months
to ana-
lyze

Enter the number of previous months from the As-of Date to be analyzed.

If Blank or Zero, then report will generate based on System Preferences > Reports > Client
Analysis > Default months for analysis

Format Select the report format to print:
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Field Description

l Print client report only: Select this option to generate the Client Analysis detail report.

l Print total report only: Select this option to generate the Summary Client Analysis report.

l Print client and total reports: Select this option to generate both the Client Analysis
detail and Summary Client Analysis reports.

Report Select the report to be generated (see calculations below):

l Standard Client Analysis: This report is intended as a trend analysis report, not a point
in time report. This report is subject to skewed results if purchase activity over the
period takes place in a comparatively short window.

l APR Yield Calculation: This report provides a point-in-time summary of the client's
monthly numbers.

Exclude
Inactive
Clients

Select this option to prevent clients marked as inactive from being included on the report.

Sample Report

Standard Client Analysis Format
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APR Yield Calculation Format
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Report Details

Column Description

Report Standard Client Analysis

Month-Year Displays Month and Year period

Sales Sales and Credits for the period.

Average Invoice Sales divided by the number of invoices
and credit memos processed.

Average Balance Average A/R Balance during the period

Average Funds Average net funds employed during the
period
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Column Description

Client A/R balance less any monies held

Earnings Earnings during the period

Yield Determined by setting of System Prefer-
ence, Reports, Client Analysis, Yield cal-
culation method:

1. (Earnings divided by average
funds) times 12: Fees on alloc-
ated period invoices closed (Dis-
tributed Earnings) divided by the
funds employed multiplied by 12

2. (Earnings divided by average
funds) times (365 or 366 divided
by days in the month): Fees on
allocated period invoices closed
(Distributed Earnings) divided by
the funds employed multiplied by
(days in year (365 or 366) divided
by days in the month

Dilution (Invoices Chargeback / Invoices Paid To
Zero)*100

Days Turn The Days Turn result is the average num-
ber of days a client’s A/R portfolio turns
over, calculated as 365 days / ((12 *
sales) / (average A/R balance))

A/R Balance Displays A/R Balance

Escrowed Reserves Displays money held in Reserve Escrow

Cash Reserves Displays Cash Reserves Balance

Funds Employed A/R Balance - Escrowed Reserves -
Cash Reserves

Hold Accounts Displays money held in a hold account

Adjusted Funded Employed Funds Employed - Hold Accounts
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Column Description

Additional Loan Balance Displays additional loan balance

Total Loan Balance Adjusted Funds Employed + Additional
Loan Balance

Policy Exceptions Displays the Client Information > Policy
Exceptions Panel > Free form text box
information.

Top Debtors Section

Name Debtor name

Debtor# Debtor code

Balance Debtor A/R Balance

Concentration Debtor Concentration % = Debtor A/R
Balance / Client’s Total A/R Balance *
100

Active Customers Number of Active Customers/Debtors
for the Client

Advance Rate Client’s Advance Rate set at the Client
Terms

Credit Limit Client’s Total Credit Limit

Report: APR Yield Calculation

Month-Year Displays Month and Year period

Sales Sales and Credits for the period

Average Invoice Sales divided by the number of invoices
and credit memos processed.

Excluded Sales Open The total period invoices less the period
invoices closed.

Included Sales Closed Total period invoices that are closed at
the as of date.

Funds Employed Average net funds employed during the
period
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Column Description

Excluded Funds Average Funds - Average Funds Closed

Included Funds Funds Employed - any funds from
invoices not yet paid

Distributed Earnings Calculated by spreading the total fees
on all closed invoices (Included Closed)
across all applicable months

Yield Determined by setting of System Prefer-
ence, Reports, Client Analysis, Yield cal-
culation method.

1. (Earnings divided by average
funds) times 12: Fees on alloc-
ated period invoices closed (Dis-
tributed Earnings) divided by the
funds employed multiplied by 12

2. (Earnings divided by average
funds) times (365 or 366 divided
by days in the month): Fees on
allocated period invoices closed
(Distributed Earnings) divided by
the funds employed multiplied by
(days in year (365 or 366) divided
by days in the month

Dilution (Invoices Chargeback / Invoices Paid To
Zero)*100

Totals

Sales Total of the column divided by the num-
ber of actual days accounted for mul-
tiplied by 30

Excluded Sales Open Closing balance at the end of the month
prior to the first month reported plus the
total of all invoices and credit memos
entered during the period of the report.

Included Sales Closed Total period invoices that are closed as
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Column Description

of the as of date.

Distributed Earnings Fees on allocated period invoices
closed, this value is the total of all fees
allocated to the to the report range.

A/R Balance Displays A/R Balance

Escrowed Reserves Displays money held in Reserve Escrow

Cash Reserves Displays Cash Reserves Balance

Funds Employed A/R Balance - Escrowed Reserves -
Cash Reserves

Hold Accounts Displays money held in a hold account

Adjusted Funded Employed Funds Employed - Hold Accounts

Additional Loan Balance Displays additional loan balance

Total Loan Balance Adjusted Funds Employed + Additional
Loan Balance

Policy Exceptions Displays the Client Information > Policy
Exceptions Panel > Free form text box
information.

Top Debtors Section

Name Debtor name

Debtor# Debtor code

Balance Debtor A/R Balance

Concentration Debtor Concentration % = Debtor A/R
Balance / Client’s Total A/R Balance *
100

Active Customers Number of Active Customers/Debtors
for the Client

Advance Rate Client’s Advance Rate set at the Client
Terms
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Column Description

Credit Limit Client’s Total Credit Limit

Security Roles

To generate the Client Analysis Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print Client Analysis Report

System Preferences

The following system preference that affects this report is found in the Administration module, System
Preferences, Fields/screen behavior, Miscellaneous folder.

Preference Description

Calculate earn-
ings based on
account table
flag

Set to True - All accounts flagged as an Earning Account in Tables > Accounting >
Account Table > Standard Tab > Earning Account check box will be included in the cal-
culation instead of their presence in the appropriate G/L group table.

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Client Analysis folder.

Preference Description

Default months for analysis Enter number for the Default setting of
Months to Analyze

Drop cents in top section Set to TRUE top section of the report will
display whole dollars.

Earnings total will be average Set to True Earnings total will be an Aver-
age Earnings

Exclude partial last month from
total

Set to TRUE to exclude partial last month
from total

Maximum months for analysis Enter number for Maximum months for
analysis

Show hold account balances Select option for Hold account bal-
ances:
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Preference Description

1. Do not show hold account bal-
ances

2. Show all hold account balances
even if zero

3. Show only non-zero hold account
balances

Top Debtors will accumulate to
master

Set to TRUE top member debtors will
accumulate to Master Debtor

Yield Calculation Method Select option to indicate Yield cal-
culation Method:

1. (Earnings divided by average
funds) times 12: Fees on alloc-
ated period invoices closed (Dis-
tributed Earnings) divided by the
funds employed multiplied by 12

2. (Earnings divided by average
funds) times (365 or 366
divided by days in the month):
Fees on allocated period invoices
closed (Distributed Earnings)
divided by the funds employed
multiplied by (days in year (365
or 366) divided by days in the
month

Concentration Report

Concentration Reports are available to determine possible levels of liquidity within the portfolio, based on
the Account Debtors outstanding balances.

The default report definitions for this report are:
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l Portfolio concentration = Concent1

l With Period Sales= Concent1p

l Bank Report = Concent1b

l Client concentration w/rating = ConcntD

l Client concentration w/aging = ConcntDA

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services >
Requests > Use last business day instead of yesterday in date range to True. The Yes-
terday option in the Date Range field is replaced with Last Business Day, and reports
printed on Monday will print Friday’s data (assuming Friday was the last business day)
instead of Sunday’s. Set System Preference Identification/system constants > CLMS|Re-
porting Services > Requests > Saturday is a business day to True to consider Saturday a
business day when the Date Range is set to Last Business Day. This function is only valid
for Reporting Services reports when Use last business day instead of yesterday in date
range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set
to True.

Select the magnifying glass icon to open the Search window and begin typ-
ing the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report,
or leave blank to include all users. When a user is selected, the report is limited to clients
that have that user selected in the A/E field on the Control panel of the Client Inform-
ation screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Debtor Group Select the debtor group to which to limit the report results from the list. Debtor Groups
are defined in the Debtor Group Table.

Value Select the specific debtor group value to which to limit the report results from the list.

Report/Form-
at

Select the format for the report:
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Field Description

l Portfolio Concentration:generate the Concentration by Debtor Report

l With Period sales: generate the Concentration by Debtor Report with period sales

l Bank Report: generate the Bank Report by Debtor.

l Client Concentration w/rating: generate the Concentration by Client/Vendor
report with the credit rating code displayed.

l Client Concentration w/aging: generate the Concentration by Client/Vendor
report with the NOA sent/received status and aging buckets displayed for each
Debtor.

Sort Select the sort option that determines the order in which to sort the report.

l Name

l Balance

l Rating

Minimum bal-
ance

Enter the minimum dollar amount of outstanding balance to list on the report. Only debt-
ors with balances equal to or greater than this amount will be listed on the report.

Minimum %
client

Enter a minimum percentage of client share to include a debtor in the report results. This
option is only active for the Client concentration w/rating and Client concentration
w/aging report formats.

Minimum %
Limit

Enter a minimum percentage of credit limit to include a debtor in the report results. This
option is only active for the Client concentration w/rating and Client concentration
w/aging report formats.

Minimum % Select And to indicate that the Minimum % client and Minimum % limit values must
both be met to include the debtor in the results. Select Or to indicate that if either the
Minimum % client or Minimum % limit value can be met, the debtor is included in the
results.

Combine to
master
debtor

Select this option to combine member clients into their master client on report.

Show debtor
#

Select this option to display Debtor Numbers on the report, if applicable.

Show clients Select this option to list the Client on the report. This option is not available when you
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Field Description

select either of the Client Concentration formats.

Each client
starts on a
new page

Select this option to print each client on a separate page(s). If this option is not selected,
the results can contain more than one client per page. This option is not available when
you select the Portfolio Concentration format.

Include aver-
age days to
pay

Select this option to generate the Concentration by Debtor Report with the average
days to pay (Days/Pay column) included. This option is only available for the Portfolio
Concentration format.

Show % of Lis-
ted

Select this option to include the % Listed column on the report, which displays the con-
centration percentage of each debtor listed on the report in relation to all other debtors
listed on the report (i.e., for debtors within the report criteria). This option is only active
for the Portfolio Concentration, With period sales, or Bank report report formats.

Show % of
Portfolio

Select this option to include the % Listed column on the report, which displays the con-
centration percentage for each debtor in relation to all debtors in the portfolio. This
option is only active for the Portfolio Concentration, With period sales, or Bank report
report formats.

Show % of Cli-
ent

Select this option to include the % Listed column on the report, which displays the con-
centration percentage for each debtor in relation to all debtors for the client. This option
is only active for the Client concentration w/rating and Client concentration w/aging
report formats.

Report Sample

Format: Portfolio Concentration
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Format: With period sales
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Format: Bank report
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Format: Client concentration w/rating
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Format: Client Concentration w/aging
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Report Details

Field Description

Format: Portfolio Concentration

Debtor Name Debtor name

Debtor # Debtor Code

Client… Client Name

Rating Debtor’s Credit Rating

D&B D&B Rating

Experian Experian Rating

Researched Credit Research Date based on System Preferences

1. Preferred researched date

Limit Limit based on System Preferences
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Field Description

1. Portfolio concentration shows house line instead of active lines

2. Zero credit limit if expired

Debtor Balance Client/Debtor Relationship Balance

% Listed Based on Show % check boxed:

If “Show % of Listed” is checked, Then Debtor Balance/Total of Customer
Listed

If “Show % of Portfolio” is Checked, Then Debtor Balance/Total of Portfolio
Balance

If “Show % of Client” is Checked, Then Debtor Balance/Total of Client Bal-
ance

Days/Pay Days to pay based on System Preferences

1.Based days to pay on

2. Days to pay calculation method

Format: With period sales

Debtor Name Debtor name

Debtor # Debtor Code

Client.. Client Name

Rating.. Debtor’s Credit Rating

Period Sales Total Sales/Purchases for the period

Researched Credit Research Date based on System Preferences

1. Preferred researched date

Limit Limit based on System Preferences

1. Portfolio concentration shows house line instead of active lines

2. Zero credit limit if expired

Debtor Balance Client/Debtor Relationship Balance

% Listed Based on Show % check boxed:
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Field Description

If “Show % of Listed” is Checked, Then Debtor Balance/Total of Customer
Listed

If Show % of Portfolio is Checked, Then Debtor Balance/Total of Portfolio
Balance

If Show % of Client is Checked, Then Debtor Balance/Total of Client Bal-
ance

Format: Bank report

Debtor Name Debtor name

Debtor # Debtor Code

Client.. Client Name

Debtor Balance Client/Debtor Relationship Balance

Format: Client concentration w/rating

Client… Client Name

Debtor Debtor Name

Debtor Balance Client/Debtor Relationship Balance

% Client Balance Percentage of the Client’s Total A/R Balance

Credit Limit Limit based on System Preferences

1. Portfolio concentration shows house line instead of active lines

2. Zero credit limit if expired

% Credit Limit Percentage of the Debtor’s Credit Limit

Other Balance Debtor total balance across its other relationships

Period Sales Total Sales/Purchase for the period

Period Payments Total Payments for the Period

Researched Date Credit Research Date based on System Preferences

1. Preferred researched date

Rating Debtor’s Credit Rating
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Field Description

Format: Client Concentration w/aging

Client… Client Name

Debtor.. Debtor Name

Debtor Balance Client/Debtor Relationship Balance

% Client Balance Percentage of the Client total Balance

Credit Limit Limit based on System Preferences

1. Portfolio concentration shows house line instead of active lines

2. Zero credit limit if expired

% Credit Limit Percentage of the Debtor’s Credit Limit

NOA Type/Date NOA Type & Date:

R- Received

S - Sent

W- Waived

Current Amount of Current A/R

1-30 Amount of A/R 1- 30 days

31-60 Amount of A/R 31- 60 days

61-90 Amount of A/R 61- 90 days

91-120 Amount of A/R 91- 120 days

Security Roles

To generate the Concentration Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print Concentration Reports

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Concentration Reports
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Preference Description

Preferred researched date Select preferred
researched date:

1. Debtor Information
Date

2. Debtor Aging Date

Based days to pay on Select the date that
days to pay will be
based on:

1. Invoice Date

2. Posted Date

Days to pay calculation method Select the cal-
culation method for
Days to pay:

1. Average days to
pay

2. Weighted average
days to pay

Period sales includes denied invoices Select TRUE to
included denied
invoices in the Period
sales amount.

Portfolio concentration shows house line
instead of active lines

Select TRUE to show
house line instead of
active lines for Port-
folio Concentration
Report

Show credit balances on report Select TRUE to show
credit balances on
the reports

Use old version Select TRUE to use
old version of the
reports
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Preference Description

Zero credit limit if expired Select TRUE to zero
credit limit if expired

Include Tracked A/R Select TRUE to
include Tracked A/R
in the Reports

Finance Maturity Date Report

The Finance Maturity Date Report generates a listing reflecting the Invoice #, Invoice Date, Invoice
Amount, Amount Funded, Invoice Balance, Finance Maturity Date, Days Past, Fee % for a Client/Debtor Rela-
tionship enabling the FI to easily manage and determine which relationships are Over due resulting in
future purchased invoices to be consider ineligible.

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.
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Field Description

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

As of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Include
Zero Bal-
ance
Invoices

Report will include invoices that have a Zero outstanding balance.

Reports User Guide
SQL Reports

182 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Client Group Codes Table.htm


Report Sample

Report Details

Column Description

Client Displays the Client Name

Debtor Displays the Debtor Name

Invoice # Displays the Invoice Number

Invoice Date Displays the Invoice Date

Invoice Amount Displays the Invoice Amount

Amount Funded Displays the Amount advanced on the Invoice

Invoice Balance Displays the Outstanding Balance on the Invoice

Finance Maturity Date Displays the Finance Maturity Date on the Invoice

Days Past Displays the number of days past the Finance Maturity Date

Fee % Fee % = Basis + Plus
where Plus amount is located at Client Terms > Due Date Fee Panel

If using Insurance Overrides, then
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Column Description

Fee % = Basis + Plus
where Plus amount is located at Detail Aging > Extra Terms Tab > Overrides

Security Roles

To generate the Cash Posting Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print Finance Maturity Date Reports

Funding Report

The Funding Report lists the most recent Reserve Release Transaction processed for a Client detailing the
Reserve disbursement transaction number, Client name, Posted date, Payee, Reserve Amount Released,
Expenses, Amount Disbursed, and Memo description along with the fields from the Client Summary Screen
Reserves tab reflecting the amounts at the time the report is generated.

Default Report Name: RelDocTF

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.
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Field Description

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.
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Report Sample
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Report Details

Line Item Description

Reserve Disbursement Most recent Reserve Release Batch # & Client Name

Posted on Date of most recent Reserve Release

Paid to Payee on the Reserve Release

Reserve amount
released

Amount of the Reserve release

Deductions/Amount Expenses description and Amount charged at the time of the Reserve
release

Amount Disbursed Amount Disbursed = Reserve Amount Released - Deductions.

Memo Description on the Reserve Release

Client Summary > Reserve Tab Section

Cash Reserves Displays the dollar amount of cash reserves for the client.

+Escrowed Reserves Displays the dollar amount of escrowed reserves in escrow for the client.

Total Reserves Displays the sum of Cash Reserves and Escrowed Reserves.

-Recourse/Ineligible The dollar amount of invoices available for recourse and invoices in dispute.

-Accrued Invoice Fees The dollar amount of accrued fees for the client, if applicable.

-Accrued Interest The dollar amount of accrued interest for the client, if applicable.

Adjusted Reserves Displays the remainder of Total Reserves minus recourse, fees, and interest.

-Required Reserves The dollar amount of required reserves.

Additional Reserves Held The dollar amount of additional required reserves.

Available for Release Displays the remainder of Adjusted Reserves minus required reserves and
float.

Security Roles

To generate the Funding Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print Funding Report
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Guarantee Analysis Report

The Guarantee Analysis Report provides a versatile summary of guaranteed sales or earnings versus
actual sales or earnings for specified clients up to a certain date.

The setting of System Preference Reports, Guarantee analysis, Report to member clients affects the res-
ults of the report as it relates to master and member clients. If set to True, the report applies only to mem-
ber clients. Master clients are not reported, even if they have a guarantee set. If set to False, the report
applies only to the master client. If a member of a master client has a guarantee set, but the master does
not, the client is not included on the report, but clients that do not belong to a master are reported.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
thru

Select the ending date of the date range for the report. Choose Current date, Previous
month-end date, or specify a Specific date in the field to the right.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
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Field Description

the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Format Select the report format to print:
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Field Description

l 1-Guaranteed Sales Versus Actual (Average by month)

l 2-Guaranteed Sales Versus Actual (not averaged)

l 3-Guaranteed Earnings Versus Actual (Average by month)

l 4-Guaranteed Earnings Versus Actual (Thru date in month)

Show
Adjusted
rates

Select this option to display adjusted rates on the report. This option is only available for the
two Guaranteed Sales Versus Actual formats.

Sort by
Broker

Select this option to sort the records returned for the report by broker.

Report Sample

Format: 1-Guaranteed Sales versus Actual (Average by Month)
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Format: 2-Guaranteed Sales versus Actual (Not Averaged)
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Format: Guaranteed Earnings versus Actual (Average by Month)
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Format: 4-Guaranteed Earnings versus Actual (Thru date in month)
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Report Details

Column Description

Format: 1-Guaranteed Sales versus Actual (Average by Month)

Client… Client Name

Client# Client Code

Signed Date Client’s Signed Date

Guaranteed Sales Client’s Guaranteed Amount established on the Client Information > Statements
Terms Panel > Guarantee Type > Sales and Guaranteed Amount

Over Months Over Months established on the Client Information > Statements Terms Panel >
Months

Average Guar-
antee

Client’s average Guaranteed Amount for Over Months Period
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Column Description

Average Sales Clients average Sales/Purchases for Over Months Period

Shortage Average Guarantee - Average Sales

Fee Rate Client’s Fee Rate (%) located at Client Terms > Purchase Fees panel > Fee Rate
(%)

Lost Earnings Shortage x Fee Rate

Format: 2-Guaranteed Sales versus Actual (Not Averaged)

Client… Client Name

Client# Client Code

Signed Date Client’s Signed Date

Guaranteed Sales Client’s Guaranteed Amount established on the Client Information > Statements
Terms Panel > Guaranteed Amount

Over Months Over Months established on the Client Information > Statements Terms Panel >
Months

Actual Guarantee Client’s Guaranteed Amount established on the Client Information > Statements
Terms Panel > Guaranteed Amount

Actual Sales Actual Sales/Purchased for “Over Months” Period

Shortage Actual Guarantee - Actual Sales

Fee Rate Client’s Fee Rate (%) located at Client Terms > Purchase Fees panel > Fee Rate
(%)

Lost Earnings Shortage x Fee Rate

Adjusted Rate Client’s Adjustment located at Client Terms > Fee Adjustment Panel where Adjust-
ment drop-down is Made at Purchase

Adjusted Earnings Actual Save x Adjusted Rate

Format: 3-Guaranteed Earnings versus Actual (Average by Month)

Client… Client Name

Client# Client Code

Signed Date Client’s Signed Date
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Column Description

Guaranteed Sales Client’s Guaranteed Amount established on the Client Information > Statements
Terms Panel > Guaranteed Amount

Over Months Over Months established on the Client Information > Statements Terms Panel >
Months

Average Guar-
antee

Client’s average Guaranteed Amount for Over Months Period

Average Sales Clients average Sales/Purchases for Over Months Period

Shortage Average Guarantee - Average Sales

Fee Rate Client’s Fee Rate (%) located at Client Terms > Purchase Fees panel > Fee Rate
(%)

Lost Earnings Shortage x Fee Rate

Format: 4-Guaranteed Earnings versus Actual (Thru date in month)

Client… Client Name

Client# Client Code

Signed Date Client’s Signed Date

Guaranteed Sales Client’s Guaranteed Amount established on the Client Information > Statements
Terms Panel > Guaranteed Amount

Over Months Over Months established on the Client Information > Statements Terms Panel >
Months

Average Guar-
antee

Client’s average Guaranteed Amount for Over Months Period

Average Sales Clients average Sales/Purchases for Over Months Period

Shortage Average Guarantee - Average Sales

Fee Rate Client’s Fee Rate (%) located at Client Terms > Purchase Fees panel > Fee Rate
(%)

Lost Earnings Shortage x Fee Rate
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System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Guarantee Analysis.

Preference Description

Exclude journals Set to True to exclude fees earned from journals from the report.

Exclude non-funded
sales

Set to True to exclude non-funded sales from the period sales figures.

Include date signed
on report

Set to True to include the client date signed on the report.

Report to member cli-
ent

Set to True to accumulate the report to member clients instead of mas-
ter clients

Override Terms Report

The Override Terms Report shows information about Overrides & Extra Terms entered for a client/debtor
relationship on either the Overrides & Extra Terms tab of the Detail Aging screen.

To access this report, in the Reports Module, on the Analysis menu, click Override Terms Report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
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Field Description

erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.
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Field Description

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.

Security Role

The Override Terms Report is configured in Security > Manage Roles > Reports > Analysis > Print Override
Terms Report (Yes/No).

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences > Fields/Screen Behavior > Screens > Client Aging folder.

Preference Description

Allow Invoice Based
Terms overrides
(Beta)

Set to True to allow terms to be set on the Overrides Tab on the Detail Aging
screen. If false, Override terms are set at the Purchase Fee panel of the Client
Terms screen in Client Information.

Report Details

The Override Terms Report contains the following rows:
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l Client row reflects the Term that is set on the Client Information > Client Terms > Purchase Fee
panel.

l Debtor row reflects the Term that is selected on Detail Aging > Overrides tab > Override Collection
Fee (Beta) drop-down.

Double Asterisk (**) is used to indicate that Override Terms are applied on the Cli-
ent/Debtor Relationship.

Column Description

Client Name Displays the Client’s name.

Client Terms Terms set at Client Information > Client Terms .

Debtor Name Displays the Debtor's name.

Override Terms Terms set at Detail Aging > Overrides Tab > Override Collection Fee (Beta)
drop-down.

** Indicates Override Terms apply on that Client/Debtor Relationship.

Reserve % Displays the Reserve %

l Reserve % on Client Terms > Purchase Fee Panel

l If using Overrides, Reserve % on Detail Aging > Overrides Tab

Reserve % Displays Rsv Escrowed (T/F) indicating Reserves are being escrowed or held.

Fee % Displays the Fee %

l Fee % on Client Terms > Purchase Fee Panel

l If using Overrides, Fee % on Detail Aging > Overrides Tab

Fee Escrowed Fee Escrowed (T/F) indicating Fees are being Escrowed or Earned.
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Column Description

Advanced Rate Calculated Advance Rate.

Insurance Extra Terms Overrides (Associated with Insurance Policy Center Add-on Module)

Basis Overrides the Basis on the Client Terms > Due Date Fee Panel basing the due
date fee by purchase date to due date plus Cushion. The choices are defined in
the Daily Rate Basis table.

Plus Overrides the Plus on the Client Terms > Due Date Fee Panel basing the due
date fee by purchase date to due date plus Cushion.

Cushion Overrides the Cushion on the Client Terms > Due Date Fee Panel basing the
due date fee by purchase date to due date plus Cushion.

Tenor Overrides the Tenor on the Policy Information > Settings Panel

Finance Maturity Days Data field Only. Does not apply to any formulas.

Overdue Days Number of days used to calculate when an invoice is over due and consider Ine-
ligible due to Insurance Ineligible Rule “Exceeds Finance Maturity Date”.

Max Invoice Period Overrides the Max Invoice Term on the Client Information > Invoice Rules Panel
and is the number of days used to determine when an invoice is Ineligible due
to Insurance Ineligible Rule “Max Invoice Ship Period Exceeded”.

Max Invoice Term Overrides the Max Invoice Age on Client Information > Invoice Rules Panel and
is the number of days used to determine when an invoice is Ineligible due to
Insurance Ineligible Rule “Max Invoice Age Exceeded”.

Report Sample
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Insurance Policy Report

The Insurance Policy report lists policy details, such as the percentage of the policy used, the percentage
of the policy remaining, the coverage amount used, the coverage amount remaining, the invoices for spe-
cific debtors, and so on, for the specified client.

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com

This report is accessed from the Analysis menu of the Reports module, provided the user has security
rights enabled.

The default report definition for this report is InsPolicy.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Insurer Insurer's Name
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Field Description

This drop-down is set up in Tables > Client & Debtor > Insurers

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
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Field Description

Group Codes.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.

Insurance
Policy

Select the insurance policy to which to limit the report results from the list.

Show Select the status of the insurance policies you want the report to contain:

l Current – Shows all active current policies.

l Outstanding – Shows policies that have open invoices allocated to them (active and
expired).

l Expired – Shows all expired policies.

l All – Shows all policies (current and expired).

Report Sample

Column Description

Insurer Insurer's Name

Policy Desc Policy’s Description

Client Name Client Name

Policy # Policy’s Number

Tenor A. Policy Level - Policy Information > Settings
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Column Description

Panel > Tenor

B. Client/Debtor Relationship Level - Detail
Aging > Extra Terms Tab > Tenor

% Used A. Insurer’s Level - Percentage of the Insurer's
Credit Limit that is used.

B. Policy Level - Percentage of the Policy Max
Liability limit that is used.

% Remaining A. Percentage still available under the Insurer’s
Credit Limit.

B. Percentage still available under the Policy
Max Liability limit.

Limit A. Insurer Level - Insurer’s Credit Limit.

B. Policy Level - Policy Information > Policy
Max Liability Limit.

C. Client/Debtor Relationship - Policy Inform-
ation > Allocation Panel > Coverage Limit for
the relationship

Invoice Balance Balance of the invoice that is covered by insur-
ance policy.

Coverage Used Amount for the invoice that used coverage
under the policy.

Expiration Date Date the Policy expires

Max Credit % Max Credit Protection % for the Client/Debtor
Relationship. Set at Detail Aging > NOA/Rules
Tab > Max Credit Protection

Availability Policy amount that is still available at the
Insurer’s Level, the Policy Level and the Cli-
ent/Debtor Relationship level.
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Insurance Turnover Report

The Insurance Turnover report lists the number of invoices purchased against the insurance policy. This
report can be requested for paid and unpaid invoices.

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com

This report is accessed from the Analysis menu of the Reports module, provided the user has security
rights enabled.

The default report definition for this report is InsTurnover.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Select the date to use for the report from the list:
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Field Description

Range l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.

Invoice
Type

Select whether to request the report for paid or unpaid invoices.

Policy
Name

Select the insurance policy for which to limit the report results from the list. Leave this field
blank to request the report for all insurance policies for the client.

Enter the insurance policy for which to limit the report results. Click the Down Arrow to display
a list of valid entries.
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Field Description

Leave this field blank to request the report for all insurance policies for the client.

Format Select whether to review the report in a detail format, which displays a breakdown of invoices
for each policy, or summary format, which displays only the total number of paid and unpaid
invoices.

Report Sample

Detail Format:

Summary Format:

Reports User Guide
SQL Reports

211 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Column Description

Detail Format

Policy Name Policy Description

Invoice Number Invoice Number

Policy Number Policy #

Invoice Date Invoice Date

Invoice Amount Invoice Amount

Number of Unpaid Invoices Number of Unpaid Invoices associated with the policy

Number of Paid Invoices Number of Paid Invoices associated with the policy

Client Client Name

Debtor Debtor Name

Summary Format

Policy Name Policy Description

Policy Number Policy #

Number of Unpaid Invoices Number of Unpaid Invoices associated with the policy
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Column Description

Number of Paid Invoices Number of Paid Invoices associated with the policy

Security Roles

To generate the Insurance Turnover Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print Insurance Turnover Report

Invoice Computation Report

The Invoice Computation Report provides the Terms Detail indicating the fees to be charged and earned
along with Fee Calculation and the Latest Invoice Note associated with a specific Invoice.

The default report definition for this report is InvCompRept.

Report Parameters

Field Description

As Of Date Select the beginning date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)
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Field Description

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in
the ClientWeb Report Queue, a screen appears to choose the date range (Cur-
rent Date, Previous Month-End Date, or Specific Date).

Invoice # Enter a specific invoice number.

Show Notes Select this option to include notes associated with the invoice on the report.
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Sample Report
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Last Payment Received Date Report

The Last Payment Received Date Report is a custom report. This report is intended to display any Debtor
for whom a payment has been received in a certain amount of time.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.
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Field Description

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Last Pay-
ment
Older
Than

Input the number of days that the system will use to determine if the debtor has had a pay-
ment received since then, if blank will default to 0 days.

Show All
Payments

If this flag is checked, the “Last Payment Older Than” field is unavailable and the report will
show all payments posted based on the parameters chosen.
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Sample Report

Report Details

Column Description

Debtor Displays the Debtor name and Debtor Code.

A/R Balance Displays the Debtor Balance.

Last Payment Date Displays the date of the last payment posted for that Debtor,

# of Days Since Last
Payment

Displays the number of days since the last time a payment was posted on that
Debtor.

Market Line Export Report

The Market Line Export Report is a custom spreadsheet report.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Reporting
Services > Requests > Use last business day instead of yesterday in date range
to True. The Yesterday option in the Date Range field is replaced with Last Busi-
ness Day, and reports printed on Monday will print Friday’s data (assuming Fri-
day was the last business day) instead of Sunday’s. Set System Preference
Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date
range is set to True.
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Security Roles

To generate the Market Line Export Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print Market Line Export

Master Client Analysis Report

This report is custom and will only generate data when run in a specific database.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As Of
Date

Select the beginning date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.
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Field Description

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Thru
date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:
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Field Description

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Months
to ana-
lyze

Enter the number of previous months from the As-of Date to be analyzed.

If Blank or Zero, then report will generate based on System Preferences > Reports > Client
Analysis > Default months for analysis

Exclude
Inactive
Clients

Select this option to prevent clients marked as inactive from being included on the report.

Report Details

Column Description

Month-Year Displays Month and Year period

Sales Sales/Purchases for the period.

A/R Balance Displays A/R Balance

Funding Balance Total amount of A/R funded for the
period

Reports User Guide
SQL Reports

223 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm
Client Group Codes Table.htm
Client Group Codes Table.htm


Column Description

Funding Percent (Funding Balance / A/R Balance) X 100

Dilution (Invoices Chargeback / Invoices Paid To
Zero)*100

A/R Turn The Days Turn result is the average num-
ber of days a client’s A/R portfolio turns
over, calculated as 365 days / ((12 *
sales) / (average A/R balance))

Credit Notes Total Amount of Credit Notes purchased
during the period

Over 60 Days Total amount of A/R Over 60 days

Over 60 as % of A/R (Over 60 days / A/R Balance) X 100

Top 5 Debtors Section

Debtor Debtor name

Credit Limit Debtor Credit Limit or Detail Aging Credit
Override, if applicable

Current Balance Client/Debtor Relationship Current Bal-
ance

Over 60 days Amount of the Client/Debtor Relationship
Balance over 60 days

Concentration Debtor Concentration % = Debtor A/R Bal-
ance / Client’s Total A/R Balance * 100

Client Section

A/R Balance Displays A/R Balance

Client Since First Funding Date

Note - Blank since Master Client’s aren’t
funded against

Account Manager Client’s A/E from Client Information > Con-
trol Panel > A/E

Collector Collectors as defined at Client Inform-
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Column Description

ation > Groups Panel > Collectors

Active Debtors Number of Active Debtors for the Client

Advance Rate Client’s Advance Rate per Client Terms

Credit Limit Client’s Credit Limit

Notice Date Notice Date as defined at Client Inform-
ation > Misc data Panel > Element: Notice

Hypotec/PPSA Expiry Date Client’s Hypotec/PPSA Expiry Date

Total Fund Employed Section

Fund employed on A/R The sum of A/R Funded for all Member Cli-
ents for the period

Inventory The sum of Inventory for all Member Cli-
ents for the period

Equipment The sum of Equipment for all Member Cli-
ents for the period

Collateral Debt The sum of Collateral Debt for all Mem-
ber Clients for the period

Collateral Credit The sum of Collateral Credit for all Mem-
ber Clients for the period

Overadvance The sum of Overadvance for all Member
Clients for the period

Other The sum of Other for all Member Clients
for the period

Real Estate The sum of Real Estate for all Member Cli-
ents for the period

Total Funds Employed Total Funds Employed at the Master Cli-
ent Level

LC Opened The sum of LC Opened for all Member Cli-
ents for the period

LG Opened The sum of LG Opened for all Member Cli-
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Column Description

ents for the period

FX Open The sum of FX Open for all Member Cli-
ents for the period

Total Involvement Total Funds Employed + LC Opened + LG
Opened + FX Open

Max Credit Protection Report

The Max Credit Protection report is used to review the total amount of an invoice that exceeds the max-
imum credit protection, as defined for the client on the Client Information screen. Using this report, you
can review the over-funded amounts for a client after a specified grace period has expired.

The default report definition for this report is MaxCredProtect.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.
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Field Description

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.
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Report Sample

NOTE
Data only displays on this report if the funded amount for the invoice exceeded the maximum credit
amount for the invoice and the invoice date plus the number of days until due (grace period + invoice
due date) is greater than the system working date.

Report Details

Column Description

Client Displays the Client’s name

Debtor Displays the Debtor's name.
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Column Description

Invoice # Displays the Invoice Number.

Invoice Amount Displays the Invoice Amount.

Invoice Balance Displays the Outstanding balance on the Invoice.

Finance Maturity Date Displays the Finance Maturity Date on the Invoice.

Grace Days Number of days for Grace (Cushion). This is set at Client Terms > Due Date Fee
Panel > Cushion or if using overrides, this is set at Detail Aging > Extra Terms
Tab > Overrides section > Cushion

Finance Maturity Days Displays the Number of days past the Finance Maturity date to the date of the
report.

Max Credit % Max Credit Protection %. This is set at Client Information > Invoice Rules Panel >
Max Credit Protection or if using overrides, this is set at Detail Aging >
NOA/Rules Tab > Max Credit Protection

Overage Amount Overage Amount = Funded Amount - Max Credit % Amount

Not Payable To Lender Report

This report displays a summary of the checks not paid to the lender. The client and debtor name will dis-
play along with the check date, check number, check amount, balance, credit limit, NOA status, checks
received and how many checks were not paid to the lender.

The default report definition for this report is NotPayFact.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
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Field Description

s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
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Field Description

this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Sequence Select the sort sequence for the report data:

l AE, Client,Debtor

l Client, Debtor

Report Sample

Report Details

Column Definition

Client Client Name

Debtor Debtor Name

Check
Date

The Date that the Check was created.

Displays if System Preference below is set to Check Date and the report is generated by
Check Date

Post Date The Date that the Check was posted.

Displays if System Preference below is set to Post Date and the report is generated by Post
Date

Check
Number

The number of the check.

Reason Reason why the check was not paid to lender.

Check
Amount

The amount of the check.
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Column Definition

Check
Source

The Check Source of the check.

Displays if System Preference below is set to TRUE and Check Sources are defined in Tables
> Data Entry > Check Sources

Balance The balance owed for the relationship at the time the report was generated. Does not show
the balance "as of" the date range, only the current balance for the relationship at the spe-
cific date/time the report was generated.

Credit
Limit

The credit limit for the relationship when the report was generated. Does not show the
credit limit "as of" the date range, only the current credit limit for the relationship at the spe-
cific date/time the report was generated.

NOA
Status

The NOA Status for the relationship when the report was generated. Does not show the
status "as of" the date range, only the current status for the relationship at the specific
date/time the report was generated.

Checks
Received

Total number of checks posted to this relationship for the life of the relationship.

Not Paid to
Lender

Total number of checks received for the life of the relationship that were marked as NPTF.

Security Roles

To generate the Not Payable to Lender Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print not payable to lender Report

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports,Not payable to lender report

Preference Description

Include check source on report Set to TRUE the report
will include Check
Source

Select based on Select based on date
by which the report
will be generated:
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Preference Description

Check Date

Transaction Post
Date

Overdraft Report

This custom report lists master clients with the (Overdraft) Reserves column displaying the cumulative
excess/deficit for the member clients under the master so that the lender can easily identify negative
availability for the master client. This report is accessed from the Analysis menu of the Reports module.

The default report definition for this report is Overdraft.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As Of
Date

Select the ending date of the date range for the report.
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Field Description

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
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Field Description

change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table.

Report Details

Field/Column Description

Name Client Name

A/R Balance Client’s total amount of A/R Balance

Ineligible A/R Client’s total amount of Ineligible A/R

Reserves/AddBacks Client’s Ineligibilities as defined in Client Information > Ineligibility Panel > Cli-
ent Ineligibility Grid

Eligible A/R Client’s total amount of Eligible A/R

Non-A/R Reserves Client’s Non-Receivable Reserves as defined at Master Client Level

Funds Employed Client’s total Funds Employed

(Overdraft) Reserves Eligible A/R - Non-A/R Reserve - Funds Employed

Other Total Amount of Balance from other GL Accounts (INV, EQU, OTH, COLL , LC, LG,
REAL, OADV)
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Report Sample

Portfolio Analysis Report

This custom report lists Groups (Master Clients) with detail and summary formats for Funds Employed
Analysis. This report is accessed from the Analysis menu of the Reports module.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.
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Field Description

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table.

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Format Select the report format to print.

l Detail

l Summary

Report Details

Field/Column Description

Format: Detail

Group Client name from Master Client

A/R Balance Sum of all client’s facilities when facility category = ARD, ARN & ARP Collateral AR
Balance at the thru date of the report.

Reports User Guide
SQL Reports

239 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field/Column Description

Purchases Sum AR amounts in all purchase batches for all affiliated clients within the date
range.

Receipts Sum AR amounts in all payment batches for all affiliated clients within the date
range.

Net Chargebacks Sum AR amounts in all adjustment batches for all affiliated clients within the
date range

AR Funds Employed Sum of all client’s AR Funds Employed for all affiliated clients

INV Sum of all client’s NFE balance for facilities when facility category = INV

EQU Sum of all client’s NFE balance for facilities when facility category = EQU

REAL Sum of all client’s NFE balance for facilities when facility category = REAL

OTH Sum of all client’s NFE balance for facilities when facility category = OTH

OADV Sum of all client’s NFE balance for facilities when facility category = OADV

COLL Sum of all client’s NFE balance for facilities when facility category = COLL

Total Funds
Employed

Sum of all client’s NFE balance for all affiliated clients

Format: Summary

Group Client name from Master Client

Funds Employed AR Sum of all client’s AR Funds Employed for all affiliated clients

Funds Employed on
Other Loans

Sum of all client’s Other Loans Funds Employed for all affiliated clients

Total Fund Employed Funds Employed AR + Funds Employed on Other Loans

Gross A/R Sum of all client’s facilities when facility category = ARD, ARN & ARP Collateral AR
Balance at the thru date of the report.

Report Sample

Detail Format
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Summary Format

Red Flag Rule Report

The Red Flag Rule report lists clients flagged for red flag conditions as of the current FactorSoft processing
date. Report: Rule Name Report, you can review various issues and critical warnings associated with any
of the Red Flag Rules setup in the Red Flag Rules Table. Report: Rule Type Report provides information asso-
ciated with the Red Flag Rules associated the insurance policy for specific clients, such as policies close to
expiration, policies with chargebacks that exceed a specified percentage of the accounts receivable
(A/R) balance, and so on.

The default report definition for this report is RedFlag.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Rule
Name

Select the rule type to which to limit the report results.

Red flag rules are defined on the Red Flag Rules table in the Tables module. For more inform-
ation on the rules that can be defined in the Tables module, refer to the FactorSoft Admin-
istrator’s Guide.

Rule
Type

Select the rule type to which to limit the report results.

Red flag rules are defined on the Red Flag Rules table in the Tables module. For more inform-
ation on the rules that can be defined in the Tables module, refer to the FactorSoft Admin-
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Field Description

istrator’s Guide.

Report Sample

Rule Type Report

Rule Name Report
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Report Details

Column Description

Rule Name Report

Client Client Name

Rule Name Rule Name as established in Red Flag Rules Table

Rule Type Rule Type as established in Red Flag Rules Table

A/R Balance Client’s A/R Balance

Level Level as established in the Red Flag Rules Table

Reports User Guide
SQL Reports

245 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Column Description

Group Filter Value as established in Red Flag Rules Table

Posted Date the Red Flag was effective

Rule Type Report

Client Name Client Name

Policy Name Policy Description

Policy Number Policy Number

Policy Limit Policy’s Max Liability

Coverage Amount Amount covered by the Policy

Percentage Used Percentage of the Policy that has been used

Security Roles

To generate the Red Flag Rule Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print Red Flag Rule Reports

Return on Investment Report

The Return on Investment Report generates a report that calculates the return on investment percentage
for closed invoices by client. A Detail Report format provides invoice level detail, while the Summary
Report format aggregates all client invoices into one ROI percentage figure.

The default report definition for this report is ReturnOnInvest.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

From/Thr-
u

Enter the beginning and ending dates to be used for the report when the Specific date
range option is selected in the Date Range list.
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Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.
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Field Description

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Format Select the report format:

l Detail Report: This report lists by client the return on investment for each invoice
closed during the reporting period.

l Summary Report: This report lists the aggregated return on investment for each cli-
ent.

Included
Weighted
ROI

Select this option to report a weighted ROI figure for each client, and a portfolio total for the
Weighted ROI at the end of the report. Weighted ROI is calculated as:

(Fee Income / Advance Amount)*(365/(sum of each invoice advance amount * days
open/Total Advance Amount))

Report Sample

Format: Detail

Format: Summary
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Report Details

Field/Column Description

Format: Detail

Client Client Name

Inv # Invoice Date

Purchase Date Date Invoice was purchased on.

Paid Date Date Invoice was paid on

Open Days Number of days that the invoice was open with a balance

Invoice Amount Invoice Amount

Total Advanced Amount advance on the Invoice

Inv Amt xDays from
Advance

Invoice Amount X Open Days

Adv Weighted Avg Days Advance Weighted Avg Days to Pay

Total Fee Total Fees Earned

ROI % Total invoice fees / Total invoice advances * 365 / (S(Invoice Age) / # of
closed invoices)

Format: Summary

Client Client Name

Open Days Number of days that the invoice was open with a balance

Invoice Amount Total Amount of Invoices

Total Advanced Total Amount Advanced on all Invoices

Inv Amt XDays from
Advance

Invoice Amount X Open Days

Adv Weighted Avg Days Advance Weighted Avg Days to Pay

Total Fee Total Fees Earned

ROI % tal invoice fees / Total invoice advances * 365 / (S(Invoice Age) / # of closed
invoices)
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Security Roles

To generate the Return on Investment Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Return on Investment Report

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports,Return on Investment report

Preference Description

Reports Module Name Enter the Report Module name to use for the report.

Signed Analysis

This report prints a summary of date signed and financial information for clients within a specified date
range. The Client name, Signed Date, First Fund, First Buy, Average Balance, Average Funds, Sales and Earn-
ings will display.

Optionally, the Signed Analysis Report can be generated using the client's first funding date instead of the
signed date as the primary date key. To utilize this option, set System Preference Reports, Signed Analysis
Report, Use First Funded Date instead of Client Signed Date to True.

The default report definition for this report is SignedAnalysis.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
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Field Description

menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Client
Signed

Select the date range within which clients were signed to use for the report from the list:

l Today

l Last Business Date

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Show
Date

Select the date range within which to report data to use for the report from the list:
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Field Description

l Today

l Last Business Date

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Sort Select the major sort field for the generated output.

l Client Name

l Signed Date

l First Funding Date

Sample Report

Client Signed Date
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First Funded Date
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Report Details

Column Description

Name Displays the Client’s name

Signed Displays the Client's Signed Date

First Fund Displays Date for the Client’s First Funding

First Buy Displays Date for the Client’s First Buy/Purchase

Average Balance Displays Client’s Average Balance for Show Data Date Range

Average Funds Display Client’s Average Funds for Show Data Date Range
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Column Description

Sales Displays Client’s Sales for Show Data Date Range

Earnings Displays Client’s Earnings for Show Data Date Range

Security Roles

To generate the Red Flag Rule Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print Signed Analysis Report

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Signed Analysis Report folder.

Preference Description

Use First Funded Date
Instead of Client
Signed Date

When set to True, Client Signed Parameter becomes First Funded Date Para-
meter and the report is generates data based on First Funded Date.

Screen Label for Date
Sorting

Free Form Text to indicate what the Label will be for the Client Signed Parameter
allowing the FI to change the Label to read “First Funded Date” instead of “Client
Signed” so that User will realize that they are running the report by First Funded
date.

Trend Analysis Report

The Trend Analysis Report provides historical information about a client’s or master client’s performance
to help assess trends within certain industries or seasons. The results can be displayed in a variety of
formats: by year, by half-year, or quarterly, by grand totals and performance averages. Detail lines on the
report are based upon the actual number of days the report includes.

The default report definition for this report is Trend.

Reports User Guide
SQL Reports

257 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.
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Field Description

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Broker Select the broker to which to limit the report results from the list.

Source Select the referral source to which to limit the report results from the list. Sources are defined
in the Referral Source Table in FactorSoft.

Format Select the report format to be printed:

l Detail: displays the monthly detail for each client.

l Alpha: displays a single period total summary for each client.

l ClientAnalysis: displays the Client Analysis report with aging

Sort By Select the sort option that determines the order in which to sort the report.

l Client: Sort clients alphabetically A-Z.

l Balance: Sort clients by balance, lowest to highest.
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Field Description

Dates Select the date format to be displayed on the report

l Alpha: display dates in alpha format with month spelled out.

l Numeric: display the dates in numeric format with the month represented by a number
01-12.

Totals Select the total type for the report:

l None: detail lines only. This is not applicable for the Summary format

l Summation: Prints a period summation total for each client and break.

l Averages: Prints the period average for each client and break.

l Both (Summation & Average): Print both the period summation and average totals.

Ending
Month

Enter the month that is the last month in the Ending Year to include in the results.

Ending
Year

Enter the year that is the most recent year to include in the results.

Months Enter the number of months back from the Ending Month and Ending Year date to include in
the results.

Breaks Select the break point for the report. Detail lines will be broken and totaled in 3 or 6 month seg-
ments, as specified. This setting is not available for the Client Analysis report format.

l None

l 3 Months

l 6 Months

Security Role

The Trend Analysis Report is configured in Security > Manage Roles > Reports > Analysis > Print Trend
Analysis Report (Yes/No).

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences > Reports > Trend Analysis folder.
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Preference Description

A/R Turn Calculation Method Select the Calculation method for A/R Turn:

l Beginning Balance/ Payments for Activity period

l Annualized Sales / Average Accounts Receivable Bal-
ance

Collection is amount applied to A/R Set to TRUE, Collections is the amount applied to A/R

Do not include non-factored payments
as chargeback or giveback

Set to TRUE, Non-factored payments are not included in the
Charge Back or Give Back amounts

Give Backs are called credit reserve Set to TRUE, Column Header on Client Analysis reads Credit
Reserves instead of Give Backs

Report by Master Clients Set to TRUE, Report generated for Master Client Level

Report Details

Field/column Description

Format: Detail

Client Client Name

Beginning Bal-
ance

Beginning Balance

Purchases Total Amount of Purchases/Sales

Collections Total Amount of Collections/Cash Postings

C/B Debit Total Amount of Chargeback Debit to the Cash Reserve

C/B Credit Total Amount of Chargeback Credit to the Cash Reserve

Write Off Total Amount of Writeoffs

Ending Balance Beginning Balance + Purchases - Collection - C/B Debit + C/B Credit

Fees Total Fees Earned

A/R Turn A/R Turn as defined in System Preferences > Reports > Trend Analysis > A/R Turn
calculation Method

Format: Summary
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Field/column Description

Client Client Name

Beginning Bal-
ance

Beginning Balance

Purchases Total Amount of Purchases/Sales

Collections Total Amount of Collections/Cash Postings

C/B Debit Total Amount of Chargeback Debit to the Cash Reserve

C/B Credit Total Amount of Chargeback Credit to the Cash Reserve

Write Off Total Amount of Write offs

Ending Balance Beginning Balance + Purchases - Collection - C/B Debit + C/B Credit

Fees Total Fees Earned

A/R Turn A/R Turn as defined in System Preferences > Reports > Trend Analysis > A/R Turn
calculation method

Format: Client Analysis

Beginning A/R Beginning A/R Balance

Purchases Amount of Purchases

Cash Col-
lections

Amount of Cash Collections

Charge Backs Amount of Charge Backs

Give Backs Amount of Give Back / Credit Reserves

Suspense Amount of Suspense

Ending A/R Ending A/R Balance

Ending Reserves Ending Reserve Balance

Net Funds
Employed

Client’s Net Funds Employed Balance

Dilution % Dilution percentage

NF Dilution % Non-Factored Dilution percentage
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Field/column Description

Coll/Purch % Collection/Purchases * 100

Net Coll/Purch % Net Collection/Purchases * 100

Funds A/R % Net Funds Employed/Ending A/R * 100

Aging Buckets w/ Percentage

Total Total Amount of A/R

1-30 - % A/R Aged 1-30 days and percentage of Total A/R

31-60 - % A/R Aged 31-60 days and percentage of Total A/R

61-90 - % A/R Aged 61-90 days and percentage of Total A/R

91-120 - % A/R Aged 91-120 days and percentage of Total A/R

121-150 - % A/R Aged 121-150 days and percentage of Total A/R

151-up - % A/R Aged 151 -up days and percentage of Total A/R

Report Sample

Detail Format

Summary Format
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Client Analysis Format
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Verification Status Report

The Verification Status Report provides a detail listing of Verification, Collection and other Note Types asso-
ciated with the invoice for a certain date range and can be scheduled via the Engine.

Default Report Name: VerificationStatusRept

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

Reports User Guide
SQL Reports

265 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Debtor Enter the debtor for which to request the report. Click the Down Arrow to display a list of valid
entries.

Leave this field blank to include all debtors in the report results.

To delete an entry in this field, click the Down Arrow twice to highlight the entry and press the
Delete key.

Debtor
Group

Enter the debtor group to which to limit the report results.

Debtor Groups are defined in the Group Code table in the Tables module.

Value Enter the debtor group value for which to limit the report results.

Debtor Groups are defined in the Group Code table in the Tables module.
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Report Sample

Report Details

Column Description

Client Displays the Client Name associated to the Invoice in which the note was posted.

Debtor Displays the Debtor Name associated to the Invoice in which the note was posted.

Inv # Displays the invoice number associated to the posted note.

PO # Displays the purchase order number associated to the posted note.

Invoice Date Displays the date of the invoice associated to the posted note.

Invoice Amount Displays the amount of the invoice associated to the posted note.

Approve Status Displays the approval status of the invoice associated to the posted note.

Date Displays the date the note was posted.

Notes Displays the contents of the note.

Security Roles

To generate the Verification Status Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print verification status report

Yield Report

The Master Summary Yield and Detail Yield Reports report custom client yield calculated based on rev-
enue. Both reports are requested from the Yield Reports screen, which is accessed from the Analysis menu
of the Reports module.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
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Field Description

date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
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Field Description

which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

G/L
Group

Select the G/L group to which to limit the report results. Only clients of the selected G/L group
are included.

Term
Type

Select the Client Terms type to which to limit the report results. Only clients of the selected
term type are included.

l Invoice based terms

l Portfolio base terms (A/R finance)

l Portfolio based terms (daily rate)

Format Select the report format to print:

l Detail - generate the Yield Detail Report

l Summary - generate the Master Summary Yield report, which is specific to Master Cli-
ents only

Convert
to native
currency

Select this option to display the financial data in the native currency for the data

base.
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Report Details

Field/Column Description

Format: Detail

Client Name Client Name

G/L Group Client’s G/L defined at Client Information > Control Panel > G/L Group

Purchases Total Purchases/Sales

Avg Daily A/R Avg Daily A/R

Avg Daily Funding Avg Daily Funding

Total Revenue Total Revenue for the Client

Yield (Total Client Revenue / Days in period of report • 365) / Average Daily Funding •
100

Format: Summary

Client Name Client Name

Purchases Total Purchases/Sales

Avg Daily A/R Avg Daily A/R

Avg Daily Funding Avg Daily Funding

Total Revenue Total Revenue for the Client

Total Revenue % Total Revenue for the Client/ Total Revenue of the Report

Cumulative Rev-
enue

Accumulates Total Revenue the line by line revenue of each client for the report

Cumul % Cumulative % of Cumulative Revenue

Yield (Total Client Revenue / Days in period of report • 365) / Average Daily Funding •
100

Report Samples

Detail Format
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Summary Format
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Audit Menu

Audit Reports

The Audit reports group contains reports that providing audit information on activity during a specified
date range.

AutoInvoice Audit Report

The AutoInvoice Audit Report is accessed from the Audit Reports menu of the Reports module for imple-
mentations of FactorSoft that utilize the AutoInvoice AddOn module, and to summarize the purchases and
invoices imported into FactorSoft using the AutoInvoice module. The report request screen contains both
a Summary and Detail format.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Reports User Guide
SQL Reports

274 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Date Select the date to use for the report from the list:
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Field Description

Range l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Format Select the report format to generate:

l Detail

l Summary
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Report Samples

Detail Report

Summary Report
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Report Details

Column Description

Detail Format

Client Client's name

Invoice Number Invoice number

Debtor Debtor's name

Invoice Date Date of the invoice

Invoice Amount Amount of the invoice

Summary Format

Client Client's name

Invoice Count Number of Invoices imported for the Client

Amount Total dollar amount invoices imported for the Client

Security Roles

To generate the AutoInvoice Audit Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Audit Reports > AutoInvoice Audit Report

Client Audit Report

The Client Audit Report displays changes to client parameters made through the Client Information
screen.

The default report definition for this report is ClientAudit.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.
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Field Description

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.
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Field Description

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Sort Select the sort option that determines the order in which to sort the report.

l Client name

l Client number

l Date/Time

l User

Report Sample

Security Roles

To generate the Cash Posting Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Audit Reports > Client Audit Reports

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Client Audit folder.

Preference Description

Show unapproved cli-
ents

Set to True to include results for unapproved clients on the report.

Reports User Guide
SQL Reports

281 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm
Client Group Codes Table.htm


Client Term Audit Report

The Client Term Audit Report displays changes made to the Term panels made through the Client Terms
screen.

The default report definition for this report is CliTermAudit.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the From and Thru
fields.

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Re-
porting Services > Requests > Use last business day instead of yesterday in
date range to True. The Yesterday option in the Date Range field is replaced
with Last Business Day, and reports printed on Monday will print Friday’s
data (assuming Friday was the last business day) instead of Sunday’s. Set
System Preference Identification/system constants > CLMS|Reporting Ser-
vices > Requests > Saturday is a business day to True to consider Saturday a
business day when the Date Range is set to Last Business Day. This function is
only valid for Reporting Services reports when Use last business day instead
of yesterday in date range is set to True.

Sort By: Select the sort option that determines the order in which to sort the report:

l Date

l Term

l User
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Report Sample

Report Details

Column Description

Date/Time Date and Time of activity

Title Client Term Title

User User Code that made changes

Field Description of the field that was changed

Was The field value prior to the change

Is The field value after the change

Security Roles

To generate the Client Term Audit Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Audit Reports > Client Term Audit Report
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CLMS™ User Access Report

The CLMS™ User Access Report details Users create a record that details who has accessed specific areas
of the CLMS™ system.

The default report definition for this report is UserAccess.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

User Select the User for which the User Access Report will be filtered.

Date range Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Reporting
Services > Requests > Use last business day instead of yesterday in date range
to True. The Yesterday option in the Date Range field is replaced with Last Busi-
ness Day, and reports printed on Monday will print Friday’s data (assuming Fri-
day was the last business day) instead of Sunday’s. Set System Preference
Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date
range is set to True.
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Report Sample

Report Details

Column Description

User Account Displays the type of Account of the User.

User Key Displays the User Code

Machine Displays the Machine ID of the User

Application Displays the Application of Activity

Action Displays the activity that took place in the Application

Time Stamp Displays the Date and Time of Action

Security Roles

To generate the CLMS™ User Access Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Audit Reports > Print CLMS User Access Report

Collateral Audit Report

The Collateral Audit Report displays changes to collateral parameters made through the Collateral
Information screen.

The default report definition for this report is CollateralAudit.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.
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Field Description

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select a collateral for the selected facility to which to limit the report, or leave blank to report
on all collaterals for the selected facility.

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.
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Report Sample

Report Details

Column Description

Facility/Collateral Facility Name/Collateral Description

Date Date and Time change was made

Form Form/Panel where change was made

User User Code that made changes

Field Description of the field that was changed

Before The field value prior to the change

After The field value after the change

Action Indicates action taken
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Security Roles

To generate the Collateral Audit Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Audit Reports > Collateral Audit Report

Collection/Verification Notes Audit Report

The Collection/Verification Notes Audit Report displays Added, Changed or Deleted notes from the Col-
lection/Verification Notes screen.

The default report definition for this report is CollNotesAuditRept.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Format Select the format for the report.

l Show All Notes - Shows all notes except for Deleted Notes.

l Show Deleted Notes - Shows only Deleted Notes that were associated with an Invoice.

Report Sample

Format: Show All Notes
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Format: Show Deleted Notes Only

NOTE
Since the Collection/Verification Note has been deleted, Format: Show Deleted Notes Only provides
limited information associated with the Deleted Note.
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Report Details

Column Description

Date/Time Displays the Date/Time the Note was entered.

Invoice # Displays the Invoice number associated with the note.

User Displays the User who entered the note.

Field Displays the field of the note form.

Was Displays the deleted data, if any, for the specific field of the note.

Is Displays the current data, if any, for the specific field of the note.
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Security Role

To generate the Collection/Verification Notes Audit Report, the following Security Role needs to be set to
YES:

l Security Roles > Reports > Audit Reports > Collection/Verification Notes Audit Report

Database Problem Report

The Database Problem Report displays issues from the executed diagnostic process.

NOTE
This report can be very large and take extensive amounts of time to complete. It is advised that the
report should not be scheduled at a time that coincides with the Date Roll Process.

This is an Engine-enabled report. The default report definition is rwDatabaseProbRept.

Field Definition

Report
Template

Lists any report template created to date. Select a template from the list to generate a
report based on its saved display parameters. Type a new Report template name and
click Save to create a new template for this report, then Select the template from the Tem-
plates tab and make any applicable parameter and scheduling selections to complete
the template.
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Report Parameters

Field Definition

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Definition

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Check Select the value to which to limit the report results from the list. drop-down to select Client or
Debtors.

Check
boxes

Check or uncheck boxes to include/exclude specific data from the report.

Client
Option

drop-down to select Client Option:

Only: run diagnostics on the selected Client only.
Start: run the diagnostics on the selected client and all clients that follow the client alpha-
betically.
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Report Sample

Report Details

Column Description

Client Displays the Client’s name

Edit Displays the source of the edit which the problem occurred

Reference Displays the Batch number or Check number

Transaction Amount Displays the transaction amount

A/R Amount Displays the A/R amounr

Check Amount Displays the Amount of the check

Variance Displays the difference between the total check amount and the amount
applied to invoices

Problem Displays a description of the problem found

Data Key Database Key

Security Roles

To generate the Database Problem Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Audit Reports > Print Database Problem Report
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Debtor Audit Report

The Debtor Audit Report displays changes to debtor parameters made through the Debtor Information
screen.

The default report definition for this report is DebAuditRept.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Definition

Date
range

Select the date to use for the report from the list:
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Field Definition

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Definition

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Sort Select the sort option that determines the order in which to sort the report.

l Debtor name

l Debtor number

l Date/Time

l User
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Report Sample

Report Details

Column Description

Date/Time Date and Time change was made

Debtor Debtor name

User User Code that made changes

Field Description of the field that was changed

Was The field value prior to the change

Is The field value after the change

Security Roles

To generate the Debtor Audit Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Audit Reports > Debtor Audit Report

Facility Audit Report

The Facility Audit Report displays changes to facility parameters made through the Facility Information
screen.

The default report definition for this report is FacilityAudit.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
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Field Description

menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.
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Report Sample

Report Details

Column Description

Facility Facility Name

Date/Time Date and Time change was made

Form Form/Panel where change was made

User User Code that made changes

Field Description of the field that was changed

Before The field value prior to the change

After The field value after the change

Action Indicates action taken
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Security Roles

To generate the Facility Audit Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Audit Reports > Facility Audit Report

Failed Report Templates Report

The Failed Report Templates Report is a SQL report that provides a detailed list of Failed Report Templates
via the Engine along with the Message Status indicating where and why the failure occurred.

The default report definition for this report is FailTempRpt.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Run By Date Range Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Reporting
Services > Requests > Use last business day instead of yesterday in date range
to True. The Yesterday option in the Date Range field is replaced with Last Busi-
ness Day, and reports printed on Monday will print Friday’s data (assuming Fri-
day was the last business day) instead of Sunday’s. Set System Preference
Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date
range is set to True.
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Report Sample

Report Details

Column Description

Template
Name

Report Template Name

Report Name Report Name

Report
Created

Date Template was created

Request
Created By

User that Requested the Report

Request
Created

Date the Report was requested by User

Report Status Explanation of the Report Status indicating whether or not the report was generated.

Destination
Type

Destination of the Report

Destination Explanation of Destination Status indicating whether or not the report failed to be
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Column Description

Status delivered via the Destination Type.

Gallium Exception Report

The Gallium Exception Report lists exceptions on invoice queries that were returned from the Gallium Pay-
ing Agent Interface. This report is only present if the Gallium interface is enabled in System Preferences.

The default report definition for this report is GalRept.

Report Parameters

Field Description

Date
range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)
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Field Description

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they

Reports User Guide
SQL Reports

312 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Show Select the exception types to be returned from Gallium in the report.

l Problems only

l Problems and Balance Due

l Everything

Report Sample
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Import History Report

The Import History Report shows the import history, as processed by the Engine, for your clients. You can
choose the time frame for imports that you want to view in the report.

To view this report, on the Audit Reports menu, click Import History Report.

Field Description

ReportTemplate Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Definition

Date Range Select the date to use for the report from the list:
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Field Definition

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services >
Requests > Use last business day instead of yesterday in date range to True. The Yes-
terday option in the Date Range field is replaced with Last Business Day, and reports
printed on Monday will print Friday’s data (assuming Friday was the last business day)
instead of Sunday’s. Set System Preference Identification/system constants > CLMS|Re-
porting Services > Requests > Saturday is a business day to True to consider Saturday a
business day when the Date Range is set to Last Business Day. This function is only valid
for Reporting Services reports when Use last business day instead of yesterday in date
range is set to True.

Import Type List of all Import Types available via the Engine: Folder Monitor Task. Select a specific
Import Type for the Report.

Report Columns

The Import History Report contains the following information:
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l Drop Date – The date and time when the import was initiated.

l Call Time – The date and time when the import started to run.

l Done Time – The date and time when the import was completed.

l Status – The status for the import.

l Wrapper – This field is for internal use only.

l File – The name of the file that was imported.

l Location – The location of the file that was imported. This is the location from which the file was
imported, not the final destination for file(s) in the import.

l Report Comments – Lists the items imported into the system with descriptions about each.
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Report Sample
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Security Roles

To generate the Facility Audit Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Audit Reports > Import History Report

Invoice Audit Report

The Invoice Audit Report provides a history of changes made to invoices.

The default report definition for this report is InvAudit.

Report Parameters

Field Description

Date
range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)
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Field Description

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
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Field Description

are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Sort Select the sort option that determines the order in which to sort the report.

l Client name

l Client number

l Date/Time

l User

Report Sample

Monitor Jurisdiction Report

The jurisdiction report has been added to FactorSoft for the Integrated Account Monitoring module. This
report has options to list open jurisdictions as of a specified date or history for all activity up to a specified
date.

The report displays the target name (client or debtor), the target type, reporting agency (FCS), the state
and jurisdiction reporting the lien, and the start and stop date for monitoring. The Open Jurisdiction report
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displays the same format but only shows open monitoring request and therefore does not have the stop
date.

The report screen is accessed from the Audit Menu in the Reports module.

The default report definition for this report is LienMonOpen.

Report Parameters

Field Description

As-of date Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked
in the ClientWeb Report Queue, a screen appears to choose the date range
(Current Date, Previous Month-End Date, or Specific Date).

Report Select the report format to be produced:

l Open Jurisdiction List

l History List
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Field Description

Selection Select the monitoring targets to be included in the report:

l Clients and Debtors

l Clients only

l Debtors only

Report Sample

Security Audit Report

The Security Audit Report provides a detailed listing of all Security settings activity within a specified date
range.

The default report definition for this report is SecAudit.
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Report Parameters

Field Description

Date Range Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Reporting
Services > Requests > Use last business day instead of yesterday in date range
to True. The Yesterday option in the Date Range field is replaced with Last Busi-
ness Day, and reports printed on Monday will print Friday’s data (assuming Fri-
day was the last business day) instead of Sunday’s. Set System Preference
Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date
range is set to True.
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Report Sample

System Preference Audit Report

The System Preference Audit Report produces a list of changes made to System Preferences for a specific
date range and/or by a specific user.

The default report definition for this report is PrefAudit.

Report Parameters

Field Definition

Date range Select the date to use for the report from the list:
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Field Definition

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Reporting
Services > Requests > Use last business day instead of yesterday in date range
to True. The Yesterday option in the Date Range field is replaced with Last Busi-
ness Day, and reports printed on Monday will print Friday’s data (assuming Fri-
day was the last business day) instead of Sunday’s. Set System Preference
Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date
range is set to True.

Sort Select the sort option that determines the order in which to sort the report.

l Date

l User
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Report Sample

Broker Menu

Broker Reports

The Broker reports are used to generate reports related to brokers.

Broker Commission Report

The Broker Commission Report is a utility to trace the performance of the client and calculate a com-
mission that can be paid to the broker. Many lenders utilize salespeople or brokers to assist in the devel-
opment of new business. Commissions are often paid to individuals based on the client’s performance.

Commission reports should only be generated after month-end earnings have been posted against a cli-
ent’s reserve account. If the report is run prior to posting, then the report will not be accurate.

NOTE
For Bulk Collateral lending databases, Sales have been added to the Purchase column and Net Col-
lections added to the Collections column of the Broker Commission Report.

The default report definition for this report is BkrComms.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Use last business day instead of yesterday in date range to True. The Yesterday option in
the Date Range field is replaced with Last Business Day, and reports printed on Monday
will print Friday’s data (assuming Friday was the last business day) instead of Sunday’s.
Set System Preference Identification/system constants > CLMS|Reporting Services >
Requests > Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Reporting Services
reports when Use last business day instead of yesterday in date range is set to True.

Broker Select the broker to which to limit the report results from the list.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Group by
Master Cli-
ent

Select this option to group member clients under their master client on the generated
report.

Category Select the broker category to which to limit the report results. Broker categories are defined
in the Broker Category Table.

Sort
Sequence

Select the sort sequence for the report:
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Field Description

l Broker within client

l Client within broker

Format Select the report format to be printed:

l Detail Report: displays invoice batch detail by client within broker

l Summary Report: displays summary totals only by client within broker

l Master Summary Report: generates the Summary By Master Client Broker Com-
mission Report

l Detail Statements: generates Broker Commission Statement with invoice batch
detail

l Summary Statement: generates Broker Commission Statement with summary totals
only

Include
non-zero
inactive cli-
ents

Include inactive clients that have cash in A/R or reserves on the report. If this option is not
selected, non-zero inactive clients are excluded form the report.

Convert
sum-
maries to
native cur-
rency

Select this option to convert the financial data to the broker’s native currency.

Show date Select the desired option for displaying dates on the report:

l Show neither

l Show date signed

l Show date first funded

Sort by
Funded
Date

Select this option to sort the report by first funded date.

This option is only available if Show date first funded is selected in the Show date field.

Report Sample

Detail Report
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Summary Report

Master Summary
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Detail Statement
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Summary Statement

Report Details

Column/Label Description

Format: Detail Report

Client Client’s Name

Date Post Date of the Batch

Batch # Batch number

Type Batch Type

Purchases Total Amount of Purchase Batch

Collections Total Amount of Payment Batch

Adjustments Total Amount of Adjustment Batch

Fee Earned Total Fee Earned for the Batch
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Column/Label Description

Rate Broker’s Commission Rate

Of Commission based on

Commission Commission amount for the batch

Total Row Total Commission Owed to the Broker by Client

Grand Total Grand Total Commission Owed to the Broker

Format: Summary Report

Client Client’s name

Purchases Total Amount of all Purchase Batches for the Client

Collections Total Amount of all Payment Batches for the Client

Adjustments Total Amount of All Adjustment Batches for the Client

Fee Earned Total Amount of All Fees Earned for the Client

Rate Broker’s Commission Rate

Of Commission Based on

Commission Total Commission owed to the Broker for the Client

Grand Total Grand Total Commission Owed to the Broker for All Clients

Format: Master Summary Report

Master Client Master Client’s Name

Member Client Member Client’s Name

Broker Broker’s Name

Purchases Total Amount of all Purchase Batches for the Member Client

Collections Total Amount of all Payment Batches for the Member Client

Adjustments Total Amount of All Adjustment Batches for the Member Client

Earnings Total Amount of All Fees Earned for the Member Client

Commission Total Commission Owed to the Broker for the Member Client
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Column/Label Description

Total Row Total Commission Owed for the Broker for the Master Client

Format: Detail Statement

Client Client’s Name

Date Post Date of the Batch

Batch # Batch number

Type Batch Type

Purchases Total Amount of Purchase Batch

Collections Total Amount of Payment Batch

Adjust Total Amount of Adjustment Batch

Fee Earned Total Fee Earned for the Batch

Rate Broker’s Commission Rate

Of Commission based on

Commission Commission amount for the batch

Total Row Total Commission Owed to the Broker by Client

Format: Summary Statement

Client Client’s Name

Purchases Total Amount of all Purchase Batches for the Client

Collections Total Amount of all Payment Batches for the Client

Adjust Total Amount of All Adjustment Batches for the Client

Fee Earned Total Amount of All Fees Earned for the Client

Commission Total Commission owed to the Broker for the Client

Grand Total Row Grand Total Commission owed to the Broker for all Clients.

Security Roles

To generate the Broker Commission Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Broker > Print Broker Commission Reports
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System Preferences

The following system preference that affects this report is found in the Administration module, System
Preferences, Fields/screen behavior, Miscellaneous folder.

Preference Description

Calculate earnings
based on account
table flag

Set to True - All accounts flagged as an Earning Account in Tables > Accounting >
Account Table > Standard Tab > Earning Account check box will be included in
the Fee Earned column.

Set to False - Accounts present in the client's appropriate G/L Account Groups will
be included in the Fee Earned column.

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Broker commission report folder.

Preference Description

Additional fee
earned account
numbers

Enter the exact account numbers (defined in the Account Table in the Tables mod-
ule) to also be included in the total in the Fee Earned column. If entering more than
one account number, separate the account numbers with a comma.

Commission by
Client cannot be
less than zero

Set TRUE - Commission calculated for a Client/Broker cannot be less than zero (i.e.
Negative amount).

Cost of funds
based on

Select option that determines how the Cost of funds basis is calculated:

l A/R Balance

l Advance rate times A/R Balance

l Advance rate times A/R Balance

l Funded A/R Balance (non-funded invoices excluded)

l Actual advance against funded A/R Balance

Cost of funds rate
(% )

Set rate percentage used to calculate Cost of funds

Do not print cli-
ents without Activ-
ity

Set TRUE - Report will only generate for clients that have Activity for the date range
of the report

Do not show cli- Set TRUE - Report will not reflect the Client’s code.
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Preference Description

ent numbers on
reports

Do not show page
numbers on
reports

Set TRUE - Report will not reflect page numbers

Earnings do not
include additional
fees

Set TRUE - Additional Fees Earnings will not be included in the report.

Earning from mis-
cellaneous
checks rule

Select option for miscellaneous checks (C-Misc or G-Misc) rule:

l Commissions are paid as with all other earnings

l These lines will appear on the report but no commission will be paid

l These lines will not appear on the broker report

Include ABL Cli-
ents

Set TRUE - ABL Clients will be include in the Broker Reports when generated.

Months cal-
culation rule

Select option how to calculate months:

l Start counting form the first day of the month signed.

l Use the exact date signed.

l If month signed is not the 1st, start from the 1st of next month.

l Start counting from the first day of the month of first funding.

l Use the exact date first funded.

l If month first funded is not 1st, start from the 1st of the next month.

Report Crystal
Reports module
name

Insert Report Module name

Sort reports by Select option how to sort Brokers:

l Company

l Name
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Preference Description

Statement Crystal
Reports module
name

Insert Statement reports module name

Use Broker cur-
rency conversion
rates where avail-
able

Set TRUE - Special Broker currency rates will be used for currency type that are avail-
able.

Current Year Broker Sales Report

This report provides a summary of broker sales for the current year. The summary includes broker name,
the clients the broker sold, signing date of client, and total sales by client.

The default report definition for this report is CurrYearBrokerSales.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Year signed Select the client signed date year for which to report broker sales. Currently,
only the current FactorSoft processing year is available.

Year Sales Select the sales year for which to report broker sales. Currently, only the current
FactorSoft processing year is available.

Report Sample

Report Details

Column Description

Broker Displays the Broker’s name

Client Displays the Client's Names

Date Signed Displays the Client's Sign Date

Sales Displays the accumulated Sales for the Year Sales selected in parameters

Security Roles

To generate the Current Year Broker Sales Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Broker > Current Year Broker Sales
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Carrier Menu

Carrier Reports

The Carrier reports are used to generate reports about carriers.

Carrier Payment Report

The Carrier Payment Report displays carrier payments created for a given client, carrier, date range and
other standard report selection criteria. The Carrier menu and Carrier Payment Report are only available if
the Carrier Payments module is enabled.

The default report definition for this report is Carrier1.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will print
Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Broker Select the broker to which to limit the report results from the list.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Carrier Select the carrier for whom the report is to be generated. This field is optional. Leaving the field
blank includes all carriers.

For the Carrier Search Window, available when System Preference > Fields/Screen Behavior
> Miscellaneous > Use Carrier Search instead of dropdowns is set to True

Select the magnifying glass icon to open the Search window and begin typing the
carrier name.
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Field Description

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Carrier field.

TIP
Choosing Contains will allow users to search by Carrier Code.

If False, this list will display no more than 32,767 carriers.

Date
Range

Select the date range basis. Available options are:

l Invoice purchase date

l Invoice date

l Carrier payment due date

l Carrier payment paid date

Include
unpaid
items

Select this option to include carrier payments that have been included in a purchase but are
not yet eligible to have a check generated (i.e., the Days to Pay have not elapsed).

Include
paid
items

Select this option to include carrier payments that have had checks generated.

Sort Select the sort option that determines the order in which to sort the report.

l Client/Carrier/Date

l Carrier/Client/Date
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Report Sample

Report Details

Column Description

Client/Carrier Displays the Client Name and Carrier Name

Invoice # Displays the Invoice Number

Invoice Date Displays the Invoice Date

Post Date Displays the Post Date of the Purchase Batch containing the Invoice with a Car-
rier Payment

Batch # Displays Purchase Batch Number

Carrier Invoice # Displays the Doc number associated with the Carrier Payment

Terms Displays the Carrier Terms

Gross Amount Displays the Gross Amount owed to the Carrier

Previous Amount Displays the Previous Amount paid to the Carrier

Fee Displays the Carrier Fees

Net Due Displays the Net Due to the Carrier

Net Due = Gross Amount - Previous Amount - Fees

Due Date Displays the Due Date of the Carrier Payment

Payment/Notes Displays When and How the carrier will be paid along with Carrier Payment
Notes entered on the Purchase Batch.
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Security Roles

To generate the Cash Posting Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Carrier > Carrier Payment Report

Client Menu

Client Reports

The Client report group contains reports that provide details on all aspects of your business with clients.

Client Approval Report

The Client Approval Report will provide a list of Approved and/or Unapproved Clients that the user can util-
ize to determine what Clients still need to be approved before use as well as what Clients have been
Approved within a specified date range.

The default report definition for this report is ClientAppr.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Reporting
Services > Requests > Use last business day instead of yesterday in date range
to True. The Yesterday option in the Date Range field is replaced with Last Busi-
ness Day, and reports printed on Monday will print Friday’s data (assuming Fri-
day was the last business day) instead of Sunday’s. Set System Preference
Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date
range is set to True.

Format Select the report format to be printed.

l Approved - List of approved clients with Create Date, User who Created,
Approve Date, and User who Approved

l Unapproved - List of unapproved clients with Create Date and User who
Created

l Approved/Unapproved - List of both approved and unapproved Clients.
Approved clients and Unapproved clients appear on their own page in
the report.
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Report Samples

Report Details

Column Description

Client Name Name of Client

Create Date Displays date the Client was created.

User Created Displays the User ID who created client.

Approved Date If approved, displays the date the Client was approved.

User Approved If approved, displays the User ID who approved the client.

Security Roles

To generate the Client Approval Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Client > Print Client Approval Report
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Client Activity Report

The Client Activity report displays purchase and payment activity and breaks out charge-back inform-
ation for selected clients over a specified date range.

The default report definition for this report is CliAct1.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
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Field Description

date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
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Field Description

which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table.

Format Select the report format to be printed. Currently, format 1 - Purchases, collections, A/R,
funds employed, chargebacks is the only option.

Combine Select the option to indicate how results are combined:

l Do not combine

l Combine to master

l Combine to group/value

l Combine to summary

l Combine to account exec

l Combine to office
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Report Sample

System Preferences

The following system preference that affects this report is found in the Administration module, System
Preferences, Fields/screen behavior, Miscellaneous folder.

Preference Description

Calculate earnings
based on account
table flag

Set to True - All accounts flagged as an Earning Account in Tables > Accounting
> Account Table > Standard Tab > Earning Account check box will be included in
the calculation.

Client Availability Report

The Client Availability report details the Client’s daily activity for a particular date range along with any
associated Disbursements.

The default report definition for this report is ClientAvail.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or

Reports User Guide
SQL Reports

353 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)
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Field Description

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Report Sample

Report Details

Column Description

Date Date of Activity

Description l Allocation from Client Statement = Daily Transactions Activity

l Disbursement = Funds Disbursed to Client and/or Third Party

Pay By Displays the Pay By Method

Check Trans # Displays the Check number
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Column Description

Reserve Amount Displays Reserve Amount

Amount Allocated Displays the Proceeds Available from Purchase Batch

Expenses Display Expenses

Balance Displays the Cash Reserve Balance

Security Roles

New Security Roles associated with this report are located at Security Roles > Reports > Client > Client
Availability (Yes/No).

Classic Client Aging Report

The Classic Client Aging Report screen allows you to print a general purpose aging report with invoice
detail by debtor within client.

The default report definition for this report is ClassicAging01.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference >
Fields/Screen Behavior > Miscellaneous > Use Client Search instead of drop
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Field Description

downs is set to True.

Select the magnifying glass icon to open the Search window and begin
typing the client name.

Select Contains or Begins with to refine results. Search window will display up
to 500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the
report, or leave blank to include all users. When a user is selected, the report is lim-
ited to clients that have that user selected in the A/E field on the Control panel of
the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use
the following System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restric-
tion defined on the Manage Users screen in the Admin module, the user will only be
able to generate the report within that office restriction. When the user generates a
report, the office to which they are restricted will be selected in the Office field by
default and the user will not be able to change the Office field when generating the
report.

Offices are defined in the Office table in the Tables feature. To access this table, on
the File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To
access this table, on the File menu, click Tables. Then, on the Client & Debtor menu,
click Client Group Codes.

Value Select the specific client group value to which to limit the report results from the list.
Client Groups are defined in the Group Code Table.
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Field Description

Debtor Enter the debtor name to which to limit the report. You can type a partial name to
display all debtors that match the letters entered. You can then double-click the
desired debtor name from the list to select it to be used to limit the report.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor
Group Codes are defined in the Debtor Group Code Table.

Value Select the specific debtor group value to which to limit the report results from the
list.

As Of Date Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the
ClientWeb Report Queue, a screen appears to choose the data range (Current Date,
Previous Month-End Date, or Specific Date).

Level Select the detail level for the report:

l Invoice

l Relationship (Debtor)

l Client

Select Select the option for the items to be reported:
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Field Description

l Unpaid only

l Unpaid & paid this month

l Everything on file

l Older than / Show selected: Select this option to limit the results to invoices
older than the number of days entered in the Age field and display only
invoices older than those days.

l Older than, show all: Select this option to limit the results to invoices older than
the number of days entered in the Age field, but display all invoices for debt-
ors that have one or more over age invoices, regardless of age.

Calc Age
By

Select the date from which to calculate aging:

l Invoice date

l Due date

l Purchase date

Show Select the date to be included in the report results:

l Invoice Date display the invoice date in the first date column and the paid
date in the second date column

l Invoice Date (Due date): display the invoice date in the first date column and
the due date in the second date column

l Due Date: display the due date in the first date column and the paid date in
the second date column

l Due Date (invoice date): display the due date in the first date column and the
invoice date in the second date column

l Purchase Date: display the purchase date in the first date column and the
paid date in the second date column

Display
Age By

Select the aging format to display on the report:
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Field Description

l Days (1-30, 31-60, 61-90...)

l Due Date (Current, 1-30, 31-60...)

l Months (August, July, June)

l Non-standard columns: use the non-standard aging buckets defined for the
client

Funded Select the invoice funding status for the items to be reported:

l Non-funded invoices only

l Funded invoices only

l Funded and non-funded

Convert to
Native Cur-
rency

Select this option to convert amounts from the base currency to the native currency
(the currency of the transaction). The conversion occurs on a client-by-client basis.
If the client has a currency type set and the currency type is different from the
default currency, FactorSoft looks up the conversion rate using the As of date in the
currency table for the client's currency.

For example, if client ABC Company has a currency type of Canadian Dollars and
the daily conversion rate for Canadian dollars is 1.5, the report increases all of the cli-
ent's amounts by a factor of 1.5.

Do not
page
break

Select this option to eliminate page breaks between clients in the generated output.

Show CPT Select this option to include CPT codes associated with invoices on the report.

Show
Debtor
Address

Select this option to include the debtor address on the report.

Show
Debtor
Contacts

Select this option to include the debtor contacts on the report.

Show
Debtor
Credit

Select this option to include the debtor credit limit on the report.
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Field Description

Limit

Show
Debtor
Phone
Numbers

Select this option to include the debtor phone number on the report.

Show Dis-
pute
Codes

Select this option to include the dispute reason for invoices in dispute to the left of
the invoice number on the report.

Show
Grand
Total

Select this option to include grand totals on the report.

Show NOA
and
Recourse
Info

Select this option to include the recourse days or NOA information for invoices
above the invoice balances on the report.

Show Per-
centage

Select this option include the percentage of the client's balance in each aging
bucket below the client totals.

Show PO# Select this option include the purchase order number on the line below the invoice.

Show Risk
Codes

Select this option to include the risk codes for invoices on the report.

Show
Skipped
Payments

Select this option to include an indicator for skipped payments. Skipped invoices will
display with an “S” to indicate that they have been skipped in cash posting.

High Level
Sort

Select the primary sort option for the report:

l Client: Sort by client

l Account executive, client: Sort by client within account executive.

l Office, client: Sort by client within office. An Office Total displays the total A/R
Balance for all clients within office at the office sub-total breaks when this
option is set.

Client Sort Select the sort option for client sorting:
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Field Description

l Name: sort by name in ascending alphabetic order.

l Client Code: sort client code in ascending alphanumeric order.

l Age level: sort by age, most current to least current.

Rela-
tionship
Sort

Select the option for sorting debtors within client:

l Debtor name

l Debtor code

l Client reference number

l Balance

Detail Sort Select the option for sorting the invoice detail within debtor:

l Invoice number

l Invoice date

Allow user
to override
para-
meters on
the web

Select this option to allow the ClientWeb user the ability to select parameters
(including Debtor) when requesting the report from the Report Queue page in Cli-
entWeb. This option applies to Classic Client Aging templates set up as a Web des-
tination with the As Of Date set to Set At Run Time (Web Template Only), which
allows the selection of the as-of date from the ClientWeb Report Queue at the time
the report is requested.
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Report Sample

Classic Client Aging (Beta) Report

The Classic Client Aging (Beta) Report screen allows you to print a general purpose aging report with
invoice detail by debtor within client.

The default report definition for this report is ClassicAging01V2.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference >
Fields/Screen Behavior > Miscellaneous > Use Client Search instead of drop
downs is set to True.

Select the magnifying glass icon to open the Search window and begin
typing the client name.

Select Contains or Begins with to refine results. Search window will display up
to 500 matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the
report, or leave blank to include all users. When a user is selected, the report is lim-
ited to clients that have that user selected in the A/E field on the Control panel of
the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use
the following System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restric-
tion defined on the Manage Users screen in the Admin module, the user will only be
able to generate the report within that office restriction. When the user generates a
report, the office to which they are restricted will be selected in the Office field by
default and the user will not be able to change the Office field when generating the
report.

Offices are defined in the Office table in the Tables feature. To access this table, on
the File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To
access this table, on the File menu, click Tables. Then, on the Client & Debtor menu,
click Client Group Codes.

Value Select the specific client group value to which to limit the report results from the list.
Client Groups are defined in the Group Code Table.

Debtor Enter the debtor name to which to limit the report. You can type a partial name to
display all debtors that match the letters entered. You can then double-click the
desired debtor name from the list to select it to be used to limit the report.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor
Group Codes are defined in the Debtor Group Code Table.

Value Select the specific debtor group value to which to limit the report results from the
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Field Description

list.

As Of Date Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the
ClientWeb Report Queue, a screen appears to choose the data range (Current Date,
Previous Month-End Date, or Specific Date).

Level Select the detail level for the report:

l Invoice

l Relationship (Debtor)

l Client

Select Select the option for the items to be reported:

l Unpaid only

l Unpaid & paid this month

l Everything on file

l Older than / Show selected: Select this option to limit the results to invoices
older than the number of days entered in the Age field and display only
invoices older than those days.

l Older than, show all: Select this option to limit the results to invoices older than
the number of days entered in the Age field, but display all invoices for debt-
ors that have one or more over age invoices, regardless of age.

Calc Age
By

Select the date from which to calculate aging:
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Field Description

l Invoice date

l Due date

l Purchase date

Show Select the date to be included in the report results:

l Invoice Date display the invoice date in the first date column and the paid
date in the second date column

l Invoice Date (Due date): display the invoice date in the first date column and
the due date in the second date column

l Due Date: display the due date in the first date column and the paid date in
the second date column

l Due Date (invoice date): display the due date in the first date column and the
invoice date in the second date column

l Purchase Date: display the purchase date in the first date column and the
paid date in the second date column

Calc
Amount

Select the Amount from which to Calculate:

l Invoice Amount (Default)

l Advance Amount

NOTE - When generating the report with Unpaid Only and Calc Amount: Advance
Amount, overpaid invoices will not display.

If using Relationship or Purchase Batch Override Terms, data will not be accurate in the
Client Adv Rate and Advance Amount. They are based on the Client Term set at the Cli-
ent Level.

Display
Age By

Select the aging format to display on the report:

l Days (1-30, 31-60, 61-90...)

l Due Date (Current, 1-30, 31-60...)

l Months (August, July, June)

l Non-standard columns: use the non-standard aging buckets defined for the
client
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Field Description

Funded Select the invoice funding status for the items to be reported:

l Non-funded invoices only

l Funded invoices only

l Funded and non-funded

Convert to
Native Cur-
rency

Select this option to convert amounts from the base currency to the native currency
(the currency of the transaction). The conversion occurs on a client-by-client basis.
If the client has a currency type set and the currency type is different from the
default currency, FactorSoft looks up the conversion rate using the As of date in the
currency table for the client's currency.

For example, if client ABC Company has a currency type of Canadian Dollars and
the daily conversion rate for Canadian dollars is 1.5, the report increases all of the cli-
ent's amounts by a factor of 1.5.

Do not
page
break

Select this option to eliminate page breaks between clients in the generated output.

Show CPT Select this option to include CPT codes associated with invoices on the report.

Show
Debtor
Address

Select this option to include the debtor address on the report.

Show
Debtor
Contacts

Select this option to include the debtor contacts on the report.

Show
Debtor
Credit
Limit

Select this option to include the debtor credit limit on the report.

Show
Debtor
Phone
Numbers

Select this option to include the debtor phone number on the report.

Show Dis-
pute

Select this option to include the dispute reason for invoices in dispute to the left of
the invoice number on the report.
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Field Description

Codes

Show
Grand
Total

Select this option to include grand totals on the report.

Show NOA
and
Recourse
Info

Select this option to include the recourse days or NOA information for invoices
above the invoice balances on the report.

Show Per-
centage

Select this option include the percentage of the client's balance in each aging
bucket below the client totals.

Show PO# Select this option include the purchase order number on the line below the invoice.

Show Risk
Codes

Select this option to include the risk codes for invoices on the report.

Show
Skipped
Payments

Select this option to include an indicator for skipped payments. Skipped invoices will
display with an “S” to indicate that they have been skipped in cash posting.

Show Cli-
ent
Advance
Rate

Select this option to include a column “Client Advance Rate” showing the Advance
Rate percentage set at the Client Level.

Note: If using Relationship or Purchase Batch Override Terms, data will not be accur-
ate in the Client Adv Rate and Advance Amount. They are based on the Client Term
set at the Client Level.

Show
Total Pay-
ments

Select this option to include a column “Payments” showing total amount of pay-
ments receive against an invoice.

High Level
Sort

Select the primary sort option for the report:

l Client: Sort by client

l Account executive, client: Sort by client within account executive.

l Office, client: Sort by client within office. An Office Total displays the total A/R
Balance for all clients within office at the office sub-total breaks when this
option is set.
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Field Description

Client Sort Select the sort option for client sorting:

l Name: sort by name in ascending alphabetic order.

l Client Code: sort client code in ascending alphanumeric order.

l Age level: sort by age, most current to least current.

Rela-
tionship
Sort

Select the option for sorting debtors within client:

l Debtor name

l Debtor code

l Client reference number

l Balance

Detail Sort Select the option for sorting the invoice detail within debtor:

l Invoice number

l Invoice date

Allow user
to override
para-
meters on
the web

Select this option to allow the ClientWeb user the ability to select parameters
(including Debtor) when requesting the report from the Report Queue page in Cli-
entWeb. This option applies to Classic Client Aging templates set up as a Web des-
tination with the As Of Date set to Set At Run Time (Web Template Only), which
allows the selection of the as-of date from the ClientWeb Report Queue at the time
the report is requested.
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Report Sample

System Preferences

The Classic Client Aging (Beta) Report is configured in System Preferences > Reports > Classic Client
Aging (BETA) folder, as described following:

Preference Description

Show NOA Sent
Instead of NOA
Received

When True, Report will show "NOA Sent."

When False, Report will show "NOA Received."

Client Change Report

The Client Change report displays changes to debtors by client, showing the debtor name, date of the
change, the data field affected and the before and after value for the field.

The default report definition for this report is CliChange1.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
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Field Description

Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.
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Field Description

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Report Sample

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Client change reports folder.

Preference Description

Show client reference
number instead of
debtor code

Set to True to display the Client Reference Number instead of the Debtor Code
has been added for the Client Change Report.

Client Contract Report

The Client Contract Report creates reports that list activity for invoices purchased under client contracts.
The Contract Detail Report that lists open contracts by debtor within client. The Activity format lists con-
tracts with purchase activity within a given date range by client.

The default report definitions for this report are ContractDtl and ContractAct.
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Report Parameters

Field Description

As of
Date

Today

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE
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Field Description

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Format Select the report format to be printed:

l Detail: generates the Contract Detail Report

l Activity: generates the Contract Activity Report

Filter By Select the line items to be included in the report.

l Open Contracts

l Closed Contracts

l All Contracts

Page
Break

Select this option to include debtors with no Federal Tax ID number recorded in the Debtor
Information Identity panel in the report results.
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Report Sample

Contract Detail Report

Contract Activity Report

Client/Debtor Summary Report

The Client/Debtor Aging Report generates a report that displays client/debtor activity for a selected
period, including purchase history by batch, a period summary, and a summary of totals by debtor.

The default report definition for this report is CliDebSumm.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
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Field Description

Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Reports User Guide
SQL Reports

381 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm
Client Group Codes Table.htm


Field Description

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Report Sample

Client Event Report (As Of Date)

The Client Event Report (As Of Date lists recurring client-related events (set up in the Client Event Table)
that have expired and produced a tickler message for the user, A/E, or group. This report was added as an
enhancement to complement the Client Event Expirations queue screen (which is accessed from the
Notes menu in the FactorSoft Desktop application) to leverage the scheduling and delivery capabilities of
CRS reports. Using the Client Event Expiration Report, you can provide daily past due event exception
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update reports to user, A/E, or group and deliver them via desktop, email, or printer. The generated report
lists each event as a line-item displaying the client name, office, event name and description, the expir-
ation date and note, if provided.

There are two report request screens that provide alternate date logic to generate the Event Expiration
Report. This Client Event Report (As Of Date) allows the report to be generated from a selected as-of
date, while the Client Event Report allows the report to be produced by selected date range.

Report Parameters

Field Description

AS Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
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Field Description

s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Tickler
note type

Select the event type to which to limit the display of client events. The entries in this list are
the events created in the Client Event Table.

Minimum Enter the client minimum outstanding balance for events to be included on the report. Cli-
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Field Description

client bal-
ance

ents with balances below this amount are excluded from the report.

Report Sample

Client Event Report

The Client Event Report lists recurring client-related events (set up in the Client Event Table) that have
expired and produced a tickler message for the user, A/E, or group. This report was added as an enhance-
ment to complement the Client Event Expirations queue screen (which is accessed from the Notes menu
in the FactorSoft Desktop application) to leverage the scheduling and delivery capabilities of CRS reports.
Using the Client Event Expiration Report, you can provide daily past due event exception update reports to
user, A/E, or group and deliver them via desktop, email, or printer. The generated report lists each event as
a line-item displaying the client name, office, event name and description, the expiration date and note, if
provided.

NOTE
To request this report, the system preference Reports, Event expiration report, Crystal Reports mod-
ule name must be set to TICKEXP.

There are two report request screens that provide alternate date logic to generate the Event Expiration
Report. This Client Event Report allows the report to be produced by selected date range, while the Client
Event Report (As Of Date) allows the report to be generated from a selected as-of date.

The default report definition for this report is CliEvent and CliEventAD.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.
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Field Description

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.
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Field Description

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Tickler
note type

Select the event type to which to limit the display of client events. The entries in this list are
the events created in the Client Event Table.

Minimum
client bal-
ance

Enter the client minimum outstanding balance for events to be included on the report. Cli-
ents with balances below this amount are excluded from the report.

Report Sample

System Preferences

The following system preference that affects this report is found in the Administration module, System
Preferences, Reports > Client Event Expirations folder.

Preference Description

Sort to client, expir-
ation date

Set to True and the report will sort to expiration date within client instead of
event type within client

Security Roles

To generate the Client Events Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Client > Print Client Events Report

Reports User Guide
SQL Reports

388 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm
Client Group Codes Table.htm


Client Funding Report

The Client Funding Report shows the advance rate, ineligibility, and gross available per invoice to help
determine a client’s availability to borrow against their reserve.

To access this report, in the Reports module, on the Client menu, click Client Funding Report.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
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Field Description

leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

As Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).
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Field Description

Report Select the report format.

l Invoice Summary Detail

l Client Funding Totals
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1. Invoice Summary Detail – Shows information about funded and active invoices. This format is also
available for delivery to ClientWeb (if available).

l As of Date – Indicates the time frame selected for the report.

l Debtor Name – Name of debtor shown in the report.

l Invoice # – Number of the invoice.

l Invoice Date – Date for the invoice.

l A/R Bal – Balance of the invoice.

l Ineligible A/R – Amount of ineligibles in the invoice.

l Available Collateral – The Invoice Balance minus Invoice Ineligible Amount.

l Advance Rate – Advance rate for the invoice.

l Gross Available – The Available Collateral multiplied by the Invoice Advance Rate.

l Ineligible Reason – Description for the Ineligible code.

l Fund Employed – The Client Net Fund Employed Balance based on the As of Date selected for
the report.

l Available for Release – The sum of Gross Available less the Fund Employed.

2. Client Funding Totals – Shows a snapshot for either all active factoring clients, or the client selec-
ted for the report.
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l As of Date – Indicates the time frame selected for the report.

l A/R Bal – Balance of the invoice.

l Ineligible A/R – Amount of ineligibles in the invoice.

l Available Collateral – The Invoice Balance minus Invoice Ineligible Amount.

l Gross Available – The sum of Invoice Available Collateral multiplied by the Invoice Advance
Rate.

l Fund Employed – The Client Net Fund Employed Balance based on the As of Date selected for
the report.

l Available Reserve – The sum of Gross Available less the Fund Employed.

l Unapplied Cash – Balance of cash received that has not yet been applied to specific
invoices.

Client Liability Report

The Client Liability Report is used in conjunction with the Sales Authorization AddOn module in association
with the New Client Liability functionality listing invoices marked as Client Liability by debtor within client.

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
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Field Description

leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Format Select the report format option.

l Detail

l Summary (Not recommended for use at this time.)
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Report Sample

Report Details

Column Description

Client Name Displays the Client’s name

Client Ref # Displays the Client/Debtor Relationship Reference #

Debtor Displays the Debtor Name

Invoice # Displays the Invoice Number

Invoice Amount Displays the Invoice Amount

Invoice Date Displays the Invoice Date

Invoice Age Displays the age of the Invoice.

Reason Displays the reason that the Invoice is on the report. (May be blank)

Max Invoice Amount Displays the Debtor's Max Invoice Amount

Total Credit Limit Displays the Debtor's All Client Credit Limit

Security Roles

To generate the Client Liability Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Client > Client Liability Report
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Client Reserve Report

The Client Reserve Report generates a listing of current reserves by client, including a subtotal of reserve
balances, a summary of potential charge-backs and potential new reserve balance.

The default report definition for this report is RsvRept.

To enable the FactorSoft Reporting Services version of the Client Reserve Report in FactorSoft and Cli-
entWeb, set the Reports module System Preference in Reports, Client reserve reports (listed below) to
C_RSVACT. You can choose any of the following formats, but only that one format will be available in Cli-
entWeb:

l Detail Crystal Reports module name

l Detail with activity (w/check#) Crystal Reports module name

l Detail with activity (w/fee%) Crystal Reports module name

l Detail with activity (w/RefNo) Crystal Reports module name

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
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Field Description

True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
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Field Description

Group Codes.

Date
range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Report
Type

Select the report format to be printed:
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Field Description

l Detail: Generates the Reserve Detail Report.

l Detail with Activity (w/Fee%): generates the Reserve Activity Report, including the Fee
%.column.

l Detail with Activity (w/Check#): generates the Reserve Activity Report, including the
Check.column, which contains the check number, if provided.

l Detail with Activity (w/Ref#): generates the Reserve Report, including the Ref
#.column, which displays the Debtor reference code.

l Summary: generates the Reserve Summary Report, which contains one line per client
displaying the reserve balance.

l Summary with potential chargebacks: generates the Reserve Summary Report, which
contains one line per client displaying the reserve balance, potential chargebacks,
and reserve availability totals.

Sort Cli-
ent by

Select the sort option that determines the order in which clients are sorted:

l Client Name

l Client Code

Sort Detail
by

Select the option that determines how the detail is sorted within client.

l Invoice #

l Check #

Include
unpaid
checks

Select this option to include unpaid checks in the report results.

Each cli-
ent starts
on a new
page

Select this option to force a new page for each client break in the report. If this is not selec-
ted, multiple clients can be printed on one page.

Hide pay-
ments to
hold
accounts

Select this option to suppress display of payments to hold accounts in the report results.
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Report Sample

System Preferences

The following system preference that affects this report is found in the Administration module, System
Preferences, Fields/screen behavior, Miscellaneous folder.

Preference Description

Calculate earnings
based on account
table flag

Set to True - All accounts flagged as an Earning Account in Tables > Accounting
> Account Table > Standard Tab > Earning Account check box will be included in
the calculation.

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Client recourse reports folder.

Preference Description

Advanced calculation
should not include
fee rate

Set to True to indicate that the Advance column represents that account hold-
back only.

Credit 'HELD' activity
should display as
'PAID'

Set to True to allow the Activity Type for reserve release through a purchase to
be “PAID” instead of “HELD” on the Client Reserve Report (Format set to Detail
with Activity (w/Fee%), Detail with Activity (w/Check#), or Detail with Activity
(w/Ref#)).

Fee column on activ-
ity reports is only fees
taken at collection

Set to True to include only fees taken at collection. If False, the program will
include a calculated representation of fees taken at purchase, so the net to
reserves will not reconcile to the report.

Heading should be Set to True to use the heading Additional Fees instead of Interest on appro-
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Preference Description

additional fee instead
of interest

priate reports.

Hide detail with activ-
ity format

Set to True to turn off the Detail with Activity with Check # and Fee % formats.

Include inactive cli-
ents in all client selec-
tion

Set to True to include inactive clients in the results.

Leave pending check
numbers as blank (do
not print 'Pending')

Set to True to prevent literal Pending from displaying on unwritten checks.

Pickup fees from pur-
chases

Set to True to include purchase fees on the report.

Show accrued invoice
fees and interest if
not deducted

Set to True to show the fees and interest below Available for Release if the pref-
erence is set to not deduct fees and interest.

Suppress trans-
actions with no
reserve effect

Set to True to exclude transactions with no reserve effect from the Detail with
Activity reports.

Use report server cli-
ent reserve report

Set to True to use the Task Scheduler-enabled report.

Client Summary and Ineligibility Report

The Client Summary Detail report lists Funds Employed, Collateral and Reserves details for a single client
or all clients for the selected dates.

The default report definitions for these reports are:

l Client Summary Detail = RsvRel1

l Client Ineligibility = Inelig1

l Suspense and Write Offs are separate = RsvRel4
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
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Field Description

lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.
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Field Description

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Use last business day instead of yesterday in date range to True. The Yesterday option in
the Date Range field is replaced with Last Business Day, and reports printed on Monday
will print Friday’s data (assuming Friday was the last business day) instead of Sunday’s.
Set System Preference Identification/system constants > CLMS|Reporting Services >
Requests > Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Reporting Services
reports when Use last business day instead of yesterday in date range is set to True.

Show Select the option that determines invoices to be included in the report. This option is only
available when the Client ineligibility report is selected:

l All unpaid invoices

l Ineligible invoices only

Sort Select the sort option that determines the order in which to display detail data. This option
is only available when the Client ineligibility report is selected:

l Debtor/Invoice: includes a break between each debtor with totals for Balance,
Amount Eligible, and Available for Recourse.

l Invoice only: same as above, but without debtor break and totals.

G/L Group Select the G/L Account Group to which to limit the report.

Format l Client summary detail: Select this option to generate the Client Summary Detail
report, which details balances for each client in Funds Employed, Collateral, and
Reserves sections.

l Client summary total: Select this option to generate the Client Summary Total
report, which is in the same format as the Client Summary Detail, but contains only a
total of all clients without individual client detail.

l Client summary detail and total: Select this option to generate both the Client Sum-
mary Total and Detail report.

l Client ineligibility report: Select this option to generate the Ineligibility Report, which
details ineligible invoices as individual line items by debtor within client, displaying
balances, ages, and ineligibility reason.

Convert Select this option to convert amounts from the base currency to the native currency (the
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Field Description

sum-
maries to
native cur-
rency

currency of the transaction). The conversion occurs on a client-by-client basis. If the client
has a currency type set and the currency type is different from the default currency, Fact-
orSoft looks up the conversion rate using the As of date in the currency table for the client's
currency. For example, if client ABC Company has a currency type of Canadian Dollars and
the daily conversion rate for Canadian dollars is 1.5, the report increases all of the client's
amounts by a factor of 1.5.

Report Sample
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System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Client summary/ineligibility reports folder.

Preference Description

Accumulate master
clients

Set to True to group member clients to master client in the report results.

Note that when this preference is set to True, this changes the Client
Group/Value filtering of the report. The client group functionality matches to the
master client and determines whether its members appear in the results
returned on the report . The Group and Value settings for the member clients of
a master are not considered.

Suspense and Write
offs are separate

Set to True to display Suspense Amt and Write Offs as separate fields on the
generated report.

Note: Set System Preferences > Reports > Client Summary/Reserve Release >
Crystal Reports module name/Excel template = RSVREL4 to generate the Sus-
pense and Write Off report format.

Additional system preferences for this report are found in the Administration module, System Preferences,
Client Rules/Defaults, Ineligibility/Summary Calculations folder.

Preference Description

Calculate Hold Bal-
ances for Reports

When set to True, the Total Funds Employed is reduced by the amount of Held
Funds. If False, then Held Funds are not part of the calculation for the reports.

Calculations

Column Calculation

Accrued Interest (Total Funds Employed + Float) x (Basis+Rate)/Per = Daily Accrued Interest

If System settings indicate Float is not applicable, then Float is 0 in the above for-
mula.

When Calculating interest for a time period, the user must calculate each day,
add them together and then round to determine the Total Accrued Interest for
the Time Period.
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Client Summary Graph Report

The Client Summary Graph report displays a graphical representation of the client’s funding, reserves and
concentration with accompanying report data.

The default report definition for these reports is CliSummGraph.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.
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Field Description

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Report Sample
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Funding

Field Description

Funded Balance Total Funds Employed. his amount is calculated by subtracting cash reserves,
settlement amounts, simple interest loans, amortized loans, P.O. financed
amounts, and held funds from the Advance Balance.

Credit Limit Total client credit limit entered on the Credit/No-buy tab of the Client Inform-
ation screen.

Credit Limit Expiration N/A

Available Credit Calculated as the Credit limit minus the Funded A/R Balance.

Invoices Funded (Last
30 Days)

Dollar amount of invoices funded in the last 30 days from the current FactorSoft
processing date.

Payments Posted
(Last 30 Days)

Dollar amount of invoices paid in the last 30 days from the current FactorSoft
processing date.

A/R Turn The average number of days for A/R turn.

First Funding Date The date on which the first funding disbursement was made to the client.

NAICS Industry Code The North American Industry Classification System (NAICS) code for the client.

Reserves

Field Description

Reserve Escrow The dollar amount of reserves in escrow for the client.

Cash Reserve The dollar amount of cash reserves for the client.

Available for Release The remainder of Adjusted Reserves minus required reserves and float.
Supply if in black, deficit if in red.

Eligible for Repur-
chase

The dollar amount of invoices available for recourse and invoices in dis-
pute.

Eligible in 30 days The dollar amount of o Invoices within 30 days of their recourse days.

Reserve for New
Purchase

Reserve escrow rate or Reserve rate from Client Terms

Unapplied Credits The total of non-factored payments.
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Concentration

Field Description

Total Dilution Total Dilution for the selected period for the displayed debtors.

AR Turn The average number of days for A/R turn for the displayed debtors.

Invoice Summary Aging

The Invoice Summary Aging Report screen allows you to print the Invoice Summary Aging by Invoice
report which lists invoices purchased from clients by the selected criteria.

The default report definition for this report is InvSummAgeDet.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

Reports User Guide
SQL Reports

411 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
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Field Description

Codes.

Level Select the detail level for the report:

l Invoice

l Relationship (Debtor)

l Client

Select Select the option for the items to be reported:

l Unpaid and paid this month

l Unpaid only

l Everything on file

Funded Select the invoice funding status for the items to be reported:

l Funded and non-funded

l Funded invoices only

l Non-funded invoices only

Calc
Age By

Select the date from which to calculate aging:

l Invoice date

l Due date

l Purchase date

Report Samples

Level: Invoice
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Level: Relationship (Debtor)

Level: Client
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Report Details

Field/Column Description

Level: Invoice

Invoice # Invoice number

PO# Purchase order number

Debtor Debtor Name

Invoice Date Invoice Date

Due Date Due Date

Purchase Date Purchase Date

Sch # Purchase Batch/Schedule #

No column Header NF - Non-Funded Invoice

Invoice amount Amount of the Invoice

Age Invoice Age

Payment Date Date invoice was paid

Paid Amount Amount Paid on the Invoice

C/B Amount Amount Charge/Back on the Invoice

Balance Current Invoice Balance

Aging Recap Section

Current Total Amount of Invoice/Invoices that are current.

31-60 Days Total Amount of Invoice(s) aged 31 to 60 days and percentage

61-90 Days Total Amount of Invoice(s) aged 61 to 90 days and percentage

91-120 Days Total Amount of Invoice(s) aged 91 to 120 days and percentage

121+ Days Total Amount of Invoice(s) aged 121 and over days and percentage.

Level: Relationship (Debtor)

Debtor Debtor Name

Balance Current A/R Balance for the Client/Debtor Relationship
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Field/Column Description

Aging Recap Section

Current Total Amount of Invoice(s) that are current.

31-60 Days Total Amount of Invoice(s) aged 31 to 60 days and percentage

61-90 Days Total Amount of Invoice(s) aged 61 to 90 days and percentage

91-120 Days Total Amount of Invoice(s) aged 91 to 120 days and percentage

121+ Days Total Amount of Invoice(s) aged 121 and over days and percentage.

Level: Client

Client Name Client Name

Balance Current A/R Balance for the Client

Aging Recap Section

Current Total Amount of Invoice(s) that are current.

31-60 Days Total Amount of Invoice(s) aged 31 to 60 days and percentage

61-90 Days Total Amount of Invoice(s) aged 61 to 90 days and percentage

91-120 Days Total Amount of Invoice(s) aged 91 to 120 days and percentage

121+ Days Total Amount of Invoice(s) aged 121 and over days and percentage.

Security Roles

To generate the Invoice Summary Aging Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Client > Invoice Summary Aging Report

Load List Report

The Load List report, which is opened from the Client menu of the Reports module, produces a list of open
loads from the Load Processor for clients. The report is organized by invoice within client. Totals of Invoice
Amount and Advance Amount are provided for each client and a grand total of Invoice Amount and
Advance Amount are displayed on the final page of the generated report, after the last client’s list of open
invoices

The default report definition for this report is LoadList.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:
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Field Description

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

As Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Show
settled
loads

Select this option to include previously settled loads in the report.

Show
denied
loads

Select this option to include loads on which the advance was denied in the report.
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Report Sample

Non Performing Loan Status Report

We’ve created a new SQL report to track transactions posted to accounts designed as non-performing
(or non-accrued) earnings. This report is available on by clicking Non Performing Loan Status Report on
the Client menu in the Reports module.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.
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Field Description

Note: There are two Client Group lists from which you can select a Client Group. Clients that
are chosen from the first Client Group parameter list determine the clients that appear in
the second Client Group parameter list.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Date
Range

Select the date to use for the report from the list:

l Today

l Last Business Day

l Last Month

l Current Month To Date

l Year Thru Last Month-End

l Current Year to Date

l Specific Date Range

l Set At Run Time (Web Template Only)

If the Specific Date Range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants, Performance, Reporting Services, Requests,
Use last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will print
Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants, Reporting Services, Requests, Saturday is a busi-
ness day to True to consider Saturday a business day when the Date Range is set to Last Busi-
ness Day. This function is only valid for Reporting Services reports when Use last business day
instead of yesterday in date range is set to True.

Format Select the format for the report:
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Field Description

l Client Summary – Includes data from all facilities rolled up and totaled to the client.
Report will include a grand total of all clients in the report.

l Facility Detail – Includes data for each facility that has “Non Accrual” activity.

Report Samples

Facility Detail Format

Client Summary Format

Report Details

Column Description

Client
Name

Name of the client.

Loans Balance of the loan and/or Net Funds employed for the date range defined for the report.
Post dated transactions are not included. If a thru date prior to the current date is selec-
ted for the Date Range parameter, the balance amount comes from the daily history
tables which are being saved as part of the engine processing date change.
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Column Description

Non-
Accrual

Total for non-accruals for the account specified in the “Non Accrual Account Selections”
system preference.

Chargeoff Total for chargeoffs for the account specified in the “Chargeoff Account Selections” sys-
tem preference.

Specific
Reserve

The Specific Reserve amount.

This column is labeled according to the selection made for the following System Prefer-
ence: System Preferences > Reports > Non Performing Loan Status Report > Mis-
cDataDefine Selections

Net Expos-
ure

Net Exposure for the client(s) or facilities in the report.

Security Roles

To generate the Non Performing Loan Status Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Client > Print Non Performing Loan Status Report

System Preferences

There are a few new System Preferences which affect this report:
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l System Preference > Reports > Non Performing Loan Status Report > Non Accrual Account Selections

l Factoring Account Selection – Used to select the factoring account to use for the report.

l ABL Account Selection – Used to select the ABL account to use for the report.

l System Preference > Reports > Non Performing Loan Status Report > Chargeoff Account Selections

l Factoring Account Selection – Used to select the factoring account to use for the report.

l ABL Account Selection – Used to select the ABL account to use for the report.

l System Preference > Reports > Non Performing Loan Status Report > MiscDataDefine Selections

l Client Specific Reserve Data Definition – Used to select the Custom Data Element to use for
the “Specific Reserve” column in the report (for clients).

l Facility Specific Reserve Data Definition – Used to select the Custom Data Element to use for
the “Specific Reserve” column in the report (for facilities).

l System Preference > Client Rules/Defaults > Ineligibility/Summary Calculation > Calculate hold bal-
ances for report

l Set to TRUE to account for Held Funds Amount on Loan Balances

Originals Received Report

The Originals Received Report lists the invoices on which originals were required for a given period.

The default report definition for this report is OriginalRec.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Reporting
Services > Requests > Use last business day instead of yesterday in date range
to True. The Yesterday option in the Date Range field is replaced with Last Busi-
ness Day, and reports printed on Monday will print Friday’s data (assuming Fri-
day was the last business day) instead of Sunday’s. Set System Preference
Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date
range is set to True.

Invoice Over Days Enter the minimum age of invoices in number of days to which to limit the dis-
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Field Description

play of invoices.

Report Sample

Collateral Menu

Collateral Reports

The Collateral report group contains reports that provide details on collaterals in bulk collateral lending
environments.

A/R Aging Declaration Report

The A/R Aging Declaration Report summarizes posting activity for the A/R Aging collateral type. This report
is accessed from the Collateral menu of the Reports module.

Reports User Guide
SQL Reports

426 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
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Field Description

s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
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Field Description

Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Format Select the report format to generate:

l Available: generate the AR Aging Declaration Report highlighting the borrowing base
calculation to “Available at Posting”.

l Aging: generate the AR Aging Report listing data entry by aging bucket.

Report Sample

Available Format
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Aging Format
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Report Details

Column Description

Available Format

Category Description for the “Asset Class” set-up by the user to identify the source for the
summary aging information ( usually Debtor Name).

Declaration Date Posting date, defaults to the current date.

Gross Collateral Displays the current collateral value used to support the loan balance.

Aged Ineligible Sum of the data entered in aging bucket(s) that are flagged as ineligible in the
Category set-up.

Other Ineligible Sum of (other) ineligible amounts posted in the Ineligibles declaration.

Eligible Collateral Displays the current Eligible Collateral amounts used to support the loan bal-
ance. (Current Collateral value - Ineligible values)
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Column Description

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)

Available at Posting Displays the calculated Available Collateral amount used to support the loan
balance. (Lower of Available Limit and Net Collateral Amount)

Aging Format

Gross Collateral Displays the current collateral value used to support the loan balance.

Unbilled Field label for generic aging bucket that user can use for miscellaneous
amounts or for sales not yet booked.

Aging Columns Each aging category is displayed as a separate column, and the outstanding
balance in each of the categories is displayed.

Aged Ineligible Sum of the data entered in aging bucket(s) that are flagged as ineligible in the
Category set-up.

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)

Security Roles

To generate the A/R Aging Declaration Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print AR Aging Declaration Report

A/R Aging Trend Report

The A/R Aging Trend Report screen is used to define the selection criteria for the A/R Aging Trend report.
The A/R Aging Report lists all declarations posted for A/R Aging collateral types within the date range
provided and high-lights the borrowing base calculation to “Available at Posting”. The report provides
details for each financial category for the date range requested. This report is accessed from the Col-
lateral menu of the Reports module.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the

Reports User Guide
SQL Reports

433 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
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Field Description

which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Report Sample
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Report Details

Column Description

Date Posting date

Gross Collateral Displays the current collateral value used to support the loan balance.

Aged Ineligible Sum of the data entered in aging bucket(s) that are flagged as ineligible in the
Category set-up.

Other Ineligible Sum of (other) ineligible amounts posted in the Ineligibles declaration.

Eligible Collateral Displays the current Eligible Collateral amounts used to support the loan bal-
ance. (Current Collateral value - Ineligible values)

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)

Available at Posting Displays the calculated Available Collateral amount used to support the loan
balance. (Lower of Available Limit and Net Collateral Amount)

Security Roles

To generate the A/R Aging Trend Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print AR Trend Report

A/R Monthly Analysis Report

The A/R Monthly Analysis Report summarizes Accounts Receivable posting activity summed by month for
selected client's Bulk AR collateral. This report is accessed from the Collateral menu of the Reports mod-
ule.

The default report definition for this report is ArMonthlyAnalysis.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

Note that inactive clients are filtered out of this report.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.
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Field Description

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.

Dilution Select the desired dilution calculation to use for the Dilution column of the report. The label
of the dilution column in the generated report will reflect the option selected.

l AR Balance: Dilution = Sum of Credits and Discounts / End of Month Accounts Receiv-
able balance.

l Total Sales: Dilution = Credits + Adjustments / Total Sales

l Total Collections: Dilution = Credits + Adjustments / Total Collections

Format Select the report format to generate:

l Monthly detail by facility: produces a report listing each Facility and its transactions
by the specified Date Range.

l Current month portfolio summary: produces a report listing each Facility activity for
the specified Month and Year.

Month If the Current month portfolio summary format is selected, select the month for which to pro-
duce the report.

Year If the Current month portfolio summary format is selected, enter the year for which to pro-
duce the report. If no year is specified, the current year is assumed by default.

Report Sample

Monthly Detail by Facility

Current Month Portfolio Summary
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Report Details

Column Description

Begin Balance Displays Gross AR amount at the beginning of the period being evaluated.

Sales Displays sum of the sales reported in Bulk AR Certificate Postings in the period
being evaluated.

Credits Displays sum of the credits reported in Bulk AR Certificate Postings in the period
being evaluated.

Discounts Displays sum of the discounts input in Bulk AR Certificate Postings in the period
being evaluated.

Adjustments Displays sum of the adjustments input in Bulk AR Certificate Postings in the
period being evaluated.

Collections Displays Collections: sum of the collections input in Bulk AR Certificate Postings
in the period being evaluated.
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Column Description

Over Pays Displays sum of the Over Pays input in Bulk AR Certificate Postings in the period
being evaluated.

End Balance Displays Gross AR amount at the end of the period being evaluated

Ineligible Displays Total Ineligible at the end of the period being evaluated.

Cash Turn Total End of Period Accounts Receivable Balance divided by the Period Total Col-
lections multiplied by the Actual number of Days in the Period.

Sales Turn Total End of Period Accounts Receivable Balance divided by the Period Total
Sales multiplied by the Actual number of Days in the Period.

Dilution l AR Balance: Dilution = Sum of Credits and Discounts / End of Month
Accounts Receivable balance.

l Total Sales: Dilution = Credits + Adjustments / Total Sales

l Total Collections: Dilution = Credits + Adjustments / Total Collections

Security Roles

To generate the A/R Monthly Analysis Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print A/R Monthly Analysis Report

A/R Trend Report

The A/R Trend report provides a summary of accounts receivable activity. The Report lists all certificate
postings for the Bulk A/R collateral types within the date range provided and also high-lights the bor-
rowing base calculation to “Availablity”. This report is accessed from the Collateral menu of the FactorSoft
Report module.

The default report definition for this report is ARTrends.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)
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Field Description

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
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Field Description

erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.
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Report Sample

Report Details

Column Description

Date Posting date.

Gross Collateral Displays the current collateral value used to support the loan balance.

Ineligible Displays the current total Ineligible amounts.

Eligible Collateral Displays the current Eligible Collateral amounts used to support the loan bal-
ance. (Current Collateral value - Ineligible values)

Adv. Rate Displays the Advance Rate set for the Collateral.

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)
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Column Description

Limit Displays the loan limit for the Collateral.

Availability Displays the sum of the calculated Available Collateral amounts used to sup-
port the loan balance. (Lower of Loan Limit and Net Collateral amount)

Security Roles

To generate the A/R Trend Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print A/R Trend Report

Availability Certificate Report

The Availability Certificate report is used to show the current loan position which and provide a method to
make an advance request. The report includes a user defined (see system preference) header and footer
instruction section and a form with availability certificate and advance request. This report is accessed
from the Collateral menu of the Reports module.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.
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Field Description

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Report Sample

Report Details

Column Description

Facility Displays Facility Name
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Column Description

Collateral Displays the Collateral Name

Limits Displays the loan limit for the Collateral

Gross Collateral Displays the current collateral value used to support the loan balance

Total Ineligible Displays the Total Ineligibles for each Collateral as shown on the Collateral
Information screen under Collateral Summary.

Eligible Collateral Displays the current Eligible Collateral amounts used to support the loan bal-
ance. (Current Collateral value - Ineligible values)

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)

Available Displays the calculated Available Collateral amount used to support the loan
balance. (Lower of Available Limit and Net Collateral Amount)

Balance Displays the Facility Balance as shown on the Facility Summary screen under
Facility Summary.

Excess Displays the excess (cash that can be distributed)

Security Roles

To generate the Cash Posting Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print Availability Certificate Report

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Availability Certificate folder.

Preference Description

Availability Certificate
heading text

Select specific text that will appear in the Heading section of the Availability Cer-
tificate Report

This text is set at Tables > Statements & Letters > Statement Text Table

Availability Certificate
footer text

Select specific text that will appear in the Footer section of the Availability Cer-
tificate Report

This text is set at Tables > Statements & Letters > Statement Text Table
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Preference Description

SQL Reports module
name

Used to assign the SQL reports module a name

Bulk Inventory Trend Report

The Bulk Inventory Trend report provides a of inventory receivable activity. The Report lists all certificate
postings for the Bulk Inventory collateral types within the date range provided and also high-lights the bor-
rowing base calculation to “Availability”. This report is accessed from the Collateral menu of the Fact-
orSoft Report module.

The default report definition for this report is BulkInvTrend.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.
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Report Sample

Report Details

Column Description

Client Displays Client Name

Facility Displays Facility Name

Collateral Displays the Collateral Name

Date Displays the date of the posting

Gross Collateral Displays the current collateral value used to support the loan balance

Ineligible Displays the Ineligibles as shown on the Collateral Information screen under Col-
lateral Summary

Eligible Collateral Displays the current Eligible Collateral amounts used to support the loan bal-
ance. (Current Collateral value - Ineligible values)

Adv. Rate Displays the advance rate used for the collateral

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)

Limits Displays the loan limit for the Collateral

Availability Displays the calculated Available Collateral amount used to support the loan
balance. (Lower of Available Limit and Net Collateral Amount)
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Security Roles

To generate the Bulk Inventory Trend Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print Bulk Inventory Trend Report

Bulk Inventory Monthly Analysis Report

The Bulk Inventory Monthly Analysis Report summarizes Inventory Posting activity summed by month for
selected Client's Bulk Inventory collateral. This report is accessed from the Collaterals menu of the Reports
module.

The default report definition for this report is InvMonthlyAnalysis and InvMonthlyAnalysis2.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.
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Field Description

Format Select the report format to generate:

l Monthly detail by facility: produces a report listing each Facility and its transactions
by the specified Date Range.

l Current month portfolio summary: produces a report listing each Facility activity by
the specified Month and Year.

Month If the Current month portfolio summary format is selected, select the month for which to pro-
duce the report.

Year If the Current month portfolio summary format is selected, enter the year for which to pro-
duce the report. If no year is specified, the current year is assumed by default.

Report Sample

Monthly Detail by Facility

Current Month Portfolio Summary
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Report Details

Column Description

Purchase Turn # of Days, Total End of period Inventory Balance divided by the period total Purchases
multiplied by the actual number of days in the period.

Usage Turn # of Days, Total End of period Inventory Balance divided by the period total Usage
multiplied by the actual number of days in the period.

Dilution - Invent-
ory Balance

Percentage, Period Total Removed divided by the end of period Inventory

Dilution - Addi-
tions

Percentage, Period Total Removals divided by the end of period Total Additions

Dilution - Reduc-
tions

Percentage, Period Total Removals divided by the end of period Total Reductions

Security Roles

To generate the Bulk Inventory Monthly Analysis Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print Bulk Inventory Monthly Analysis Report

Tracked Collateral Summary Report

The Tracked Collateral Summary Report is presented by client in three sections: Accounts Receivable
Aging, Ineligibles by Reason, and Concentration, and provides trending and analysis information for
Tracked AR data. The report is produced from a selected Last completed month and Year as-of date, and
displays up to six preceding submissions for analysis. A Format option allows the user to select whether to
locate the last submission in the most recent completed month or quarter, and report the preceding
month or quarter ends in prior months, quarters, or years. The report can be filtered by Client, A/E, Office,
Client Group/Value, Facility and/or Collateral.
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Report Parameters

Field Description

Last com-
pleted
month

Select the month of the last completed submission to be used as the as-of date month for
the report.

Year Enter the year of the last completed submission to be used as the as-of date year for the
report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Format Select the report format to be generated:
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Field Description

l Monthly

l Quarterly

l Annual

Report Sample

Healthcare Receivable Monthly Analysis Report

The HR (Healthcare Receivables) Monthly Analysis Report summarizes HC Receivable posting activity
summed by month for selected client's Bulk HR collateral . This report is accessed from the Collaterals
menu of the Reports module.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
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Field Description

date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
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Field Description

which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Dilution Select the desired dilution calculation to use for the Dilution column of the report. The label
of the dilution column in the generated report will reflect the option selected.

l AR Balance: Dilution = Sum of Credits and Discounts / End of Month Accounts Receiv-
able balance.

l Total Sales: Dilution = Credits + Adjustments / Total Sales

l Total Collections: Dilution = Credits + Adjustments / Total Collections

Format Select the report format to generate:

l Monthly detail by facility: produces a report listing each Facility and its transactions
by the specified Date Range.

l Current month portfolio summary: produces a report listing each Facility activity by
the specified Month and Year.

Month If the Current month portfolio summary format is selected, select the month for which to pro-
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Field Description

duce the report.

Year If the Current month portfolio summary format is selected, enter the year for which to pro-
duce the report. If no year is specified, the current year is assumed by default.

Report Sample

Monthly Detail by Facility

Current Month Portfolio Summary

Report Details

Column Description

Cash Turn Total End of Period Accounts Receivable Balance divided by the Period Total Col-
lections multiplied by the Actual number of Days in the Period.

Sales Turn Total End of Period Accounts Receivable Balance divided by the Period Total
Sales multiplied by the Actual number of Days in the Period.
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Column Description

Dilution l AR Balance: Dilution = Sum of Credits and Discounts / End of Month
Accounts Receivable balance.

l Total Sales: Dilution = Credits + Adjustments / Total Sales

l Total Collections: Dilution = Credits + Adjustments / Total Collections

Security Roles

To generate the Bulk Inventory Monthly Analysis Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print Healthcare Monthly Analysis Report

Healthcare Receivables Trend Report

The Healthcare Receivables Trend report provides a summary of accounts receivable activity. The Report
lists all certificate postings for the Bulk HR collateral types within the date range provided and also high-
lights the borrowing base calculation to “Availability”. This report is accessed from the Collateral menu of
the FactorSoft Report module.

The default report definition for this report is ARTrends.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Reports User Guide
SQL Reports

469 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm
Client Group Codes Table.htm
Client Group Codes Table.htm


Report Sample

Report Details

Column Description

Client Displays Client Name

Facility Displays Facility Name

Collateral Displays the Collateral Name

Date Displays the date of the posting

Gross Collateral Displays the current collateral value used to support the loan balance

Ineligible Displays the Ineligibles as shown on the Collateral Information screen under Col-
lateral Summary

Eligible Collateral Displays the current Eligible Collateral amounts used to support the loan bal-
ance. (Current Collateral value - Ineligible values)

Adv. Rate Displays the advance rate used for the collateral

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)

Limits Displays the loan limit for the Collateral

Availability Displays the calculated Available Collateral amount used to support the loan
balance. (Lower of Available Limit and Net Collateral Amount)

Security Roles

To generate the Healthcare Receivables Trend Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print Healthcare Receivables Trend Report
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Inventory Declaration Report

The Inventory Declaration Report summarizes declarations on Inventory collaterals for selected clients dur-
ing a selected date range. This report is accessed from the Collaterals menu of the Reports module.

The default report definition for this report is InvenDeclaration.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.
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Field Description

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.
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Field Description

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.

Report Sample
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Inventory Trends Report

The Inventory Trends report summarizes the financial trends of an Inventory collateral over a specified
period of time. This report is accessed from the Collateral menu of the FactorSoft Report module.

The default report definition for this report is InvenTrends.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.
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Field Description

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.
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Field Description

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Report Sample

Summary A/R Declaration Report

The Summary A/R Declaration report summarizes declarations on Summary A/R collaterals for selected
clients during a selected date range. .The results detail each category of the receivable. This report is
accessed from the Collaterals menu of the Reports module. The results detail each category of the receiv-
able.

The default report definition for this report is MedRecDeclaration.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
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Field Description

tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.
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Field Description

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Format Select the report format to be generated:

l Available: generate the availability format of the Summary AR Declaration Report

l Aging: generate the aging format of the Summary AR Declaration Report

Report Sample

Summary A/R Trends Report

The Summary A/R Trends report summarizes the financial trends of a Summary AR collateral over a spe-
cified period of time. This report is accessed from the Collaterals menu of the Reports module.

The default report definition for this report is MedRecTrend.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
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Field Description

Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
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Field Description

this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Report Sample

Tracked Ineligibility Listing Report

The Tracked Ineligible Listing Report lists Tracked AR submission ineligibles by debtor within ineligibility cat-
egory. The report is produced from a selected As Of Date, and can be filtered by Client, A/E, Office, Client
Group/Value, Facility and/or Collateral.
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Report Parameters

Field Description

As Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Year Enter the year of the last completed submission to be used as the as-of date year for the
report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.
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Field Description

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
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Field Description

facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Sample Report

Tracked Ineligibility Report

The Tracked Ineligibility Report provides three report formats for viewing ineligibles identified in the
Tracked AR module.

The default report definitions for this report is TrackIneligSumm, TrackIneligDet1, and TrackIneligDet2.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.
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Field Description

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

As Of
Date

Select the ending date of the date range for the report. Choose Current date, Previous
month-end date, or specify a Specific date in the field to the right.

Format Select the report format to be generated:

l Summary by Category

l Detail by Category

l Detail by Invoice
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Field Description

Show
both pos-
ted and
pending

Select this option to include pending imports in the report results.

Report Sample

Credit Menu

Credit Reports

The Credit report group contains reports that provide details on credit lines, approvals, decisions, and
overrides.

Credit Approval Report

The Credit Approval Report generates a report that displays credit approval information for a defined
period. This report displays any Invoices that had a Single Order Approval associated with it and were pur-
chased in the date range specified. When a credit request is approved as a Single Order Approval (SOA)
with a specific Source chosen at the time the order was approved, the approval source is displayed in the
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Approval Source column of this report. Approval Sources are created in Credit Approval Source table in
the Tables module.

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Approval
Source

Select the approval source to which to limit the report results from the list. Click Clear to
remove the selection. Approval Sources are defined in the Credit Approval Sources table in
the FactorSoft Table module. Leaving this field blank will include all sources in the results.

Report
Type

Select the report format to be printed:

l Payment

l Aging

l Purchase

As of Select the date range to use for the report from the list:
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Field Description

date l Current date

l Last month end

l Specific date range

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Date
range

Select the date to use for the Payment or Purchase report formats from the list:

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

l Today only

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Report Sample

Report Type: Purchase
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Credit Override Report

The Credit Override Report displays a summary of credit limit overrides by client. The report lists client
invoice number, debtor name, buy number, posted date, invoice amount, credit limit, current balance and
user name that performed the override.

The default report definition for this report is CredOver.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Sequence Client is currently the only Sequence option.
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Report Samples

Expiring Credit Lines Report

The Expiring Credit Lines Report provides a snapshot of credit lines that expire within a specified number of
days.

The default report definition for this report is ExpLines.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Reports User Guide
SQL Reports

496 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm
Client Group Codes Table.htm


Field Description

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Groups are
defined in the Debtor Group Code Table.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.

Sequence Select the sort option that determines the order in which to sort the report.

l Debtor/Client: sequence by client within debtor.

l Client/Debtor: sequence by debtor within client.

l Analyst/Expiration: sequence by expiration date within Analyst code.

Credit
limit
expires
within

Enter the number of days within which a credit limit must expire to be included on the
report.

New
page for
each cli-
ent

Select this option to force a new page for each client break in the report. If this is not selec-
ted, multiple clients can be printed on one page. This option is only available when the
Sequence option Client/Debtor is selected.

Include
zero bal-
ances

Select this option to include clients and debtors with a zero balance that otherwise match
the selection criteria.

Include
already
expired

Select this option to include debtors with expired credit lines that have already expired
when they otherwise match the selection criteria.

Analyst
group

Select the specific Analyst group value to which to limit the report results from the list. This
list is populated from the Client Group Code Table. This field is required if the Ana-
lyst/Expiration option is chosen in Sequence.
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Report Samples

Debtor Menu

Debtor Reports

The Debtor reports group contains reports that detail or summarize a variety of debtor-related items.

Account Status Exception Report

The Account Status Exception Report produces a list of exception transactions by debtor within client.
Each transaction listed includes the No-buy Status Code, transaction date, type, reference code and
amount.

The default report definition for this report is AcctStatExcept.
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Report Parameters

Field Description

Date
from

Select the ending date of the date range for the report. Choose Current date, Previous
month-end date, or specify a Specific date in the field to the right.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
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Field Description

Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Debtor Select the debtor to which to limit the report results.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Group Codes
are defined in the Debtor Group Code Table.

Value Select the specific debtor group value to which to limit the report results from the list.

Report Samples

Country Code Exposure Report

This report lists active debtors, gross, ineligible, and net A/R totals by country, as set for customer/debtors
on the Debtor Information screen.

The default report definition for this report is CountryBal1.
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Report Parameters

Field Description

Debtor Group Select the debtor group to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Codes Table.

Value Select the specific debtor group value to which to limit the report results from
the list.

Report Sample

Debtor Aging Report

The Debtor Aging Report lists receivables by debtor. The format and level of detail can be configured
using the Parameter tab. This report allows you to review all processed batches and open invoices for the
selected client/debtor relationship for a as-of date.

This report details debtor aging with invoices listed by client and debtor on multiple lines.

The default report definition for this report is DebAgeInv.
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Report Parameters

Field Definition

As Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
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Field Definition

True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Insurer Select the insurance carrier to which to limit the report. Insurance carriers are defined in the
Insurers table. Click Clear to remove the selection.

Debtor Enter a character (number or letter) or combination of characters to display the debtor
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Field Definition

names beginning with that character or combination of characters in the list. Select the
debtor to which to limit the report results from the list.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Groups are
defined in the Debtor Group Code Table.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.

Combine
to master
debtor

Select this option to combine member customer/debtor totals to the master cus-
tomer/debtor.

Convert
to native
currency

Select this option to convert amounts from the base currency to the native currency (the
currency of the transaction). The conversion occurs on a client-by-client basis. If the client
has a currency type set and the currency type is different from the default currency, Fact-
orSoft looks up the conversion rate using the As of date in the currency table for the client's
currency. For example, if client ABC Company has a currency type of Canadian Dollars and
the daily conversion rate for Canadian dollars is 1.5, the report increases all of the client's
amounts by a factor of 1.5.

Include
Tracked
AR

Select this option to include tracked AR in the report.

Use non-
standard
columns

Select this option to display non-standard aging buckets if defined.

Show
house
line

Select this option to include the All client credit limit recorded for customer/debtors on the
Debtor Information screen in the report.

This option is only available if Format is set to Excel, at risk by name with a Level of detail
of One line per debtor.

Zip/-
postal
code
from

Enter the beginning ZIP Code or postal code for a postal code range to which to limit the
report. The report limits the results to customer/debtors whose postal code entered in the
Address panel of the Debtor Information screen falls within the range.

Thru Enter the ending ZIP Code or postal code for a postal code range to which to limit the report.

Format Select the format for the report:
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l 5 column, standard: standard aging format through 90+ days past due

l 5 column, standard with P.O./Ref#: standard aging format through 90+ days past
due, with additional column for purchase order/reference number

l 5 column, at risk by name: similar to the standard aging format through 90+ days
past due, with additional columns for dollar amount at Lender and Client Risk for each
debtor or at Client Risk for invoice detail. This report is sorted by Customer/Debtor
name.

l 5 column, at risk by balance: similar to the standard aging format through 90+ days
past due, with additional columns for dollar amount at and Client Risk for each debtor
or at Client Risk for invoice detail. This report is sorted by Customer/Debtor out-
standing balance. The balance sort order is determined by system preference.

Sort Select the sort option that determines the order in which to sort the report.

l Invoice number

l Invoice date

l Due date
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Report Sample

Debtor Aging Report (per Client/Debtor)

The Debtor Aging Report lists receivables by debtor. The format and level of detail can be configured
using the Parameter tab.This report allows you to review all processed batches and open invoices for the
selected client/debtor relationship for a as-of date.

This report summarizes debtor aging with each client reported on one line within debtor.

The default report definition for this report is DebAgeSum.
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Report Parameters

Field Definition

As Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.
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Field Definition

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Insurer Select the insurance carrier to which to limit the report. Insurance carriers are defined in the
Insurers table. Click Clear to remove the selection.
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Field Definition

Debtor Enter a character (number or letter) or combination of characters to display the debtor
names beginning with that character or combination of characters in the list. Select the
debtor to which to limit the report results from the list.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Groups are
defined in the Debtor Group Code Table.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.

Combine
to master
debtor

Select this option to combine member customer/debtor totals to the master cus-
tomer/debtor.

Convert
to native
currency

Select this option to convert amounts from the base currency to the native currency (the
currency of the transaction). The conversion occurs on a client-by-client basis. If the client
has a currency type set and the currency type is different from the default currency, Fact-
orSoft looks up the conversion rate using the As of date in the currency table for the client's
currency. For example, if client ABC Company has a currency type of Canadian Dollars and
the daily conversion rate for Canadian dollars is 1.5, the report increases all of the client's
amounts by a factor of 1.5.

Use non-
standard
columns

Select this option to display non-standard aging buckets if defined.

Show
house
line

Select this option to include the All client credit limit recorded for customer/debtors on the
Debtor Information screen in the report.

This option is only available if Format is set to Excel, at risk by name with a Level of detail
of One line per debtor.

Zip/-
postal
code
from

Enter the beginning ZIP Code or postal code for a postal code range to which to limit the
report. The report limits the results to customer/debtors whose postal code entered in the
Address panel of the Debtor Information screen falls within the range.

Thru Enter the ending ZIP Code or postal code for a postal code range to which to limit the report.

Minimum
balance

Enter the dollar amount for the minimum total balance debtor balance to be included in
the report. Customers with balances lower than this amount are excluded from the report.

Country Select the country to which to limit the report. The report limits the results to cus-

Reports User Guide
SQL Reports

509 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Definition

tomer/debtors whose Country selected in the Address panel of the Debtor Information
screen falls within the range.

Format Select the format for the report:

l 5 column, standard: standard aging format through 90+ days past due

l 6 column standard: same as 5 column, with additional 120+ past due column.

l 7 column standard: same as 6 column, with additional 150+ past due column.

l Insurer: aging report with additional insurance related info - Buyer#, Limit, Effective
Date and Termination Date.

l 5 column, at risk by name: similar to the standard aging format through 90+ days
past due, with additional columns for dollar amount at Lender and Client Risk for each
debtor or at Client Risk for invoice detail. This report is sorted by Customer/Debtor
name.

l 5 column, at risk by balance: similar to the standard aging format through 90+ days
past due, with additional columns for dollar amount at and Client Risk for each debtor
or at Client Risk for invoice detail. This report is sorted by Customer/Debtor out-
standing balance. The balance sort order is determined by system preference.

Report Sample

Debtor Aging Report (per Debtor)

The Debtor Aging Report lists receivables by debtor. The format and level of detail can be configured
using the Parameter tab.This report allows you to review all processed batches and open invoices for the
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selected client/debtor relationship for a as-of date.

This report summarizes debtor aging with the debtor total for all clients reported on one line.

The default report definition for this report is DebAgeTop.

Report Parameters

Field Definition

As Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.
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If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.
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Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Insurer Select the insurance carrier to which to limit the report. Insurance carriers are defined in the
Insurers table. Click Clear to remove the selection.

Debtor Enter a character (number or letter) or combination of characters to display the debtor
names beginning with that character or combination of characters in the list. Select the
debtor to which to limit the report results from the list.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Groups are
defined in the Debtor Group Code Table.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.

Combine
to master
debtor

Select this option to combine member customer/debtor totals to the master cus-
tomer/debtor.

Convert
to native
currency

Select this option to convert amounts from the base currency to the native currency (the
currency of the transaction). The conversion occurs on a client-by-client basis. If the client
has a currency type set and the currency type is different from the default currency, Fact-
orSoft looks up the conversion rate using the As of date in the currency table for the client's
currency. For example, if client ABC Company has a currency type of Canadian Dollars and
the daily conversion rate for Canadian dollars is 1.5, the report increases all of the client's
amounts by a factor of 1.5.

Use non-
standard
columns

Select this option to display non-standard aging buckets if defined.

Show
house
line

Select this option to include the All client credit limit recorded for customer/debtors on the
Debtor Information screen in the report.

This option is only available if Format is set to Excel, at risk by name with a Level of detail
of One line per debtor.

Zip/-
postal
code
from

Enter the beginning ZIP Code or postal code for a postal code range to which to limit the
report. The report limits the results to customer/debtors whose postal code entered in the
Address panel of the Debtor Information screen falls within the range.
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Field Definition

Thru Enter the ending ZIP Code or postal code for a postal code range to which to limit the report.

Minimum
balance

Enter the dollar amount for the minimum total balance debtor balance to be included in
the report. Customers with balances lower than this amount are excluded from the report.

Country Select the country to which to limit the report. The report limits the results to cus-
tomer/debtors whose Country selected in the Address panel of the Debtor Information
screen falls within the range.

Format Select the format for the report:

l 5 column, standard: standard aging format through 90+ days past due

l 6 column standard: same as 5 column, with additional 120+ past due column.

l 7 column standard: same as 6 column, with additional 150+ past due column.

l Insurer: aging report with additional insurance related info - Buyer#, Limit, Effective
Date and Termination Date.

l 5 column, at risk by name: similar to the standard aging format through 90+ days
past due, with additional columns for dollar amount at Lender and Client Risk for each
debtor or at Client Risk for invoice detail. This report is sorted by Customer/Debtor
name.

l 5 column, at risk by balance: similar to the standard aging format through 90+ days
past due, with additional columns for dollar amount at and Client Risk for each debtor
or at Client Risk for invoice detail. This report is sorted by Customer/Debtor out-
standing balance. The balance sort order is determined by system preference.
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Report Sample

Debtor Availability Reports

The Debtor Availability Report provides a look at debtor’s credit information, such as the credit limit, expir-
ation, amount past due, amount available, and whether there is Factor Risk.

The default report definitions for this report are DebAvail1 and DebAvail1a.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set
to True.

Select the magnifying glass icon to open the Search window and begin typ-
ing the client name.

Select Contains or Begins with to refine results. Search window will display up
to 500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report,
or leave blank to include all users. When a user is selected, the report is limited to cli-
ents that have that user selected in the A/E field on the Control panel of the Client
Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the
following System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To
access this table, on the File menu, click Tables. Then, on the Client & Debtor menu,
click Client Group Codes.
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Field Description

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To
access this table, on the File menu, click Tables. Then, on the Client & Debtor menu,
click Client Group Codes.

Debt-
or/Customer

Enter the debtor for which to request the report. Begin typing to display a list of valid
entries.

Leave this field blank to include all debtors in the report results.

Debtor Group Enter the debtor group to which to limit the report results.

Debtor Groups are defined in the Group Code table in the Tables module.

Value Enter the debtor group value for which to limit the report results.

Debtor Groups are defined in the Group Code table in the Tables module.

Format Select the report format to generate:

l Standard format

l At risk format

l SOA Information

Select Select the debtor/relationship category to which to limit the report:

l Every relationship

l Open balances

l Over credit limit

l With client risk

l With exposure

l Flagged as no-buy with balance

Sort by Select the sort option that determines the order in which to sort the report.
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Field Description

l Client/debtor

l Client/available

l Client/balance

l Client/at-risk

l Client/exposure

l Debtor/client

l Debtor/credit limit

l Debtor/balance

Show Select the option for the debtor demographic data to be displayed:

l Name only

l Name, phone

l Name, address

l Name, phone, address

Summarize to
master

Select this option to group debtors according to their master debtor, if applicable.

Hide expiration
date

Select this option to exclude the Credit Expires column from the report.

Convert to nat-
ive currency

Select this option to convert amounts from the base currency to the native currency
(the currency of the transaction). The conversion occurs on a client-by-client basis. If
the client has a currency type set and the currency type is different from the default
currency, FactorSoft looks up the conversion rate using the As of date in the currency
table for the client's currency.

For example, if client ABC Company has a currency type of Canadian Dollars and the
daily conversion rate for Canadian dollars is 1.5, the report increases all of the client's
amounts by a factor of 1.5.

Show debtor
number

Select this option print the debtor number next to the debtor name in the report res-
ults.

Show debtor Select this option to print beneath the debtor name the warning message entered in
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Field Description

warning the Warning field of the Debtor Information upper fields beneath the debtor name in
the report, if applicable.

Show client ref
#

Select this option to include the Client Reference column, which prints the client ref-
erence number for the debtor with each client entry.

Show contacts Select this option to print the contact names entered in the Contacts panel of the
Debtor Information screen.

Report Sample

Standard Format:

At Risk Format:

SOA Information Format:
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Report Details

Column Description

Standard Format

Debtor/Customer Displays the Debtor's Name and Information

Client Ref # Displays the Client's Reference number for the Debtor

Credit Limit Displays the Debtor's credit limit

Credit Expires Displays the date the credit limit expires

Total Balance Displays the Total Balance of the Debtor

Past Due Invoices Displays the Amount of total past due invoices

Available Credit Displays the available credit for the debtor

Client Risk Displays the client risk for the debtor

At Risk Format

Debtor/Customer Displays the Debtor's Name and Information

Client Ref # Displays the Client's Reference number for the Debtor

Credit Limit Displays the Debtor's credit limit

Credit Expires Displays the date the credit limit expires

Total Balance Displays the Total Balance of the Debtor

Past Due Invoices Displays the Amount of total past due invoices

Unshipped Approvals

Unused SOA
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Column Description

Used SOA

Available Credit Displays the available credit for the debtor

Exposure

Client Risk Displays the client risk for the debtor

SOA Information

Debtor/Customer Displays the Debtor's Name and Information

Credit Limit Displays the Debtor's credit limit

Credit Expires Displays the date the credit limit expires

Open Orders

Unused SOA

Unused SOA Expires

Used SOA

Factor Risk Displays the Client's Factor Risk

Security Roles

To generate the Debtor Availability Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Debtor Reports > Print Debtor Availability Reports

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Debtor Availability Report folder.

Preference Description

Do not include neg-
ative balances in
availability

If True, a negative balance will not be used to increase availability.

Do not show expir-
ation date if credit
limit is zero

If True, expiration dates will not show if the debtor credit limit is zero.
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Preference Description

Show client number
on clients

If True, Client Number will show on the report.

Show debtor number
on debtors

If True, Debtor Number will show on the report.

Show exposure
instead of lender risk

If True, a column will display on the report showing exposure (over line) instead
of lender risk.

Show past due
invoices instead of
past due balance

If True, the report will display past due invoice instead of balance.

Show used SOA
amount

If True, the report will show the SOA that has been used to approved the invoice.

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Terminology folder.

Preference Description

Our Client's customer
is a

Used to assign the terminology of the Client's Customer, if blank, the default is
Debtor.

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Data Entry Behavior, At Risk Logic folder.

Preference Description

Approvals are reser-
vations

If True, then Status of the Credit Request is approved or w/i line. If False, then
the Status of the Credit Request is w/i line only.

Debtor Credit Limit Warning Report

The Client/Debtor Credit Limit Warning Report displays debt ratios of debtors for selected clients.

The default report definition for this report is CrLimWarn.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:
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Field Description

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

% of Limit Select a check source to which to limit the report, or leave this blank to include all defined
sources.

Sequence Select a specific batch to which to limit the report, or leave this blank to include all batches.

Report Sample
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Debtor Credit Standing

The Debtor Credit Standing report (accessed from the Debtor menu) summarizes credit rating inform-
ation for debtors. This report displays debtor, lender, credit and calculated ratings and the credit expir-
ation date, number of expirations, average days to pay, and current credit expiration date for each
debtor.

The default report definition for this report is DebCredStand.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.
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Field Description

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Debtor Select the debtor to which to limit the report results.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Group Codes
are defined in the Debtor Group Code Table.

Value Select the specific debtor group value to which to limit the report results from the list.
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Report Sample

Debtor Information Report

There are two possible report formats for this report.

l If System Preference Reports, Debtor Information Reports, Debtor Information Reports option is set to
DebInfoRept (this is the default value for this preference), the Debtor Information Report lists each
debtor for the selected criteria with the following debtor information: Debtor Code and Name,
Created date, Payment due date, Statement date, Outstanding balance, Payment amount, Days
past due, NAICS code, and Debtor Group

l If System Preference Reports, Debtor Information Reports, Debtor Information Reports option is set to
DebInfo, the Debtor Information report lists each debtor for the selected criteria with the clients with
whom the debtor has relationships in FactorSoft and specific debtor information, including the
Debtor City and State, debtor all-client credit limit, SIC and NAICS codes, overall debtor balance and
the balance for each client. A sample of the report is illustrated below.
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Report Parameters

Field Description

As Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
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Field Description

on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Debtor Enter the customer/debtor to which to limit the report.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Group Codes
are defined in the Debtor Group Code Table.

Value Select the specific debtor group value to which to limit the report results from the list.

Report Samples

DebInfoRept
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DebInfo

Debtor Insurance Report

The Debtor Insurance Report provides list of debtors that have insurance coverage, added on the Cred-
it/No Buy tab of the Debtor Aging screen. The report lists insurance by debtor, and includes the house line,
buyer number, terms, coverage amount, expiration date, credit line and balance.

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com

The default report definition for this report is DebInsure3N.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
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Field Description

the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Insurance Company Select the insurance provider to which to limit the report results. Insurance pro-
viders are defined in the Insurers Table.

Debtor Group Select the debtor group to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.

Value Select the specific debtor group value to which to limit the report results from
the list. Debtor Groups are defined in the Debtor Group Code Table.

Show clients Select the option to indicate which clients to show, if any. This option adds an
additional column to the report that lists the clients with which the debtor has
balances or relationships.

l Do not show clients

l Show clients with balances

l Show active clients

l Show all clients

Selection Select the option that determines the items to be displayed:

l List unterminated items only

l List terminated items only

l List unterminated and terminated per the after date

Show terminations
after

Enter the insurance termination date before which debtors are excluded from
the report. Only debtors with insurance with an expiration date greater than or
equal to the entered date are included.

Show 12-Month High
Balance

Set this option to Yes to display the 12 month high balance on the report. Set this
option to No to exclude the 12 month high balance.
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Report Sample

Security Roles

To generate the Debtor Insurance Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Debtor Reports > Print Debtor Insurance Report

Debtor Invoice Audit Report

The Debtor Invoice Audit report provides a flexible way to report on debtors by activity and balance. Addi-
tionally, this report allows you to specify a selection percentage—meaning that you can select a random
sample of debtors on which to report. Random sampling is a quick and accurate way to see the overall
trends within the entire group of debtors.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
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Field Description

scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client Select the client group to which to limit the results in the report.
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Field Description

Group Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Minimum
Balance

Enter the minimum balance for debtors to be included in the report.

NOTE: This field is optional and can be left blank indicating that any and all invoices with a
balance greater than $0 should be included in the report.

Selection
%

Enter the percentage of debtors and their invoices to report as a random sample.

NOTE: This field is required to generate any data. If left blank, no data will be included in the
report.

Minimum
days
since last
selection

Enter number indicating the days past the Last Audit Date to include invoices from that Cli-
ent/Debtor Relationship in the report.

NOTE: Audit Date is stored in the database on the Aging Table. It is not displayed anywhere
in desktop where an user can see.

Do not
post last
audit
date

If Checked and the report is generated, the system will not update the Audit Date on the
Aging Record and the report will not populate the Last Audit Date.

If Unchecked and the report is generated, the system will update the Audit Date on the
Aging record and the report will reflect the Last Audit Date.
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Report Sample

Debtor List Report

The Debtor List Report contains several core reports and numerous options for refining each report to your
specific needs.

The default report definitions for this report are:

l No buy list = NoBuyList

l Debtor list = DebList1

l Credit limit audit report = DebLimAudit1
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Report Parameters

Field Description

Date Selec-
tion

Select the option that determines the data returned for the date range:

l None

l First use in range

l Purchase in range

l Customer created in range

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Use last business day instead of yesterday in date range to True. The Yesterday option in
the Date Range field is replaced with Last Business Day, and reports printed on Monday
will print Friday’s data (assuming Friday was the last business day) instead of Sunday’s.
Set System Preference Identification/system constants > CLMS|Reporting Services >
Requests > Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Reporting Services
reports when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office
to which they are restricted will be selected in the Office field by default and the user will
not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Groups are
defined in the Debtor Group Code Table.

Value Select the specific debtor group value to which to limit the report results from the list.
Debtor Groups are defined in the Debtor Group Code Table.

Debtor
Inform-
ation

Select the option for the Debtor Information to include on the report:
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Field Description

l Name Only

l Name, Phone

l Name, Address

l Name, Phone, Address

Debtor
Number

Select this option to include the debtor number in the Debtor List results

Debtor
Warning

Select this option to include the debtor warning text (entered in the upper fields of the
Debtor Information screen) in the Debtor List results.

Client
Reference

Select this option to include the Client Reference Number on the Debtor List with Clients or
Client/Debtor Report. This option is only available when Debtor list with client or Cli-
ent/Debtor Report is selected from the Report Type list.

Balance Select the balance type to include in the report. All debtors meeting the other criteria spe-
cified for the report and falling into this Balance category are included on the report.

l All

l Open Balance

l Zero Balance

l Credit Balance

l Debit Balance

No-buy Select the No-Buy category for debtors to be included in the report.

l All

l No no-buy reason

l Any no-buy reason

l Specific no-buy reason

If Specific no-buy reason is selected, select the no-buy reason to limit selection to from
the Specific no buy list.

NOA Select the NOA statuses to which to limit the selection of debtors for reporting.
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Field Description

l All

l Not sent/waived

l Not received/waived

l Waived

Sort Select the sort option that determines the order in which to sort the report.

l Debtor by name

l Debtor by number

l Debtor by balance

l Debtor by name/Client

l Debtor by number/Client

Report
Type

Select the report format to be printed:

l No-buy list: lists of selected debtors including no-buy description

l Debtor list: lists of selected debtors

l Debtor list with clients: list of selected debtors with client names

l Client/Debtor report: summary of debtors by client

l 3-up labels: Generates mailing labels in a 3-up format

l Mail merge export: creates an export file debtor list

l Credit limit audit report: lists debtors with limits and current balance

l Foreign Debtor Report: lists debtors with country

No Tax ID Select this option to include debtors with no Federal Tax ID number recorded in the Debtor
Information Identity panel in the report results.

Over credit
limit

Select this option to include debtors who are over their credit limit in the report results.

Minimum
total credit
limit

Enter the minimum credit limit for debtors to be included in the report results.
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Field Description

Days since
last pur-
chase
(Blank for
all)

Enter the minimum number of days since last purchase for debtors to be included in the
report results.

Balance is
restricted
to client
selection

Select this option to show the debtor balance for the selected client only in the report res-
ults. If not selected, the Current Balance listed on the report is the debtor's all-client bal-
ance, regardless of client selected.

Exclude
flagged do
no mail

Select this option to exclude debtors with return address reasons set defined as Do not
mail from the report.

Specific no
buy

Select the no buy reason to which to limit report selection. This option is only valid if the
Specific no-buy reason option is selected in the No-buy option of the Selections group.

System Preferences

l Admin Module > System > System Preferences > Reports > Debtor List > Include Tracked A/R

l Set to True to have Tracked A/R included in the report.

l Set to False to exclude Tracked A/R from the report.

Report Sample
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Debtor Master List

The Debtor Master List report screen is used to create a report that lists master debtors and the member
debtors assigned to each master.

The default report definition for this report is DebMastList1.

Report Parameters

Field Description

Debtor Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature.
To access this table, on the File menu, click Tables. Then, on the Client & Debtor
menu, click Client Group Codes.

Value Select the specific client group value to which to limit the report results from the
list. Client Groups are defined in the Group Code Table.
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Report Sample

Return Mail Report

The Return Mail Report is accessed in Customer/Debtor Menu of the Reports module. This option returns
the Return Mail Report screen that is used to select the parameters for the report.

The default report definition for this report is RetMail1.

Report Parameters

Field Description

Selection Select the option that determines the returned address records to be included
in the report.
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Field Description

l All reasons: All debtors with a return address reason set.

l OK to mail: All debtors with a return address set where the return address
reason is defined Ok to mail

l Do not mail: All debtors with a return address set where the return
address reason is defined Do not mail.

l Specific reason: Only the specific return address reason selected from the
Reason field is included.

Reason Select the specific return address reason to be included in the report. This
option is only available if the Selection field is set to Specific reason.

With balances only Select this option to exclude debtors with zero balances from the report.

Report Sample

Dispute/Ineligibility Menu

Dispute/Ineligibility Reports

The Dispute/Ineligibility reports group contains reports that detail disputes, dilution, and eligibility.

Denied Invoices Report

The Denied Invoices Report generates a list of denied invoices by debtor within client.

The default report definition for this report is DeniedInv.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
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Field Description

day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the report results from the list. Client Groups are
defined in the Client Group Code Table.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table.
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Report Sample

Dilution Report

The Dilution Report provides a dilution summary for selected clients over a specified date range, and
according to a dispute code assigned during data entry or on the invoice information window. The results
include invoices closed per period (total, eligible, and ineligible), payments made against invoices (total,
eligible, and ineligible), and dilution based on all/eligible invoices.

The default report definition for this report is Dilution1.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

Reports User Guide
SQL Reports

547 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the report results from the list. Client Groups are
defined in the Client Group Code Table.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table.

Different
Dispute
Code

Select the Dispute code on which to report.

Exclude
non-fun-
ded
invoices

Select this option to exclude non-funded invoices from the calculation of dilution per-
centage.
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Report Sample

Dispute Report

The Dispute report lists dispute codes posted against invoices on the Purchase window, as well as dispute
codes posted against payments and adjustments on the Post Payment window or the Adjustment screen.

The default report definition for this report is DisputeInv1.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Report Select the report type to generate:
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Field Description

l All invoices placed in dispute: to generate a report of all dispute codes that were pos-
ted against all purchased invoices on the Purchase screen.

l Open invoices placed in dispute: to generate a report of all dispute codes that were
posted against open invoices only on the Purchase screen.

l Codes posted against payments/adjustments: generates a report of all dispute
codes that were posted against payments and adjustments on the Post Payment
screen or Adjustment screen.

Include
Summary

Select this check box to include the total number of dispute postings under each client list-
ing when generating the report.

Report Sample

Report Details

Column Description

Client Displays the name of the Client associated to the Disputed Invoice.

Debtor/Customer Displays the name of the Debtor/Customer associated to the Disputed Invoice.

Invoice # Displays the Invoice Number of the Disputed Invoice.

PO # Displays the Purchase Order number associated to the Disputed Invoice.

Purchase Date Displays the Purchase Date of the Invoice.

Invoice Date Displays the Date of the Invoice.

Due Date Displays the Due Date of the Invoice as calculated by: Invoice Date + Days Due
= Due Date
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Column Description

Current Balance Displays the current balance of the Disputed Invoice.

Dispute Date Displays the Date the Invoice was Disputed.

Date Canceled Displays the Date the Dispute was canceled.

Dispute Reason Displays the Dispute Reason Code selected at dispute.

Notes Highlighted green, this row displays notes associated to the Disputed Invoice.

Security Roles

To generate the Dispute Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Dispute/Ineligibility Reports > Print Dispute Reports

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Fields/Screen Behavior, Miscellaneous folder.

Preference Description

Use dispute code
instead of explan-
ation

l If FALSE and Invoice Information > In Dispute is Checked, then the
Invoice is “In Dispute” and should appear on the Report.

l If TRUE and the Invoice Information > Explanation is populated with a
Dispute Code with “ In Dispute” Checked in Tables > Data Entry > Dis-
pute/Ineligibility/No Buy Code Table, then Invoice is “In Dispute” and
should appear on the Report.

Extended Eligibility Report

The Extended Eligibility Report lists unpaid invoices with extended eligibility. The setting to extend eligibility
based on Will Pay entries is set up in on the Collections panel of the Client Information screen.

There are two formats for the report: 1) show the items extended today, regardless of the date to which
they were extended, 2) show the items which will have their extension expire within a time frame, regard-
less of when the will pay entry was entered.

The default report definition for this report is ExtendInel1.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
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Field Description

Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.
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Field Description

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Report Select the report type to generate:

l Invoices extended in date range

l Unpaid invoices extend into the date range

Excess/Dispute Report

The Excess/Dispute Report lists all invoices that have been disputed and are not covered by the insurance
policy.

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com

This report is accessed from the Dispute/Ineligibility menu of the Reports module, provided the user has
security rights enabled.

The default report definition for this report is DisputeInvIns1.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
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Field Description

print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.

Insurance
Policy

Select the insurance policy to which to limit the report results from the list.

Report Select the report type to request.

l All Invoices Placed in Dispute.: This report displays all invoices that include a dispute
code.

l Open Invoices Placed in Dispute.: This report displays all invoices that include a dis-
pute code and the invoice balance is not zero.
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Report Sample

The date in the Re-Purchase Date field on this report corresponds to the date entered
in the Repurchase field for data purposes only on the Invoice Information screen.

Unauthorized Purchase Report

The Unauthorized Purchase Report produces a list of invoices by debtor within client that were purchased
above the debtor's sales limit without sales authorization.

The default report definition for this report is UnAuthPurch.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table.

Report Sample
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Facility Menu

Facility Reports

The Facility report group contains reports that provide details on facilities in bulk collateral lending envir-
onments.

ABL Payment Import Report

The ABL Payment Import report summarizes successful imports and lists each unsuccessful payment
import record uploaded from the ABL Lockbox Payment Importer. The report is accessed from the Facility
menu in the Reports module.

The default report definition for this report is ABLPayImport.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As Of Date Select the ending date of the date range for the report.
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Field Description

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked
in the ClientWeb Report Queue, a screen appears to choose the date range
(Current Date, Previous Month-End Date, or Specific Date).

Report Sample

Report Details

Column Description

Date Displays the date and time stamp the upload launched.

Location Displays the location of the folder where import files are placed.

File Name Displays the file name of the import.
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Column Description

Status Displays the status of the transaction that was imported:

l Processed - successfully completed

l Process w/ Exceptions - successfully completed with exceptions, see res-
ults

l Failed - unsuccessful, no transaction records created

Results Displays details based on the Status.

Security Roles

To generate the ABL Payment Import Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print ABL Payment Importer Report

Account Table Report

This report generates the Chart of Accounts Report, which lists the accounts configured in the FactorSoft
Accounts Table.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Sample

Report Details

Column Description

Account # Displays the assigned General Ledger account number

Description Displays the name of the General Ledger Account

Notes Displays an additional description given to the account type

Security Roles

To generate the Account Table Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Account Table

Daily Transaction Journals Report

The Daily Transaction Journals report is used to assist in your end-of-day processes, helping you close
out your daily transactions and balance your portfolio to FactorSoft. This report is accessed from the Facil-
ity menu of the Reports module.

The Daily Transaction Journals report has several formats that provide detail different daily Loan Trans-
action activities. See the Format field for descriptions.

NOTE
The disclaimer “Post dated transactions are not included” appears at the top of these reports to indic-
ate that only transactions from the As Of date to the current FactorSoft processing date are included
on the report

The default report definitions for this report are:
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l Transaction Summary – DailyTransSummary

l Adjustment Journal – DailyTransAdj

l Advance Journal – DailyTransAdv

l Payment Journal – DailyTransCash

l Cash Receipt Journal – DailyTransCash

l Unclaimed Cash Deposit – DailyTransCash

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As Of Date Select the ending date of the date range for the report.
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Field Description

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is
clicked in the ClientWeb Report Queue, a screen appears to choose the
date range (Current Date, Previous Month-End Date, or Specific Date).

Client Select the client for which you want to generate the report. Leave client
blank to generate a portfolio level report for the date requested.

Note that inactive clients are filtered out of this report.

A/E Select the Account Executive (FactorSoft user) to which to limit the res-
ults in the report, or leave blank to include all users. When a user is selec-
ted, the report is limited to clients that have that user selected in the A/E
field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an
A/E, use the following System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an
Office restriction defined on the Manage Users screen in the Admin mod-
ule, the user will only be able to generate the report within that office
restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user
will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor
menu, click Office.

Client Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables
feature. To access this table, on the File menu, click Tables. Then, on the
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Field Description

Client & Debtor menu, click Client Group Codes.

Value Select the specific client group value to which to limit the results in the
report.

Client Groups are defined in the Client Group Code table in the Tables
feature. To access this table, on the File menu, click Tables. Then, on the
Client & Debtor menu, click Client Group Codes.

Facility Select the facility for the selected client to include in the report or leave
blank to include all facilities. This field only becomes active if you select
a client from the Client list above.

Format Select the report format to be generated:

l Transaction Summary – Rolls forward each facility loan balance
from the beginning of the day, adding all transactions posted
against that loan, summed by transaction type, and arriving at
the end of day loan balance

l Adjustment Journal – Displays each facility loan adjusting type
transaction which includes the following: Addl Fees, Accrual Post-
ing, Fee Distribution, Adjustments, Transfers and Expenses,
summed by transaction type.

l Advance Journal – Displays each facility total loan advances
made in the day

l Payment Journal – Displays each facility total loan payments
applied in the day

l Cash Receipt Journal – Displays each facility total cash received
in the day

l Unclaimed Cash Journal – Displays each facility cash receipts
posted to unclaimed cash in the day

Exclude Participations Select this check box to exclude lending partners' participation trans-
action types from the report. This option only applies if you are using the
Participation add-on.
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Report Sample

Security Roles

To generate the Daily Transactions Journal Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Daily Transaction Journal Reports

Facility Analysis Report

The Facility Analysis Report summarizes monthly facility activity during a selected date range. The ana-
lysis rolls forward each facility loan balance from the beginning of a month, adding all transactions pos-
ted against that loan, summed by transaction type, and arriving at the end of the month loan balance.
This report is accessed from the Facility menu of the Reports module.

The default report definitions for this report are FacilityAnalysis and FacilityAnalysis2.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.
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Field Description

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.
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Field Description

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Format Select the report format to be generated:

l Monthly detail by facility - for a selected facility the analysis reports on monthly activity,
summed to transaction type, for each month end included in the report call date range.

l Monthly summary by client - generates a portfolio level analysis for a selected month’s
transaction activity listed by facility.

Month Select the month to be reported for the Monthly summary by client format.

Year Enter the year to be reported for the Monthly summary by client format

Report Sample
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Report Details

Column/Label Description

Loan Turn End of Month Loan Balance / Total Collections * Actual Number of
Days in the Month.

Note: Results in number of days the loan turns (not a percentage).

Yield Total Fees + Total Facility Posting Amount / End of Month Loan Bal-
ance *360 / Actual Number of Days in the Month.

Note: Result is the annualized percentage return on investment.

Security Roles

To generate the Facility Analysis Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Facility Analysis Report

Facility Ledger Report

The Facility Ledger Report is an accounting ledger which provides a listing of all transactions posted to the
selected facility during a specified date range. This report is accessed from the Facility menu of the
Reports module.

The default report definition for this report is FacilityLedger.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
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Field Description

the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the adjacent fields.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
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Field Description

have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.
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Report Sample

Security Roles

To generate the Facility Ledger Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Facility Ledger Report

Facility List Report

The Facility List Report prints a list of all the facilities associated with a client. This report is accessed from
the Facility menu of the Reports module.

The default report definition for this report is FacilityList.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
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Field Description

have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Show
Facility
Address

Select this option to include the facility address in the Facility Description column of the
report.

Show
Facility
Phone
Number

Select this option to include the facility primary phone number in the Facility Description
column of the report.

Show
Facility
Fax

Select this option to include the facility FAX phone number in the Facility Description column
of the report.
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Field Description

Show
Facility
Email

Select this option to include the facility email address in the Facility Description column of the
report.

Sample Report

Report Details

Column Description

Client Displays the Client to which the Facility is associated

Facility Description Displays the Facility name and contact information based on parameters set.

Loan Limit Displays the maximum exposure for this loan agreement

Status The status of the facility: Active/Inactive

Type Custom field for category defined in Facility Information

Credit Rating Displays the Credit Rating of the Facility

A/E Displays the account executive to which the client account is assigned.

G/L Group Displays the default general ledger Account Group for the facility.

Currency Displays the currency type to use to conduct transactions and produce reports
for the facility.
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Facility Loan Status Report

The Facility Loan Status report lists two sets of historic activity. First, Bulk AR collateral and or Factoring
Batch transaction, second is the Loan Balance and Funds Employed Balance activity. The report is based
on facilities activity within a specified date range. The Facility Loan Status includes both factoring detail as
a “collateral” and non-detail Bulk AR collateral concurrently for databases that have both types. This
report is accessed from the Facility menu of the Reports module.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

Note that inactive clients are filtered out of this report.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

GL
Group

Select the GL Group to which to limit the results in the report.

Sum To drop-down to select statement format:
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Field Description

l Date: activity by each day in the period

l Activity: activity by individual batch

l Portfolio: accumulated activity calculated by adding all postings and transactions

Check
Box

Include Facility Position: as secondary report attachment.

Report Sample

Date Format

Activity Format
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Portfolio Format

Report Details

Column Description/Calculation

Date and Activity Format

Date Displays the posting date.

Type Displays the Collateral Post or Transactions Type abbre-
viated descriptor.

Ref# Displays the transaction identification.
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Column Description/Calculation

Accounts Receivable Postings

Net Sale Displays reported Net Sales less Credit amounts for the
period.

Net Collections Net collections included on Collateral posting.

Discounts Displays reported Payment Discount amount for the period.

Other Displays posting against invoices for the period.

Adjustments Displays Adjustments to collaterals and Invoices for the
period.

Loan Transactions

Funding Displays the distributions made to the borrower for the
period.

Cash Receipts Displays the payments received against the loan amount for
the period.

Charges & Fees Displays the Fees & Changes added to the Loan Balance for
the period.

Expenses Displays the Expenses added to the Loan Balance for the
period.

Adjustments Displays Adjustments made to the Loan Balance for the
period.

Balances

Accounts Receivable Displays the balance of Collateral Bulk AR plus Open
Factored Invoices.

Funding Displays the balances of Loan Amount plus Factored Funds
Employed.

Portfolio Format

Loan Limit Limit set at the facility level.

Accounts Receivable Postings

Net Sales Displays reported net sales less credit amounts for the
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Column Description/Calculation

period.

Collections Displays reported net collections less over payment amount
for the period.

Adjustments Displays the sum of Discounts, Other and Adjustments to col-
laterals and Invoices for the period.

Ineligibles Displays the ending Ineligible amount for the period.

Loan Transactions

Advances Displays the funding distributions made to the borrower for
the period.

Collections Displays the cash receipt payments received against the
loan amount for the period.

Other Displays the sum of Fees & Changes Expenses and Adjust-
ments added to the Loan Balance for the period.

Balances

Accounts Receivable Displays the balance of Collateral Bulk AR plus Open
Factored Invoices.

Loan Balance Displays the balances of Loan Amount plus Factored Funds
Employed.

Accrued Revenue Displays the Current Period to Date accruing revenue.

Security Roles

To generate the Cash Posting Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Facility Loan Status Report

Facility Position Report

The Facility Position report provides an overview of each client’s facility information, broken down by cli-
ent, facility, and collateral.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
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Field Description

Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

Note that inactive clients are filtered out of this report.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
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Field Description

Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Format drop-down to select the specific report format: Client Detail or Client Summary

Security Role

Security Roles for this report are located at Security > Manage Roles > Reports > Facility > Print Facility
Position Report (Yes/No).

Report Details

Column Description/Calculation

General Report Details

Facility (name)/ Collateral (name) Displays the Facility or Collateral name

Currency Displays the default currency type for the facility. Currency
types are created in the Currency Denominations Table in
the Table module and assigned on the New Facility screen
when the facility is created.

Type Displays the Collateral type as defined on the Collateral
Information screen

Limits (omit cents) Displays the client's overall credit limit as defined on the
Credit/no buy panel of the Client Information screen.

Advance Rate (%) Displays the Collateral Advance Rate % as defined on the Col-
lateral Information screen in the Availability Rate (% ) field

Gross Collateral Displays the sum total of the current collateral values used
to support the loan balance.

The sum of Gross Collateral for all facilities is the figure dis-
played in the optional Gross Collateral column at the Client
level.

Total Ineligibles Displays the Total Ineligibles for each Collateral as shown on
the Collateral Information screen under Collateral Summary.

Eligible Collateral Displays the current Eligible Collateral amounts used to sup-
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Column Description/Calculation

port the loan balance. (Current Collateral value - Ineligible
values)

Net Collateral Displays the calculated Net Collateral amount used to sup-
port the loan balance. (Eligible Collateral value * Advance
Rate)

Availability Displays the calculated Available Collateral amount used to
support the loan balance. (Lower of Available Limit and Net
Collateral Amount)

Balance Displays the Facility Balance as shown on the Facility Sum-
mary screen under Facility Summary.

Excess/Deficit Sum of facility amounts available to be disbursed.

Client Detail Format - Current days activity in Blue

Activity Section (left) - Loan transaction ledger for current days activity

Activity Date

Description Displays the appropriate Description for the type of trans-
action posted.

For example, a Loan Payment transaction will show the Source
value and an Accrual Posting transaction will show Accrual Posting.

Transaction Type Displays the Transaction Type such as Accrual Posting, State-
ment and Disbursement.

Begin Balance Balance at the beginning of current day.

Amount Activity Amount.

End Balance Balance at the end of current day.

Extra Summary Section (right) - Current Balances of:

Fee Balance Unposted/paid accrued fees.

Fee Reserve Calculated facility reserve based on MTD accrued fees.

Other Reserves Facility Reserves

LOCRsv Letter of Credit Reserve
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Column Description/Calculation

Payment RSV Balance of Reserved established from Cash Posting.

U/C Balance Balance of unapplied unclaimed cash.

Activity Section (middle left) - Collateral updates posted in the current day. (Same columns for Bulk AR
Collateral and Bulk Inventory Collateral)

Activity Date

Begin Balance Balance at the beginning of current day.

Sales Sales included on Collateral posting

Credits Credits included on Collateral posting

Adjustments (minus) Adjustments (minus) included on Collateral posting

Adjustments (plus) Adjustments (plus) included on Collateral posting

Discounts Discounts included on Collateral posting

Collections Net collections included on Collateral posting

Over Payments Over Payments included on Collateral posting

End Balance Balance at the end of current day

Supplemental Collaterals

Activity Date

Begin Value Balance at the beginning of current day

Change Displays Collateral value change entered by the User

End Value Balance at the end of current day
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Report Sample

Reports User Guide
SQL Reports

593 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Facility Position Summary Report

The Facility Position Summary report provides an overview of each client’s facility position summarized to
“Excess/Deficit” availability portfolio wide.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.

Reports User Guide
SQL Reports

594 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

Note that inactive clients are filtered out of this report.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
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Field Description

table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Report Sample

Report Details

Column Description/Calculation

Gross Col-
lateral

Displays the sum total of the current collateral values used to support the loan bal-
ance

Currency Displays the Currency type assigned to the facility

Availability Displays the calculated Available Collateral amount used to support the loan bal-
ance. (Lower of Available Limit and Net Collateral Amount)

Balance Displays the Facility Balance as shown on the Facility Summary screen under Facility
Summary

Excess/Deficit Sum of facility amounts available to be disbursed

Security Roles

To generate the Facility Position Summary Report, the following Security Role needs to be set to YES:
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l Security Roles > Reports > Facility > Print facility position summary report

Facility Trial Balance Report

The Facility Trial Balance Report is an accounting of the daily transactions. This report can display results
in a variety of formats. This report is accessed from the Facility menu of the Reports module.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests
> Use last business day instead of yesterday in date range to True. The Yesterday option
in the Date Range field is replaced with Last Business Day, and reports printed on
Monday will print Friday’s data (assuming Friday was the last business day) instead of
Sunday’s. Set System Preference Identification/system constants > CLMS|Reporting Ser-
vices > Requests > Saturday is a business day to True to consider Saturday a business
day when the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date range is set
to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include
all facilities. This field only becomes active if you select a client from the Client list above.

Par-
ticipation

Select a participant entity to which to limit the report. This list is only populated if you are
using the Participation module.

Member Select a member of the participant entity to which to limit the report. This list is only pop-
ulated if you are using the Participation module.
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Field Description

Account # Select the G/L Account to which to limit the report.

Format Select the report format to be generated:

l Detail as Account/Check #/Date

l Detail as Account/Date/Check #

l Summarize to Account

l Summarize to Account/Client

l Summarize to Account/Date/Source

l Summarize to Date/Account/Source

G/L Group Select a G/L Group to which to limit the report, or leave this field blank to include all G/L
Groups.

Convert to
native cur-
rency

Select this option to convert amounts from the base currency to the native currency (the
currency of the transaction). The conversion occurs on a client-by-client basis. If the cli-
ent has a currency type set and the currency type is different from the default currency,
FactorSoft looks up the conversion rate using the As of date in the currency table for the
client's currency.

For example, if client ABC Company has a currency type of Canadian Dollars and the
daily conversion rate for Canadian dollars is 1.5, the report increases all of the client's
amounts by a factor of 1.5.

Include
Facility

Select this option to include the Facility.

Exclude
Trans-
actions with
Pending
Checks

Select this option to filter out transactions that do not have a check number assigned.

Report Sample

Detail Format
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Summary Format
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Security Roles

To generate the Facility Trial Balance Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print facility trial balance report

Monthly Client Trend Report

The Monthly Client Trend report is an analysis of the most recent 24 months of Client activity. The report
compares period to period data over four critical areas which includes:

l Financial information: Client Information > Financials: Summarized balance sheet and income
statement information is entered, saved and accumulated for the client and evaluated in the
report.

l Collateral activity > Collateral Information: Collateral data captured in posting history is trended.

l Loan activity: Facility Information: Loan transactions and loan balance history is used to trend loan
activity.

l Receivables (AR) and Payables (AP): Facility Information > Accounts Payable/Receivable: Addi-
tional input of Receivable and payable monthly summary account balances are used to establish
trends. This information is entered in the Facility > Accounts Payable\Receivable panel.

This report is available on by clicking Monthly Client Trend on the Facility menu in the Reports module.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
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Field Description

scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
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Field Description

table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Report Sample

Report Calculations

The data in this report is calculated in the thousands. This report also calculates the following ratios:
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l A/R Turn - Beginning Collateral Balance / Gross Cash * 30 days

l Inv Turn - Beginning Collateral Balance / Inventory Removal * 30 days

l Loan Turn - Beginning Loan Balance / Net Cash * Number of Days in the Month

l % Dil – Dilution: EOM total credits+ EOM total discounts * 100 / EOM total sales

l % Yld - Yield: [(EOM total interest + Float + Fees + Deferred Fees / Yield days) * 365 * 100] / Average
Loan Balance

Report Details

Column Description

Date Month/Year starting at the 24th month working down to the current period.

C/A Current Asset - last record created in the period for each date listed

C/L Current Liability - last record created in the period for each date listed

W/C Working Capital - last record created in the period for each date listed

T/D Total Liability - last record created in the period for each date listed

N/W Net Worth - last record created in the period for each date listed

Mos Number of months - last record created in the period for each date listed

REV Net Sales - last record created in the period for each date listed

G/P Gross Profit - last record created in the period for each date listed

B/T Before Tax - last record created in the period for each date listed

Sales Posted Sales - Sum of all sales reported on Certificate Postings for each period lis-
ted in the date column

Cred&Adj Posted Credits and Adjustments - S um of all Credits and Adjustments reported on
Certificate Postings for each period listed in the date column.

Grs Cash Posted Collections - Sum of all Cash Collections reported on Certificate Postings for
each period listed in the date column.

A/R Bulk AR Collateral Balance - last record created in the period for each date listed

AR Inel Bulk AR Ineligible Balance - last record created in the period for each date listed

AR Elig Bulk AR Eligible Collateral Balance - last record created in the period for each date
listed
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Column Description

Inv Bal Bulk Inventory Collateral Balance - last record created in the period for each date
listed

Inv Inel Bulk Inventory Ineligible Balance - last record created in the period for each date lis-
ted

Inv Elig Bulk Inventory Eligible Collateral Balance - last record created in the period for each
date listed

Total Elig Total Eligible - Sum of each of the collateral lines last record created in the period
for each date listed

Adv Facility Transaction Disbursements - Sum of all Facility Disbursement transaction
amounts reported for each period listed in the date column

Net Cash Facility Transaction Type26 > Payments - Sum of all Facility Payment transaction
amounts reported for each period listed in the date column

Loan Bal Loan Balance - last record created in the period for each date listed

A/R Turn Calculated Account Receivable Turn - as calculated for each period listed

Inv Turn Calculated Inventory Turn - as calculated for each period listed

Loan Turn Calculated Loan Turn - as calculated for each period listed

% Dil Calculated Dilution - as calculated for each period listed

Incm Total Income - Sum of all Facility Statement transaction amounts reported for each
period listed in the date column

% Yld Calculated Yield - as calculated for each period listed

0-30 Receivable age bucket 0-30 days - last record created in the period for each date
listed

30-60 Receivable age bucket 31-60 days - last record created in the period for each date
listed

60-90 Receivable age bucket 61-90 days - last record created in the period for each date
listed

Over 90 Receivable age bucket 91+ days - last record created in the period for each date lis-
ted

0-30 Payables age bucket 0-30 days - last record created in the period for each date lis-
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Column Description

ted

30-60 Payables age bucket 31-60 days - last record created in the period for each date lis-
ted

60-90 Payables age bucket 61-90 days - last record created in the period for each date lis-
ted

Over 90 Payables age bucket 91+ days - last record created in the period for each date lis-
ted

System Preferences

To use this report, a System Preference must be set to define how many months of data to update in the
tables each night.

l Identification/system constants > CLMS Engine > Overnight tasks to designate the number of
months to recalculate

NOTE
The report compiles a large amount of information. The nightly engine tasks updates these
tables each date roll. Processing this task could take several hours or more to complete. It is
recommended that the setting be for 1-3 periods. It is generally unnecessary to calculate 24
prior periods every night.

Security Roles

To generate the Monthly Client Trend Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Monthly Client Trend report

Monthly Position Trend Report

The Monthly Position Trend Report analyzes month end collateral availability trends over time. A facility-
level summary format and a collateral level detail format are included. Each displays the facility or col-
lateral line information and balance at each month-end for the 12 month period preceding the
month/year specified on the Monthly Position Trend Report request screen.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Last com-
pleted
month

Select the month of the last completed submission to be used as the as-of date month for
the report.

Year Enter the year of the last completed submission to be used as the as-of date year for the
report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Format Select the report format to be generated:
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Field Description

l Client Summary : Portfolio-level report that list each facility “Excess/Deficit” value for
each period listed.

l Facility Detail : Loan level report that details the EOM position of each collateral avail-
ability and sums to the EOM Facility totals and EOM Excess Availability.

Report Samples

Client Summary Format

Facility Detail Format
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Security Roles

To generate the Monthly Position Trend Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print monthly position trend report

Over Advance Report

The facility-level Over Advance Report lists facilities that have a negative facility excess/deficit balance.
Information for each facility returned in the report includes: the Facility Limit, Loan Balance, Available Col-
lateral, Over Advance amount, Days Over, and Low Amount and High Amount over advance.

The default report definition for this report is OverAdvance.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
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Field Description

leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office
to which they are restricted will be selected in the Office field by default and the user will
not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Include
Current
Day in Cal-
culation

Select this option to include the current day in the calculation of number of days ending in
an over advance position.

Reports User Guide
SQL Reports

613 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm
Client Group Codes Table.htm


Report Sample

Security Roles

To generate the Over Advance Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Over Advance report

Posted Loan Statement Report

The Posted Loan Statement report allows the user to print or reprint previously posted loan statements - it
does not apply charges and update the account balance. When the user selects a Client and Facility, the
Statement dates for reprint displays the previously run statements available for reprint by the statement
date ranges so that the user can select the statement to be reprinted.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office
to which they are restricted will be selected in the Office field by default and the user will
not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Statement
dates

Select a previously-posted statement to reprint.

Show float
balance

Select this option to include the Float Balance column on the report.
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Field Description

Show daily
interest
amount

Select the option to include the Est. Interest column on the report.

Show com-
pound bal-
ance

Select the option to include the Compound Balance column on the report.

Allow user
to override
para-
meters on
the web

Select this option to allow the ClientWeb user the ability to select parameters when
requesting the report from the Report Queue page in ClientWeb. This option applies to Pos-
ted Loan Statements templates set up as a Web destination and with the Scheduling tab
set to Web request, which allows the selection of the previously run statement to reprint
from the ClientWeb Report Queue at the time the report is requested.

Report Sample
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Report Details

Column Description

Statement Format

Address The Loan Statement Address will display the following:

l Lender Name (in bold print) Located in System Preferences > Iden-
tification/system constants > Name & address > Lender name)

l Client Name

l Facility Description

l Client/Facility Address

Date Displays the day of the Month

Begin Balance Displays the beginning Loan Balance on the specific day

Disbursement Displays the amount of the Loan Disbursement on the specific day

Payment Displays the amount of the Loan Payment on the specific day; if there are multiple
Loan Payments posted on the same day, this column will display the total Loan Pay-
ments for the specific day

Other Displays the amount of Other Loan Transactions. This is typically the Accrual Posting
transactions on the Loan on the specific day

End Balance Displays the ending Loan Balance on the specific day

Float Balance Displays the Float Balance for the day that is calculated as:

Payment column * Float Days (as defined on the Statement Terms > Fee Type Interest
record) + End Balance column

Compound Bal-
ance

Displays the Compound Balance for the day that is calculated as:

Payment Column * Float Days (as defined on the Statement Terms > Fee Type Interest
record) + End Balance column Plus prior day Interest

Est. Interest Displays the calculated daily interest that is calculated as:

(End Balance column or Float Balance (if applicable)) *Rate% / 360 or 365

Number of
Days; Interest
Rate

Displays number of days for the period; displays the interest rate as defined on the
Statement Terms > Fee Type Interest record
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Column Description

Other Charges Displays all Fee Types that are flagged as Active on Facility Statement Terms

Average Daily
Balance

Displays the average of the End Balance for the period

Interest Charge Displays the interest calculated as:

(End Balance or Float Balance total (if applicable) * Rate % / 360 or 365)) * Days in
Period

Other Charges Displays the total of the calculated Other Charges

Total State-
ment Charges

Displays the total of the Interest Charge and the Other Charges

Past Due Bal-
ance

Displays any Interest that has not yet been applied to the Loan

Total Due Displays the total of the Interest Charge, Other Charges and Past Due balance.

Column Description

Fee Type Calculation

Fee Description Displays the Description of the Maintenance Fee type on Facility Information > State-
ment Terms

Post Date Displays the date that the fee type was analyzed in the date range the statement was
run

Loan Limit Displays the value in the Facility Information > Limits > Loan Limit field

Available Displays the Net Availability

Ending Balance Displays the Loan Balance as of the end of the reported day

Excess Deficit Displays the difference between the Availability and the Loan Balance

Fee Rate Displays the rate set for that fee type on Facility Information > Statement Terms

Fee Amount Displays the calculated value of the Fee Rate column * Excess Deficit column

Security Roles

To generate the Posted Loan Statement Report, the following Security Role needs to be set to YES:
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l Security Roles > Reports > Facility > Print loan statement report (preliminary) and Print loan
statement report (non-preliminary)

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Facility/Collateral Rules (Formerly Asset Based Lending, Periodic statement generation folder.

Preference Description

Max days in advance
to allow posting

Maximum number of days prior to the statement through date to allow
advance posting of statement fees

For example, if the Max Days = 5 and the system date is 6/25/20 and the state-
ment through date is 6/30/20, the system would allow the posting of the fees
to occur.

If the system date is 6/24/20 and the statement through date is 6/30/20, the
system would not allow the posting of the fees to occur.

Standard Maintenance
Fee Days in Month

Standard number of days in month used to calculate daily maintenance fee
amount

Use control date for
certificate approve
time (T/F)

If True, the Certificate Posting will be posted as of the current date. If False, the
Certificate Posting will be posted as of the date entered.

Use ending date to
determine fee month
(T/F)

If True, the fiscal month the fees will apply to will be determined by the ending
date of the statement. If False, the fees will apply to the date when the state-
ment is run.

Use thru date to
determine statement
post date (T/F)

Determines if the post date for the Loan Statement is the date indicated as the
thru date when running the Loan Statement

For example, if the Thru Date is 6/30/20, this will be the post date of the State-
ment transaction in the system.

Use thru date to
determine accrual
post date (T/F)

Determines if the accrual post date for the Loan Statement is determined by
the thru date when running the Loan Statement.

The system will look at the thru date on the Loan Statement and add the value
in the Facility Information > Statements > Days to wait for posting to determine
the date of the accrual posting.

For example, if the Thru Date is 6/30/20 and the Days to wait for posting = 1, the
accrual posting date will be 7/1/20.

Reports User Guide
SQL Reports

620 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Preference Description

Interest Calculation
Rounding Method

Select the rounding method for periodic generation of loan statements in Fact-
orSoft.

l No rounding limitation

l Limit rounding to 2 decimal places

l Limit rounding to 3 decimal places

l Limit rounding and truncate after 2 decimal places

Do not calculate
interest float if loan bal-
ance is not positive
(T/F)

Determines if interest on float is calculated on days where the Loan Balance is
negative

Do not calculate
unused line fee if loan
balance is not positive
(T/F)

Determines if the unused line fee (set up under Facility Information > State-
ment Terms > Fee Type = Unused Line) is calculated if the Loan Balance is neg-
ative

Use effective dates
with the spread rate
when calculating
interest (T/F)

Determines if the effective dates on the spread rate is used when calculating
interest

Use tiered basis
method when cal-
culating interest (T/F)

Determines if the Lender can set up multiple interest rates on the Facility
Information > Statement Terms > Fee type = Interest. The multiple rates can be
set up by clicking the “View” button next to the rate under the Interest Rate sec-
tion.

Customize the Statement

To add your logo and footer text to statements set the following in the Administration module, System
Preferences, Facility/Collateral Rules (Formerly Asset Based Lending), Reports, Loan Statement
Reports folder.

Preference Description

Logo Image File
Name

The fully qualified path and file name which the image file is located.

Recommended Logo Size: 1.7” x .8”

Acceptable File Types: .jpg, .tiff, .png
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Preference Description

Footer Text drop-down to select the statement text to be used in the footer of the report.

Statement language options are defined on the Statement Text Table screen in
the Tables module.

Unclaimed Cash Ledger Report

The Unclaimed Cash Ledger provides a summary of cash transactions that have not been posted to Facil-
ity/Loan. The report will also display the transaction of posting the unclaimed cash to the loan. This report
is specific to bulk collateral accounts in FactorSoft.

The default report definition for this report is UnclaimedLedger.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the adjacent fields.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
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Field Description

on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Report Sample

Report Details

Column Description

Date Displays the post date of the Unclaimed Cash Deposit or the Unclaimed Cash
Posting

Reference # Displays the value entered by the User at the time of posting the Unclaimed
Cash Deposit or the Unclaimed Cash Posting

Transaction Type Displays the value of the transaction type; this will be either Unclaimed Deposit
or Unclaimed Cash Posting

Beginning Balance Displays the beginning amount in the Unclaimed Cash account at the time of
posting
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Column Description

Amount Displays the amount of either the Unclaimed Cash Deposit or the Unclaimed
Cash Posting

Ending Balance Displays the ending amount in the Unclaimed Cash account at the time of post-
ing

Security Roles

To generate the Unclaimed Cash Ledger, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Unclaimed Cash Ledger Report

Unposted Accrued Fees Report

The Unposted Accrued Fees provides you with a listing of the fees and/or interest that have been accrued
since previously generated loan statements.

The default report definition for this report is UnpostedAccruedFees.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.
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Field Description

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Report Sample

Report Details

Column Description

Client Displays the Client name

Facility Displays the Facility name

Description Displays the Fee Type Description found on Facility Information > Statement
Terms

Posted Date Displays date the accrued fees will be posted to the Loan

Stmt Date Displays the date the Loan Statement was posted to the transaction ledger

Amount Posted Displays the calculated or flat fee amount for each fee type charged on the
Loan Statement

Balance Displays the balance of the calculated or flat fee amount for each fee type on
the Loan Statement

Facility Total Displays the total Amount Posted and Balance for the Facility

Client Total Displays the total Amount Posted and Balance for the Client

Grand Total Displays the grand total Amount Posted and Balance for the Client
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Security Roles

To generate the Unposted Accrued Fees, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Unposted Accrued Fees Report

Participation Menu

Participation Reports

The Participation reports are used to generate reports about participation.

Participation Ledger Report

The Participation Ledger Reports provides a summary of transactions for a specified date range.

The default report definition for this report is ParticipLedger.

Report Parameters

Field Description

Participation Select the participant to which to limit the report results.

Member Select the member to which to limit the report results.

A/E Select the account executive to which to limit the report, or leave blank to include all
account executives.

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.
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Field Description

Date Range Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of
the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set
System Preference Identification/system constants > CLMS|Reporting Services >
Requests > Use last business day instead of yesterday in date range to True. The Yes-
terday option in the Date Range field is replaced with Last Business Day, and reports
printed on Monday will print Friday’s data (assuming Friday was the last business day)
instead of Sunday’s. Set System Preference Identification/system constants >
CLMS|Reporting Services > Requests > Saturday is a business day to True to consider
Saturday a business day when the Date Range is set to Last Business Day. This function
is only valid for Reporting Services reports when Use last business day instead of yes-
terday in date range is set to True.

Report Sample

Reports User Guide
SQL Reports

629 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Participation Report

The Participation Report provides a summary of Participant’s financial details per batch, for specified cli-
ents within a specified date range.

The default report definition for this report is Participation1.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of
the date range to which to limit the report in the From and Thru fields.
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Field Description

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services >
Requests > Use last business day instead of yesterday in date range to True. The Yes-
terday option in the Date Range field is replaced with Last Business Day, and reports
printed on Monday will print Friday’s data (assuming Friday was the last business day)
instead of Sunday’s. Set System Preference Identification/system constants > CLMS|Re-
porting Services > Requests > Saturday is a business day to True to consider Saturday a
business day when the Date Range is set to Last Business Day. This function is only valid
for Reporting Services reports when Use last business day instead of yesterday in date
range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set
to True.

Select the magnifying glass icon to open the Search window and begin typ-
ing the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report,
or leave blank to include all users. When a user is selected, the report is limited to clients
that have that user selected in the A/E field on the Control panel of the Client Inform-
ation screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
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Field Description

office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To
access this table, on the File menu, click Tables. Then, on the Client & Debtor menu,
click Client Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Cli-
ent Groups are defined in the Group Code Table.

Report Sample

Participation Settlement Report

The Participation Settlement report calculates the current settlement requirement. The settlement is gen-
erated to reset the investment balance requirements based on the changes in the facility loan balance
since the previous settlement transaction posting.

The default report definition for this report is ParticipSettlement.
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Report Parameters

Field Description

Participation Select the participant to which to limit the report results.

Member Select the member to which to limit the report results.

A/E Select the account executive to which to limit the report, or leave blank to include all
account executives.

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.

Date Range Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of
the date range to which to limit the report in the From and Thru fields.
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Field Description

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set
System Preference Identification/system constants > CLMS|Reporting Services >
Requests > Use last business day instead of yesterday in date range to True. The Yes-
terday option in the Date Range field is replaced with Last Business Day, and reports
printed on Monday will print Friday’s data (assuming Friday was the last business day)
instead of Sunday’s. Set System Preference Identification/system constants >
CLMS|Reporting Services > Requests > Saturday is a business day to True to consider
Saturday a business day when the Date Range is set to Last Business Day. This function
is only valid for Reporting Services reports when Use last business day instead of yes-
terday in date range is set to True.

Report Sample

Productivity Menu

Productivity Reports

The Productivity report group contains cash and purchase productivity reports.

Cash Productivity Report

The Cash Productivity Report provides a snapshot of specified client’s cash postings, including checks pos-
ted and invoices paid, over a specified period of time.

The default report definition for this report is CashProd1.

A Fees column can be added to the Cash Productivity Report to display collection fees accountable to
the user. This feature applies to the Summarize to Client within user and Summarize to user formats of
the Cash Productivity Report, and System Preference Reports, Cash productivity report, Report module
name must be set to CashProdCB to utilize this feature.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
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Field Description

Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
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Field Description

menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table.

User Select the FactorSoft user login to limit the report to cash postings entered by that user only.

Format Select the report format to be printed:

l Detail report

l Summarize to client/date within user

l Summarize to client within user

l Summarize to date within user

l Summarize to user

Report Sample

Format: Detail Report
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Format: Summarize to Client/Date within User

Format: Summarize to Client within User

Format: Summarize to date within user

Format: Summarize to user
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Report Details

Column Description

Format: Detail Report

User User Name

Client Client Name

Posted Post Date on Payment Batch

Check
Batch #

Payment Batch #

Trans
Batch

Transaction Ck Batch #

Checks
Posts

Number of Checks Posted in Payment Batch

Invoices
Paid

Number of Invoices Paid in Payment Batch

Amount
Posted

Amount Posted in Payment Batch

Format: Summarize to Client/Date within User

User User Name

Client Client Name

Posted Post Date on Payment Batch

Checks
Posts

Number of Checks Posted in Payment Batch

Invoices Number of Invoices Paid in Payment Batch
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Column Description

Paid

Amount
Posted

Amount Posted in Payment Batch

Format: Summarize to Client within user

User User Name

Client Client Name

Checks
Posts

Number of Checks Posted in Payment Batch

Invoices
Paid

Number of Invoices Paid in Payment Batch

Amount
Posted

Amount Posted in Payment Batch

Format: Summarize to date within user

User User Name

Posted Post Date on Payment Batch

Checks
Posts

Number of Checks Posted in Payment Batch

Invoices
Paid

Number of Invoices Paid in Payment Batch

Amount
Posted

Amount Posted in Payment Batch

Format: Summarize to user

User User Name

Checks
Posts

Number of Checks Posted in Payment Batch

Invoices
Paid

Number of Invoices Paid in Payment Batch

Amount Amount Posted in Payment Batch
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Column Description

Posted

Security Roles

To generate the Cash Productivity Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Productivity Reports > Print Cash Productivity Report

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Cash Productivity Report folder.

Preference Description

CLMS Report Module
Name

Used to assign the report module a name for the Cash Productivity Report; if
blank, will use system standard.

Collector Response Report

The Collector Response Productivity Report is accessed from the Productivity Menu of the Reports module.
This report lists, by User Name, the number of collection or verification messages set by each user while
working the Collection/Verification Queue, or by verifying invoices from the Manage Pending Purchases
screen.

The default report definition for this report is ColResp1.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
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Field Description

plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Reporting
Services > Requests > Use last business day instead of yesterday in date range
to True. The Yesterday option in the Date Range field is replaced with Last Busi-
ness Day, and reports printed on Monday will print Friday’s data (assuming Fri-
day was the last business day) instead of Sunday’s. Set System Preference
Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date
range is set to True.

Group Select the message group to be reported:
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Field Description

l Collections

l Pre-purchase Verification

l Post-purchase Verification

Sample Report

Format: Collections

Format: Pre-purchase Verification

Format: Post-purchase Verification
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Report Details

Column Description

All Formats

Collector Displays the User's name

Total Number of collection or verification messages set by User

OTHER Number of collection or verification messages set by User

Security Roles

To generate the Collector Response Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Productivity Reports > Collector Response Report

Credit Decision Productivity Report

The Credit Decision Productivity Report is accessed from the Productivity Menu of the Reports module. This
report lists the users that have made credit decisions in the specified time period and displays the aver-
age time period for making a decision on the credit request.

The default report definition for this report is CredProd1.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the report results from the list. Client Groups are
defined in the Client Group Code Table.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table.

User Select the Dispute code on which to report.

Report Sample

Report Details

Column Description

User Displays the User's name
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Column Description

Description User’s Description in Manage Users Screen

Requested Number of Credit Requests worked by the User

Approved Number of Credit Requests approved by the User

Denied Number of Credit Requests denied by the User

Average Time in
Queue

Average Time Credit Request is in the Manage Credit Requests screen

Security Roles

To generate the Collector Response Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Productivity Reports > Credit decision productivity report

Date Roll Status Report (Beta)

The Date Roll Status Report (Beta) shows RollHeader and RollDetail Information pertaining to successful
and failed date roll tasks that occur during scheduled overnight processing through the Engine. This
report does not include any date roll information if the date change is performed manually.

To generate this report, in the Reports module, on the Productivity menu, click Date Roll Status Report.
You must have the following Security Role to see this option: Security Roles > Reports > Productivity
Reports > Print Date Roll Status Report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
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Field Description

the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Roll Select the date roll time-frame to be reported:

l Yesterday

l Day before Yesterday

l Specific Date Range

Date From Indicate the Starting date for the report

Date Thru Indicate the Ending date for the report
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Sample Report

Report Details

Column Description

Roll Date Date of Roll Date

New Date New Date when Roll Date has completed

Hdr Start Time Start Time of Roll Date Header

Hdr Status Name Status of Roll Date Header
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Column Description

Level Level Task was completed in

Task No Task Number

Description Task Description

Dtl Status Name Status of Roll Date detail

Task Time Task Time

Dtl Start Time Start Time of Roll Date detail

Dtl End Time End Time of Roll Date detail

Reason A description of the reason for task failure

Rollhdr Fail Time Time when Roll Header failed

Fail Message Message for Roll Header failing

Security Roles

To generate the Date Roll Status Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Productivity Reports > Print Date Roll Status Report

Invoice Delivery Batch Detail Report

The Invoice Delivery Batch Report, which is accessed from the Productivity menu of the Reports module,
list the Invoice Delivery related details of a single purchase batch. The report displays the batch level cre-
ation and updated dates and status of the Invoice Delivery package, as well as each individual debtor
package. Delivery details for each debtor include the delivery address and the attachments included in
the package.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
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Field Description

menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Batch# Enter the purchase batch number for the Invoice Delivery batch details to be displayed. This
field is required. The user can first create the Invoice Delivery Status Report to obtain the
batch number.

Report Sample
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Report Details

Column/Label Description

Header Section

Client Client’s Name

Batch No. Purchase Batch #

Post Date Post Date of the Purchase Batch

Trans-Status Status of the Purchase Batch

Invoice Delivery Package Section

Create Date Date the Invoice Delivery Package
was Created

Modified Date Date the Invoice Delivery Package
was Modified

Status Status of the Invoice Delivery Pack-
age

Message Header Section

Debtor Debtor’s Name

Create Date Date the Message Header was
Created

Modified Date Date the Message Header was
Modified

Status Status of the Message Header

Invoice Delivery Rule Debtor’s Delivery option:

1. Deliver cover page & Images

2. Deliver Nothing

3. Deliver images only

4. Delivery cover page only

Set at Debtor Information > Col-
lections Panel
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Column/Label Description

Delivery sent Date the Message was Sent

Delivery mode Mode of sending the Message

1. Email

2. Print

Delivery Status Status of the Message

Invoice Delivery Package Detail Section

Address Address that the Package was
sent to

Address Type

Attachment Attachments included in the
Invoice Delivery Package

Attachment Type Attachment Type

Reference Key Reference Key is the Image Key or
Document Key

File Name File Name and Location of the
Invoice Delivery Package Message

Security Roles

To generate the Invoice Delivery Batch Detail Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Productivity Reports > Print Invoice Delivery Batch Detail Report

Invoice Delivery Report

The Invoice Delivery Report is accessed from the Productivity menu of the Reports module. This screen is
used to generate the Invoice Delivery Exception report, which lists clients and debtors for which Invoice
Delivery was attempted, but not successfully completed.

The default report definition for this report is InvDelExcptRept.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.
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Field Description

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will print
Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Reports User Guide
SQL Reports

656 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Report Select the report format to be generated.

l Invoice Delivery Exception

l Invoice Delivery Exception by Batch

l Invoice Delivery Batches Waiting On Unassigned Images

Batch# Enter the batch number when requesting the Invoice Delivery Exception by Batch version of
the report.

Report Sample

Reports: Invoice Delivery Exception or Invoice Delivery Exception by Batch
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Report: Invoice Delivery Batches Waiting on Unassigned Images

Report Details

Column Description

Reports: Invoice Delivery Exception or Invoice Delivery Exception by Batch

Post Date Post Date of the Purchase Batch

Batch # Purchase Batch number

Invoice # Invoice number

User User who processed Purchase Batch
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Column Description

Failure Text Failure text indicating the reason the Invoice Delivery package did not
send successfully

Coverpage Location of the Invoice Delivery Cover Page

Report: Invoice Delivery Batches Waiting on Unassigned Images

Client Client’s Name

Post Date Post Date of the Purchase Batch

Batch # Purchase Batch Number

Security Roles

To generate the Invoice Delivery Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Productivity Reports > Print Invoice Delivery Report

Invoice Delivery Status Report

The Invoice Delivery Status Report, which is accessed from the Productivity menu of the Reports module,
lists batches by client on which Invoice Delivery packages have been sent or on which delivery was
attempted and displays the status of the delivery attempt. Other information listed includes the debtor
name, batch post date, invoice creation and modified dates, transaction and invoice package status,
debtor invoice delivery rule, and mode of delivery.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
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Field Description

s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
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Field Description

this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Format Select the report format to be generated.

l By Batch

l By Date

Batch# Enter the batch number when requesting the By Batch version of the report.

Show
Only Pro-
cessed
Batches

Select this check box to only include batches that have been processed in the report res-
ults.

Report Sample
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Report Details

Column/Label Description

Client Client’s Name

Batch No. Purchase Batch Number

Post Date Post Date of Purchase Batch

Trans Status Transaction status of Purchase Batch

Debtor Debtor’s Name

Create Date Create Date of Invoice Delivery Package

Modified Date Modified Date of Invoice Delivery Package

Status Status of building the Invoice Delivery Package

Invoice Delivery Rule Debtor’s Invoice Delivery Rule setting

Delivery Sent Date & Time that Invoice Delivery Package was sent

Delivery Mode Mode by which the Invoice Delivery Package was sent

Delivery Status Status on Sending the Invoice Delivery Package

Security Roles

To generate the Invoice Delivery Status Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Productivity Reports > Print Invoice Delivery Status Report

Purchase Productivity Report

The Purchase Productivity Report produces a report that lists data entry and approval statistics for users
to assist in evaluating user performance in FactorSoft.

The default report definition for this report is PurchProd.

A Fees column can be added to the Purchase Productivity Report to display purchase fees accountable
to the user. System Preference Reports, Purchase productivity report, Report module name must be set
to PurchProdCB to utilize this feature.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the From and Thru fields.
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Field Description

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Reporting
Services > Requests > Use last business day instead of yesterday in date range
to True. The Yesterday option in the Date Range field is replaced with Last Busi-
ness Day, and reports printed on Monday will print Friday’s data (assuming Fri-
day was the last business day) instead of Sunday’s. Set System Preference
Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date
range is set to True.

Report Sample

Report Details

Column Description

User Id User Name

Description User’s Description set in Manage Users Screen

Data Entry Batches Number of Batch User created via Data Entry

Data Entry Invoices Number of Invoices User created via Data Entry

Data Entry Time The Amount of Time that it took the user to complete Data Entry Batches & Invoices

Data Entry Aver-
age

The Average Time for the user to Data Entry the Batches & Invoices

Approval Batches The Number of Batches that the User approved

Approval Invoices The Number of Invoices that the User approved

Approval Time The amount of time for the user to approve the Batches and Invoices
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Column Description

Approval Average The average time for the user to approve the Batches and Invoices

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Purchase Productivity report folder.

Preference Description

Imports count as their own users Set to True for to imports count as their own user

Only first user gets credit for data
entry batch and invoices

Set to True to count invoices only once on original entry for the user
that created the batch and not count rework

CLMS Report Module Name Set Report Name to use when generating the report

Security Roles

To generate the Purchase Productivity Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Productivity Reports > Print Purchase Productivity Report

Statements Menu

Statements Reports

The Statements report group contains a variety of client and debtor statement options.

Activity Statements Report

The Activity Statements report provides a summary of financial activity for specified clients during a
defined date range. The results of this statement can be presented in three ways:

l Debtor Assignment Notifications

l Purchases by Debtor

l Purchases then Payments/Credits

The default report definition for this report is ActStmt.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
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Field Description

is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.
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Field Description

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Format Select the report format to be printed:

l Debtor Assignment Notifications

l Purchases by Debtor

l Purchases then Payments/Credits

Report Sample

Client Activity Statements Report

The Client Activity Statement generates a report based on a specified client’s activity, by specified terms,
within a specified date range. The Client Activity Statements report both factoring detail collateral and
non-detail collateral concurrently for databases that have both types.
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An alternate format displays several columns of Load Processor advance activity. To utilize this format, set
System Preference Reports, Client activity Statement, Activity by date Crystal Reports module name to
CLISTMTAC.

The default report definition for this report is CliStmt.

TIP
To remove unnecessary data and present a useful Client Activity Statement, two functions on the
Recalculate Redundant Data option need to be run prior to producing this report. These can be found
on the Administration module, System menu, Database maintenance, Recalculate Redundant Data
option. Run Payment C/B Codes, then Activity Tables.

Field Description

ReportTemplate Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Reports User Guide
SQL Reports

670 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group (as defined in the Client Group Table) for which this report is to be
generated.

Value Select the client group’s value (as defined in the Client Group Table) for which this report is
to be generated.

G/L
Group

Select a G/L Group to which to limit the report, or leave this field blank to include all G/L
Groups.

Terms
type

Select the terms to use for the statement to be printed:

l None

l Invoice based terms

l Portfolio based terms (A/R finance)

l Portfolio based terms (daily rate)

Sum to Determines the statement format:
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Field Description

l Date: activity by each day in the period

l Activity: activity by individual batch

l Client: activity within client by each day in the period

l Group: activity within group by each day in the period

Sort Select the option that determines the order in which to sort the statement:

l Client

l A/E

l G/L Group

Include
non-
zero
inactive
clients

Include inactive clients that have cash in A/R or reserves on the report. If this option is not
selected, non-zero inactive clients are excluded form the report.

Convert
native
currency

Select this option to convert amounts from the base currency to the native currency (the cur-
rency of the transaction). The conversion occurs on a client-by-client basis. If the client has
a currency type set and the currency type is different from the default currency, FactorSoft
looks up the conversion rate using the As of date in the currency table for the client's cur-
rency.

For example, if client ABC Company has a currency type of Canadian Dollars and the daily
conversion rate for Canadian dollars is 1.5, the report increases all of the client's amounts by
a factor of 1.5.

Report
by facil-
ity
instead
of client

Select this option to print the Client Activity Statement report for facilities instead of clients.
This setting is intended for clients that are using the ABL asset-based lending product.

Show
A/E

Select this option to print the account executive name in the statement results.

Show cli-
ent
name

Select this option to print the client name in the statement results.
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Field Description

Show
yield

Select this checkbox to include yield in the results.

Yield = (Total Client Revenue / Days in period of report • 365) / Average Daily Funding • 100

Report Sample

Report Details

Column Description/Calculation

Date Displays the posting date.

Batch # Displays the transaction identification.

Type Displays the Collateral Post or Transactions Type abbreviated
descriptor.

Accounts Receivable

Purchases

Gross Receipts

Discounts Displays reported Payment Discount amount for the period.

Other Displays posting against invoices for the period.

Adjustments Displays Adjustments to collaterals and Invoices for the
period.

Disbursements and Charges

Funding Displays the distributions made to the borrower for the period.
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Column Description/Calculation

Cash Receipts Displays the payments received against the loan amount for
the period.

Charges & Fees Displays the Fees & Changes added to the Loan Balance for
the period.

Expenses Displays the Expenses added to the Loan Balance for the
period.

Adjustments Displays Adjustments made to the Loan Balance for the
period.

Balances

Accounts Receivable Displays the Expenses added to the Loan Balance for the
period.

Funding Displays the distributions made to the borrower for the period.

Cash Reserves

Security Roles

To generate the Client Activity Statements Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Statements > Print Client Activity Statement

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Client activity report folder.

Preference Description

Include load
advances and load
settlement columns

Set to True to include load advance data on the Client Activity Statement
Report (both FactorSoft Reporting Service and Crystal Reports versions). Note
that this preference was added due to the fact that the run time for the Client
Activity Statement was negatively impacted for implementations of FactorSoft
that employed the Load Processor module, so by default the columns are
excluded from the reports.
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Compound Interest Statement Report

The Compound Interest Statement provides a report of compound interest earned on a specified interest
bearing account for specified clients through a given date. This report can be scheduled via the Engine.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Interest
bearing
account

Select the account for which to produce the Compound Interest Statement. This is a
required field.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.
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Field Description

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Basis table Select the fluctuating interest rate on which you are basing the interest rate to apply. The
choices are defined in the Daily Rate Basis table.

Plus/Minus
Rate

The percentage points to be added to or subtracted from the basis rate to determine the
interest rate to apply.

Post Select the account to apply the interest gain or loss to. This only applies if the Preliminary
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Field Description

interest
against

statement option is not selected.

Calculate
through
date

Enter the date through which to calculate interest for the selected client.

Format drop-down to select statement format:

l Detail Statement: Details compound interest for each client

l Summary Report: Lists summary information for each client

Pre-
liminary
statement

Select this option to generates the statement only. Leave this option unselected to gen-
erate the statement and post the interest to the account indicated in the Post interest
against field.

Report Sample

Detail Statement Format
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Summary Report Format
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Daily Earnings Statement Report

The Daily Earning Statement screen enables you to create a statement for selected clients that includes
Batch information (date posted, batch number, amount), Total Fees, Total Days, any Previous Fees, Cur-
rent Fees, and Future Fees, if any.

The default report definition for this report is EarnDaily.

Report Parameters

Field Description

As of date Select the ending date of the date range to which to limit the statement.

l Current Date

l Previous Month-End Date

l Specific Date

If the Specific Date option is selected, enter the date in the adjacent field.

Selection Select the option that determines the items to be included in the statement:
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Field Description

l Print items with unpaid fees only

l Print all items from date

From Date Enter the beginning date of the date range to which to limit the statement.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client Select the client group to which to limit the results in the report.
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Field Description

Group Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Pre-
liminary

Select this option to generate the statement only. Leave the option unselected to generate
the statement and post the associated fees to the client account. This option is only valid if
Print items for unpaid fees only is selected in the Selection field.

Debtor Finance Charges Report

The Debtor Finance Charge Report displays the results of the Calculate Debtor Finance Charge process,
listing the invoices for the period by debtor, with the finance charge and FC invoice number.

The default report definition for this report is DebCharges.

Report Parameters

Field Description

Year Select the fiscal year for debtor finance charge records to be included on the report.

Month Select the fiscal month for debtor finance charge records to be included on the report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
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Field Description

Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the account executive to which to limit the report results from the list. Click Clear to
remove the selection.

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.
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Report Sample

Debtor Statements Report

The Debtor Statement generates a statement of open invoices for your client in a format that can be
provided for easy viewing and mailing. Your remittance address appears on the statement and, option-
ally you can show your client’s name and address.

Debtor statement templates can be configured to be delivered to the Preference selection of the debtor
only, if desired:

l All Format options can be used to distribute statements to debtors only. The report template must
be set up with a Preference destination, and with the Contact Group on the Report Request Prefer-
ence Printing screen set to Only debtors.

The default report definition for this report is Stmt01.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Selection Select the option that determines the date that is used to select records to be included
within the date range.

l No date selection

l Only select where post date in range

l Only select where invoice date in range

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests
> Use last business day instead of yesterday in date range to True. The Yesterday option
in the Date Range field is replaced with Last Business Day, and reports printed on
Monday will print Friday’s data (assuming Friday was the last business day) instead of
Sunday’s. Set System Preference Identification/system constants > CLMS|Reporting Ser-
vices > Requests > Saturday is a business day to True to consider Saturday a business
day when the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date range is set
to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
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Field Description

s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the user
will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table.
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Field Description

Debtor Select the debtor for which to generate statements. Enter the debtor name or partial
debtor name to search. Results matching the characters entered are displayed in the list
box below the field.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Groups are
defined in the Debtor Group Code Table.

Value Select the specific debtor group value to which to limit the report results from the list.
Debtor Groups are defined in the Debtor Group Code Table.

Alpha from
/ thru

Enter an alphabetic range of debtor names for which to generate statements. For
instance, entering a - G would produce statements for all debtors with names starting
with the letters A through G, provided they matched all other selection criteria defined on
this tab.

Select Select the invoice types to be selected for inclusion in the statement.

l Unpaid & Paid This Month: All paid and unpaid invoices.

l Unpaid Only: Only the invoices that remain unpaid.

l Select Items Only: For use with Collection Queue Statement printing.

l Everything on File: Prints all transactions for the debtor.

Select Age
By

Select the date from which to begin aging for selection of invoices for the statement:

l Invoice date

l Purchase date

l Due date

Format Select the report format to be printed:
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Field Description

l Standard: Generates the standard format report, defined by Crystal Report module
specified in System Preference Reports, Debtor Statements, Standard Crystal
Reports module name.

l Past due: Generates the standard past due format report, defined by Crystal Report
module specified in System Preference Reports, Debtor Statements, Past due Crystal
Reports module name.

l Client w/i debtor: Generates a statement by debtor with invoices listed by the Client
from which they were purchased.

l Detail: generates the Detail format, which lists all invoices for a specific client/debtor
relationship (specific Client and Debtor criteria must be selected on the report
request screen).

l Summary: generates the Summary format, which lists all invoices for all of the cli-
ent/debtor relationships for the specified criteria, and includes a grand total.

Sort by Select the option that determines the order in which to list invoices for a debtor on the
statements.

l Invoice number

l Invoice date

Invoices
were

Select the option that determines the invoices to select based on the client criteria selec-
ted on the Client/debtor selection tab:

l Purchased from

l Issued by

l Leave blank

l Vendor

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the screen before printing it

l Export to generate the statement as an export file in XML or text BBS format as
determined by system preference.

Output
Path

Specify the folder in which the Export file will be saved.

Reports User Guide
SQL Reports

689 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

Exclude
standard
text at bot-
tom

Select this option to exclude the text defined in System Preference Reports, Debtor state-
ments, Text at bottom from the generated statement.

Exclude cli-
ent text at
bottom

Select this option to exclude the client text from the generated statement.

Exclude
"Remit All
Payments
To"

Select this button to exclude the "Please Remit All Payments To" line from above the lender
address.

Exclude
negative
invoice bal-
ances

Select this option to exclude invoices with negative balances (credit invoices) from the
statement.

Exclude
flagged do
not mail

Select this option to exclude debtors with return address reasons set defined as Do not
mail from statement printing and mailing.

At Least
Days Old

Enter the minimum number of aging days for invoices to be included in the statement.

Days past
due

Enter the minimum days past due for invoices to be included in the statement. This selec-
tion is used with the Past Due Items Only in the Select field.

Not older
than days

Enter the maximum number of aging days for invoices to be included in the statement.

Min state-
ment
amount

Enter the minimum dollar amount for invoices to be included in the statement.

Intro-
duction

Select the Statement Text to print as introductory text for the statement. The Statement
Text are defined in the Statement Text Table.

Conclusion Select the Statement Text to print as concluding text for the statement. The Statement Text
are defined in the Statement Text Table.
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Report Example

Standard Format:

Summary Format:
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Report Details

Column Description

Invoice # Displays the Invoice Number of the Transaction.

Date Displays the Date of the Invoice.

Amount Displays the Amount of the Invoice.

PO/Load# Displays the PO or Load Number associated with the Invoice if one exsists.

Note: Column displays on Summary Format Only

Age Displays the Age of the Invoice.

Balance Displays the Balance due on the Invoice

Total Due Displays the Total Amount Due.

Security Roles

To generate the Debtor Statements Report, the following Security Role needs to be set to YES:
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l Security Roles > Reports > Statements > Print Debtor Statements

Debtor Statements Recap Report

This screen is used to produce the Debtor Statement Recap report, which is a custom report that lists
debtor statements generated for a given statement date.

The default report definition for this report is DebStmtRecap.

Report Parameters

Field Description

As of
date

Select the ending date of the date range to which to limit the report.

l Current Date

l Previous Month-End Date

l Specific Date

If the Specific Date option is selected, enter the date in the adjacent field.

Debtor Enter the customer/debtor name to which to limit the report. You can enter the first letter of
the debtor name to list debtors whose names begin with the same letter in the list below this
field. Leave this field blank to include all customers in the report.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Groups are
defined in the Debtor Group Table.

Value Select the specific debtor group value to which to limit the report results from the list.
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Posted Client Fee Statement Report

The Posted Client Fee Statement report allows the user to print or reprint previously posted client fee state-
ments - it does not apply charges and update the account balance. When the user selects a Client and
Facility, the Statement dates for reprint displays the previously run statements available for reprint by the
statement date ranges so that the user can select the statement to be reprinted.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office
to which they are restricted will be selected in the Office field by default and the user will
not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

G/L group Select a G/L Group to which to limit the report, or leave this field blank to include all G/L
Groups.

Sort Select the option that determines the order in which to sort the statement:
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Field Description

l Client

l A/E

Previous
Statement
Date

Select a previously-posted statement to reprint.

Show A/E Select this option to print the account executive name in the statement results.

Show client
name

Select this option to print the client name in the statement results.

Include
non-zero
inactive cli-
ents

Include inactive clients that have cash in A/R or reserves on the report. If this option is not
selected, non-zero inactive clients are excluded form the report.

Convert
native cur-
rency

Select this option to convert the financial data to the client’s native currency.

Allow users
to override
para-
meters on
the web

Select this option to allow web users to select their own parameters from the web.
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Report Sample

System Preferences

The following system preferences used to determine which default report definition is used are located in
System Preferences > Reports > Client Fee Statement folder:

Report Definition Preference

CliStmt1.rpt Fee statement without float days - Set to Blank

CliStmtF.rpt Fee statement with float days - Set to Blank

CliStmtDF1.rpt Calculate Fees Daily - Set to True

CliFeeF-MA.rpt Multi-Fee Version - Set to Trueand Take Float on Actual Day - Set to True

CliFeeF-M.rpt Multi-Fee Version - Set to Trueand Take Float on Actual Day - Set to False

NFEStmtF.rpt Fee statement with float days

CliFee1.rpt Calculate fees Daily - Set to False and Fee statement without float days
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Transactions Menu

Transactions Reports

The Transaction reports group contains a variety of transaction report options.

BofA LockBox Detail Report

The BofA LockBox Detail Report will provide data included in the LockBox detail import file from Bank of
America.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Reporting
Services > Requests > Use last business day instead of yesterday in date range
to True. The Yesterday option in the Date Range field is replaced with Last Busi-
ness Day, and reports printed on Monday will print Friday’s data (assuming Fri-
day was the last business day) instead of Sunday’s. Set System Preference
Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date
range is set to True.
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Report Sample

Report Details

Column Description

Header

File Date Displays the date the data is “as of”; typically the file contains data from the previous
day

File Imported Displays the file name

File Import Date Displays the date the file was imported in to the system

LockBox Details Displays successful or failure messages

Origin Bank Displays the bank account number provided in the import file

Error Message Displays error message, if any.

Report

LockBox Num-
ber

Displays the number of the LockBox included in the import file from the bank

Dollar Amount Displays the dollar value of the LockBox included in the import file from the bank

Security Roles

To generate the BofA LockBox Detail Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Transaction Reports > Print BofA LockBox File Report

Reports User Guide
SQL Reports

700 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Cash Receipts Report

The Cash Receipts Report screen is used to generate the Cash Receipts Register report.

The default report definition for this report is ColSumm3.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
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Field Description

True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Clients Select the clients to be included in the report, based on the Client Terms type:
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Field Description

l All

l Fee Based

l Daily Rate

l A/R Finance

Hide pay-
ments on
hold
accounts

Select this option to not print payments to hold accounts on the report.

Report Sample

Chargeoff/Recovery Report

The Chargeoff/Recovery report produces a list of clients or debtors with chargeoffs and is used in con-
junction with the Fair Isaac RMS (2) Recovery Systems Export.

The default report definition for this report is ChgOffDet1
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
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Field Description

Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
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Field Description

menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Report Select the format for the report:

l Detail

l Debtor summary

l Client summary by member client

l Client summary by master client

Debtor Enter the customer/debtor name to which to limit the report. You can enter the first letter of
the debtor name to list debtors whose names begin with the same letter in the list below this
field. Leave this field blank to include all customers in the report.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Groups are
defined in the Debtor Group Table.

Value Select the specific debtor group value to which to limit the report results from the list.

Sort Select the sort option that determines the order in which to sort the report.

l Debtor

l Client

l Amount

Report Sample
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System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Charge off report folder.

Preference Description

Client group used on
report

Select the default Client Group to use for the Detail report.

Claim Payment Report

The Claim Payment Report lists CPT codes purchased and paid by debtor, and includes the total charge
(invoice) amount, NRA (or Net Realizable Amount), amount paid, adjustment amount, and percentages of
the claim charged and NRA. This report is accessed from the Analysis menu of the Reports module,
provided the user has security rights enabled.

The default report definition for this report is ClaimPmt.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

Reports User Guide
SQL Reports

708 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.
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Report Sample

Collection/Adjustment Summaries Report

The Collection/Adjustment Summary Report screen allows you to choose a variety of formats for the col-
lection and adjustment summary reports.

The default report definitions for this report are:

l Collection Summary = ColDoc01, ColDoc02

l Adjustment Summary = AdjDoc01, AdjDocW

l Return Check Summary = ColDoc01

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
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Field Description

erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.
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Field Description

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group (as defined in the Client Group Table) for which this report is to be gen-
erated.

Value Select the client group’s value (as defined in the Client Group Table) for which this report is to
be generated.

Clients Select the clients to be included in the report, based on the Client Terms type:
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Field Description

l All

l Fee Based

l Daily Rate

l A/R Finance

Report Select the report format to be produced:

l Collection summary

l Adjustment summary

l Return check summary

Report Sample

ColDoc02 Format:

AdjDocW Format:
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AdjDoc04 Format:

Security Roles

To generate the Collection Adjustment Summaries Report, the following Security Role needs to be set to
YES:

l Security Roles > Reports > Transaction Reports > Print Collection Summary Reports

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Adjustment Report folder.

Preference Description

Crystal Reports mod-
ule name

Used to assign the crystal reports module a name for the Collection Adjustment
Summaries Report, Adjustment Summary format.
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The following system preferences for this report are located in the Administration module, System Prefer-
ences, Terminology folder.

Preference Description

Our Client's customer
is a

Used to assign the terminology of the Client's Customer, if blank, the default is
Debtor.

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Collection Report folder.

Preference Description

Crystal Reports mod-
ule name

Used to assign the crystal reports module a name for the Collection Adjustment
Summaries Report, Collection Summary format.

Completed Transfers Report

The Completed Transfers Report provides data regarding Manual and Auto Transfer transactions that
have occurred within the date range specified by the User.

This report is accessed from the Transactions menu of the Reports module.

The default report definition for this report is CompTrans.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
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Field Description

erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.
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Field Description

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Enter the debtor group value for which to limit the report results.

Debtor Groups are defined in the Group Code table in the Tables module.
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Report Sample

Report Details

Column Description

Date of Transfer Transaction Post Date

Client From # Client Code for the “from” transfer Client

Client Name Client Name for the “from” transfer Client

Amt of Transfer Transaction Amount

Client To # Client Code for the “to” transfer Client

Transfer Type “M” for Manual; “A” for Auto

Security Roles

To generate the Completed Transfers Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Transaction Reports > Print Completes Transfers Report

Credit Memo Report

The Credit Memo Report lists credit memos applied at the time of payment. This report includes negative
payments for invoices on which a dispute code is set that is used To flag payments in the Dis-
pute/Ineligibility/No Buy Code Table..

This report is accessed from the Transactions menu of the Reports module.

The default report definition for this report is CreditMemo.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
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Field Description

business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.
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Field Description

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Enter the debtor group value for which to limit the report results.

Debtor Groups are defined in the Group Code table in the Tables module.

Debtor Enter the debtor for which to request the report. Click the Down Arrow to display a list of valid
entries.

Leave this field blank to include all debtors in the report results.

To delete an entry in this field, click the Down Arrow twice to highlight the entry and press the
Delete key.

Debtor
Group

Enter the debtor group to which to limit the report results.

Debtor Groups are defined in the Group Code table in the Tables module.

Value Enter the debtor group value for which to limit the report results.

Debtor Groups are defined in the Group Code table in the Tables module.

Report Sample

DDA Transaction Report

The DDA Transaction Report lists check/wire transactions that have been exported from FactorSoft to FIS
through the Connectware Interface.

The default report definitions for this report are DDATrans and DDATransSummary.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will print
Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
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Field Description

Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
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Field Description

table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Display Select the report format to be generated:

l Detail

l Summary

Sort by Select the sort option that determines the order in which to sort the report.

l Check #

l Payor

l Check Type

Report Samples

Detail Format
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Summary Format

Daily Client Purchase Report

The Client Purchase Report produces a report that lists purchase for a given date range.

The default report definition for this report is DailyDepositDtl.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Level Select the report format:

l Daily Detail Recap

l Daily Summary Recap
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Report Sample

Daily Statement Report

The Daily Statement Report provides Purchase Detail, Allocation of Available Funds, and Statement Sum-
mary of Available Funds.

The default report definition for this report is DailyStmt.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

TIP
This Report may not be accurate for historical conversion data and it is recommended that the report
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is ran from the Date of First Funding in FactorSoft going forward..

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.
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Report Sample

Report Details

Column Description

Allocation of Available Funds Section

Date Check date
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Column Description

Assignee A. Payee: Client and/or Third Party

B. Line Item for monies owed to Factor/Lender defined at System Preferences >
Reports > Daily Statement > Allocation of Available Funds Section - Assignee’s
Column)

Amount A. Check Amount

B. Total Monies Due to Factor/Lender + Expenses

Calculations

Column Calculation

Invoices Purchased

Advance Amount Invoice Amount x Advance Rate.

Allocation of Available Funds

Footer Amount Total of all Expenses + Total Due Factor Reserve Held.

Statement Summary

Proceeds from
Purchases

Invoice Amount x Advance.

Expenses Posted
Against Schedule

Expenses Total on a Purchase Batch, displayed as a negative amount.

Recourse Items
Deducted

Recourse A/R Amount + Recourse Fee Earned - Recourse Reserve Escrow.

Total Reserves Due to
Client

Total Reserves Held, if Reserves are due to Factor, amount in negative. If
Reserves are due to Client, amount is positive.

Other Funds Due to
Client

Advance Amount (Load Advance) + Settlement Amount (PO Advance).

Total Funds Available
for Allocation

Proceeds from Purchases - Expenses + Total Reserve Due to Client - Recourse
Items Deducted + Other Funds Due to Client

Reserve Activity Calculations of Funds Due

Proceeds from
Rebates Closed

All monies from Payments (Cash Posting) released from Reserve Escrow Less
Fees = Net to Cash Reserve on Closed Invoices where Close Date is within date
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Column Calculation

Invoices range of the report.

Example:
Invoice Amount = $1,000
Adv Rate = 90% ($900)
Reserve Escrow = 10% ($100)
Fee Earned =1% ($10)
Net to reserve calculation: Release (Reserve Escrow) - Fee Earned = Net to Cash
Reserve
$100 - $10 = $90 (Net to Cash Reserve)

Over/Short Payments
and Chargebacks

Total of Chargebacks and Adjustments

Example 1 (Shortpayment/Chargeback):
Invoice Amount = $1,000
Adv Rate = 90% ($900)
Reserve Escrow = 10% ($100)
Fee Earned =1% ($10)
Payment in amount of $950 posted against invoice. There is a Shortpayment of
$50 which would be reflected in this line item.

Example (Adjustment Batch):
Invoice Amount = $1,000
Adv Rate = 90% ($900)
Reserve Escrow = 10% ($100)
Fee Earned =1% ($10)
User creates an adjustment batch charging back the entire invoice and $910
(Advance Amount + Fee Earned) is posted against Cash Reserve.

Total Cash Reserves Beginning Reserve Balance +Proceeds from Reserves on Closed Invoices - Short
Payments & Chargebacks + Proceeds from Payments on NonPurch Inv +/- Mis-
cellaneous Charges/Refund

Total Due to Client
Reserve Released

Total of all monies Released at the time of Purchase and via Client Summary >
Reserve Release for the date range of report. Displays as a negative amount
reducing the Ending Reserve Balance.

Total Due to Factor
Reserves Held

Total of all monies Held at the time of purchase for the date range of the report.
Displays on Report as a Positive amount increasing the Ending Reserve Balance.

Ending Reserve Bal-
ance

Total Cash Reserves + (Total Due to Factor Reserves Held - Total Due to Client
Reserve Releases)
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System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Daily Statement folder.

Preference Description

Allocation of Avail-
able Funds Section -
Assignee’s column

Indicate the Assignee’s name or description for money owed to Factor/Lender.

Security Roles

To generate the Daily Statement Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Transaction Reports > Print Daily Statement Report

NonFactored Fee Report

This report displays non-factored fees associated to payments on non-factored invoices. The is a custom
report and will only display data when the non-factored invoice number begins with NFC.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client

Reports User Guide
SQL Reports

735 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm
Client Group Codes Table.htm


Field Description

Groups are defined in the Group Code Table.

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Security Roles

To generate the NonFactored Fee Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Transaction Reports > Print NonFactored Fee Report

Open Schedule Report

The Open Schedule report displays schedule/batches that are still open and have not been processed.

The default report definition for this report is OpenBuy.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
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Field Description

Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
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Field Description

table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Batch Enter the schedule/batch number to which to limit the report, or leave blank to include all
open batches.

Report Select the format for the report:

l Open Schedule Report: Detail by client

l Schedule Status Report: Detail by schedule

l Open Schedule List: Summary by client

Value Select the specific debtor group value to which to limit the report results from the list.

Separate
Page for
each Cli-
ent

Select this option to force a new page for each client break in the report. If this is not selec-
ted, multiple clients can be printed on one page.

Report Sample
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Partial Payment/Chargeback Report

The Partial Payment/Chargeback Report provides a tool to review any partial or unapplied payments and
charge-backs currently open for a client. This report can be used as a daily report for data entry, to inform
personnel of exceptions that appear in collections.

The default report definitions for this report are:

l PartPmt1 = Partial Payment Report and Chargeback Report

l Unapplied1 = Unapplied Payment Report

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services >
Requests > Use last business day instead of yesterday in date range to True. The Yes-
terday option in the Date Range field is replaced with Last Business Day, and reports
printed on Monday will print Friday’s data (assuming Friday was the last business day)
instead of Sunday’s. Set System Preference Identification/system constants > CLMS|Re-
porting Services > Requests > Saturday is a business day to True to consider Saturday a
business day when the Date Range is set to Last Business Day. This function is only valid
for Reporting Services reports when Use last business day instead of yesterday in date
range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set
to True.

Select the magnifying glass icon to open the Search window and begin typ-
ing the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report,
or leave blank to include all users. When a user is selected, the report is limited to clients
that have that user selected in the A/E field on the Control panel of the Client Inform-
ation screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To
access this table, on the File menu, click Tables. Then, on the Client & Debtor menu,
click Client Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To
access this table, on the File menu, click Tables. Then, on the Client & Debtor menu,
click Client Group Codes.

Report Select the report format to generate:
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Field Description

l Partial Payment Report: lists cash input exception items, such as overpayments,
shortages, and non-factored cash.

l Chargeback Report: lists the items that are available for charge-back, which
includes items from the partial payment report plus any items that are currently in
dispute or beyond recourse days.

l Unapplied Payments Report: lists payments that have been received but have
not been applied to a purchase/invoice.

Chargeback/
giveback

Select whether to include chargebacks and give-backs in one column or in separate
columns.

l One column for both

l Separate columns

Exclude Over-
payments

Select this option to exclude overpayments from the report.

Sequence By
A/E

Select this option to separate the report by Account Executive. Each A/E break will force
a new page so that each A/E is reported separately.

Total by
Debtor

Select this option to include debtor totals at each debtor break in the report.

Show inact-
ive clients

Select this option to include inactive clients in the report results.

Report Sample
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System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Partial Payment/chargeback report folder.

Preference Description

Partial payments
include open non-
factored payments

Set to True to include open non-factored payments in the report.

Use report server par-
tial payments/

chargeback request
form

Set to True to use the Task Scheduler-enabled report form.

Payment History Report

The Payment History Report shows the payment activity and performance for a selected debtor or for all
debtors of a selected client.

The default report definition for this report is PmtRept6.
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Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
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Field Description

lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Report Select the format for the report:

l Earning style

l Activity style

l Payment style by client

l Payment style by debtor

Format Select the report type to produce. This option is not available when the Activity style format
is selected in Report.

l Detail

l Summary

l Total (all clients only)

Select Select the invoices to be selected for reporting. This option is only available if the selected
Report is Earnings style or Activity style.
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Field Description

l All invoices

l Payment only

Sort Select the sort option that determines the order in which report is presented. This option is
only available if the selected Report is Activity style.

l Invoice number

l Payment date

Calculate
Late
Fees?

Select this option to calculate late fees on all selected entries

Include
Non-
Factored?

Select this option to include non-factoring clients in the report results. If this option is not
selected, non-factoring clients are excluded for the report.

All clients
includes
inactive

Select this option to include inactive clients in the report results. If this option is not selected,
inactive clients are excluded form the report.

Report Sample

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Payment history report folder.
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Field Description

Use over due activity
format

Set to True to generate the alternate overdue activity format of the Payment His-
tory Report, which lists the Invoice Due Date, Dilution percentage, and Invoice
Age (calculated from invoice due date to payment date).

Purchase Summary Report

The Purchase Summary Report allows a Client, Date Range, and a Report Type selection .

The default report definition for this report is PurchSum.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Select the date to use for the report from the list:
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Field Description

range l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will print
Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Debtor Enter a character (number or letter) or combination of characters to display the debtor
names beginning with that character or combination of characters in the list. Select the
debtor to which to limit the report results from the list.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Groups are
defined in the Debtor Code Table.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Group Code Table.
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Field Description

Report
Type

Select the report to be generated:

l Purchases without fees: summary of purchases, grouped by client.

l Purchases without Fees w/Pay By Method: same as Purchase without fees, but also dis-
plays the Pay By method for the purchase activity.

l Debtor purchase detail: detail of purchases for a customer/debtor.

l Debtor purchase summary by client: summary of purchases by debtor, grouped by
client.

l Debtor purchase summary by Debtor: summary of purchases by debtor, grouped by
debtor.

l Purchases with fees: summary of purchases showing fees, grouped by client.

l Purchases with fees summary: grand total of purchases showing fees, grouped by cli-
ent.

l Purchases with Fees w/Pay By Method: same as Purchase with fees, but also dis-
plays the Pay By method for the purchase activity.

l Negative invoices by Debtor: lists negative invoices, sorted by customer/debtor within
client.

l Negative invoices by invoice#: lists negative invoices, sorted by invoice number within
client.

Pay By
Method

Select a Pay By Method by which to limit the report. This option is only available for the
Purchases without Fees w/Pay By Method or Purchases with Fees w/Pay By Method report
types.

Show
PO#

Select this option to include a PO# column on the report. This option is only available for the
Debtor Purchase Detail report type.
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Report Sample

Purchase Upload Exception Report

The Purchase Upload Exception report details EDI 810 Invoice Submissions that fail during upload. When
generate this report you can select the client and date for which you want to see failures.

To access this report, in the Reports module, on the Transactions menu, click Purchase Upload Exception
Report.
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Report Parameters

Field Description

Date Range Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business
Day, set System Preference Identification/system constants > CLMS|Reporting
Services > Requests > Use last business day instead of yesterday in date range
to True. The Yesterday option in the Date Range field is replaced with Last Busi-
ness Day, and reports printed on Monday will print Friday’s data (assuming Fri-
day was the last business day) instead of Sunday’s. Set System Preference
Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when
the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date
range is set to True.

Report Columns

The new Purchase Upload Exception report contains the following information:
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l Client – The client for which invoices were uploaded.

l File – Name of the file used for the import.

l Message – Indicates the data element that triggered the failure, as well as the line and record num-
ber.

l Number of Records – Indicates the number of failures listed in the report.

l Transmission Value – Indicates the value of the failures listed in the report.

Remittance Statement Report

The Remittance Statement lists payment posting checks by client, sorted by the option selected on the
report request screen, in a statement format.

The default report definition for this report is ColSumm2.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of
the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set
System Preference Identification/system constants > CLMS|Reporting Services >
Requests > Use last business day instead of yesterday in date range to True. The Yes-
terday option in the Date Range field is replaced with Last Business Day, and reports
printed on Monday will print Friday’s data (assuming Friday was the last business day)
instead of Sunday’s. Set System Preference Identification/system constants >
CLMS|Reporting Services > Requests > Saturday is a business day to True to consider
Saturday a business day when the Date Range is set to Last Business Day. This function
is only valid for Reporting Services reports when Use last business day instead of yes-
terday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set
to True.

Select the magnifying glass icon to open the Search window and begin typ-
ing the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report,
or leave blank to include all users. When a user is selected, the report is limited to cli-
ents that have that user selected in the A/E field on the Control panel of the Client
Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the
following System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To
access this table, on the File menu, click Tables. Then, on the Client & Debtor menu,
click Client Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Cli-
ent Groups are defined in the Group Code Table.

Clients Select the clients to be included in the report, based on the Client Terms type:

l All

l Fee Based

l Daily Rate

l A/R Finance

Sort Select the sort option that determines the order in which to sort the report.
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Field Description

l Check Date

l Invoice Number

l Debtor Name

l Post Date

l Batch Number

Show extra
tools

Select this option to print additional totals on the report for total Collected, Advanced,
and Fees, and a summation of these as Total Due.

Show adjust-
ment type
recap

Select this option to show total adjustment amounts by adjustment type at the end of
the report.

Ratio
invoice/ad-
vance

Not used.

Hide pay-
ments on hold
accounts

Select this option to not print payments to hold accounts on the report.

Do not show
rate

Select this option to not print the Discount Rate on the report.

Report Samples
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Remittance Summary Report

The Remittance Summary Report lists payment posting checks by client, sorted by the option selected on
the report request screen.

The default report definition for this report is ColSumm1.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)
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Field Description

If the Specific date range option is selected, enter the beginning and ending dates of
the date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set
System Preference Identification/system constants > CLMS|Reporting Services >
Requests > Use last business day instead of yesterday in date range to True. The Yes-
terday option in the Date Range field is replaced with Last Business Day, and reports
printed on Monday will print Friday’s data (assuming Friday was the last business day)
instead of Sunday’s. Set System Preference Identification/system constants >
CLMS|Reporting Services > Requests > Saturday is a business day to True to consider
Saturday a business day when the Date Range is set to Last Business Day. This function
is only valid for Reporting Services reports when Use last business day instead of yes-
terday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set
to True.

Select the magnifying glass icon to open the Search window and begin typ-
ing the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report,
or leave blank to include all users. When a user is selected, the report is limited to cli-
ents that have that user selected in the A/E field on the Control panel of the Client
Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the
following System Preference:

l Terminology > Select account executive based on check box: TRUE
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Field Description

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To
access this table, on the File menu, click Tables. Then, on the Client & Debtor menu,
click Client Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Cli-
ent Groups are defined in the Group Code Table.

Clients Select the clients to be included in the report, based on the Client Terms type:

l All

l Fee Based

l Daily Rate

l A/R Finance

Sort Select the sort option that determines the order in which to sort the report.

l Check Date

l Invoice Number

l Debtor Name

l Post Date

l Batch Number

Show extra
tools

Select this option to print additional totals on the report for total Collected, Advanced,
and Fees, and a summation of these as Total Due.

Show adjust-
ment type

Select this option to show total adjustment amounts by adjustment type at the end of
the report.
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Field Description

recap

Ratio
invoice/ad-
vance

Not used.

Hide pay-
ments on hold
accounts

Select this option to not print payments to hold accounts on the report.

Do not show
rate

Select this option to not print the Discount Rate on the report.

Report Sample

Returned Check Report

The Returned Check Report lists checks that have been marked for return from the Check Search screen.

The default report definition for this report is RetCheck.
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Report Parameters

Field Description

Date
range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
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Field Description

Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.
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Field Description

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Sequence Select the option that determines the order in which to sort the report:

l Payor

l Return check date

Report Sample

Transaction Report

The Transaction Report allows you to generate transaction reports in summary or detail formats for spe-
cific or all clients within a specified date range.

The default report definitions for this report are:
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l Trans = Purchases & Collections, Purchases Only, Collections Only

l CliLedge3 = Client Ledger (include non-factored column)

l CliLedge4 = Client Ledger (include fees taken column)

l CliLedge6 = Client Ledger (include fees & tax columns)

l purchrep = Purchase Summary

l TransAct1 = Transaction Activity

l TransOffDate = Posted off-date report

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table.

Report
Type

Select the report to be generated:
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Field Description

l Purchases & Collections

l Purchases Only

l Collections Only or Collections/Adjustments Only

l Client Ledger (include Non-factored column)

l Client Ledger (include fees taken column)

l Client Ledger (include fees & tax columns)

l Purchase Summary

l Transaction activity

l Posted off-date report

l Purchases Only Portfolio Grand Totals

l Purchases Only Client and Portfolio Grand Totals

l Collections Only Portfolio Grand Totals

l Collections Only Client and Portfolio Grand Totals

Format Select the format, Detail or Summary, for the selected report. This field is only available when
the selected Report Type is Purchase & Collections, Purchase Only, or Col-
lections/Adjustments Only.

Other Select the option for additional formatting. These options are only available when the selected
Report is Purchase & Collections, Purchase Only, Collections/Adjustments Only (both options
available) or Transaction Activity (Each client only).

l Include expense summary

l Each client on a separate page

Report Details

Column Description

Format: Purchases Only Portfolio Grand Totals and Collections Only Portfolio Grand Total

A/R Amount Accounts Receivable amount for the entire portfolio
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Column Description

- Fee Escrow Fee Escrow amount for the entire portfolio

- Reserve Escrow Reserve escrow amount for the entire portfolio

- Expenses Expenses amount for the entire portfolio

- Actual Reserve Actual Reserve amount for the entire portfolio

- Fee Earned Fee Earned for the entire portfolio

Write Off Amount Write Off amount for the entire portfolio

Deposit Amount Deposit amount for the entire portfolio

Paid Amount Paid amount for the entire portfolio

Grand Total Portfolio grand total (Portfolio grand total = all the Clients
final balances).

Format: Purchases Only Client and Portfolio Grand Totals and Collections Only Client and Portfolio
Grand Totals

Client Name Displays Client name

A/R Amount The final balance of the Accounts Receivable amount

- Fee Escrow The final balance of the fee escrow amount

- Reserve Escrow The final balance of the Reserve escrow amount

- Expenses The final balance of the Expenses amount

- Actual Reserve The final balance of the Actual Reserve amount

- Fee Earned The final balance of the Fee Earned

Write Off Amount The final balance of the Write Off amount

Deposit Amount The final balance of the Deposit amount

Paid Amount The final balance of the Paid amount

Portfolio Grand Total Portfolio grand total (Portfolio grand total = all the Clients
final balances).

Report Samples

Format: Collections/Adjustments Only
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Format: Purchases Only Portfolio Grand Totals

Format: Purchases Only Client and Portfolio Grand Totals

Format: Collections Only Portfolio Grand Totals

Format: Collections Only Client and Portfolio Grand Totals
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Security Roles

To generate the Transaction Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Transaction Reports > Print Transaction Reports

System Preferences

The following system preference that affects this report is found in the Administration module, System
Preferences, Fields/screen behavior, Miscellaneous folder.

Preference Description

Calculate earnings
based on account
table flag

Set to True - All accounts flagged as an Earning Account in Tables > Accounting
> Account Table > Standard Tab > Earning Account check box will be included in
the calculation.

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Transaction report folder.

Preference Description

Collections selection
included adjustments

Set to True to include adjustments in Collections Only report.

Include medical
receivable balance

Set to True to display the last medical receivables balance on certain reports if
balance forward is also shown.

Place recourse fee in
fee column on pur-
chase summary

Set to True to include the recourse fee on the Purchase Summary report in the
Fee Amount column instead of the Recourse Amount column.
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Preference Description

Show balance for-
ward on purchases
and collections report

Set to True to display balance forward on the Purchases & Collections report.

Reports User Guide
SQL Reports

772 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Crystal (Legacy) Reports

Accounting Menu

Adjusted Fee Report

The Adjusted Fee Report displays a summary of adjusted fee rates per client, including terms, basis,
stated rate, floor rate, basis rate, minimum rate, maximum rate, adjusted rate, advance rated and
recourse days. The Report Template list displays any report template created to date. Select a template
from the list to generate a report based on its saved display parameters.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Use the Parameters tab to specify the report’s selection criteria.

Field Description

Client drop-down to select the client for which to run the report.
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Field Description

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is to
be generated. Click Clear to remove the selection.

Default Displays the default printer used to generate reports
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Field Description

Printer

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

As-of
date

Enter the applicable beginning date.

Output Select how you want to get the report:

l Preview – Opens the report in a window (printing available). If you select this option,
the report cannot be scheduled.

l Print – Prints the report without preview.

l Fax – Faxes the report directly to the client. For this option to work, a third-party fax
server solutions must be installed and set up in System Preferences.

l Email – Emails the report directly to the client.

Report Sample

System Preferences

The following system preferences for this report are set in the Administration module, System Preferences,
Reports, Adjustments Reports folder.

Preference Description

Crystal Reports mod-
ule name

Used to assign the crystal reports module a name for the Adjusted Fee Report.

Copies to print When the Print output method is selected, this preference sets the default num-
ber of copies to print.
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Preference Description

Preference printing
cover page

The WinFax cover page located in the common report directory to be used as a
Fax cover page when the Fax output method is selected.

Show explanation on
report

Determines whether or not the adjustment explanation is displayed on the
report.

Show invoice dispute
code on report

Determines whether any dispute code recorded for the invoice is displayed on
the report.

Buyout Calculation Report

This report provides a buyout summary of open invoices for selected clients over a specified date range.
The summary includes invoice dates, aging, amount, balances, escrow (rebate), fees, and a total buyout
amount.

This is an Engine-enabled report.

Report format options exist for the Buyout Calculation Report to separate monies from “other sources”
(e.g., Carrier Payments) from invoice balances. These other monies are shown in the Other Loan Amount
column. To use this format for the Client summary only, Breakout fees and escrow reserves report options,
set System Preference Reports, Buyout report, Crystal report module (with breakout and with summary) to
BUYOUTBS1. To use this format for the Client summary only report option only, set System Preference
Reports, Buyout report, Crystal report module (without breakout and with summary) to BUYOUTS1.

Note that the original BUYOUT-S and BUYOUT-BS formats include the “loans from other sources” in the
invoice balance totals.
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Field Description

Options Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As of
date

Select the ending date of the date range for the report. Choose Current date, Previous
month-end date, or specify a Specific date in the field to the right.

Portfolio
fees from

Select the starting date of the date range for the report to include Portfolio fees associated
with the accounts. . Choose Current date, Previous month-end date, or specify a Specific
date in the field to the right.

Client drop-down to select the client for which to run the report.
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Field Description

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.
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Field Description

Sort cli-
ent

Select the sort format for the results. You can sort the results by:

l Client name

l Client code

l A/E

l Group value

Group Selecting Group value in the Sort client field enables the Group field. Select the group value
by which to sort the results.

Output Select how you want to get the report:

l Preview – Opens the report in a window (printing available). If you select this option,
the report cannot be scheduled.

l Print – Prints the report without preview.

l Fax – Faxes the report directly to the client. For this option to work, a third-party fax
server solutions must be installed and set up in System Preferences.

l Email – Emails the report directly to the client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help.

Print cli-
ent sum-
mary
only

Select this check box to print summaries by client only, without specific invoice detail. If this
option is not selected, each invoice is listed per client.

Breakout
fee and
reserve
escrow

Select this option to print Fee Escrow and Reserve Escrow as separate columns on the
report.

Ignore cli-
ent non-
accrual
date

Select this option to calculate buyout based on payment date when the client has a non-
accrual date set in the Termination panel of the Client Information screen.
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Report Sample

Without Breakout Fee or Without Summary Format

With Breakout Fees and without Summary Format

Without Breakout Fees and with Summary Format
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Report Details

Column Description

Buyout A and Buyout-B A

Debtor Displays Debtor Name.

Invoice Number Displays Invoice number.

Invoice Date Date for the invoice.

Sch# Displays the batch # that Invoice was purchased on .

Funded Date Displays the date the Invoice was purchased/funded.

Invoice Amount Displays the Invoice Amount .

Age Displays the age of the invoice as determined by System Preference to be cal-
culated by Invoice Date, Purchase Date, or Due Date.

Balance Displays the Invoice balance.

Fee Escrow Displays the amount in Fee Escrow for the Invoice; calculated as the Invoice
Amount x Fee rate % in Client Terms.

Note: This is only calculated if the “Escrow fees?” box is checked.

Reserve Escrow Displays the amount in Reserve Escrow for the Invoice; calculated as the Invoice
Amount x Reserve Rate % in Client Terms.

Note: This is only calculated if the “Escrow fees?” box is checked.

Earned Fee Displays any calculated fee on the Invoice that is not a fee earned at the time of
purchase; this is typically a fee that is calculated based on Client Terms > Col-
lection Fee Table

Additional Fee Displays any calculated fee on the Invoice that is not a fee earned at the time of
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Column Description

purchase; this fee would be calculated based on Client Terms > Additional
fees and Additional Fee Type = Charge at collection.

Buyout Amount Displays the calculated buyout amount for each Invoice The Buyout Amount is
calculated as the Invoice Balance + (Earned Fee - Reserve Escrow)

Buyout-S A and Buyout-BS A

Client Displays Client Name.

Balance Displays the Invoice balance.

Rebates Displays the amount in Reserve Escrow for the Invoice; calculated as the Invoice
Amount x Reserve rate % in Client Terms

Note: This is only calculated if the “Escrow fees?” box is checked.

Earned Fee Displays any calculated fee on the Invoice that is not a fee earned at the time of
purchase; this is typically a fee that is calculated based on Client Terms > Col-
lection Fee Table

Additional Fee Displays any calculated fee on the Invoice that is not a fee earned at the time of
purchase; this fee would be calculated based on Client Terms > Additional
fees and Additional Fee Type = Charge at collection.

Invoice Buyout
Amount

Displays the calculated buyout amount for each Invoice The Buyout Amount is
calculated as the Invoice Balance + (Earned Fee - Reserve Escrow)

Statement Fee Displays the accrued statement fees as of the date the Buyout report is run
through; these fees are calculated on the Client Fee Statement

Cash Reserves Displays the balance in the Cash Reserves as of the date the Buyout report is
run through

Actual Buyout
Amount

Actual Buyout Amount = Invoice Buyout Amount - Cash Reserves

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Buyout report folder.

Preference Description

Always show grand Set this option to True to include grand total in the totals section of the report.
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Preference Description

total

Crystal Reports mod-
ule name

There are four Crystal Report module name preferences used to assign the
Crystal Reports module for the report.

l without breakout and without summary

l with breakout and without summary

l without breakout and with summary

l with breakout and with summary

Do not include float
days

Set this option to True to exclude float days from age and fee calculations.

Do not show cash
reserves

Set this option to True to exclude the display of cash reserves from the totals
section of the report.

Do not show state-
ment fees

Set this option to True to exclude the display of accrued statement fees from
the totals section of the report.

Include escrow trans-
fers

Set to True to include escrow transfers (invoice escrow - ledger escrow) on the
report.

Use old (non-API)
module

Old, out of date function will be used if this option is set to True.

Cash Posting Report

This report allows the user to print a summary of the Cash posted for a given date range.
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Field Description

Options Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Cash
Account

Select the Cash Account to which to limit the report, or leave this field blank to include all
Cash Accounts.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.
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Field Description

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Source Select a check source to which to limit the report, or leave this blank to include all defined
sources.

Batch Select a specific batch to which to limit the report, or leave this blank to include all batches.

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only
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Field Description

Date
range

Select the date range to use for the report from the list:

l Last month

l Current month-to-date

l Year thru last month date

l Specific date range

l Today

l Yesterday

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Select Choose the format for the Cash Report:

l Pending: cash that is currently pending will be printed in the report.

l Updated: cash that has been updated/processed will be printed in the report

Report Select the report format to be printed.

l Detail

l Summary

Show Select the view options for the report:

l Bank#: display the Bank number of the check, if available.

l Client: display the client name to whom the payment applies.

l Date: display the check date .

l Summary: include a summary section at the end of the detail report that sums the
Amount of Checks and Count of Checks for each Source, and provides the per-
centage of the grand total that Source represents.

Sequence Select the desired data sort order for the report
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Field Description

l Amount: sort by amount of payment lowest to highest

l Check#: sort by check number

l Check batch: sort by payment batch number.

l Client: sort by client name.

l Entry: Sort in the order that the checks were input into the system

l Payor: sort by payor name

Output Select how you want to get the report:

l Preview – Opens the report in a window (printing available). If you select this option,
the report cannot be scheduled.

l Print – Prints the report without preview.

l Fax – Faxes the report directly to the client. For this option to work, a third-party fax
server solutions must be installed and set up in System Preferences.

l Email – Emails the report directly to the client.

Report Sample

Detail Report

Summary Report
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Report Details

Column Description

Detail Report

Bank# Displays the Bank# entered on a Check when positing a payment batch

Check# Displays the Check number

Payor Displays the Payor on a Check

Client Displays the Client’s name

Check Date Display the date of the Check

Batch# Display payment batch number

Amount Displays the Amount of the check

Summary Report

Check# Displays the Check number

Source Displays the Check Source

Check Date Display the date of the Check

Amount Displays the Amount of the check

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Cash posting report folder.

Preference Description

Detail Crystal Reports Used to assign the crystal reports module a name for the Cash Posting Report,
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Preference Description

module name Detail report format.

Detail Crystal Reports
module name

Used to assign the crystal reports module a name for the Cash Posting Report,
Detail Summary format.

Use report server
cash posting report
form

Set to True to enable the Engine-enabled report screen.

Deferred Income Report

The Deferred Income Report provides a summary of specified client’s deferred refactoring fees.

Fields Description

Date
Thru

Allows a period ending date to be entered.

Click Today to display the current FactorSoft processing date or L-Month to display the last
day of the previous month in this field.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Fields Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Client
Croup

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Format Select the report format to be printed:

l Deferred Refactor Fees - Summary

l Deferred Refactor Fees - Detail

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This Select a printer from the drop-down list to overwrite the printer default for this report only.
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Fields Description

Report

Output Select how you want to get the report:

l Preview – Opens the report in a window (printing available). If you select this option,
the report cannot be scheduled.

l Print – Prints the report without preview.

l Fax – Faxes the report directly to the client. For this option to work, a third-party fax
server solutions must be installed and set up in System Preferences.

l Email – Emails the report directly to the client.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.

Earnings by State Analysis Report

The Earning by State Analysis Report located at Reports Module > Accounting > Earnings By State Ana-
lysis creates an Excel spreadsheet that lists all earnings for each state in alphabetical order along with
the Client name.

Field Description

Month/Year from Enter the beginning month and year for the report date range.

Month/Year thru Enter the ending month and year for the report date range.

List individual clients Select this option to list each client and the total of earnings by client within
each state. If this option is not selected, the report list the total earnings by state
without the client detail.

View spreadsheet Select this option to display the report result in Microsoft Excel when finished. If
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Field Description

when finished this option is not selected, the report is written to the report folder without being
displayed.

Process Click this button to generate the report.

Exit Click this button to close the screen without creating the report.

Report Sample

Report Details

Column Description

State Each State in the Client

Date Month and Year Selected

Total Total for each State

Security Roles

To generate the Earnings by State Analysis Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Accounting Reports > Earnings by State

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Earnings by State folder.

Preference Description

Folder for Completed
Excel Spreadsheets

Use this System Preference for the location of the Excel spreadsheets produced
when the Earnings by State Report is run. If no location is specified, the report is
saved in the root drive of the local computer.
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Financial Reports

The Print Financial Reports window is accessed through the Reports drop-down menu by first selecting
Accounting Reports and then selecting Financial Reports.

The program provides Financial Statements based upon all transactions that have been input into the sys-
tem. The Financial Reports will print financial statements in Balance Sheet, Profit & Loss, Income/Expenses
and Summary formats.

Field Description

Date Thru Allows period ending date to be entered. Click Today to display the current Fact-
orSoft processing date or L-Mont to display the last day of the previous month
in this field.

Office Select the office to which to limit the report results. If the user has an Office
restriction defined on the Manage Users screen in the Admin module, the user
will only be able to generate the report within that office restriction. When the
user generates a report, the office to which they are restricted will be selected in
the Office field by default and the user will not be able to change the Office field
when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table,
on the File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Reports Select the reports to be generated. Any or all reports can be generated. Each
report prints separately if more than one is selected.

l Balance Sheet - generates a report of assets and liabilities.

l G/A Expenses - generates the General and Administrative Expenses
Report

l Income/Earnings - generates the Statement of Income and Earnings

Default Printer Displays the default printer used to generate reports.

Reports User Guide
Crystal (Legacy) Reports

793 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm


Field Description

Change Default Click this button to assign a different printer as the default printer. This will
change the default printer for all reports.

This Report Select a printer from the drop-down list to overwrite the printer default for this
report only.

Output Select how you want to get the report:

l Preview – Opens the report in a window (printing available). If you select
this option, the report cannot be scheduled.

l Print – Prints the report without preview.

l Fax – Faxes the report directly to the client. For this option to work, a third-
party fax server solutions must be installed and set up in System Prefer-
ences.

l Email – Emails the report directly to the client.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.

Report Sample

Balance Sheet:
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G/A Expenses:

Income/Earnings:

Reports User Guide
Crystal (Legacy) Reports

795 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



System Preferences

The following system preference is found in the Administration module, System Preferences, Reports, Fin-
ancial reports folder.

Preference Description

Use old financial
report function

Select this option to use the older format Print Financial Report screen, which
does not contain the full selection criteria options.

The following system preference is found in the Administration module, System Preferences, Reports, Fin-
ancial reports, Statement of income & earnings folder.

Preference Description

Crystal Reports mod-
ule name

Used to assign the crystal reports module a name for the Statement of Income
and Earnings report.

Place a line under all
subtotals

Set this preference to true to underline subtotals in the report.

Hold Account Ledger

The Hold Account Ledgers Report displays details of selected client’s Hold Accounts, including item and
batch details, within a specified date range.
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Field Description

Date
Range

Enter the beginning date of the report date range. Click Today to display the current Fact-
orSoft processing date or MTD to display the beginning day of the previous month in this
field.

Thru Enter the ending date of the report date range. Click Today to display the current FactorSoft
processing date or MTD to display the ending day of the previous month in this field.

Account Select the account to which to limit the report. Only accounts marked as Hold Account on the
Hold Account tab of the Account Table screen are listed here.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.
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Field Description

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Format Select the report format to produce:

l Details in date range

l Open items thru date

l Summary

Sort Cli- Select the option to determine the order in which the report is sorted on clients:
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Field Description

ents By l Client name

l Client code

Sort
Detail By

Select the sort option that determines the order in which to sort the Open Items Thru Date
format within client:

l Post date

l Paid to/by

Output Select how you want to get the report:

l Preview – Opens the report in a window (printing available). If you select this option,
the report cannot be scheduled.

l Print – Prints the report without preview.

l Fax – Faxes the report directly to the client. For this option to work, a third-party fax
server solutions must be installed and set up in System Preferences.

l Email – Emails the report directly to the client.

Include
unpaid
checks

Select this option to include unpaid checks in the results. If this option is not selected, unpaid
checks are excluded from the results.

Each cli-
ent
starts on
a new
page

Select this option to print each client on a separate page(s). If this option is not selected, the
results can contain more than one client per page.

Wash
items
against
same
invoice

Select this option to close multiple items for the invoice to equal zero. This option is only avail-
able for the Open Items Thru Date format.

Print Click this button to generate the report.

Exit Click this button to close the screen without producing the report.
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Report Sample

Spreadsheet Reports

The Spreadsheet Report located at Reports Module > Accounting > Spreadsheet Report provides a sum-
mary of transactions per client within a specific date range.

Fields Description

Date
Range

Enter the beginning date of the report date range. Click Today to display the current Fact-
orSoft processing date or MTD to display the beginning day of the previous month in this
field.

Thru Enter the ending date of the report date range. Click Today to display the current FactorSoft
processing date or MTD to display the ending day of the previous month in this field.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
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Fields Description

s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Format Select the report format to produce:

l Detail

l Summary

Output Select how you want to get the report:

l Preview – Opens the report in a window (printing available). If you select this option,
the report cannot be scheduled.

l Print – Prints the report without preview.

l Fax – Faxes the report directly to the client. For this option to work, a third-party fax
server solutions must be installed and set up in System Preferences.

l Email – Emails the report directly to the client.

Include
Misc.

Select this option to include the Miscellaneous information column on the report.
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Fields Description

Column

Include
non-
factoring
clients

Select this option to include non-factoring client in the report results. If this option is not
selected, non-factoring clients are excluded for the report.

Print Click this button to generate the report.

Exit Click this button to close the screen without generating the report.

Report Sample

Report Details

Column Description

Name Client Name

Date Date

Source Source of the transaction, only available on Detail format.

Batch# The batch number of the transaction, only available on Detail format.

Check# The check number of the transaction, only available on Detail format.

A/R Amount A/R Amount

Settlement Escrow Amount in Settlement Escrow

Fee Escrow Fee Escrow Amount
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Column Description

Reserve Escrow Reserve Escrow Amount

Reserve Ledger Reserve Ledger Amount

Disbursed Amount Disbursed

Totals If all clients are selected, column totals are summarized for each client in the
report. The end of report will provide a total for all clients.

Trial Balance Report

The Trial Balance is a summary of daily transactions that affect the General Ledger.. There are a number
of feature variations to print this report.

Field Description

Date-
From

Enter the beginning date of the date range to which to limit the report.

l Click Today to display the current processing date in this field.

l Click L-Month to enter the previous beginning date of the month to date period in
Date Range and previous ending date of the month to date period in Thru.

l Click MTD to enter the current beginning date of the month to date period in Date
Range and current processing date in the Thru.

l Click YTD to enter the current beginning date of the year to date period in Date Range
and current processing date in the Thru.

Thru Enter the ending date of the date range to which to limit the report.

Client drop-down to select the client for which to run the report.
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Field Description

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

G/L
Group

Select a G/L Group to which to limit the report, or leave this field blank to include all G/L
Groups. Click Clear to remove the selection.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is to
be generated. Click Clear to remove the selection.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.
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Field Description

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Account Select the account to which to limit the report. The accounts are defined in the Accounts
table. Click Clear to remove the selection.

Format Select the report format to be printed:

l Detail as Account/Date/Check#

l Detail as Account/Check#/Date

l Summarize to Account

l Summarize to Account/Client

l Summarize to Account/Date/Source

l Summarize to Date/Account/Source

Convert
to native
currency

Select this option to convert amounts from the base currency to the native currency (the cur-
rency of the transaction). The conversion occurs on a client-by-client basis. If the client has
a currency type set and the currency type is different from the default currency, FactorSoft
looks up the conversion rate using the As of date in the currency table for the client's cur-
rency. For example, if client ABC Company has a currency type of Canadian Dollars and the
daily conversion rate for Canadian dollars is 1.5, the report increases all of the client's
amounts by a factor of 1.5.

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Output Select how you want to get the report:
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Field Description

l Preview – Opens the report in a window (printing available). If you select this option,
the report cannot be scheduled.

l Print – Prints the report without preview.

l Fax – Faxes the report directly to the client. For this option to work, a third-party fax
server solutions must be installed and set up in System Preferences.

l Email – Emails the report directly to the client.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.

Sample Reports

Detail as Account/Check#/Date
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Detail as Account/Date/Check#
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Summarize to Account
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Summarize to Account/Client
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Summarize to Account/Date/Source
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Summarize to Date/Account/Source
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Report Details

Column Description

Formats: Detail as Account/Date/Check# or Detail As Account/Check#/Date

Account# Account Number

Check # Check Number

Date Post Date

Payee Payee on Posted Check or Client Name

Client# Client Code

Source Transaction Type

Reference Batch Number

Beginning Balance Beginning Balance on the Account

Debit Amount Debits to the Account

Credit Amount Credit to the Account

Ending Balance Ending Balance on the Account

Format: Summarize to Account

Account # Account Number

Beginning Balance Beginning Balance on the Account

Debit Amount Debits to the Account

Credit Amount Credit to the Account

Ending Balance Ending Balance on the Account

Format: Summarize to Account/Client

Account # Account Number

Client Client’s Name

Beginning Balance Beginning Balance on the Account

Debit Amount Debits to the Account

Credit Amount Credit to the Account
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Column Description

Ending Balance Ending Balance on the Account

Format: Summarize to Account/Date/Source

Account # Account Number

Client Client’s Name

Source Transaction Type

Beginning Balance Beginning Balance on the Account

Debit Amount Debits to the Account

Credit Amount Credit to the Account

Ending Balance Ending Balance on the Account

Format: Summarize to Date/Account/Source

Date Date

Account # Account Number

Client Client’s Name

Source Transaction Type

Debit Amount Debits to the Account

Credit Amount Credit to the Account

Security Roles

To generate the Trial Balance Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Accounting Reports > Print Trial Balance Reports

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Trial balance folder.

Preference Description

Do not include client number with client
name

Set to True to exclude the client number from the report res-
ults.
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Preference Description

Get cash reserves starting balance from
client

Set to True to take initial client cash reserve balances from
Client record instead of Client Account record.

Include inactive clients in drop-down list Set to True to include inactive clients in the Client report cri-
teria selection list.

Non-balance sheet accounts are year-
to-date

True or False

Show zero amounts in the report column Set to True to show zero amounts in columns. Set to False to
replace the “$0.00” displayed in columns cells that have no
balance with blanks.

Use old trial balance function Set this option to True to use the old format Trial Balance
Report screen.

Use account summary balances not cli-
ent balances

True or False

Analysis Report

Analysis Reports

The Analysis reports group contains reports that summarize or detail statistical reports by client or debtor.

A/R Summary Report

The A/R Summary Report is a summary of the accounts receivable totals and transactions. The inform-
ation displayed includes Beginning Balances, Sales, Collections, Charge-backs, Adjustments, Ending Bal-
ances, Earning, Non-factored Cash, Accounts Receivable Turn, Collection Ratio, Beginning Reserve
Balances, Reserve Activity, Ending Reserves and Grand Totals for each category.

The Analysis option (of which there are three possibilities) determines the displayed results. The method
of each analysis calculation varies, so keep in mind which one you have chosen. Different calculation
methods provide different meanings, and the actual numbers will vary accordingly.
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Field Description

Date
Range

Enter the beginning date of the date range to which to limit the report.

l Click Today to display the current processing date in this field.

l Click L-Month to enter the previous beginning date of the month to date period
in Date Range and previous ending date of the month to date period in Thru.

l Click MTD to enter the current beginning date of the month to date period in
Date Range and current processing date in Thru.

Thru Enter the ending date of the date range to which to limit the report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set
to True.

Select the magnifying glass icon to open the Search window and begin typ-
ing the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report,
or leave blank to include all users. When a user is selected, the report is limited to cli-
ents that have that user selected in the A/E field on the Control panel of the Client
Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the
following System Preference:

l Terminology > Select account executive based on check box: TRUE

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To
access this table, on the File menu, click Tables. Then, on the Client & Debtor menu,
click Client Group Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this
report is to be generated. Click Clear to remove the selection.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report
only.

Output Select how you want to get the report:
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Field Description

l Preview – Opens the report in a window (printing available). If you select this
option, the report cannot be scheduled.

l Print – Prints the report without preview.

l Fax – Faxes the report directly to the client. For this option to work, a third-party
fax server solutions must be installed and set up in System Preferences.

l Email – Emails the report directly to the client.

Format Select the report format to be generated:

l A/R, Earnings Only: The column will adjust and show Earnings Only

l A/R, Earnings Cash Reserves: The column will adjust and show Earnings and
Cash Reserves Activity

l A/R, Non-Factored, Cash Reserves: The column will adjust and show Non
Factored Cash and Cash Reserves Activity

l A/R, Sales, Applied, Cash Reserves, Earnings: Sales, applied cash, cash reserves,
and earnings will be displayed on the report.

l A/R, Fee, Interest Income: The column will adjust and show Fee and Interest
Income activity.

l A/R, Y-T-D Fee, Interest Income: The column will adjust and show Year-To-Date
Fee and Interest Income activity.

l A/R, Sales, Applied, Cash Reserves: The column will adjust and show Sale,
Applied Cash and Cash Reserves.

Sort Select the sort order for the results. You can sort the results by:

l Name

l Client#

Analysis
Column

Select the analysis method for the report:
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Field Description

l Collection Ratio (Collections / Beginning Balance *100): The Collection Ratio is a
percentage of collections related to the beginning month’s outstanding bal-
ance.

l Collection Ratio (Based on business days): The Collection Ratio is a percentage
of the collection base on the total number of business days of the outstanding
balance.

l A/R Turn ((Beginning Balance / Collections) *Days): The Accounts Receivable
Turn is reflected in days, the average number of days for Accounts Receivable
collection (i.e. the average number of days to pay).

Show
zero
activity
active
clients

Include active clients that have no activity or a zero balance in A/R yet have cash in
reserves on the report. If this option is not selected, zero-activity active clients are
excluded form the report.

Show
grand
total
only

The results display a summary total only.

Include
non-
Fact-
oring cli-
ents

Select this option to include non-factoring clients in the report results. If this option is
not selected, non-factoring clients are excluded for the report.

Include
non-
zero
inactive
clients

Include inactive clients that have cash in A/R or reserves on the report. If this option is
not selected, non-zero inactive clients are excluded form the report.

Print Click this button to generate the report.

Exit Click this button to close the screen.

Sample Report

A/R, Earning Only Format
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A/R, Earnings, Cash Reserves Format

A/R, Non-Factored, Cash Reserves Format

A/R, Fee, Interest Income Format

A/R, Y-T-D Fee, Interest Income Format
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A/R, Sales, Applied Cash, Cash Reserves Format

Report Details

Column/Label Description

Client Client’s Name

Format: A/R, Earnings, Only

Beginning Balance Beginning A/R Balance for the Date Range of the report

Sales New Sales or A/R for the Date Range of the report

Collections Collections or Payments posted for the Date Range of the report

Chargebacks Chargebacks processed for the Date Range of the report

Adjustments Adjustments processed for the Date Range of the report

Ending Balance Ending Balance = Beginning Balance + Sales - Collections + Chargebacks + Adjust-
ments

Earnings Earnings for the Date Range of the report

Collection Ratio Collection Ratio calculation based on Analysis Column parameter selected.

Format: A/R, Earnings, Cash Reserves
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Column/Label Description

Beginning Balance Beginning A/R Balance for the Date Range of the report

Sales New Sales or A/R for the Date Range of the report

Collections Collections or Payments posted for the Date Range of the report

Chargebacks Chargebacks processed for the Date Range of the report

Adjustments Adjustments processed for the Date Range of the report

Ending Balance Ending Balance = Beginning Balance + Sales - Collections + Chargebacks + Adjust-
ments

Earnings Earnings for the Date Range of the report

Collection Ratio Collection Ratio calculation based on Analysis Column parameter selected.

Beginning
Reserves

Beginning Cash Reserves Balance for the Date Range of the report

Reserve Activity Reserve Activity for the Date Range of the report

Ending Reserves Ending Reserves = Beginning Cash Reserves Balance + Reserve Activity

Format: A/R, Non-Factored, Cash Reserves

Beginning Balance Beginning A/R Balance for the Date Range of the report

Sales New Sales or A/R for the Date Range of the report

Collections Collections or Payments posted for the Date Range of the report

Non-Factored Non-Factored payments posted for the Date Range of the report

Chargebacks Chargebacks processed for the Date Range of the report

Adjustments Adjustments processed for the Date Range of the report

Ending Balance Ending Balance = Beginning Balance + Sales - Collections - Non-Factored +
Chargebacks + Adjustments

Collection Ratio Collection Ratio calculation based on Analysis Column parameter selected.

Beginning
Reserves

Beginning Cash Reserves Balance for the Date Range of the report

Reserve Activity Reserve Activity for the Date Range of the report
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Column/Label Description

Ending Reserves Ending Reserves = Beginning Cash Reserves Balance + Reserve Activity

Format: A/R, Sales, Applied, Cash Reserves, Earnings

Beginning Balance Beginning A/R Balance for the Date Range of the report

Sales New Sales or A/R for the Date Range of the report

Collections Collections or Payments posted for the Date Range of the report

Non-Factored Non-Factored payments posted for the Date Range of the report

Chargebacks Chargebacks processed for the Date Range of the report

Adjustments Adjustments processed for the Date Range of the report

Ending Balance Ending Balance = Beginning Balance + Sales - Collections - Non-Factored +
Chargebacks + Adjustments

% Total End Bal-
ance

Earnings Earnings for the Date Range of the report

Collection Ratio Collection Ratio calculation based on Analysis Column parameter selected.

Beginning
Reserves

Beginning Cash Reserves Balance for the Date Range of the report

Reserve Activity Reserve Activity for the Date Range of the report

Ending Reserves Ending Reserves = Beginning Cash Reserves Balance + Reserve Activity

Format: A/R, Fee, Interest Income

Beginning Balance Beginning A/R Balance for the Date Range of the report

Sales New Sales or A/R for the Date Range of the report

Collections Collections or Payments posted for the Date Range of the report

Chargebacks Chargebacks processed for the Date Range of the report

Adjustments Adjustments processed for the Date Range of the report

Ending Balance Ending Balance = Beginning Balance + Sales - Collections + Chargebacks + Adjust-
ments
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Column/Label Description

Fee Income Income from Fee earned for the Date Range of the report

Interest Income Income from Interest earned for the Date Range of the report

Beginning
Reserves

Beginning Cash Reserves Balance for the Date Range of the report

Reserve Activity Reserve Activity for the Date Range of the report

Ending Reserves Ending Reserves = Beginning Cash Reserves Balance + Reserve Activity

Format: A/R, Y-T-D Fee, Interest Income

Accounts Receiv-
ables

Beginning Balance, Current Activity and Ending Balance for Accounts Receivable
for the Date Range of the report

Cash Reserves Beginning Balance, Current Activity and Ending Balance for Cash Reserves for the
Date Range of the report

YTD Fee Income Beginning Balance, Current Activity and Ending Balance for YTD FEE Income for the
Date Range of the report

YTD Interest
Income

Beginning Balance, Current Activity and Ending Balance for YTD Interest Income for
the Date Range of the report

Format: A/R, Sales, Applied, Cash Reserves

Beginning Balance Beginning A/R Balance for the Date Range of the report

Sales New Sales or A/R for the Date Range of the report

Paid to Invoices Payments posted against Invoices for the Date Range of the report

Paid to Non-
Invoices

Payments posted against Non-Factored Invoices for the Date Range of the Report

Recourse C/B Chargebacks on Recourse Invoices for Date Range of the report

Other C/B Chargebacks on other invoices for the Date Range of the Report

Adjust Adjustments processed for the Date Range of the report

Ending Balance Ending Balance = Beginning Balance + Sales - Paid to Invoices - Paid to Non-
Invoices + Recourse C/B + Other C/B + Adjust

Beginning
Reserves

Beginning Cash Reserves Balance for the Date Range of the report
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Column/Label Description

Escrow Returned Reserve Escrow posted to the Cash Reserves for the Date Range of the report

Non-Factored Non-Factored posted to the Cash Reserves for the Date Range of the report

Reserve Release Reserve Released from the Cash Reserves

Other Activity Other Activity posted against the Cash Reserves for the Date Range of the report.

Ending Reserves Ending Reserves = Beginning Reserves + Escrow Returned + Non-Factored -
Reserve Release + Other Activity

Security Roles

To generate the A/R Summary Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > A/R Summary Report

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Trial balance folder.

Preference Description

A/R Turn collections
should not contain
non-factored

Set to True to exclude non-factored payments from collections in the cal-
culation.

Earnings should
include taxes

Set to True to include taxes in Earnings columns.

Include bulk A/R val-
ues

Set to True to include bulk A/R collateral in the AR balance totals.

Include medical
receivables values

Set to True to include medical receivables values in the report.

Sales/applied/cash
reserves/earnings
module name

Assign the Crystal Reports module for the report.

Use old report logic Set this option to True to use the old format Print A/R Summary Report screen.
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Funds Employed Summary Report

The Print Funds Employed Summary report lists comprehensive information about the total amount of
monies that are currently employed, extended, or lent for clients. Information provided includes current
outstanding balance, unapplied payments, total invoices outstanding, the amounts advanced, the
amounts in reserve accounts.

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the account executive to which to limit the report results from the list. Click Clear to
remove the selection.

Office Select the office to which to limit the report results. If the user has an Office restriction
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Field Description

defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Group/Valu-
e

Select the client group and the specific client group value to which to limit the report res-
ults from the list. Client Groups are defined in the Group Code Table.

As Of Date Enter the date through which to display funds employed data. This field displays the cur-
rent FactorSoft processing date by default.

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This Report Select a printer from the drop-down list to overwrite the printer default for this report only.

Output Select one of the following print output options from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Format Select the report format to be generated:

l Totals escrow, cash reserves: Lists A/R Balance, Unapplied Payments, Invoices Out-
standing, Amount Escrowed, Advanced, Cash Reserves and total Funds Employed
for each client.

l Fee & reserve escrow, cash & total reserves: Same as above, with the addition of
Fee Escrowed and Total Reserves (Cash Reserves minus Reserve Escrowed).

Include
non-Fact-
oring clients

Select this option to include non-factoring client in the report results. If this option is not
selected, non-factoring clients are excluded for the report.
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Field Description

Include
non-zero
inactive cli-
ents

Include inactive clients that have cash in A/R or reserves on the report. If this option is not
selected, non-zero inactive clients are excluded form the report.

Print Click this button to generate the report.

Exit Click this button to close the screen.

Sample Report

Format: Total escrow, cash reserves

Format: Fee & reserve escrow, cash & total reserves

Report Details

Column Description

Client Client’s Name

Client# Client Code

Format: Total escrow, Cash Reserves

A/R Balance A/R Balance

Unapplied Payments Payments associated with a Non-Factored Invoices

Invoices Outstanding Invoices Outstanding = A/R Balance + Unapplied

Reports User Guide
Crystal (Legacy) Reports

830 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Column Description

Payments

Amount Escrowed Amount held in Escrow (Fees or Reserves)

Advanced Amount Advanced to the Client

Cash Reserves Cash Reserves Balance

Loan Amount Net Fund Employed

Format: Fee & reserve escrow, cash & total reserves

A/R Balance A/R Balance

Unapplied Payments Payments associated with a Non-Factored Invoices

Invoices Outstanding Invoices Outstanding = A/R Balance + Unapplied
Payments

Fee Escrowed Amount held in Fee Escrow

Reserve Escrowed Amount Held in Reserve Escrow

Advanced Advanced = Invoices Outstanding - Reserve
Escrowed

Cash Reserves Cash Reserves Balance

Total Reserves Total Reserves = Cash Reserves + Reserve Escrowed

Funds Employed Net Funds Employed

To modify the column header from Funds Employed
to Loan Amount go to System Preferences >
Reports > Fund Employed summary > Use loan
amount for funds Employed

Security Roles

To generate the Funds Employed Summary Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print funds employed summary reports

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Funds employed summary folder.
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Preference Description

Include bulk A/R val-
ues

Set to True to include Bulk A/R collateral in the AR balance totals.

Include hold account
balances flagged as
NFE

Determines how NFE hold account balances are included in the report:

l Include in funding and unapplied payment columns

l Include in funding and reserve escrow columns

l Include in funding and cash reserve columns

l Include in funds employed column only

l Do not include the hold account balance in any column

Note - Funding indicates the Funds Employed/Loan Amount Column

Include inactive cli-
ents in drop-down list

Set to True to include clients marked inactive in the Client list field.

Include medical
receivables values

Set to True to include medical receivables values in the report.

Use loan amount for
funds employed

Set to True to use the loan amount as funds employed instead of the cal-
culated funds employed value.

Guarantee Analysis Report

The Guarantee Analysis Report provides a versatile summary of Guaranteed Sales versus Actual sales for
specified clients up to a certain date. This report includes funded and non-funded sales, but a system
preference can specify that the report includes only funded invoices.

Fields Description

Date Allows a period ending date to be entered. Click Today to display the current FactorSoft pro-

Reports User Guide
Crystal (Legacy) Reports

832 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Fields Description

Thru cessing date or L-Month to display the last day of the previous month in this field.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Client
Croup

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.
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Fields Description

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Format Select the report format to be printed:

1. Guaranteed Sales Versus Actual (Average by month)

2. Guaranteed Sales Versus Actual (not averaged)

3. Guaranteed Earnings Versus Actual (Average by month)

4. Guaranteed Earnings Versus Actual (Thru date in month)

Show
adjusted
rates

Select this option to display adjusted rates on the report. This option is only available for the
two Guaranteed Sales Versus Actual formats.

Sort by
broker

Select this option to sort the records returned for the report by broker.

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.
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Sample Report

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Guarantee Analysis.

Preference Description

Exclude journals Set to True to exclude fees earned from journals from the report.

Exclude non-funded
sales

Set to True to exclude non-funded sales from the period sales figures.

Include date signed
on report

Set to True to include the client date signed on the report.

Report to member cli-
ent

Set to True to accumulate the report to member clients instead of mas-
ter clients

Merchant Analysis Report

The Merchant Analysis Report provides a financial trend overview for specified clients over a defined
period of time. This is an Engine-enabled report.

The Merchant Trend Analysis generates data for the prior 12 months from the last Statement Date.
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Field Description

Options Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.
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Field Description

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Report Select the report format to be printed:

l Merchant Trend Analysis

l Merchant Activity Report

l Merchant Profit Statement

Combine
multiple
periods
into aver-
age
report

Select this option to average balances over time.

As of
date

Select the date to use for the report from the list:
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Field Description

l Current date

l Specific dates

l Month-to-date

l Year-to-date

If the Specific dates option is selected, enter the beginning as of date to which to limit the
report in the adjacent fields.

Output Select one of the following print output options from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Folder to generate the report as a data file in the common reports folder.

Report Sample

Format: Merchant Trend Analysis
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Format: Merchant Activity Report

Format: Merchant Profit Statement
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Report Details

Column Description

Report: Merchant Trend Analysis

Statement
Date

Merchant Statement Date

'# of Invoices
Purchased

Number of Invoices Purchased

'# of CR
Memos

Number of Credit Memos

'# of
Chargebacks

Number of Chargebacks

Invoices
Purchased
(000’s)

Amount of Invoices Purchased

Payments
Received
(000’s)

Amount of Payments Posted

Amt. of CR Amount of Credit Memos
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Column Description

Memos (000’s)

Amt. of
Chargebacks
(000’s)

Amount of Chargebacks

Avg Daily Bal-
ance (000’s)

Amount of the Client’s Average Daily Balance

A/R Turn
(days)

Displays A/R Turn days

Average
Invoice Size ($)

Amount of Average Invoice Size

CR Memos as
% of Invoices $

Amt of CR Memos / Invoices Purchased * 100

Chargebacks
as % of
Invoices

Amt of Chargebacks / Invoices Purchased * 100

Delinquency Analysis Section

Current (1-30
days)

% of A/R aged 1-30 days based on Due Date

31-60 days % of A/R aged 31-60 days based on Due Date

61-90 days % of A/R aged 61-90 days based on Due Date

91-120 days % of A/R aged 91-120 days based on Due Date

Over 120 days % of A/R aged Over 120 days based on Due Date

High Concentration Customers Section

Customer
Name

Customer/Debtor Name

Balance Debtor Current Balance

% of Mer-
chant’s Total
Balance

Debtor Balance / Clients Total A/R
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Column Description

Last Period --

Report: Merchant Activity Report

Beginning Bal-
ance

Client’s Beginning A/R Balance

Debits > Count & Amount

Sales Count & Amount of New A/R Purchased

Finance
Charges

Count & Amount of Finance Charges

Total Debits Amount of Sales + Amount of Finance Charges

Credits > Count & Amount

Payments Count & Amount of Payments Posted

Credit Memos Count & Amount of Credit Memos Posted

Chargebacks Count & Amount of Chargebacks Processed

Total Credits Amount of Payments + Amount of Credit Memos + Amount of Chargebacks

Total Number
of Transactions

Total Count of All Transactions (Sales, Finance Charges, Payments, Credit Memos,
Chargebacks)

Ending Bal-
ance

Beginning Balance + Total Debits - Total Credits

Total Batches Total number of Batches Processed

Total New Cus-
tomers

Total number of New Customer/Debtors Created

Report: Merchant Profit Statement

Average Out-
standing Bal-
ance

Average Outstanding Balance = Daily balance / Number of days in the reporting
period for a single month report.

When the report is generated for multiple-months period, Average Outstanding Bal-
ance is the Sum of Daily Balance / Number of days in the reporting period.

Sales for Period Purchases/Sales for the Statement Period for the report
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Column Description

Annual Sales
(Based on 12
months)

Annual Purchases/Sales based on 12 months with the calculation method selected in
System Preferences > Reports > Merchant Analysis Reports > Profit Statement > Cal-
culate annual sales method

Number of
Invoices for
Period

Number of Invoices Purchased for the Statement Period

Broker Fee
Required

If Yes, Broker Commissions/Fees are required for Statement Period

Average A/R
Turn

Average A/R Turn = Avg O/S Balance / (Sales for period / Reporting Periods))*30

Base Discount Rate is established at Client Terms > Merchant Fees > Purchase Fee Rate

Revenue/Expense = Sales for Period * Base Discount Rate

Yield = Revenue/Expense / Avg Outstanding Balance

Annualized
Yield

Yield = Base Discount Yield * 12

Self Insurance Rate - set in System Preferences > Reports > Merchant Analysis Reports > Profit
Statement > Self insurance rate

Revenue/Expense = Sales for Period * Self Insurance Rate

Yield = Revenue/Expense / Avg Outstanding Balance

Labor Rate - set in System Preferences > Reports > Merchant Analysis Reports > Profit
Statement > Labor Rate

Revenue/Expense = Sales for Period * Labor Rate

Yield = Revenue/Expense / Avg Outstanding Balance

Cost of Funds Rate - set in System Preferences > Reports > Merchant Analysis Reports > Profit State-
ment > Cost of funds rate

Revenue/Expense Sales for Period * Cost of Funds

Yield Revenue/Expense/Avg Outstanding Balance

Base Discount
(Sub Total

Rate Sum of Base Discount, Self Insurance, Labor & Cost of funds
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Column Description

Row) Revenue/Expense Sum of Base Discount, Self Insurance, Labor & Cost of funds

Yield Sum of Base Discount, Self Insurance, Labor & Cost of funds

Transaction
Premium

Rate - set in System Preferences > Reports > Merchant Analysis Reports > Profit
Statement:

1. Transaction Premium Amount #1

2. Transaction Premium Amount #2

3. Transaction Premium rate #1

4. Transaction Premium rate #2

5. Transaction Premium rate #3

Revenue/Expense = Sale for period * Transaction Premium

Yield = Revenue/Expense / Avg Outstanding balance

Broker Fee Rate - Broker’s Commission Rate from Client/Broker Relationship for the Statement
Period

Revenue/Expense = Sales for Period * Broker Commission Rate

Yield = Revenue/Expense / Avg Outstanding Balance

Total Discount Total Discount Rate = Sum of all Rates

System Preferences

The following system preferences for the Merchant Activity report are found in the Administration module,
System Preferences, Reports, Merchant Analysis, Activity Report.

Preference Description

Crystal Report Module Used to assign the crystal reports module name for the Merchant Activity
Report.

The following system preferences for the Merchant Profit Statement report are found in the Administration
module, System Preferences, Reports, Merchant Analysis, Profit statement.

Preference Description

Calculate annual Indicates the method for calculating annual (12 month) sales:
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Preference Description

sales method - Based on last 12 months regardless of months selected

- Based on sales for period extended to 12 months

Cost of funds rate The rate for cost of funds used in the report

Crystal Report Module Used to assign the crystal reports module name for the Merchant Profit State-
ment report.

Labor Rate The labor rate to be multiplied times the base discount to use for the report.

Self insurance rate The rate for self-insurance used in the report.

Transaction premium
amount #1

First premium amount

Transaction premium
amount #2

Second premium amount

Transaction premium
rate #1

The rate to be used for transaction premium if equal to or less than Transaction
Premium amount #1.

Transaction premium
rate #2

The rate to be used for transaction premium greater than amount #1 and equal
to or less than Transaction Premium amount #2.

Transaction premium
rate #3

The rate to be used for transaction premium if greater than Transaction
Premium amount #2.

The following system preferences for the Merchant Activity report are found in the Administration module,
System Preferences, Reports, Merchant Analysis, Trend analysis.

Preference Description

Do not suppress zeros
in spreadsheet

Set to True to display zero fields as zeros on the report, rather than
blanks.

Folder for completed
Excel spreadsheet

Enter the folder name on the local computer in which to save the report
for the Folder Output option.

Treat reassignments
as chargebacks

Reassignments taken on the statement are included in the count and
amount of chargebacks.
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Not Payable to Lender Report

This report displays a summary of the checks not paid to the lender. The client and debtor name will dis-
play along with the check date, check number, check amount, balance, credit limit, NOA status, checks
received and how many checks were not paid to the lender.

Field Description

Date-
From

Enter the beginning date of the date range to which to limit the report.

l Click Today to display the current processing date in this field.

l Click L-Month to enter the previous beginning date of the month to date period in
Date Range and previous ending date of the month to date period in Thru.

l Click MTD to enter the current beginning date of the month to date period in Date
Range and current processing date in the Thru.

l Click YTD to enter the current beginning date of the year to date period in Date Range
and current processing date in the Thru.

Thru Enter the ending date of the date range to which to limit the report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is
to be generated. Click Clear to remove the selection.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.
>

Sequence Select the sort sequence for the report data:

l AE, Client, Debtor

l Client, Debtor

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.
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Field Description

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Trial balance folder.

Preference Description

Include check source
on report

Set to True to include the check source on the report results.

Select based on Select the date to be used to select checks to report:

l Check Date

l Transaction posting date
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Report Sample

Over Escrow Report

The Over Escrow report provides a summary of selected client's escrow standings, listing the total bal-
ance, invoice age balance, escrow balance, over escrow, cash reserves, total reserves and over total.

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is to
be generated. Click Clear to remove the selection.

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Invoice
Age

Enter the age of the report. Maximum length is 3 digits.

Format Currently, the Over Escrow Report is the only format option.

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.
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Field Description

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Show
zero cli-
ent

Select this option to include zero balance clients in the report.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.
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Sample Report

Report Details

Column Description

Client Client Name

Total Bal-
ance

Total A/R Balance

"0" Day Bal-
ance

Column label will change based on Report Parameter: Invoice Age, then column displays
Invoice Balance Over Age

Escrow Bal-
ance

Fee Escrow + Reserve Escrow
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Column Description

Over
Escrow

Client Summary > Funds Employed tab > Advanced Balance

Cash
Reserves

Current Cash Reserves Balance

Total
Reserves

Cash Reserves + Escrow Balance

Over Total Client Summary > Funds Employed tab > Factoring NFE

Security Roles

To generate the Over Escrow Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print over escrow reports

Sales By Country Spreadsheet Report

The Sales by Country Spreadsheet report creates a spreadsheet in MicroSoft Excel format that lists clients
with sales by country and province or state. The clients listed can be filtered by selection criteria specified
on the report screen.

There is an option to exclude from the sales total invoices that are in dispute by specific dispute codes. To
exclude specific dispute codes from the sales total, in the Tables module, select the option: Mark as
excluded on Sales by Country/Client on the Dispute/Ineligibility/No Buy Codes table.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
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Field Description

menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Date
Range

Select the date to use for the report from the list:

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

l Today only

If the Specific Date Range is selected, enter the beginning and ending dates to which to limit
the report in the adjacent fields.

Sample Report

Tab 1
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Tab 2

Tab 3

Report Details

Column Description

Tab 1: Country-State-Due Days
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Column Description

Country Client’s Country setting on the Client Information > Address Panel

Client Client Name

Debtor
Province/State

Debtor’s Province/State

Term Payment Terms - Due Days

Total Sales Total Amount of Invoices/Sales

Excluded
Amount

Total Amount of any and all invoices that have a Dispute/Ineligibility/No Buy Code
that has “Mark as Excluded on Sales by Country/Client”

Included - Tax
Amount

Total Amount of Tax amount that is part of the included Sales.

= Net Sales Total Sales - Excluded Amount - Tax Amount = Net Sales

Tab 2: Country-State

Country Client’s Country setting on the Client Information > Address Panel

Client Client Name

Debtor
Province/State

Debtor’s Province/State

Total Sales Total Amount of Invoices/Sales

Excluded
Amount

Total Amount of any and all invoices that have a Dispute/Ineligibility/No Buy Code
that has “Mark as Excluded on Sales by Country/Client”

Included - Tax
Amount

Total Amount of Tax amount that is part of the included Sales.

= Net Sales Total Sales - Excluded Amount - Tax Amount = Net Sales

Tab 3: Country

Country Client’s Country setting on the Client Information > Address Panel

Client Client Name

Total Sales Total Amount of Invoices/Sales

Excluded Total Amount of any and all invoices that have a Dispute/Ineligibility/No Buy Code

Reports User Guide
Crystal (Legacy) Reports

857 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Column Description

Amount that has “Mark as Excluded on Sales by Country/Client”

Included - Tax
Amount

Total Amount of Tax amount that is part of the included Sales.

= Net Sales Total Sales - Excluded Amount - Tax Amount = Net Sales

Security Roles

To generate the Sales by Country Spreadsheet, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Sales by Country Spreadsheet

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Sales by Country Spreadsheet

Preference Description

Break terms on value
(Default is 90)

Indicate the number to group Terms up to and after .

Sales Volume Report

The Sales Volume Report displays sales volumes by month, quarter, and year, sorted by state.

This is an Engine-enabled report.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

State Enter the State Code (50 United States only) to which to limit the report results.
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Field Description

Thru
Date

Allows a period ending date to be entered. Click L-Mo-End to display the last day of the pre-
vious month in this field.

Broker Select the broker to which to limit the report results from the list. Click Clear to remove the
selection. Leaving this field blank will include all brokers in the results.

Sort Select the sort option that determines the order in which to sort the report.

l Client

l State

l Broker

l YTD charges

Output Select one of the following print output options from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Sample Report

Security Roles

To generate the Sales Volume Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print Sales Volume Reports (crystal)

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Sales volume report folder.
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Preference Description

Show client number
before client name

Set to True to display the client number before the client name in the report.
The client name is listed first by default.

Include inactive cli-
ents in drop-down list

Set to True to include clients marked inactive in the Client list field.

Include master cli-
ents in drop-down list

Set to True to include master clients in the Client list field.

Signed Analysis Report

This report prints a summary of date signed and financial information for clients within a specified date
range. The client name, signed date, average balance, average funds, sales and earnings are printed on
the report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
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Field Description

Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Client
signed
from

Enter the beginning client-signed date for the clients to be included on the report.

Thru Enter the ending client-signed date for the clients to be included on the report.

Show
data
from

Enter the beginning date for the data to be included on the report.

Thru Enter the ending date for the data to be included on the report.

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Report Sample
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Statistics by Region Report

This report displays a summary of invoice purchase and collection statistics by region. The ter-
ritory/region/client, amount purchased, amount collected, amount adjusted, fees earned, average
invoice, number buys, number invoices, number checks, number payments and number adjustments are
listed on this report.

Field Description

Date Range Enter the beginning date of the report date range. Click Today to display the
current FactorSoft processing date or MTD to display the beginning day of the
previous month in this field.

Thru Enter the ending date of the report date range. Click Today to display the cur-
rent FactorSoft processing date or MTD to display the ending day of the pre-
vious month in this field.

Territory Select the territory to which to limit the report results. Territories are defined in
the Territory Name Table in FactorSoft. Click Clear to remove the current setting.

Default Printer Displays the default printer used to generate reports.

Change Default Click this button to assign a different printer as the default printer. This will
change the default printer for all reports.

This Report Select a printer from the drop-down list to overwrite the printer default for this
report only.

Output Select one of the following print output options from the drop-down list:
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Field Description

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Format Select the report format to produce:

l Detail: include client detail entries

l Summary: include summary totals by region only.

Report Sample

Summary Format

Detail Format
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Report Details

Column Label Description

Format: Detail

Territory/Region/Client… Displays the Territory, Region and Client Name

Territories are defined in the Territory Name Table Maintenance under
the Client & Debtor Menu in Tables Module.

Regions are defined in the Region Table under the Client & Debtor Menu
in Tables Module.

Amount Purchased Displays Amount Purchased in $ for each Client, and by Region and Ter-
ritory

Amount Collected Displays Amount Collected in $ for each Client, and by Region and Ter-
ritory

Amount Adjusted Displays Amount Adjusted in $ for each Client, and by Region and Ter-
ritory

Fees Earned Displays Fees Earned for each Client, and by Region and Territory

Average Invoice Displays Average Size Invoice in $ for each Client, and by Region and Ter-
ritory
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Column Label Description

Number Buys Displays the number of Purchase Batches processed for each Client,
and by Region and Territory

Number Invoices Displays the number of Invoices purchased for each Client, and by
Region and Territory

Number Checks Displays the number of Checks posted for each Client, and by Region
and Territory

Number Payments Displays the number Payments processed for each Client, and by
Region and Territory

Number Adjustments Displays the number Adjustment processed for each Client, and by
Region and Territory

Format: Summary

Territory/Region Displays the Territory and Region

Territories are defined in the Territory Name Table Maintenance under
the Client & Debtor Menu in Tables Module.

Regions are defined in the Region Table under the Client & Debtor Menu
in Tables Module.

Amount Purchased Displays Amount Purchased in $ for the Region and Territory.

Amount Collected Displays Amount Collected in $ for the Region and Territory.

Amount Adjusted Displays Amount Adjusted in $ for the Region and Territory

Fees Earned Displays Fees Earned for the Region and Territory

Average Invoice Displays Average Size Invoice in $ for the Region and Territory

Number Buys Displays the number of Purchase Batches processed for the Region and
Territory

Number Invoices Displays the number of Invoices purchased for the Region and Territory

Number Checks Displays the number of Checks posted for the Region and Territory

Number Payments Displays the number Payments processed for the Region and Territory

Number Adjustments Displays the number Adjustment processed for Region and Territory
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Terms Analysis Report

The Terms Analysis report displays, by debtor, an invoice count and the amount over and under specified
days due.

To run this report, select Terms Analysis Report from the Analysis option on the Reports menu.

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.
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Field Description

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office
to which they are restricted will be selected in the Office field by default and the user will
not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports
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Field Description

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This Report Select a printer from the drop-down list to overwrite the printer default for this report only.

Date
range

Select the date range to use for the report from the list:

l Last month

l Current month-to-date

l Year thru last month date

l Specific date range

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Over-
/under
days due

Enter the number of days over or under the days due to be included in the results.

Format Select the report format to produce:

l Detail (client w/in debtor)

l Summary (one line per debtor)

Output Select one of the following print output options from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client. .

l Email to email the report directly to the selected client.

Report Sample

Format: Detail (client w/i debtor)
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Format: Summary (one line per debtor)

Report Details

Column/Label Description

Format: Detail (client w/i debtor)

Debtor Displays Debtor Name

Client Displays Client Name

Total Invoices Displays Total Number of Invoices for the Cli-
ent/Debtor Relationship

Total Purchases Displays Total Amount of Invoices Purchased
for the Client/Debtor Relationship
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Column/Label Description

Count at/Under Displays the number of Invoices whose due
days are at or under the Parameter: Over-
/Under Days Due for the Client/Debtor Rela-
tionship

Amount at/Under Displays the amount of Invoices whose due
days are at or under the Parameter: Over-
/Under Days Due for the Client/Debtor Rela-
tionship

Count Over Displays the number of Invoices whose due
days are over the Parameter: Over/Under
Days Due for the Client/Debtor Relationship

Amount Over Displays the amount of invoices whose due
days are over the Parameters: Over/Under
Days Due for the Client/Debtor Relationship

Format: Summary (one line per debtor)

Debtor Displays Debtor Name

Total Invoices Displays Total Number of Invoices for the
Debtor

Total Purchases Displays Total Amount of Invoices Purchased
for the Debtor

Count at/Under Displays the number of Invoices whose due
days are at or under the Parameter: Over-
/Under Days Due for Debtor

Amount at/Under Displays the amount of Invoices whose due
days are at or under the Parameter: Over-
/Under Days Due for Debtor

Count Over Displays the number of Invoices whose due
days are over the Parameter: Over/Under
Days Due for the Debtor

Amount Over Displays the amount of invoices whose due
days are over the Parameters: Over/Under
Days Due for the Debtor
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Security Roles

To generate the Terms Analysis Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print terms analysis report

Verification Analysis Report

The Verification Analysis Report summarizes Verification activity for a specified number of clients over a
defined period of time.

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-

Reports User Guide
Crystal (Legacy) Reports

874 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.
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Field Description

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

As-of
Date

Select the date to use for the report from the list:

l Current date

l Last month-end

l Specific date

If the Specific date is selected, enter the date to which to limit the report in the adjacent
fields.

Sequence Select the sort option that determines the order in which to sort the report.

l Client Name: sort alphabetically by client name.

l Client Number: sort alpha-numerically by client-id.

Output Select one of the following print output options from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.
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Report Sample

Report Details

Column Description

Client Displays Client's Name

A/R Balance Displays total A/R Balance for the As of Date of the report.

Net Funds Employed Displays Total Net Funds Employed for the As of Date of the report.

Amount Verified Displays the Amount verified for the As of Date of the Report.

% Balance Verified Amount Verified / A/R Balance

% NFE Verified Amount Verified / Net Funds Employed

Open Invoices Displays the number of Open Invoices for the As of Date of the report.

Verified Invoices Displays the number of verified invoices for the As of Date of the report.

% Invoices Verified Verified Invoices / Open Invoices

Security Roles

To generate the Verification Analysis Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Analysis Reports > Print verification analysis report

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Verification analysis folder.
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Preference Description

Exclude items with
open disputes

Set to True to exclude formerly verified invoices that were later placed in dis-
pute from the Verification Analysis Report.

Treat pre-purchase
verification reasons
based on post-veri-
fication codes

Set to True to Treat pre-purchase verifications reasons based on Tables Mod-
ule > Data Entry > Verification/Collection Messages Table > Post: Positive,
Negative, No Action, Not Used.

If Post code is Positive, the invoices is considered verified. All other Post Codes
are considered not verified.

Broker Menu

Broker Reports

The Broker reports are used to generate reports related to brokers.

Broker Commission Report

The Broker Commission Report is a utility to trace the performance of the client and calculate a com-
mission that can be paid to the broker. Many lenders utilize salespeople or brokers to assist in the devel-
opment of new business. Commissions are often paid to individuals based on the client’s performance.

Commission reports should only be generated after month-end earnings have been posted against a cli-
ent’s reserve account. If the report is run prior to posting, then the report will not be accurate.

NOTE
For Bulk Collateral lending databases, Sales have been added to the Purchase column and Net Col-
lections added to the Collections column of the Broker Commission Report.
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Report Parameters

Field Description

Date
Range

Enter the beginning date of the report date range. Click Today to display the current Fact-
orSoft processing date or MTD to display the beginning day of the previous month in this
field.

Thru Enter the ending date of the report date range. Click Today to display the current Fact-
orSoft processing date or MTD to display the ending day of the previous month in this field.

Broker Select the broker to which to limit the report results from the list. Click Clear to remove the
selection.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Category Select the broker category to which to limit the report results. Broker categories are defined
in the Broker Category Table. Click Clear to remove the selection.

Format Select the report format to be printed:

l Detail Report: displays invoice batch detail by client within broker

l Summary Report: displays summary totals only by client within broker

l Detail Statements: generates Broker Commission Statement with invoice batch
detail

l Summary Statement: generates Broker Commission Statement with summary
totals only

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Include
non-zero
inactive cli-
ents

Include inactive clients that have cash in A/R or reserves on the report. If this option is not
selected, non-zero inactive clients are excluded form the report.
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Field Description

Convert
sum-
maries to
native cur-
rency

Select this option to convert the financial data to the broker’s native currency.

Show date Select the desired option for displaying dates on the report:

l Show neither

l Show date signed

l Show date first funded

Print Click this button to generate the report.

Exit Click this button to close the screen.

Report Sample

Detail Report
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Summary Report

Master Summary
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Detail Statement
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Summary Statement
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Report Details

Column/Label Description

Format: Detail Report

Client Client’s Name

Date Post Date of the Batch

Batch # Batch number

Type Batch Type

Purchases Total Amount of Purchase Batch

Collections Total Amount of Payment Batch

Adjustments Total Amount of Adjustment Batch

Fee Earned Total Fee Earned for the Batch

Rate Broker’s Commission Rate
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Column/Label Description

Of Commission based on

Commission Commission amount for the batch

Total Row Total Commission Owed to the Broker by Client

Grand Total Grand Total Commission Owed to the Broker

Format: Summary Report

Client Client’s name

Purchases Total Amount of all Purchase Batches for the Client

Collections Total Amount of all Payment Batches for the Client

Adjustments Total Amount of All Adjustment Batches for the Client

Fee Earned Total Amount of All Fees Earned for the Client

Rate Broker’s Commission Rate

Of Commission Based on

Commission Total Commission owed to the Broker for the Client

Grand Total Grand Total Commission Owed to the Broker for All Clients

Format: Master Summary Report

Master Client Master Client’s Name

Member Client Member Client’s Name

Broker Broker’s Name

Purchases Total Amount of all Purchase Batches for the Member Client

Collections Total Amount of all Payment Batches for the Member Client

Adjustments Total Amount of All Adjustment Batches for the Member Client

Earnings Total Amount of All Fees Earned for the Member Client

Commission Total Commission Owed to the Broker for the Member Client

Total Row Total Commission Owed for the Broker for the Master Client
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Column/Label Description

Format: Detail Statement

Client Client’s Name

Date Post Date of the Batch

Batch # Batch number

Type Batch Type

Purchases Total Amount of Purchase Batch

Collections Total Amount of Payment Batch

Adjust Total Amount of Adjustment Batch

Fee Earned Total Fee Earned for the Batch

Rate Broker’s Commission Rate

Of Commission based on

Commission Commission amount for the batch

Total Row Total Commission Owed to the Broker by Client

Format: Summary Statement

Client Client’s Name

Purchases Total Amount of all Purchase Batches for the Client

Collections Total Amount of all Payment Batches for the Client

Adjust Total Amount of All Adjustment Batches for the Client

Fee Earned Total Amount of All Fees Earned for the Client

Commission Total Commission owed to the Broker for the Client

Grand Total Row Grand Total Commission owed to the Broker for all Clients.

Security Roles

To generate the Broker Commission Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Broker > Print Broker Commission Reports
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System Preferences

The following system preference that affects this report is found in the Administration module, System
Preferences, Fields/screen behavior, Miscellaneous folder.

Preference Description

Calculate earnings
based on account
table flag

Set to True - All accounts flagged as an Earning Account in Tables > Accounting >
Account Table > Standard Tab > Earning Account check box will be included in
the Fee Earned column.

Set to False - Accounts present in the client's appropriate G/L Account Groups will
be included in the Fee Earned column.

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Broker commission report folder.

Preference Description

Additional fee
earned account
numbers

Enter the exact Earnings Account numbers (defined in the Account Table in the
Tables module) to also be included in the total in the Fee Earned column. If entering
more than one account number, separate the account numbers with a comma.

Excluded Fee
Earned Accounts

Enter the exact Earnings Account numbers (defined in the Account Table in the
Tables module) to be excluded from the total in the Fee Earned column. If entering
more than one account number, separate the account numbers with a comma.

Commission by
Client cannot be
less than zero

Set TRUE - Commission calculated for a Client/Broker cannot be less than zero (i.e.
Negative amount).

Cost of funds
based on

Select option that determines how the Cost of funds basis is calculated:

l A/R Balance

l Advance rate times A/R Balance

l Advance rate times A/R Balance

l Funded A/R Balance (non-funded invoices excluded)

l Actual advance against funded A/R Balance

Cost of funds
rate (% )

Set rate percentage used to calculate Cost of funds

Do not print cli- Set TRUE - Report will only generate for clients that have Activity for the date range
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Preference Description

ents without
Activity

of the report

Do not show cli-
ent numbers on
reports

Set TRUE - Report will not reflect the Client’s code.

Do not show
page numbers
on reports

Set TRUE - Report will not reflect page numbers

Earnings do not
include addi-
tional fees

Set TRUE - Additional Fees Earnings will not be included in the report.

Earning from mis-
cellaneous
checks rule

Select option for miscellaneous checks (C-Misc or G-Misc) rule:

l Commissions are paid as with all other earnings

l These lines will appear on the report but no commission will be paid

l These lines will not appear on the broker report

Include ABL Cli-
ents

Set TRUE - ABL Clients will be include in the Broker Reports when generated.

Months cal-
culation rule

Select option how to calculate months:

l Start counting form the first day of the month signed.

l Use the exact date signed.

l If month signed is not the 1st, start from the 1st of next month.

l Start counting from the first day of the month of first funding.

l Use the exact date first funded.

l If month first funded is not 1st, start from the 1st of the next month.

Report Crystal
Reports module
name

Insert Report Module name

Sort reports by Select option how to sort Brokers:
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Preference Description

l Company

l Name

Statement Crys-
tal Reports mod-
ule name

Insert Statement reports module name

Use Broker cur-
rency conversion
rates where avail-
able

Set TRUE - Special Broker currency rates will be used for currency type that are avail-
able.

Carrier Menu

Carrier Reports

The Carrier reports are used to generate reports about carriers.

Carrier Payment Report

The Carrier Payment Report displays carrier payments created for a given client, carrier, date range and
other standard report selection criteria.

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com
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Report Parameters

The following fields are available on the Parameters tab of the Insurance Excess Report screen.

Field Description

Report
Template

Enter the report template to use when requesting the report.

To create a new template, click the New button, enter the name of the new template, and
click the Create button. The new template is created.

Settings for a template can be defined on the Destination tab and the Scheduling tab.

Date
Range

Enter the type of date range for which to request the report, such as today, the current
month to date, specific date range, and so on.

Click the Down Arrow to display a list of valid entries.

From If Specific Date Range was entered in the Date Range field, enter the beginning date in a
range of dates for which to request the report.

Thru If Specific Date Range was entered in the Date Range field, enter the ending date in a
range of dates for which to request the report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.
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Field Description

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Carrier Enter the Carrier for whom the report is to be generated. Leave this field blank to include all
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Field Description

carriers.

Date
Range

Enter the date range basis. Available options are:

l Invoice purchase date

l Invoice date

l Carrier payment due date

l Carrier payment paid date

Include
Unpaid
Items

Select this check box to include carrier payments that have been included in a purchase but
are not yet eligible to have a check generated (i.e., the Days to Pay have not elapsed).

Include
Paid
Items

Select this check box to include carrier payments that have had checks generated.

Sort Enter the format for which to sort the report.

Sample Report

Client Menu

Client Reports

The Client report group contains reports that provide details on all aspects of your business with clients.

Reports User Guide
Crystal (Legacy) Reports

893 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Aging Reports

The Aging Report screen allows you to print client aging reports and review the accounts receivable pur-
chased from clients. This versatile and customizable report displays a summary of a client’s adjusted fee
rates per client, including terms, basis, stated rate, floor rate, basis rate, minimum rate, maximum rate,
adjusted rate, advance rate, recourse days, and more.

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to

Reports User Guide
Crystal (Legacy) Reports

894 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the user
will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default Displays the default printer used to generate reports
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Field Description

Printer

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This Report Select a printer from the drop-down list to overwrite the printer default for this report only.

As-of date Select the date to use for the report from the list:

l Current Date

l Last month-end

l Specific date

If the Specific date is selected, enter the date to which to limit the report in the adjacent
fields.

Format Select the report format to be printed:

l Classic aging: general purpose aging report; invoice detail by debtor within client

l Position aging: specific to financial position

l Delinquency: displays past and overdue invoices

l Reserve summary: client-level only summary report of Reserve

l Invoice summary

l Analysis aging: relationship-level only report

Level Select the detail level for the report:

l Invoice

l Relationship (Debtor)

l Client

Select Select the option for the items to be reported:
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Field Description

l Unpaid and paid this month

l Unpaid only

l Everything on file

l Older than/show selected

l Older than/show all

For the two Older Than options, enter the number of days in the adjacent field.

Funded Select the invoice funding status for the items to be reported:

l Funded and non-funded

l Funded invoices only

l Non-funded invoices only

Calc age
by

Select the date from which to calculate aging:

l Invoice date

l Due date

l Purchase date

Display
age by

Select the aging format to display on the report:

l Days (1-30, 31-60, 61-90...)

l Months (August, July, June)

l Due Date (Current, 1-30, 31-60...)

l Statement Date

l Non-standard columns: use the non-standard aging buckets defined for the client

Show date Select the date to be included in the report results:

l Invoice Date

l Purchase Date

l Due Date
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Field Description

Currency
only

Select the currency to which to limit the report. This list is populated from the Currency
Denomination Table.

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help.

Group by
master cli-
ent

Select this option to group clients according to their master client, if applicable.

Group by
master
debtor

Select this option to group debtors according to their master debtor, if applicable.

Do not skip
pages
between cli-
ents

Select this option to not include a page break prior to each client. To start each client on a
new page, do not select this option.

Do not
show
uniden-
tified pay-
ments

Select this option to exclude unidentified payments from the report results.

Convert
summaries
to native
currency

Select this option to convert the financial data to the client’s native currency.

Sort: High
Level

Select the primary sort option for the report:
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Field Description

l Client: Sort by client

l Account executive, client: Sort by client within account executive.

l Office, client: Sort by client within office. An Office Total is displays the total A/R Bal-
ance for all clients within office at the office sub-total breaks when this option is set.

Sort: Client Select the sort option for client sorting:

l Name: sort by name in ascending alphabetic order.

l Client Code: sort client code in ascending alphanumeric order.

l Age level: sort by age, most current to least current.

Sort: Rela-
tionship

Select the option for sorting customer/debtors within client:

l Debtor name

l Debtor code

l Client reference number

l Balance

Sort: Detail Select the option for sorting the invoice detail within debtor:

l Invoice number

l Invoice date

Show Select the options in this list for the columns to be included on the report:
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Field Description

l Client totals

l Debtor address

l Debtor contacts

l Debtor credit limit

l Debtor phone number

l Description

l Detail counts

l Dispute codes

l Grand totals

l Invoice type

l Lines above totals

l NOA & recourse info

l Percentages

l Purchase orders

l Risk codes

l Use Redundancy

l Zero clients

l Zero relationships

Print now Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.
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Report Sample

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Aging reports folder.

Preference Description

Classic aging Crystal
report module name

Used to assign the Crystal Reports module name for the non-Task Scheduler
enabled classic aging report.

Delinquency aging
Crystal Reports mod-
ule name

Used to assign the Crystal Reports module name for the non-Task Scheduler
enabled delinquency aging report.

Fast aging logic Used to allow aggregated historical data (“redundant data”) from the Calc
tables to be used to create the Aging Reports.
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Preference Description

l Never use fast aging logic: Set the preference to this value to prevent
FactorSoft from using the redundant data to create Aging Reports.

l Allow ‘use redundancy’ selection: Set the preference to this value to
allow FactorSoft to use redundant data to create Aging Reports. Setting
this preference activates the Use Redundancy option on the Print Aging
Report screen. This option allows you to select via the report screen
whether to create the Aging Report from redundant data or to use stand-
ard aging, which builds the aging data from current financial data in the
tables.

l Always use fast aging logic for current date: Set the preference to this
value to automatically use the redundant data to produce aging reports
with an As of date set to Current date on the Print Aging Reports screen.

Hide non-factors
moved to held
accounts

Set to True to exclude non-factored payments that have been moved to hold
accounts. This setting applies only to the new Task Scheduler enabled report.

Include country in
debtor address

Set to True to display the country in the debtor address.

Preference printing
cover page

Used to assign the WinFax Pro cover page stored in the common report dir-
ectory.

Server classic Crystal
Reports module
name

Used to assign the Crystal Reports module name for the Task Scheduler
enabled classic aging report.

Server delinquency
Crystal Reports mod-
ule name

Used to assign the Crystal Reports module name for the Task Scheduler
enabled delinquency aging report.

Server invoice Crystal
Reports module
name

Used to assign the Crystal Reports module name for the Task Scheduler
enabled invoice aging report.

Server position Crys-
tal Reports module
name

Used to assign the Crystal Reports module name for the Task Scheduler
enabled position report.

Trust redundant data
on aging where pos-

Set to True to trust redundant data on aging.

Reports User Guide
Crystal (Legacy) Reports

902 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Preference Description

sible

Use report server
aging request form

Set to True to use the Task Scheduler enabled report form.

Client Activity Report

The Client Activity report displays purchase and payment activity and breaks out charge-back inform-
ation for selected clients over a specified date range.

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.
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Field Description

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.
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Field Description

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Date
range

Select the date to use for the report from the list:

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

l Today only

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Format Select the report format to be printed. Currently, format 1 - Purchases, collections, A/R,
funds employed, chargebacks is the only option.

Combine Select the option to indicate how results are combined:

l Do not combine

l Combine to master

l Combine to group/value

l Combine to summary

l Combine to account executive

l Combine to office

Group If Combine to group/value is selected in the Combine option, select the group value to
combine to from this list.

Output Select one of the following print output options from the drop-down list
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Field Description

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help. See the Preference
Printing Appendix for more information.

l Excel to create an Excel spreadsheet output file with the file name CliAct_YYMMDD999,
where YYMMDD is the FactorSoft processing date and 999 is a three digit sequence
number.

Print now Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

Report Sample

System Preferences

The following system preference that affects this report is found in the Administration module, System
Preferences, Fields/screen behavior, Miscellaneous folder.

Preference Description

Calculate earnings
based on account
table flag

Set to True - All accounts flagged as an Earning Account in Tables > Accounting
> Account Table > Standard Tab > Earning Account check box will be included in
the calculation.
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The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Client activity report folder.

Field Description

Path to use for Excel
output

Used to assign the absolute folder location to which to write the Excel spread-
sheet output. If this preference is not set, the Excel output folder is the com-
puter's root folder by default.

Report module name Used to assign the Crystal Reports module name for the Client Activity report.
CliAct1 is the default, standard format. CliAct2 displays Debit Purchases and
Credit Purchases in separate columns.

Client Change Report

The Client Change report displays changes to customer/debtors by client, showing the debtor name,
date of the change, the data field affected and the before and after value for the field.

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the report results from the list. Client Groups are
defined in the Group Code Table. Click Clear to remove the selection.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default Displays the default printer used to generate reports.
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Field Description

Printer

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Date
range

Select the date to use for the report from the list:

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

l Today only

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Output Select one of the following print output options from the drop-down list

l Preview to preview the report on the window before printing it.

l Print to print the report without previewing it.

l Fax to fax the report directly to the selected client. Click for available fax solutions.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection.

Print
now

Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.
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Sample Report

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Client change reports folder.

Preference Description

Show client reference
number instead of
debtor code

Set to True to display the Client Reference Number instead of the Debtor Code
has been added for the Client Change Report.

Client/Debtor Summary Report

The Client/Debtor Aging Report generates a report that displays client/debtor activity for a selected
period, including purchase history by batch, a period summary, and a summary of totals by debtor.

This is an Engine-enabled report.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.
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Field Description

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Date
range

Select the date to use for the report from the list:
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Field Description

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help. See the Preference
Printing Appendix for more information.
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Report Sample

Items Recoursed Report

This report displays the invoice paid after recourse within the date range entered. The information dis-
played on this report is the client, debtor for that client, invoice number, invoice date, post date, buy batch
number, invoice amount, recourse date, batch number, recourse amount, paid date, batch number, paid
amount and current balance
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Date-
from

Enter the beginning date of the report date range. Click Today to display the current Fact-
orSoft processing date or MTD to display the beginning day of the previous month in this
field.
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Field Description

Thru Enter the ending date of the report date range. Click Today to display the current FactorSoft
processing date or MTD to display the ending day of the previous month in this field.

Report Select the report format to be printed:

l Items recoursed within date range

l Items paid after recourse within date range

l Items unpaid after recourse within date range

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection.

Summary
only

Not available.

Start new
page for
each cli-
ent

Select this option to force a new page for each client break in the report. If this is not selec-
ted, multiple clients can be printed on one page.

Show dis-
pute
reason
on report

Select this option to display the dispute reason code selected for an invoice on the report.
When the report is produced, a new Dispute Reason column is displayed, which displays the
dispute explanation selected for the invoice.

Print now Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.
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Report Sample

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Client recourse reports folder.

Preference Description

Recoursed report
Crystal Reports mod-
ule name

Used to assign the Crystal Reports module name for the Available for Recourse
report.

Client Master List Report

The Print Client Master List report creates a report of all clients that meet the criteria defined in the Print Cli-
ent Master Report screen. You can also produce a MS Excel file of your Client Master List and print 3-up
address labels from this report screen.

This is an Engine-enabled report.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

The filtering options on this tab allow you to limit the selection criteria for the report to create very specific
or general reports.

Field Description

Broker Select the broker to which to limit the report results from the list. Click Clear to
remove the selection. Leaving this field blank will include all brokers in the res-
ults.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the
report, or leave blank to include all users. When a user is selected, the report is
limited to clients that have that user selected in the A/E field on the Control
panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E,
use the following System Preference:
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Field Description

l Terminology > Select account executive based on check box: TRUE

Source Select the referral source to which to limit the report results from the list. Referral
sources are defined in the Referral Source Table. Click Clear to remove the
selection.

Client Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature.
To access this table, on the File menu, click Tables. Then, on the Client & Debtor
menu, click Client Group Codes.

Value Select the specific client group value to which to limit the report results from the
list. Client Groups are defined in the Group Code Table. Click Clear to remove
the selection.

Office Select the office to which to limit the report results. If the user has an Office
restriction defined on the Manage Users screen in the Admin module, the user
will only be able to generate the report within that office restriction. When the
user generates a report, the office to which they are restricted will be selected in
the Office field by default and the user will not be able to change the Office field
when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table,
on the File menu, click Tables. Then, on the Client & Debtor menu, click Office.

UCC Date Before Enter the cutoff date for UCC filings to which to limit the report results. Leave this
field blank to not limit the report by UCC filing date.

Show SIC Code Select this option to display the client's SIC (Standard Industrial Classification)
code in the report results, if available.

Show Bank Inform-
ation

Select this option to display the client's bank information in the report results
(name, address, contact, and account, as available).

Report Type Select the report format to be printed:

l List: Generates the Client Master List report.

l 3-up Labels: Generates mailing labels in a 3-up format.

l Export for MS-Outlook: Generates the contents of the Client Master List
as a MS Outlook document. The file is generated to the root directory of
the user's computer.
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Field Description

Sort Select the sort option that determines the order in which to sort the report.

l Client name: Sort alphabetically by client name.

l Client number: Sort alphanumerically by client number.

l State: - Sort alphabetically by State code.

Output Select one of the following print output options from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Cli-
ent Information Preference selection. Click here for Preference Printing
help. See the Preference Printing Appendix for more information.

Select Select the applicable option for determining the clients to be included in the
report results:
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Field Description

l All Clients: Include all clients.

l Active Only: Include only active clients.

l Inactive Only: Include only client marked as inactive.

l Over % of Limit: Include only clients whose balance is over a given per-
cent of their defined limit. Enter the desired percentage in the adjacent
field.

l Has Balance Over: Include only clients whose balance is over a given dol-
lar amount. Enter the desired dollar amount in the adjacent field.

l No Balance: Include only zero-balance clients.

l Terminated: Include on clients who have been terminated within a spe-
cified date range. Enter the desired date range in the adjacent From and
Thru fields. To include all terminated clients, select this option and leave
the From and Thru fields blank.

l Negative Cash Reserve: Include only clients whose cash reserve balance
is negative.

l Active No-Buy: Include only active clients with Do not allow new pur-
chases set on the Client Information Credit/no-buy panel.

Print now Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

Report Sample
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Client Profit Report

This report displays an analysis of client profitability for a given number of months from a specified as-of
date.

To run this report, select Client Profit Report from the Analysis option on the Reports menu. The report may
be defined with the fields below.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.
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Field Description

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports

Change Click this button to assign a different printer as the default printer. This will change the default
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Field Description

Default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

As of
date

Enter the ending date for the data to be analyzed in the reports. Click Today to enter the cur-
rent FactorSoft processing date in this field.

By
Master

Select the option to determine how to report master client data:

l Master with detail

l Ignore master

l Summarize to master

Sort Select the sort option that determines the order in which to sort the report.

l Client name

l Client number

l State/Province

l Volume ascending

l Volume descending

# Of
Months

Enter the number of previous months from the As-of Date to be analyzed.

Output Select one of the following print output option from the drop-down list.

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help. See the Preference
Printing Appendix for more information.

Print
now

Click this button to generate the report to the Output method selected.
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Field Description

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

General Parameters Tab

General Parameters are used to set up Cost of Funds and Allocated Expenses parameters for the report.

Field Description

Grid Displays each dated parameter configuration as a line-item.

l Year: displays the year for which the parameter configuration is applied

l Month: displays the number of the month for which the parameter con-
figuration is applied

l Expenses: displays the factor to be applied for calculating Allocated
Expenses

l Cost of Funds: displays the factor to be applied for calculating Cost of
Funds

Add Click this button to open the General Parameters screen to create a new para-
meter configuration.

Update Select a line-item and click this button to open the General Parameters screen
to update an existing parameter configuration.

Delete Select a line-item and click this button to delete an existing parameter con-
figuration.

Client Parameters Tab

Client Parameters are used to set up Charge-off/Recovery parameters by client for the report.

Field Description

Grid Displays each dated parameter configuration as a line-item.
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Field Description

l Client Name: displays the client name for which the parameter con-
figuration is applied

l Client #: displays the client number

l Year: displays the year for which the parameter configuration is applied

l Month: displays the month for which the parameter configuration is
applied

l Recovered: displays the dollar amount recovered for the client in the spe-
cified period.

Add Click this button to open the Client Parameters screen to create a new para-
meter configuration.

Update Select a line-item and click this button to open the Client Parameters screen to
update an existing parameter configuration.

Delete Select a line-item and click this button to delete an existing parameter con-
figuration.
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Sample Report

Client Reserve Report

The Client Reserve Report generates a listing of current reserves by client, including a subtotal of reserve
balances, a summary of potential charge-backs and potential new reserve balance.

This is an Engine-enabled report.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
range

Select the date to use for the report from the list:

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

l Today only

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.
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Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Format Select the report format to be printed:
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Field Description

l Detail: Generates the Reserve Detail Report.

l Detail with Activity (w/Fee%): generates the Reserve Activity Report, including the Fee
%.column.

l Detail with Activity (w/Check#): generates the Reserve Activity Report, including the
Check.column, which contains the check number, if provided.

l Detail with Activity (w/Ref#): generates the Reserve Report, including the Ref
#column, which displays the Debtor reference code..

l Summary: generates the Reserve Summary Report, which contains one line per client
displaying the reserve balance.

l Summary with potential chargebacks: generates the Reserve Summary Report, which
contains one line per client displaying the reserve balance, potential chargebacks,
and reserve availability totals.

Sort Cli-
ent by

Select the sort option that determines the order in which clients are sorted:

l Client Name

l Client Code

Sort Detail
by

Select the option that determines how the detail is sorted within client. This option is only
available when the Format option Detail with Activity (wCheck#) is selected.

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection.

Include
unpaid
checks

Select this option to include unpaid checks in the report results.

Each cli- Select this option to force a new page for each client break in the report. If this is not selec-
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Field Description

ent starts
on a new
page

ted, multiple clients can be printed on one page. This option is only available when the
Format option Detail is selected.

Hide pay-
ments to
hold
accounts

Select this option to suppress display of payments to hold accounts in the report results.
This option is only available when one of the three Detail with Activity options is selected in
Format.

Note that by default, payments to hold accounts are excluded from the Reserve Activity
(core process ReserveActivity) page in ClientWeb. Payments to hold accounts can be
included on this page by setting the System Preference Reports, Client reserve reports,
Show payments to hold account on web to True.

Print now Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

Report Sample

System Preferences

The following system preference that affects this report is found in the Administration module, System
Preferences, Fields/screen behavior, Miscellaneous folder.

Preference Description

Calculate earnings
based on account
table flag

Set to True - All accounts flagged as an Earning Account in Tables > Accounting
> Account Table > Standard Tab > Earning Account check box will be included in
the calculation.
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The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Client reserve reports folder.

Preference Description

Advanced calculation
should not include
fee rate

Set to True to indicate that the Advance column represents that account hold-
back only.

Credit 'HELD' activity
should display as
'PAID'

Set to True to allow the Activity Type for reserve release through a purchase to
be “PAID” instead of “HELD” on the Client Reserve Report (Format set to Detail
with Activity (w/Fee%), Detail with Activity (w/Check#), or Detail with Activity
(w/Ref#)).

Detail Crystal Reports
module name

Used to assign the Crystal Reports module name for the Detail report.

Detail with activity
(w/check#) Crystal
Reports module
name

Used to assign the Crystal Reports module name for the Detail with Activity
(w/Check#)report.

Detail with activity
(w/fee%) Crystal
Reports module
name

Used to assign the Crystal Reports module name for the Detail with Activity
(w/Fee%)report.

Detail with activity
(w/RefNo) Crystal
Reports module
name

Used to assign the Crystal Reports module name for the Detail with Activity
(w/Ref#)report.

Fee column on activ-
ity reports is only fees
taken at collection

Set to True to include only fees taken at collection. If False, the program will
include a calculated representation of fees taken at purchase, so the net to
reserves will not reconcile to the report.

Heading should be
additional fee instead
of interest

Set to True to use the heading Additional Fees instead of Interest on appro-
priate reports.

Hide detail with activ-
ity format

Set to True to turn off the Detail with Activity with Check # and Fee % formats.

Include inactive cli-
ents in all client selec-

Set to True to include inactive clients in the results.
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Preference Description

tion

Leave pending check
numbers as blank (do
not print 'Pending')

Set to True to prevent literal Pending from displaying on unwritten checks.

Pickup fees from pur-
chases

Set to True to include purchase fees on the report.

Show accrued invoice
fees and interest if
not deducted

Set to True to show the fees and interest below Available for Release if the pref-
erence is set to not deduct fees and interest.

Summary Crystal
Reports module
name

Used to assign the Crystal Reports module name for the Summary report.

Summary with
chargebacks Crystal
Reports module
name

Used to assign the Crystal Reports module name for the Summary with Poten-
tial Chargebacks report.

Suppress trans-
actions with no
reserve effect

Set to True to exclude transactions with no reserve effect from the Detail with
Activity reports.

Use report server cli-
ent reserve report

Set to True to use the Task Scheduler-enabled report.

Client Summary Worksheet Report

Client Summary Worksheet Field Codes

The Client Summary Worksheet can be customized using the database codes from :

l Client Summary Worksheet Field Codes (fsClient and/or fsClientCalc API modules)

l Clients Table

l Collateral field Codes

NOTE
Jack Henry™ makes every effort to keep this field code documentation up-to-date, but you can
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always find the most up-to-date information on Clients Table Field Codes by selecting Database
Maintenance, Print Table Views from the Administration module System menu. A list of all tables is
returned. Select Clients from the list and click the Print button to print a report of the field codes in the
Clients table.

Field Names must be inserted into the Client Summary Worksheet within angle brackets (< >).

Client Summary Worksheet

The Client Summary Worksheet screen is a powerful tool in FactorSoft that is used to create reports from
templates created in Excel spreadsheets. Use the Client Summary Worksheet window to generate a work-
sheet using either templates you have created or the templates delivered with FactorSoft.

Refer to Using the Client Summary Worksheet in the FactorSoft Reports Guide for detailed instructions.

Report Parameters

Field Description

Template Lists the templates saved in the defined FactorSoft Reports folder. To create a report,
select the desired template to use from this list. Following is a list of the Excel worksheets
provided with FactorSoft:
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Field Description

l 20/20 Tax Guard Template: This template is used to electronically transmit client
information to the 20/20 Tax Guard monitoring service for the creation of IRS form
8821.- Activity Accrual Summary. Provides a summary of client’s A/R activity, Cash
Received, Purchases, Reserve Activity, Settlement, and Fees, during a specified date
range.

l Activity by Region: Provides a summary of client’s A/E activity during a specified
date range, including Amounts, Fees, Averages, and Number of Buys, Invoices,
Checks, Payments, and Adjustments.

l AR Loan Summary: Provides a summary of client’s A/E activity during a specified
date range, including Amounts, Fees, Averages, and Number of Buys, Invoices,
Checks, Payments, and Adjustments.

l Average Net Funds: Provides a summary of client’s Current Gross A/R, Current Cash
Reserves, Current Escrowed Reserves, Current Funds Employed, and Average Funds
Employed.

l Balance: Provides a summary of client’s A/E activity during a specified date range,
including Amounts, Fees, Averages, and Number of Buys, Invoices, Checks, Pay-
ments, and Adjustments.

l Broker Analysis: Provides a summary of Broker activity during a specified date
range, including A/R Activity—balances, purchases, collections, chargebacks, give-
back, gross collections, hold account analysis—Settlement, a breakdown of Fees,
and a breakdown for Commissions. The Date Signed is also listed.

l Client Worksheet: Provides a summary of client’s financial activity, by A/E, during a
specified date range, including Gross A/R, Recourse/Ineligible, Eligible A/R, Advance
Rate, Gross Available, Funds Employed, Accrued Fees, Available Cash, Current Bal-
ance, a breakdown of balances by Aging bucket and the percentage of each
against the Total. A Month To Date summary of Sales, Recourse, Payments
chargebacks, givebacks, WO/Suspense, as well as a Dilution %.

l Ineligibility: Provides a summary of client’s ineligibility during a specified date range,
including Gross A/R, Cash Reserves, Escrow Reserves, Funds Employed, Effective
Rate, Industry , Eligible Rate, Ineligible Rate, and Ineligible Amount.

l Insurers: Provides a summary of Insurers for each client, and lists the Insurer,
Amount Insured, Expiration, and UCC#.

l Yield: Provides a summary of client’s A/E activity during a specified date range,
including Amounts, Fees, Averages, and Number of Buys, Invoices, Checks, Pay-
ments, and Adjustments.
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Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.
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Field Description

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Broker Select the Broker to limit the report to clients represented by a specific broker only. Click
Clear to remove the selection.

Territory Select the Territory to limit the report to clients assigned to a specific sales territory only.
Click Clear to remove the selection.

Region Select the Region to limit the report to clients assigned to a specific sales territory region
only. Click Clear to remove the selection.

As of date Enter the “to” date of the date range for which to produce the report. Click Today adjacent
to this field to enter the current working date.

Activity
from date

Enter the “from” date of the date range for which to produce the report. Click Make 1st
adjacent to this field to enter the first day of the current working date month.

Sort field #1 Select primary sort criteria from this list. The possible sort criteria are A/E, Group, Region,
and Territory. If Group is selected, you can also select the group to sort on from the Group
field. Click Clear to remove the selection.

Sort field
#2

Select secondary sort criteria from this list. The possible sort criteria are A/E, Group,
Region, and Territory. If Group is selected, you can also select the group to sort on from
the Group field. Click Clear to remove the selection.

Sort field
#3

Select tertiary sort criteria from this list. The possible sort criteria are A/E, Group, Region,
and Territory. If Group is selected, you can also select the group to sort on from the Group
field. Click Clear to remove the selection.

Client filter Select the client segment for which you want to produce the report. The possible values
are:

l All clients: Produce the report for all clients.

l Active only: Produce the report only for clients not flagged as Inactive on the Client
Information screen.

l Inactive Only: Produce the report only for clients flagged as Inactive on the Client
Information screen

l With Current Balances: Produce the report only for clients that have current bal-
ances greater than zero. Clients with activity during the period but a zero balance
at the end of the period are not included.
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Field Description

Summary
only

Select this option to display the sort field criteria as one-line totals. If cleared, the report
includes detail line items, totals for each sort break, and grand totals.

Create sep-
arate
broker
reports

Select this option to separate each broker’s clients on separate books (tabs) in the Excel
workbook.

If you select this option for the BrokerAnalysis.xls, a separate sheet for each broker is
included in the generated Excel file regardless of the selection. If you wish to report only
brokers with activity, set System Preference Reports, Client summary worksheet, Delete
blank sheets to True.

View
spread-
sheet when
finished

Select this option to display the report in Microsoft Excel when the report is generated. If
this is not selected, the report is produced in the C:\ drive of the local computer, and can
be accessed there after it is generated.

Convert to
native cur-
rency

Select this option to convert amounts from the base currency to the native currency (the
currency of the transaction). The conversion occurs on a client-by-client basis. If the cli-
ent has a currency type set and the currency type is different from the default currency,
FactorSoft looks up the conversion rate using the As of date in the currency table for the
client's currency. For example, if client ABC Company has a currency type of Canadian
Dollars and the daily conversion rate for Canadian dollars is 1.5, the report increases all of
the client's amounts by a factor of 1.5. A note in the Client Name cell on the worksheet will
indicate conversion status for a client. The possible notes include:

l No client currency set: The client doesn't have a currency type set. No conversion
occurred.

l No currency rate available for the selected date range for [CurrencyType]: The
client had a currency type set, but a conversion rate wasn't available for the report
dates. No conversion occurred.

l Converted from USD to [CurrencyType]: Conversion from default currency to nat-
ive currency for the client occurred.

l Default currency (USD) matches the currency of the client: The default currency
matches the client's currency and no conversion was necessary.

Accu-
mulate to
master cli-
ents

Select this option to roll all clients assigned to a Master client into the Master, and display
the results as a single row for the Master Client.

Not all values can be rolled up to Master Clients.

Reports User Guide
Crystal (Legacy) Reports

939 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

If this option is selected, the Excel template must include a Totals row including the
columns for which you want to accumulate member totals to the master must in order to
display the accumulated master totals in the generated worksheet. For more information,
refer to the Using the Client Summary Worksheet appendix in the FactorSoft Reports
Guide.

Process Click this button to generate the report.

Exit Click this button to close the screen.

Report Sample

Activity Accrual Summary

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Client Summary Worksheet folder.

Preference Description

Alternate template
folder name

Set the path and folder name allow to declare an alternate template folder in
which to store Microsoft Excel Templates for FactorSoft Live users. Using this fea-
ture will prevent the Excel templates from being available to any other Fact-
orSoft Live users.

Excel template name If using the old Client Summary Worksheet function, this system preference is
used to specify the Excel template to be used.

Excel worksheet top
row

If using the old Client Summary Worksheet function, this system preference is
used to specify the first row in the spreadsheet in which to print data.

Exclude aging from
spreadsheet

If using the old Client Summary Worksheet function, this system preference is
used to exclude aging information from the spreadsheet.

Exclude current
amounts from spread-

If using the old Client Summary Worksheet function, this system preference is
used to exclude current balances from the spreadsheet.
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Preference Description

sheet

Folder for completed
Excel spreadsheets

Set the path and folder name where completed Excel spreadsheets are saved
by the Client Summary Worksheet.

Use old client work-
sheet function

Set to False to use the new Client Summary Worksheet screen.

Collateral Field Codes

The following field codes can be used to access collateral data from the FactorSoft for Bulk Collaterals sys-
tem’s tables.

Note that these field codes are for use with the Client Summary Worksheet only, and consequently the
data returned is client-level data for the collaterals. These field codes cannot be used to return data at
the facility or collateral level.

Field Name Description

Act_BulkSales Returns the increases to Bulk A/R for the reporting period

Act_BulkCredit Returns the decreases to Bulk A/R for the reporting period

Act_PlusAdjustments Returns the total adjustment decreases to Bulk A/R for the reporting period

Act_MinusAd-
justments

Returns the total adjustment decreases to Bulk A/R for the reporting period

Act_Discount Returns the total discounts to Bulk A/R for the reporting period

Act_BulkNetCol-
lections

Returns the total of payments applied to the Bulk A/R balance for the reporting
period

Act_OverPayment Returns the total amount of all overpayments received toward Bulk A/R for the
reporting period

Beg_BulkArBal Returns the Bulk A/R balance as of the day before the beginning date or the
reporting period

Col_GrossBulkAR Returns Gross Collateral for Bulk A/R collateral types (type 0)

Col_IneligBulkAR Returns ineligible balance for Bulk A/R collateral types (type 0)

Resv_BulkAR Returns reserve balance for Bulk A/R collateral types (type 0)
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Field Name Description

SetASide_BulkAR Returns set aside balance for Bulk A/R collateral types (type 0)

Col_EligBulkAR Returns eligible collateral balance for Bulk A/R collateral types (type 0)

Col_NetBulkAR Returns net collateral balance for Bulk A/R collateral types (type 0)

Col_LimitBulkAR Returns collateral limit for Bulk A/R collateral types (type 0)

Col_AvailBulkAR Returns available collateral for Bulk A/R collateral types (type 0)

Col_GrossEquip Returns Gross Collateral for Equipment collateral types (type 1)

Col_IneligEquip Returns ineligible balance for Equipment collateral types (type 1)

Col_EligEquip Returns eligible collateral balance for Equipment collateral types (type 1)

Col_NetEquip Returns net collateral balance for Equipment collateral types (type 1)

Col_LimitEquip Returns collateral limit for Equipment collateral types (type 1)

Col_AvailEquip Returns available collateral for Equipment collateral types (type 1)

Col_GrossInventory Returns Gross Collateral for Inventory collateral types (type 2)

Col_IneligInventory Returns ineligible balance for Inventory collateral types (type 2)

Col_EligInventory Returns eligible collateral balance for Inventory collateral types (type 2)

Col_NetInventory Returns net collateral balance for Inventory collateral types (type 2)

Col_LimitInventory Returns collateral limit for Inventory collateral types (type 2)

Col_AvailInventory Returns available collateral for Inventory collateral types (type 2)

Col_GrossPO Returns Gross Collateral for Purchase Order collateral types (type 3)

Col_EligPO Returns eligible collateral balance for Purchase Order collateral types (type 3)

Col_NetPO Returns net collateral balance for Purchase Order collateral types (type 3)

Col_LimitPO Returns collateral limit for Purchase Order collateral types (type 3)

Col_AvailPO Returns available collateral for Purchase Order collateral types (type 3)

Col_GrossRE Returns Gross Collateral for Real Estate collateral types (type 4)

Col_EligRE Returns eligible collateral balance for Real Estate collateral types (type 4)
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Field Name Description

Col_NetRE Returns net collateral balance for Real Estate collateral types (type 4)

Col_LimitRE Returns collateral limit for Real Estate collateral types (type 4)

Col_AvailRE Returns available collateral for Real Estate collateral types (type 4)

Col_GrossSec Returns Gross Collateral for Securities collateral types (type 5)

Col_EligSec Returns eligible collateral balance for Securities collateral types (type 5)

Col_NetSec Returns net collateral balance for Securities collateral types (type 5)

Col_LimitSec Returns collateral limit for Securities collateral types (type 5)

Col_AvailSec Returns available collateral for Securities collateral types (type 5)

Col_GrossMedRec Returns Gross Collateral for Summary A/R collateral types (type 7)

Col_IneligMedRec Returns ineligible balance for Summary A/R collateral types (type 7)

Col_EligMedRec Returns eligible collateral balance for Summary A/R collateral types (type 7)

Col_NetMedRec Returns net collateral balance for Summary A/R collateral types (type 7)

Col_LimitMedRec Returns collateral limit for Summary A/R collateral types (type 7)

Col_AvailMedRec Returns available collateral for Summary A/R collateral types (type 7)

Col_GrossARAging Returns Gross Collateral for A/R Aging collateral types (type 9)

Col_IneligARAging Returns ineligible balance for A/R Aging collateral types (type 9)

Col_EligARAging Returns eligible collateral balance for A/R Aging collateral types (type 9)

Col_NetARAging Returns net collateral balance for A/R Aging collateral types (type 9)

Col_LimitARAging Returns collateral limit for A/R Aging collateral types (type 9)

Col_AvailARAging Returns available collateral for A/R Aging collateral types (type 9)

Col_GrossOther Returns Gross Collateral for Other collateral types (type 10)

Col_EligOther Returns eligible collateral balance for Other collateral types (type 10)

Col_NetOther Returns net collateral balance for Other collateral types (type 10)

Col_LimitOther Returns collateral limit for Other collateral types (type 10)
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Field Name Description

Col_AvailOther Returns available collateral for Other collateral types (type 10)

Col_GrossLnBacked Returns Gross Collateral for Loan Backed collateral types (type 11)

Col_IneligLnBacked Returns ineligible balance for Loan Backed collateral types (type 11)

Col_EligLnBacked Returns eligible collateral balance for Loan Backed collateral types (type 11)

Col_NetLnBacked Returns net collateral balance for Loan Backed collateral types (type 11)

Col_LimitLnBacked Returns collateral limit for Loan Backed collateral types (type 11)

Col_AvailLnBacked Returns available collateral for Loan Backed collateral types (type 11)

Col_GrossBulkInv Returns Gross Collateral for Bulk Inventory collateral types (type 12)

Col_IneligBulkInv Returns ineligible balance for Bulk Inventory collateral types (type 12)

Col_EligBulkInv Returns eligible collateral balance for Bulk Inventory collateral types (type 12)

Col_NetBulkInv Returns net collateral balance for Bulk Inventory collateral types (type 12)

Col_LimitBulkInv Returns collateral limit for Bulk Inventory collateral types (type 12)

Col_AvailBulkInv Returns available collateral for Bulk Inventory collateral types (type 12)

Col_GrossTotal Returns Gross Collateral total of all collateral types (type 99)

Col_IneligTotal Returns ineligible total of all collateral types (type 99)

Col_ResvTotal Returns reserve total of all collateral types (type 99)

Col_SetASideTotal Returns set aside total of all collateral types (type 99)

Col_EligTotal Returns eligible collateral total of all collateral types (type 99)

Col_NetTotal Returns net collateral total of all collateral types (type 99)

Col_LimitTotal Returns collateral limit total of all collateral types (type 99)

Col_AvailTotal Returns available collateral total of all collateral types (type 99)

Emp_BulkArBal Returns the bulk A/R amount as of the reporting date, same as Emp_BulkArAmt

Emp_BulkArAmt Returns the bulk A/R amount as of the reporting date, same as Emp_BulkArBal

Emp_BulkUnApplied Returns the unapplied cash amount as of the reporting date
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Client Summary Worksheet Basics

The Client Summary Worksheet is template-driven. This means that a skeleton report template is first cre-
ated in Microsoft Excel, and then is executed in the Reports module to extract data from the FactorSoft
database, populate the report with the client data, and print the report as a completed Excel spreadsheet.
The spreadsheet can then be transformed into output in any of the ways that you typically associate with
an Excel spreadsheet (print, PDF, data file, etc.).

Excel Spreadsheets

Since the underlying templates of the Client Summary Worksheet are based on Excel spreadsheets, you
can utilize the page layout, formulas, sorting/filtering, and chart features of Excel to customize your
reports. Reports can be as simple or complex as you desire, with the following limitations:

l Must be stored in the FactorSoft Reports directory.

l Must have a horizontal format.

l One line per client.

l Must always have one empty “H” row between the last header row and the first client (repeating
data) row.

l Must always be one empty “H” row between the last client (repeating data) row and the overall
Total row.

l Sort fields will automatically include subtotals and an overall total at the end.

You can create templates for as many reports as you require, and each template can be used again and
again.

FactorSoft Field Codes

There are four sets of field codes that you can utilize to extract client and financial data from the Fact-
orSoft and ABL databases for display in your reports:

l Client Oriented Field Codes (various data from Client, Client Terms, and Tables views)

l Client Calc Field Codes (calculated financial data from FactorSoft tables)

l Clients Table (data fields in the Clients Table)

l ABL Field Codes (data from ABL tables)
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FactorSoft Client Summary Worksheet Screen

The Client Summary Worksheet screen provides the FactorSoft interface for producing the report. This
screen provides criteria for filtering the data on the report by date ranges, all clients, specific clients, and
more specific criteria such as Account Executives (A/E), Client Groups, Offices, Brokers, Territories, and
Regions.

This screen also provides options that allow you to sort and group the data on the report by A/E, Group,
Office, Region, and/or Territory.

The Client Summary Worksheet screen is fully described in the FactorSoft Help File.

Client Summary Worksheet Field Codes

These field codes allow access to a variety of financial data for display in the Client summary Worksheet.
These field codes are returned by the fsClient and/or fsClientCalc API modules, and are only applicable to
the Client Summary Worksheet.

Field Name Description

AcctExecName Name of the account executive assigned on the Control Panel of the Client
Information. From Client Information, Control tab.

AcctGroupDescr The name of the G/L account group assigned to a client

Act_Adjusts All chargebacks for period

This code also equals <Act_CreditCb> + <Act_CreditDb>)

Act_Advances Total advanced amount for the period

Act_ArTurn The average number of days a client’s A/R portfolio turns over(not the aver-
age days to pay) calculated as (365 days / ((12 * sales) / (average bal-
ance)))

Act_AvgBal Average A/R balance for the selected period

Act_AvgNfe Average net funds employed for the selected period

Act_AvgInvoice Average invoice amount for the selected activity period

This code equals the same value as <Act_Purchases> / <Act_CountInv>

Act_BegBal A/R balance at the beginning of the selected period

Same as < Beg_ArBal >

Act_BegFeeEscrow Fee escrow balance at the beginning of the selected period
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Field Name Description

Same as <Beg_FeeEscrow>

Act_BegRsvEscrow Reserve escrow balance at the beginning of the selected period

Same as <Beg_RsvEscrow>

Act_BulkCredit Credit(s) recorded in Bulk AR Certificate Posting for the period selected

Act_BulkSales Sales recorded in Bulk AR Certificate Posting for the period selected

Act_BulkPlusAdjustments Adjustments (+) recorded in Bulk AR Certificate Posting for the period selec-
ted

Act_BulkMinusAd-
justments

Adjustments (-) recorded in Bulk AR Certificate Posting for the period selec-
ted

Act_BulkDiscount Discount(s) recorded in Bulk AR Certificate Posting for the period selected

Act_BulkNetCollections Net Collections recorded in Bulk AR Certificate Posting for the period selec-
ted

Act_BulkOverPayment Over payment(s) recorded in Bulk AR Certificate Posting for the period selec-
ted

Act_CbDebits Debit chargebacks against purchased invoices for the selected period

Act_CbNonFactor All chargebacks against non-factored invoices for the selected period

Act_CbRecovery Credit chargebacks against purchased invoices for the selected period

Act_Collects Total Collections for the selected period

Act_CountAdj Number of Adjustments for the selected period

Act_CountBuys Number of Purchase Batches for the selected period

Act_CountChk Number of Checks processed for the selected period

Act_CountInv Number of Invoices purchased for the selected period

Act_CountPmt Number of Payments applied for the selected period

Act_CreditCb Credit chargebacks (givebacks)

Act_CreditMemo Total amount of credit invoices purchased for the selected period

Act_DebitCb Debit chargebacks (chargebacks)
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Field Name Description

Act_DebitMemo Total amount of debit invoices purchased for the selected period

Act_EarnAdj Total earnings generated from Adjustment transactions for the selected
period

Act_Earnings Total earnings for the selected period

Act_EarnTax Tax earned on Purchases within period

Act_EndBal A/R balance at the end of the selected period

Same as < Emp_ArBal>

Act_LoanAdjust Total amount of adjustments posted to the loan for the selected period

Act_LoanCollect Total amount of payment collections posted to the loan for the selected
period

Act_LoanDisburse Total amount of disbursement fundings posted to the loan for the selected
period

Act_LoanTrfFrom Total amount of transfers posted from the loan for the selected period

Act_LoanTrfTo Total amount of transfers posted to the loan for the selected period

Act_NonFactored Total amount of non-factored payments posted for the selected period

Act_Purchases Total amount of invoices purchased for the selected period

This code equals the same value as <Act_DebitMemo> + <Act_Cred-
itMemo>

Act_Rebates Total amount of rebates for the selected period

Act_Recourse Total amount of recoursed invoices for the selected period

Act_Refactors Total amount of fees generated from invoices refactored for the selected
period

Act_RsvHeld Total amount of reserves held on purchases for the selected period

Act_RsvRel Total amount of all reserve releases for the selected period (this includes
releases done from the release tab of the client summary screen, as well as
monies released from the reserve from the checks/journals screen)

Act_RsvRelExp Total amount of expenses captured from reserve releases done from the
release tab of the client summary screen for the selected period

Reports User Guide
Crystal (Legacy) Reports

948 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Name Description

Act_RsvRelTrans Total amount of Reserve Release transactions only.

Act_SalesExp Total amount of expenses captured from purchases for the selected period

Act_StmtEarn Total amount of earnings captured from posted statements for the selected
period

Act_Suspense The net total of debit and credit items to the suspense accounts for the
selected period

Act_SuspenseActAl Total net Hold Account activity for the reporting date range (Collection Hold
Acct Activity + C-Misc Journal Hold Acct Activity)

Act_SuspenseActColl Total net Hold Account activity from Collections for the reporting date range

Act_Verified Total amount of invoices verified for the selected period

Act_VerPre The pre-purchase verification total amount at the end of the selected
period.

Act_VerPost The post-purchase verification total amount at the end of the selected
period.

Act_WriteOff Total amount of write-offs processed for the selected period

Adv_Current Total amount of A/R that is current

Adv_PastAmt0 Total amount of A/R in the first aging bucket

Adv_PastAmt1 Total amount of A/R in the second aging bucket

Adv_PastAmt2 Total amount of A/R in the third aging bucket

Adv_PastAmt3 Total amount of A/R in the fourth aging bucket

Adv_PastAmt4 Total amount of A/R in the fifth aging bucket

Adv_PastAmt5 Total amount of A/R in the sixth aging bucket

Adv_PastAmt4+5 Total amount of A/R in the fifth and sixth aging bucket

This code also equals <Adv_PastAmt4> + <Adv_PastAmt5>

AdvRate Advance rate from the client terms currently assigned to the client record
(e.g. 85.00)

AdvRatePer Advance rate percentage from the client terms currently assigned to the cli-
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Field Name Description

ent record (e.g. 0.85)

Age_Current Total of the current aging

Age_PastAmt0 Total of the current aging

Same as Age_Current

Age_PastAmt1 Total of the first aging bucket

Age_PastAmt2 Total of the second aging bucket

Age_PastAmt3 Total of the third aging bucket

Age_PastAmt4 Total of the fourth aging bucket

Age_PastAmt5 Total of the fifth aging bucket

Age_PastAmt4+5 Combination of fields <Age_PastAmt4> plus <Age_PastAmt5>

Age_PastPer0 This is the percentage of the total A/R that falls into the current aging
bucket. This can also be calculated as <Age_Current> divided by <Act_
EndBal>

Age_PastPer1 This is the percentage of the total A/R that falls into the first aging bucket.
This can also be calculated as <Age_PastAmt1> divided by <Act_EndBal>

Age_PastPer2 This is the percentage of the total A/R that falls into the second aging
bucket. This can also be calculated as <Age_PastAmt2> divided by <Act_
EndBal>

Age_PastPer3 This is the percentage of the total A/R that falls into the third aging bucket.
This can also be calculated as <Age_PastAmt3> divided by <Act_EndBal>

Age_PastPer4 This is the percentage of the total A/R that falls into the fourth aging bucket.
This can also be calculated as <Age_PastAmt4> divided by <Act_EndBal>

Age_PastPer4+5 Combination of fields <Age_PastPer4> plus <Age_PastPer5>

AttnContacts List all active contacts for the client with Attention selected in the Client
Information Contacts tab.

AuthContacts List all active contacts for the client with Authority selected in the Client
Information Contacts tab.

AveLoanBal Average loan balance as of the reporting date
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Field Name Description

Beg_ArBal A/R balance at the beginning of the period

Same as <Act_BegBal>

Beg_FeeEscrow Fee escrow balance at the beginning of the period

Same as <Act_BegFeeEscrow>

Beg_LoanAmt Loan balance at the beginning of the selected period

Beg_MedArAmt Beginning A/R amount for medical receivables as of the reporting date

Beg_MedArBal Beginning A/R balance for medical receivables the day before the reporting
date

Beg_NetFunds Net funds employed balance at the beginning of the period

Same as <Emp_BegDeployed>

Beg_RsvAmt Cash reserve balance at the beginning of the period

Same as <Emp_BegCashRsv>

Beg_RsvEscrow Reserve escrow balance at the beginning of the period

Same as <Act_BegRsvEscrow>

Bkr_CommsAmt The total amount of broker commission at the end of the selected period.

Bkr_OthRate The broker commission rate for brokers not selected in the Parameters tab
of the Client Summary Worksheet (i.e., "other" brokers). If there are more
than one, the percentage is cumulative of all "other" brokers percentages.

Bkr_SelRate The broker commission rate for the Broker selected in the Parameters tab of
the Client Summary Worksheet screen, if applicable.

Col_AnyDilution If there was dilution during the period, this value will be returned as TRUE. If
there was no dilution during the period, the value returned will be FALSE.

Col_Balance Current A/R balance for the selected period Same as <Emp_ArBal>

Col_Collateral Available collateral

Calculated as (<Emp_ArBal> - <Col_Dilution> - <Col_Recourse> - <Col_
InelAll> - <Col_InelTable>

Col_Dilution Total Dilution for the selected period
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Field Name Description

Calculated as (Charge-backs on paid positive invoices / Total positive
invoices paid)

Col_Dilution% The dilution percentage over time.

Col_InDispute Total amount of all current invoices in dispute

Col_InelAll Current total amount of all ineligible items (ineligible for any reason)

Same as <Col_InelInvoices> + <Col_InelTierAmt> + <Col_InelCrossAmt> +
Col_InelOverCred>

Col_InelCrossAmt Current total amount of all invoices ineligible due to cross ineligibility reas-
ons

Col_InelInvoices Total amount of all ineligible specific invoices

Col_InelInv&Over Total amount of ineligibility due to specific ineligible invoices and invoices
over credit limits.

This code also equals (<Col_InelInvoices> plus <Col_InelOverCred>)

Col_InelOverCred Current total amount of all invoices ineligible due to being over a credit limit

Col_InelTable Total amount of ineligibility from the Ineligible Titles Table

Col_InelTierAmt Total amount of ineligibility generated by the tiered ineligibility table

Col_InelTier&Cross Total amount of ineligibility generated by cross ineligibility and tiered
ineligibility table

Same as (<Col_InelTierAmt> + <Col_InelCrossAmt>)

Col_RecDays The age (in number of days) specified in the client information at which an
invoice becomes available for recourse

Col_RecDaysShortOver Recourse not including in dispute; calculated as field <Col_RecDays> plus
<Col_RecShort> plus <Col_RecOver>.

Col_Recourse All recourse items; calculated as <Col_RecDaysShortOver> plus <Col_InDis-
pute>.

Col_RecOver The total amount of cash posting credit chargebacks for the period selected

Col_RecShort The total amount of cash posting debit chargebacks for the period selected

Col_Unpaid The total amount of the total number of unpaid items in open A/R for a spe-
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Field Name Description

cific date range

Contacts List all active contacts for the client in the Client Information Contacts tab.

CurrencyType Currency type assigned to client. From Client Information, Control tab.

Emp_AdvBal The advance balance at the end of the selected period

Emp_AmortLoan The balance of the loans payable G/L account at the end of the selected
period

Emp_ArBal The total amount of the A/R balance at the end of the selected period Same
as < Act_EndBal>

Emp_BegCashRsv Cash reserves balance at the beginning of the selected period

Emp_BegDeployed Funds employed balance at the beginning of the selected period.

Emp_BulkARAdvRate The Advance Rate stored within the ABL Bulk Loan Posting closest to the
given as-of date. The following query retrieves the advance rate.

Emp_BulkIneligAmt The Total Bulk Ineligibles at the client level as posted by the user and stored
in the AblBulkIneligHdr and AblBulkIneligDtl tables. This element provides the
most current record for a given client and date.

Emp_BulkEligCollAmt Returns the Eligible bulk A/R collateral.

Same as <emp_BulkARBal> – <emp_BulkIneligAmt>

Emp_BulkNetCollAmt Returns the Net Bulk Collateral.

Same as (<emp_BulkARBal> – <emp_BulkIneligAmt>) * <emp_BulkARAd-
vRate>

Emp_BulkUnApplied Unapplied cash balance as of the reporting date selected

Emp_CashRsv Cash reserves balance at the end of the selected period

Emp_Deployed Funds employed balance at the end of the selected period

Emp_Escrow Total escrow held; this is <Emp_FeeEscrow> plus <Emp_RsvEscrow>.

Emp_FeeEscrow Fee escrow balance at the end of the selected period

Emp_LoanAmt Loan Balance as of the date selected

Emp_MedArAmt Current A/R balance for medical receivables the day before the reporting
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Field Name Description

date

Emp_MedArBal Current A/R amount for medical receivables as of the reporting date

Emp_MedDeclDate Declaration posting date

Emp_NetSettle The net settlement amount at the end of the selected period. The formula
for this field is:

EmpNetSettle = EmpDeployed + Rsv_AccInvFees + Rsv_AccInvTax + Rsv_
intFees

Emp_PoFinance Purchase order finance balance at the end of the selected period

Emp_RsvEscrow Reserve escrow balance at the end of the selected period

Emp_Settle The amount of funds awaiting settlement at the end of the selected period
(settlement, in this context, is about advancing funds before the invoice is
purchased, as in PO financing. When the invoice is purchased, the funds are
settle out the settlement account).

Emp_SimpLoan The simple loan balance at the end of the selected period.

fac_accruedfee The sum of the facility reserve fees under a client.

fac_feebal The facility fee balance for the specified period.

fac_feersv The amount of facility fee reserve for the specified period.

fac_ineligibles The sum of the facility ineligibles under a client.

fac_limit The sum of the facility limits under a client.

fac_otherrsv The amount of facility other fee reserve for the specified period.

fac_paymentrsv The amount of facility payment reserves for the specified period.

fac_ucbal The facility unapplied cash balance for the specified period.

FinChgDebtor Indicates (True/False) if there is a second monthly statement charge and
finance charges are accessed against debtors. From Client Terms, Addi-
tional Fees tab.

FinChgPer Finance charge per from any second monthly statement charge. From Cli-
ent Terms, Additional Fees tab.

0=day
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Field Name Description

1=month

2=year 360

3=year 365

4=year actual

FinChgRate Finance charge rate from any second monthly statement charge. From Cli-
ent Terms, Additional Fees tab.

FirstBuyDate Lists the date of first purchase for the client.

FirstFundDate Lists the date of first funding for the client.

FloatDays Float days from the client terms record currently assigned to the client. From
Client Terms, Float days tab

FloatDaysAre Code from client terms record currently assigned to the client to indicate on
what float days are based. From Client Terms, Float days tab.

0=Calendar Days

1=Monday-Friday

2=Business Days

GuarContacts List all active contacts for the client with Guarantor selected in the Client
Information Contacts tab.

InelTable Total value of the ineligible titles table for the client. From Tables, Ineligible
titles table.

MasterName Lists the master client name. If the current client does not have a master cli-
ent, blanks are returned. If the current client does have a master client, the
master client name and number (if applicable) are returned.

Members List of members of this master client. If the client is not a master client this
will be the name of the client. From Client Information screen, Part of Master.

Misc=DE name

(where "DE name" is the
actual Miscellaneous
Data Element name)

Name of the miscellaneous data element to reproduce in the Client Sum-
mary Worksheet. Miscellaneous Data Elements are created and their value
defined on the Misc. Data tab of the Client Information screen. Note the vari-
ation in format of the field name: a miscellaneous data element value is
included in the Client Summary Worksheet by including the misc= field
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Field Name Description

along with the actual data element name defined on the Client Information
Screen. From Client Information, Misc. data. tab

NameWithCode Client name with client number following in parenthesis if a client number
exists. From Client Information screen, Client name, Client code.

NoticeContacts List all active contacts for the client with Notices selected in the Client Inform-
ation Contacts tab.

Office Office assigned to client. From Client Information, Control tab.

OldestOpenInvDate Lists the invoice date of the oldest open invoice by invoice date.

OldestOpenInvDateNo Lists the invoice number of oldest open invoice by invoice date.

OldestOpenPostDate Lists the post date of the oldest open invoice by post date.

OldestOpenPostDateNo Lists the invoice number of the oldest open invoice by post date .

ProgAdminFeeTaken Code for when the administrative fee is taken from the current client terms
record. From Client Terms, Portfolio Fees tab.

0=On Fee Statement

1=At Purchase

2=At Collection)

ProgAdminRate Administrative fee % from the client terms record currently assigned to the
client. From Client Terms, Portfolio Fees tab.

ProgAdvanceRate Advance rate from the client terms record currently assigned to the client.
From Client Terms, Portfolio Fees tab.

ProgDailyRate Daily rate from the client terms record currently assigned to the client. From
Client Terms, Portfolio Fees tab.

ProgFeeBasisKey Database key of daily rate basis plus table from the client terms record cur-
rently assigned to the client.

ProgFeeRatePer Daily rate per code from the client terms record currently assigned to the cli-
ent. From Client Terms, Portfolio Fees tab.

0=day

1=month
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Field Name Description

2=year 360

3=year 365

4=year actual

ProgRecourseDays Recourse days from the client terms record currently assigned to the client.
From Client Terms, Recourse tab.

ProgRecourseType Recourse type from the client terms record currently assigned to the client.
From Client Terms, Recourse tab.

0=Recourse is stated in days

1=Recourse is stated in statements

ProgRsvEscrow Indicates if reserve escrow is held from the client terms record currently
assigned to the client. From Client Terms, Purchase Fees tab.

True=Reserve is Escrowed

False=Reserve is not Escrowed

ProgTitle Displays the Client Terms descriptive name for the client.

ProgType Program type code from the client terms record currently assigned to the cli-
ent. From Client Terms, Type field.

0= Invoice based terms

1= Portfolio based terms - Daily rate

2= Portfolio based terms - A/R finance

3= Inventory – non A/R

4=Time Payments

5=Loan Style Terms

6=Merchant Bank Terms

Rsv_AccInvFees The total amount of the accrued invoice fees at the end of the selected
period

Rsv_AddlFeeAcc The total amount of the accrued additional fees at the end of the selected
period
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Field Name Description

Rsv_AddlReqd The total amount of additional reserves required at the end of the selected
period

Rsv_AdjRsv The adjusted reserve balance at the end of the selected period

Rsv_AdvanceRate Advance rate from the client terms record currently associated with the cli-
ent

Rsv_Available Total available reserves for the period

Same as Reserve "Available for Release" on Client Summary Report

Rsv_AvailRsv Available reserves

Calculated as (<Rsv_MaxAdvance> - <Rsv_FundsEmpl>)

Rsv_CashRsv Total cash reserve balance at the end of the selected period

Rsv_Collateral Total collateral at the end of the selected period

Same as <Col_Collateral>

Rsv_EarnedFeeAcc The total amount of the accrued earned fees at the end of the selected
period.

Rsv_Escrow The total amount of escrow (fee and reserve) at the end of the selected
period

Calculated as (<Emp_FeeEscrow> + <Emp_RsvEscrow>)

Rsv_FundsEmpl Funds employed balance at the end of the selected period

Same as <Emp_Deployed>

Rsv_Ineligible Total amount of ineligibles

Same as (<Col_Recourse> + <Col_InelAll>)

Rsv_IntFees Total amount of NFE fees plus daily fees for the selected period

Rsv_MaxAdvance Maximum advance based on current collateral

Calculated as (<Col_Collateral> * <Rsv_AdvanceRate>)

Rsv_PriorAccFees The total accrued fees for the previous period

Rsv_ReqRsv The total required reserve based on the current A/R balance
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Field Name Description

Rsv_TotRsv The total of Cash Reserves and Escrowed Reserves

Same as (<Rsv_CashRsv> + <Rsv_Escrow>)

StmtGuarAmt The total sales or earnings amount guaranteed to be sold by the client over
the period specified in StmtGuarMos. From Client Information, Statement
Terms panel.

StmtGuarMos The number of months over which the sales or earnings guarantee applies.
From Client Information, Statement Terms panel.

StmtGuarType The basis for the guarantee of sales for the statement period. Sales or
Earned Fees. From Client Information, Statement Terms panel.

Territory Territory value assigned to region for the client. From Tables, Region table.

Trend_AnnAvgBal The average annual A/R balance

Trend_AnnPurch The average annual purchase

Client Oriented Field Codes (Returned by fsClient API)

The Client Oriented Field Codes are used to display a variety of attributes for Clients, taken from Client
Information, Client Terms, and several Tables.

Field Name Description

AcctExecName Name of the account executive assigned on the Control Panel of the Client
Information. From Client Information, Control tab.

AttnContacts List all active contacts for the client with Attention selected in the Client Inform-
ation Contacts tab.

AuthContacts List all active contacts for the client with Authority selected in the Client Inform-
ation Contacts tab.

Contacts List all active contacts for the client in the Client Information Contacts tab.

CurrencyType Currency type assigned to client. From Client Information, Control tab.

FinChgDebtor Indicates (True/False) if there is a second monthly statement charge and fin-
ance charges are accessed against debtors. From Client Terms, Additional
Fees tab.

FinChgPer Finance charge per from any second monthly statement charge. From Client
Terms, Additional Fees tab.
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Field Name Description

0=day

1=month

2=year 360

3=year 365

4=year actual

FinChgRate Finance charge rate from any second monthly statement charge. From Client
Terms, Additional Fees tab.

FirstBuyDate Lists the date of first purchase for the client.

FirstFundDate Lists the date of first funding for the client.

FloatDays Float days from the client terms record currently assigned to the client. From Cli-
ent Terms, Float days tab

FloatDaysAre Code from client terms record currently assigned to the client to indicate on
what float days are based. From Client Terms, Float days tab.

0=Calendar Days

1=Monday-Friday

2=Business Days

GuarContacts List all active contacts for the client with Guarantor selected in the Client Inform-
ation Contacts tab.

InelTable Total value of the ineligible titles table for the client. From Tables, Ineligible titles
table.

Members List of members of this master client. If the client is not a master client this will
be the name of the client. From Client Information screen, Part of Master.

Misc=”DE name” Name of the miscellaneous data element to reproduce in the Client Summary
Worksheet. Miscellaneous Data Elements are created and their value defined
on the Misc. Data tab of the Client Information screen. Note the variation in
format of the field name: a miscellaneous data element value is included in the
Client Summary Worksheet by including the “misc=” field along with the actual
data element name defined on the Client Information Screen. From Client
Information, Misc. data. tab
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Field Name Description

NameWithCode Client name with client number following in parenthesis if a client number
exists. From Client Information screen, Client name, Client code.

NoticeContacts List all active contacts for the client with Notices selected in the Client Inform-
ation Contacts tab.

Office Office assigned to client. From Client Information, Control tab.

ProgAdminFeeTaken Code for when the administrative fee is taken from the current client terms
record. From Client Terms, Portfolio Fees tab.

0=On Fee Statement

1=At Purchase

2=At Collection)

ProgAdminRate Administrative fee % from the client terms record currently assigned to the cli-
ent. From Client Terms, Portfolio Fees tab.

ProgAdvanceRate Advance rate from the client terms record currently assigned to the client.
From Client Terms, Portfolio Fees tab.

ProgDailyRate Daily rate from the client terms record currently assigned to the client. From Cli-
ent Terms, Portfolio Fees tab.

ProgFeeBasisKey Database key of daily rate basis plus table from the client terms record cur-
rently assigned to the client.

ProgFeeRatePer Daily rate per code from the client terms record currently assigned to the client.
From Client Terms, Portfolio Fees tab.

0=day

1=month

2=year 360

3=year 365

4=year actual

ProgRecourseDays Recourse days from the client terms record currently assigned to the client.
From Client Terms, Recourse tab.

ProgRecourseType Recourse type from the client terms record currently assigned to the client.
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Field Name Description

From Client Terms, Recourse tab.

0=Recourse is stated in days

1=Recourse is stated in statements

ProgRsvEscrow Indicates if reserve escrow is held from the client terms record currently
assigned to the client. From Client Terms, Purchase Fees tab.

True=Reserve is Escrowed

False=Reserve is not Escrowed

ProgTitle Displays the Client Terms descriptive name for the client.

ProgType Program type code from the client terms record currently assigned to the cli-
ent. From Client Terms, Type field.

0= Invoice based terms

1= Portfolio based terms - Daily rate

2= Portfolio based terms - A/R finance

3= Inventory – non A/R

4=Time Payments

5=Loan Style Terms

6=Merchant Bank Terms

StmtGuarAmt The total sales or earnings amount guaranteed to be sold by the client over the
period specified in StmtGuarMos. From Client Information, Statement Terms
panel.

StmtGuarMos The number of months over which the sales or earnings guarantee applies.
From Client Information, Statement Terms panel.

StmtGuarType The basis for the guarantee of sales for the statement period. Sales or Earned
Fees. From Client Information, Statement Terms panel.

Territory Territory value assigned to region for the client. From Tables, Region table.
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Clients Table Field Codes

The following codes are accessed directly from the Client Table, and can be used in Client Summary Work-
sheet templates.

Field Name Field Type Field Length

AcctExec nvarchar 24

AcctGroupHdrKey int 4

Addr1 nvarchar 100

Addr2 nvarchar 100

AeCliApprRuleKey int 4

AgeDays1 int 4

AgeDays2 int 4

AgeDays3 int 4

AgeDays4 int 4

AgeDays5 int 4

AgeInterval smallint 2

AgingAccurate bit 1

AgingAsOfDate datetime 16

AllowDating bit 1

AllowHauler bit 1

AllowInstallments bit 1

AllowLoads bit 1

AllowPoFinance bit 1

AltName nvarchar 200

AtRistReqd bit 1

AutoApprRuleKey int 4

AutoCloseHoldAbbr nvarchar 12
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Field Name Field Type Field Length

AutoNonHoldAbbr nvarchar 40

AutoOverAction smallint 2

AutoOverAmtLimit money 21

AutoOverHoldAbbr nvarchar 12

AutoRecHoldAbbr nvarchar 12

AutoShortAmtLimit money 12

AutoShortPerLimit money 12

BankState nvarchar 60

BegAsOfDate datetime 16

BegBalAmt money 21

BegFeeEscrow money 21

BegRsvAmt money 21

BegRsvEscrow money 21

BegSettleAmt money 21

BizType nvarchar 40

BulkChargeBack bit 1

CalcColFeeOnNegInv bit 1

CalcColFeeOnNegInv bit 1

CalcNoFloat bit 1

City nvarchar 100

ClientKey int identity 4

ClientMotorNo nvarchar 12

ClientNo nvarchar 24

CloseDay smallint 2
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Field Name Field Type Field Length

ConcentrationLimit money 21

Country nvarchar 60

CredAppBy nvarchar 24

CredAppFor nvarchar 24

CredRate nvarchar 20

CrossAgeInelig bit 1

CrossAgePercent money 21

CurrBalAmt money 21

CurrencyType nvarchar 40

CurrFeeEscrow money 21

CurrNonFundAmt money 21

CurrRsvAmt money 21

CurrRsvEscrow money 21

DaysDue smallint 2

DbDunsNo nvarchar 40

DebtorMotorNo nvarchar 12

DefaultBankAcctKey int 4

DefaultRsvAcctKey int 4

DeliverBy nvarchar 60

DilutionLimit money 21

DiscDays int 4

DiscRate money 21

DueFrom smallint 2

EarlyPayToFactor bit 1
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Field Name Field Type Field Length

EdiInterchangeNo nvarchar 18

Email nvarchar 100

ExpectedDilution money 21

ExtendInel smallint 2

Fax nvarchar 40

FedBizNo nvarchar 60

FedCoNo nvarchar 60

FedTaxNo nvarchar 40

FundNotes ntext <memo>

HoldInclEscrow bit 1

HoldInclMisc bit 1

HoldRsvAmt money 21

HoldRsvCode int 4

HoldRsvLarge money 21

HoldRsvLim money 21

HoldRsvPer money 21

Inactive bit 1

Inbox nvarchar 40

IndivCreditLimit money 21

IndivCreditPer money 21

IneligDays smallint 2

InsurerAmt money 21

InsurerExpire smalldatetime 16

InsurerKey int 4
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Field Name Field Type Field Length

InvDupeRule smallint 2

InvTerms nvarchar 80

LanguageCode nvarchar 40

LoadAdvanceLimit money 21

MasterClient smallint 2

MasterClientKey int 4

MaxInvAge smallint 2

MaxInvAmt money 21

MaxWriteOff money 21

MgrCliApprRuleKey int 4

MinInvFee money 21

MotorCarrNo nvarchar 12

Name nvarchar 200

NameKey nvarchar 60

NeverTfr bit 1

NextBatchNo int 4

NextColNo int 4

NextInvNo nvarchar 20

NoAdvAtBuy bit 1

NoaReqd bit 1

NoaWaivedLim money 21

NoBuy bit 1

NoDebLimIsIneligible bit 1

NoFeeOnNegInv bit 1
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Field Name Field Type Field Length

NoMixedBuy bit 1

NoRecourse int 4

NoRsvOnNegInv bit 1

NoRsvRel bit 1

NoStmt bit 1

Notes ntext <memo>

Office nvarchar 40

OkBy nvarchar 24

OnlyFromTfr bit 1

OverDebLimIsIneligible bit 1

ParticipantKey int 4

ParticipationCode smallint 2

ParticipationRate money 21

Password nvarchar 24

PastDueDays smallint 2

PayRebatesOnCollection bit 1

Phone1 nvarchar 40

Phone2 nvarchar 40

PoAdvanceLimit money 21

Policies ntext <memo>

PreCalcTime datetime 16

Preference smallint 2

ProgramsKey int 4

PurchOrdReqd smallint 2
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Field Name Field Type Field Length

PurProg nvarchar 16

RecourseDays smallint 2

Region nvarchar 60

RelAddOn int 4

RsvBankAcctNo nvarchar 40

ScanTableKey nvarchar 40

ShowOnBuy bit 1

Sic nvarchar 20

SignedDate datetime 16

SignLines smallint 2

SmartFaxNo nvarchar 30

Source nvarchar 60

State nvarchar 60

StdDiscount money 21

StmtDesc text <memo>

StmtTextName nvarchar 40

TaxCode nvarchar 6

TermDate datetime 16

TermDesc ntext <memo>

TermDisputeKey int 4

TierInelHdrKey int 4

TotalCreditLimit money 21

UccDate datetime 16

UccNo nvarchar 40
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Field Name Field Type Field Length

VerificationNote ntext <memo>

VerRatio money 21

VerReqd bit 1

VerReqdAmt money 21

VolRebateHdrKey int 4

Warning nvarchar 100

WebAccess bit 1

WebChatOk bit 1

ZipCode nvarchar 20

Creating a New Client Summary Worksheet Template

NOTE
This is a how-to guide focused primarily on the functionality of FactorSoft, and consequently assumes
a level of knowledge with Microsoft Excel. For tutorials and help creating Excel spreadsheets, we recom-
mend visiting http://office.microsoft.com/en-us/excel/FX100646951033.aspx.

You can create reports in a variety of formats using Microsoft Excel and the defined FactorSoft Field Codes
(a complete list of field codes is included in this document at Client Summary Worksheet Field Codes).
The following provides instruction on creating such a report from scratch.

This report would contain four data fields:

Name Field Code

Client Name NameWithCode

A/E Name AcctExecName

Beginning Balance Act_BegBal

Ending Balance Act_EndBal

In addition, this example contains two formulas, summing the beginning and ending balances (formula is
=Sum(firstCell:lastCell) ).
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This description is based on Microsoft Office Excel 2007. Actual steps may vary based on the version of
Microsoft Office you are using.
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1. To begin, open a new Book in Microsoft Excel.

NOTE
In the Client Summary templates, column A is used to identify row types to FactorSoft, so should
never be used to contain any printed data. In fact, when you create output from the Client Sum-
mary Report, you will want to hide column A to prevent these codes from being printed in the
final output.

2. Grab the border of column B and widen it out to accept a longer field.

This will contain the Client Name field, so be sure to provide plenty of room.

Before creating the header line, enter two fields that will print your company’s name and the as-of
date for the report at the top left of the report.

3. In cell B1, enter field code <FactorName> to import your company name.

4. In cell B2, enter the text “As of:” followed by the field code <AsOfDate> to print the as-of date of the
report.

Next, enter the header line that will define the heading rows.

5. In cell A4, enter H to create a header row.

There are three row type identifiers that can be entered in column A:

Field Description

H Header row. A header row accepts text and cell formatting. The out-
put of a header row is static.

R Repeating data row. A repeating data row accepts either text or field
codes or a combination of the two. Field codes are entered between
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Field Description

“angle brackets” (technically the less-than and greater-than sym-
bols – e.g. <field_code>).

T Totals row. Totals rows contain Excel formulas. If sorting is used on the
Client Summary Worksheet screen, the report will be subtotaled at
each break point and a grand total will be created at the end of the
report.

Note that if the Accumulate to master clients option is selected in the
Client Summary Worksheet screen, the columns for which you want to
accumulate member totals to the master must be included in a totals
row to display the accumulated master totals in the generated work-
sheet.

6. Enter the text for the first header in cell B4:

7. In cell 5A, enter H.

NOTE
An empty H row must precede the first R
row.

8. In cell 6A, enter R to create a repeating data row.

9. In cell 6B, enter the field code for the client name and code.

Next, expand columns, enter header text and field codes for the remainder of the data on the report,
as shown in the following illustration. Note that columns D and F are used as spacing between the
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two amount columns, and also that a border has been added to the header row. This was done by
selecting rows B4 through G4, right-clicking in the selected row, selecting Format Cells, and then
the Border tab on the Format Cells screen.

10. In cell 7A, enter an H to insert another blank row after the repeating data row.

NOTE
An empty H row must precede the last R
row.

11. In cell A8, enter T to create a totals row.

12. Enter an Excel formula in the Total row for the Beginning Balance:
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l Select cell E8.

l Select the Formula tab and click AutoSum in the Excel ribbon.

l Enter the cell prior to the first R row as the first coordinate, a colon, and then the cell following
the last R row as the second coordinate. A blue box should surround the cells to be summed,
as in the following illustration.

l Press the Enter key.

A zero is displayed in row E8.

13. Enter an AutoSum formula for the Ending Balance using the same procedure as above.

14. Right-click in column A and click Hide in the pop-up menu.

This hides column A so that the Row Type Identifiers are not printed in the output.

See Client Summary Worksheet Field Codes for details about the field codes available for use in Cli-
ent Summary Worksheets. The data displayed when the worksheet is processed are the actual val-
ues from your database.
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Generate the 2020 Tax Guard Spreadsheet

A template to extract information for interface with 20/20 Tax Guard Monitoring Service has been added
for the Client Summary Worksheet in the Reports module in version 2.14.7. This template can be used to
electronically transmit client information to 20/20 Tax Guard for the creation of IRS form 8821. To create
the Tax Guard spreadsheet:

1. Open the reporting module and choose Client Summary Worksheet from the Client Menu.

2. From the drop-down list of spreadsheet templates, select the 2020TaxGuardTemplate.x ls.

NOTE
If you do not have this spreadsheet in your Reports directory, contact Support to arrange to
have the worksheet added to your Reports Folder.

3. Enter the current days date in the As-of date

4. Enter any valid day in the past in the Activity From Date.

NOTE
There is no financial data in the extract, so the actual date set for the Activity From Date is not
important.

Generate the Client Summary Worksheet

The Client Summary Worksheet screen is the tool in FactorSoft that is used to create reports from the tem-
plates created in Excel spreadsheets. A full description of the Client Summary Worksheet screen is found
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in the FactorSoft Reports section of this guide. This section contains examples in which the Client Balance
List template created in the previous section is utilized to demonstrate generating and sorting reports.

To generate the desired Client Summary Worksheet report, simply select the desired template, set the
selection criteria to limit the report to the desired data, and then click the Process button. The completed
Client Summary Worksheet report is created and saved as an Excel spreadsheet. The location that the
completed spreadsheet is created is defined by a System Constant: Reports, Client summary
worksheet, Folder for completed Excel Spreadsheets.

Example 1

In this example, the Client Balance List report created in the previous section is selected, and the only
selection criteria selected is the date range.

When the Process button is pressed, a progress bar appears showing the progress of the report, and then
a message appears that contains the location and name of the completed report.

The processing of the report retrieves the data from the database and generates the results in an Excel
spreadsheet

Reports User Guide
Crystal (Legacy) Reports

977 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Example 2

This example uses the same template as Example 1, but shows the effect of using a Sort field and limiting
display to Active accounts only in Client Filters:

l Show active clients only

l Sort by Account Executive
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The processing of the report retrieves the data from the database and generates the results in an Excel
spreadsheet:

Note that the report format, which is controlled by the template, is the same, but the results are grouped
by Account Executive (based on the Sort criteria) and subtotaled by Account Executive.
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Example 3

This example shows the Client Worksheet report generated based on the options specified on the Client
Summary Worksheet screen. The Client Worksheet template is one of the stock templates provided with
FactorSoft (ClientWorkSheet.xls):

The processing of the report retrieves the data from the database and generates the results in an Excel
spreadsheet:

Getting Started

This section of the document addresses the following topics:
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l Creating a new Client Summary Worksheet

l Saving the worksheet template in the FactorSoft Reports directory

l Generating Client Summary Worksheets

FactorSoft is provided with an array of pre-defined templates designed to suit a variety of anticipated
reporting needs. These reports can be customized to suit your needs such as isolating one or including all
clients, grouping by specific subcategories (A/E, Client Group, Office, etc), and sorting to prioritize results
based on the selection criteria entered on the Client Summary Worksheet screen. These templates are
outlined in the following table:

Template Description

Activity_Accrual_
Summary.xls

The Activity Accrual Summary provides a summary of clients’ A/R activity, Cash
Received, Purchases, Reserve Activity, Settlement, and Fees during a specified
date range.

Activity_By_
Region.xls

The Activity By Region report provides a summary of clients’ A/R activity,
broken-out by region during a specified date range, including Amounts, Fees,
Averages, and Number of Buys, Invoices, Checks, Payments, and Adjustments.

AR_Loan_Sum-
mary.xls

The AR Loan Summary provides a snapshot of clients’ A/R activity during a spe-
cified date range, including Amounts, Fees, Averages, and Number of Buys,
Invoices, Checks, Payments, and Adjustments.

Average_Net_Fund-
s.xls

The Average Net Funds report provides a summary of clients’ Current Gross A/R,
Current Cash Reserves, Current Escrowed Reserves, Current Funds Employed,
and Average Funds Employed.

Balance.xls The Balance report provides a summary of clients’ A/R activity during a spe-
cified date range, including Amounts, Fees, Averages, and Number of Buys,
Invoices, Checks, Payments, and Adjustments.

Broker_Analysis.xls The Broker Analysis report provides a summary of Broker activity during a spe-
cified date range, including A/R Activity—balances, purchases, collections,
chargebacks, giveback, gross collections—Settlement, a breakdown of Fees,
and a breakdown for Commissions. The Date Signed is also listed.

The report can be run on one broker or all brokers, for all or one client. The Sort
Fields do not apply to this report.

ClientWorkSheet.xls The Client Worksheet provides a summary of clients’ financial activity, by A/E,
during a specified date range, including Gross A/R, Recourse/Ineligible, Eligible
A/R, Advance Rate, Gross Available, Funds Employed, Accrued Fees, Available
Cash, Current Balance, a breakdown of balances by Aging bucket and the per-
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Template Description

centage of each against the Total, a Month To Date summary of Sales,
Recourse, Payments chargebacks, givebacks, WO/Suspense, as well as dilution
percentage.

Ineligibility.xls The Ineligibility report provides a summary of clients’ ineligibility during a spe-
cified date range, including Gross A/R, Cash Reserves, Escrowed Reserves,
Funds Employed, Effective Rate, Industry, Eligible Rate, Ineligible Rate, and Ine-
ligible Amount.

Insurers.xls The Insurers report provides a summary of Insurers for each client, and lists the
Insurer, Amount Insured, Expiration, and UCC#. The report can be run on one cli-
ent or all clients.

Save the Worksheet Template

When you have created the template in Excel, save it to the FactorSoft Report Path. All templates must be
saved in the defined Reports directory, typically C:\FactorSoft\Reports. To verify your defined Report dir-
ectory, open the About FactorSoft screen from the Help menu.

NOTE
If an older version of FactorSoft is being used, the path may be displayed with a FactorSoft or
CADENCE folder instead of a FactorSoft folder.

Templates for use with the Client Summary Worksheet must be saved in the .XLS format specific to
Microsoft Excel 97-2003, not the newer .XLSX format specific to Microsoft Excel 2007. If using Excel 2007,
select Save As and in the Save As Type list, select Excel 97-2003 Workbook (*.xls).

The Report Path field contains the path where you must save the Excel spreadsheet templates.

1. Save the template as an .XLS file.

2. Save the template with a descriptive name (Client_Balance_List.xls in this example) to make it easy
for anyone who might use the report to find it.

Using the Client Summary Worksheet

Business methods among lenders vary greatly; consequently, their requirements for personalized reports
vary as well. The Client Summary Worksheet in FactorSoft was developed with customization in mind. With
it, you can create ad hoc reports based on many predefined data fields from the Client and CalcClient
tables and then save the report as a template to be reused over and over again.
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Client Summary/Ineligibility Report

This report lists Funds Employed, Collateral and Reserves for the client listed or all clients for the selected
dates.

The Client Summary/Ineligibility Report can optionally produce a Microsoft Excel
spreadsheet output instead of a traditional report. To enable this functionality:

l Set System Preference Reports, Client summary/reserve release, Report is to
Excel template

l Save the Excel template that defines the format of the report in the common
report folder (typically C:\FactorSoft\Reports)

If an older version of FactorSoft is being used, the path may be displayed with a Fact-
orSoft or CADENCE folder instead of a FactorSoft folder.

Set System Preference Reports, Client summary/reserve release, Report is to Excel template

Save the Excel template that defines the format of the report in the common report folder (typically
C:\FactorSoft\Reports)

If an older version of FactorSoft is being used, the path may be displayed with a FactorSoft or CADENCE
folder instead of a FactorSoft folder.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
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Field Description

True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

As of date Enter the “to” date of the date range for which to produce the report. Click Today adjacent
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Field Description

to this field to enter the current working date.

Activity
from date

Enter the “from” date of the date range for which to produce the report. Click Make 1st adja-
cent to this field to enter the first day of the current working date month.

Client sum-
mary
detail

Select this option to generate the Client Summary Detail report, which details balances for
each client in Funds Employed, Collateral, and Reserves sections.

Client sum-
mary total

Select this option to generate the Client Summary Total report, which is in the same format
as the Client Summary Detail, but contains only a total of all clients without individual client
detail.

Client
ineligibility
report

Select this option to generate the Ineligibility Report, which details ineligible invoices as indi-
vidual line items by debtor within client, displaying balances, ages, and ineligibility reason.

Convert
sum-
maries to
native cur-
rency

Select this option to convert amounts from the base currency to the native currency (the
currency of the transaction). The conversion occurs on a client-by-client basis. If the client
has a currency type set and the currency type is different from the default currency, Fact-
orSoft looks up the conversion rate using the As of date in the currency table for the client's
currency. For example, if client ABC Company has a currency type of Canadian Dollars and
the daily conversion rate for Canadian dollars is 1.5, the report increases all of the client's
amounts by a factor of 1.5.

Show Select the option that determines invoices to be included in the report. This option is only
available when the Client ineligibility report is selected:

l All unpaid invoices

l Ineligible invoices only

Sort Select the sort option that determines the order in which to display detail data. This option
is only available when the Client ineligibility report is selected:

l Debtor/Invoice: includes a break between each debtor with totals for Balance,
Amount Eligible, and Available fro Recourse.

l Invoice only: same as above, but without debtor break and totals.

Output Select one of the following print output options from the drop-down list:
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Field Description

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Process Click this button to generate the report to the Output method selected.

Exit Click this button to close the screen.

Report Sample

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, client summary/ineligibility reports folder.
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Preference Description

Accumulate master
clients

Set to True to group member clients to master client in the report results.

When this preference is set to True, this changes the Client Group/Value filtering
of the report. The client group functionality matches to the master client and
determines whether its members appear in the results returned on the report .
The Group and Value settings for the member clients of a master are not con-
sidered.

Available for Recourse Report

The Client Recourse - Available for Recourse Report generates a report that lists the items that are cur-
rently available for recourse or chargebacks. Typically, these items could include; Short payments, Over
payments, Unidentified Invoice, Items beyond Recourse days, and In Dispute Items. The report can include
opening and closing texts (defined in the Statement Text Table) so that the report can be provided to the
client as a notice of invoices eligible for recourse.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
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Field Description

the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Group/Valu-
e

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

In the adjacent list, select the specific client group value to which to limit the report results
from the list.

Client Groups are defined in the Group Code Table.

Click Clear to remove the selections.

As-of Date Set the date through which to limit the report results for items available for recourse
through a given date in the past. This is a required field.

Introduction Select the Statement Text Table entry that contains the text to include at the beginning of
the report. Leave this field blank if you don not which to include text at the beginning of
the report.

Conclusion Select the Statement Text Table entry that contains the text to include at the end of the
report. Leave this field blank if you don not which to include text at the end of the report.
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Field Description

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This Report Select a printer from the drop-down list to overwrite the printer default for this report only.

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help.

Show Eli-
gible

Select the options that indicate the invoices to be included in the report. Any individual
option, any combination of options, or all options are valid, but at least one must be selec-
ted to generated the report (provided there are matching invoices for the selection cri-
teria defined).

l Over age invoices

l Invoices paid short

l Invoices paid over

l Invoices in dispute

l Ineligible invoices

Sort by cli-
ent then

Select the secondary sort method that determines how items are sorted within client on
the report:

l Invoice - sort by invoice number within client

l Debtor w/o total - sort by debtor name within client

l Debtor with total - sort by debtor within client. A totals line separates each debtor.

Include Last Select this option to include the last Collection Note entered for the invoice in the Explan-
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Field Description

Collection
Note in
Explanation

ation column of the report.

Each Client
Starts on a
New Page

Select this option to force a new page for each client break in the report. If this is not selec-
ted, multiple clients can be printed on one page.

Print Click this button to generate the report to the Output method selected.

Exit Click this button to close the screen.

Report Sample

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Client recourse reports folder.

Preference Description

Show [No Buy] on no
buy clients

Set to True to display the literal [No Buy] after the client name for no-buy clients.

Available for recourse
report Crystal Reports
module name

Used to assign the Crystal Reports module name for the Available for Recourse
report.

Collateral Menu

Aging Summary Report

The Aging Summary Report summarizes activity for selected clients during a selected date range. For
each month end, the report displays a summary of the accounts payable and/or receivable over
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successive periods of aging, as well as the total AR/AP for the facility at month end. This report is accessed
from the Collateral menu of the Reports module.

Field Description

Template Lists any report template created to date. Select a template from the list to generate a
report based on its saved display parameters. Type a new Template name and click the
save button to create a new template for this report, then select the template from the
Templates tab and make any applicable parameter and scheduling selections to com-
plete the template.

Click this button to save a report template.

Click this button to close the report screen.

Click this button to generate the report to the selected Output format.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen

Reports User Guide
Crystal (Legacy) Reports

991 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

If you leave this field blank, you cannot make selections in the Facility or Collateral fields.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

C/O Obsolete Field. No selection necessary.

Client
Group

Select the client group to which to limit the results in the report. Client Groups are defined in
the Client Group Code table in the Tables feature.
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Field Description

To access this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click
Client Group Codes.

Value Select the specific client group value to which to limit the results in the report.

To access this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click
Client Group Codes.

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Format Select the report format to be generated:

l Accounts receivable: generate a report based on Accounts Receivable balances
entered

l Accounts payable: generate a report based on Accounts Payable balances entered.

l Both: generates two reports, one after the other. First report is a report based on
Accounts Receivable balances entered. The second is a report based on Accounts Pay-
able balances entered.

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
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Field Description

Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

From
date

Enter the beginning date of the date range for records to be selected for the report.

Thru
date

Enter the ending date of the date range for records to be selected for the report.

Report Sample

Security Roles

To generate the Aging Summary Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print Aging Summary Report
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Credit Menu

Credit Reports

The Credit report group contains reports that provide details on credit lines, approvals, decisions, and
overrides.

Credit Approval Report

The Credit Approval Report generates a report that displays credit approval information for a defined
period. This report displays any Invoices that had a Single Order Approval associated with it and were pur-
chased in the date range specified. When a credit request is approved as a Single Order Approval (SOA)
with a specific Source chosen at the time the order was approved, the approval source is displayed in the
Approval Source column of this report. Approval Sources are created in Credit Approval Source table in
the Tables module.

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Reports User Guide
Crystal (Legacy) Reports

996 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm
Client Group Codes Table.htm


Field Description

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Approval
Source

Select the approval source to which to limit the report results from the list. Click Clear to
remove the selection. Approval Sources are defined in the Credit Approval Sources table in
the FactorSoft Table module. Leaving this field blank will include all sources in the results.

Report
Type

Select the report format to be printed:

l Payment

l Aging

l Purchase

As of
date

Select the date range to use for the report from the list:

l Current date

l Last month end

l Specific date range

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Date
range

Select the date to use for the Payment or Purchase report formats from the list:
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Field Description

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

l Today only

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help. See the Preference
Printing Appendix for more information.

Report Sample
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Credit Decision Report

Use this window to generate a report of credit decisions recorded on the Approve or Deny Credit Requests
window.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Date
From

Enter the beginning date of the report date range. Click Today to display the current Fact-
orSoft processing date or MTD to display the beginning day of the previous month in this
field.
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Field Description

Thru Enter the ending date of the report date range. Click Today to display the current FactorSoft
processing date or MTD to display the ending day of the previous month in this field.

Include
pending
and
held
items
within
date
range

Select this option to include credit requests that are currently in Pending or Held status in the
report results.

Include
deleted
items
within
date
range

Select this option to include deleted credit requests in the report results.

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help. See the Preference
Printing Appendix for more information.

Print
now

Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.
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Report Sample

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Credit decision report folder.

Preference Description

Amount approved is Select the option to calculate the Amount approved column in the report:

l Credit limit increase

l Order reservation amount

l Credit limit increase on standard approval, order reservation amount
on others

Date on report is Select the date to display on decision tickets sent to the client when the request
is approved or denied:

l Date request was entered in the system

l Date/time the request was approved or denied

Include requests can-
celed within date
range

Set to True to include requests that were canceled on the Approve / Deny
Credit Request screen within the date range parameters, even though they
were not requested.

Include request
approved within date
range

Set to True to include requests that were approved on the Approve / Deny
Credit Request screen within the date range parameters.

Show purchase order
number in notes field

Set to True to display the purchase order number in the first Notes line on the
report, if available.
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Manual Risk Report

The Manual Risk Report lists invoices that have been manually re-risked from lender risk to client risk or cli-
ent risk to lender risk. The report can also be configured to report moves in both directions. This report is
accessed from the Credit Menu of the Reports module.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:
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Field Description

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table. Click Clear to remove the selection.

Date
Range

Select the date to use for the report from the list:

l Last Month - Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the adjacent fields.

Report Select the re-risked invoices to be included on the report:

l List both moves to lender-risk and client-risk

l List moves to lender-risk only

l List moves to client-risk only

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it
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Report Sample

Debtor Menu

Debtor Reports

The Debtor reports group contains reports that detail or summarize a variety of debtor-related items.

Account Status Exception Report

The Account Status Exception Report produces a list of exception transactions by debtor within client.
Each transaction listed includes the No-buy Status Code, transaction date, type, reference code and
amount.

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
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Field Description

plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.
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Field Description

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Debtor Enter the debtor name for the debtor to which to which to limit the report results. Matching
debtor names appear in the adjacent list box. You can double-click to select the debtor from
the list.

Date
From

Enter the beginning date of the report date range.

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help. See the Preference
Printing Appendix for more information.

Print
now

Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

Reports User Guide
Crystal (Legacy) Reports

1007 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Client Group Codes Table.htm


Report Sample

Country Code Exposure Report

This report groups customer/debtors by country, as set for each customer/debtor on the Debtor Inform-
ation screen. Select Country Code Exposure Report from the Report module’s Debtor menu to open the
Country Exposure Report screen.

Report Parameters

Field Description

Debtor Group Select the debtor group to which to limit the report results from the list. Debtor
Groups are defined in the Debtor

Debtor Value Select the specific debtor group value to which to limit the report results from
the list.

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

Print Click this button to generate the report to the Output method selected.

Exit Click this button to close the screen.
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Report Sample

Credit Insured Exposure Spreadsheet

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Insurance Company Select the insurance provider for which to generate the spreadsheet. Insurance
providers are defined in the Insurers table.

Report output path Specify the output folder for the Credit Insured Spreadsheet export file.

Print now Click this button to generate the spreadsheet.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

Debtor Aging Report

The Debtor Aging Report lists receivables by debtor. The format and level of detail can be configured
using the Parameter and Client/Insurance tabs.This report allows you to review all processed batches
and open invoices for the selected client/debtor relationship within a specified date range.

Report Parameters

Field Description

Debtor Enter the customer/debtor to which to limit the report.

Debtor Group Select the debtor group to which to limit the report results from the list. Debtor
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Field Description

Group Codes are defined in the Debtor Group Code Table. Click Clear to
remove the selection.

Value Select the specific debtor group value to which to limit the report results from
the list. Click Clear to remove the selection.

Zip/postal code -
from

Enter the beginning ZIP Code or postal code for a postal code range to which to
limit the report. The report limits the results to customer/debtors whose postal
code entered in the Address panel of the Debtor Information screen falls within
the range.

Thru Enter the ending ZIP Code or postal code for a postal code range to which to
limit the report.

Minimum balance Enter the dollar amount for the minimum total balance debtor balance to be
included in the report. Customers with balances lower than this amount are
excluded from the report.

Country Select the country to which to limit the report. The report limits the results to cus-
tomer/debtors whose Country selected in the Address panel of the Debtor
Information screen falls within the range.

As of date Enter the date through which to report debtor balances. Click Today to use the
FactorSoft current processing date.

Combine to master
debtor

Select this option to combine member customer/debtor totals to the master
customer/debtor.

Convert to native cur-
rency

Select this option to convert amounts from the base currency to the native cur-
rency (the currency of the transaction). The conversion occurs on a client-by-
client basis. If the client has a currency type set and the currency type is dif-
ferent from the default currency, FactorSoft looks up the conversion rate using
the As of date in the currency table for the client's currency. For example, if cli-
ent ABC Company has a currency type of Canadian Dollars and the daily con-
version rate for Canadian dollars is 1.5, the report increases all of the client's
amounts by a factor of 1.5.

Use non-standard
columns

Select this option to display non-standard aging buckets if defined.

Show house line Select this option to include the All client credit limit recorded for cus-
tomer/debtors on the Debtor Information screen in the report.
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Field Description

This option is only available if Format is set to Excel, at risk by name with a
Level of detail of One line per debtor.

Show PO#/Ref field Select this option to include the Ref column on the report, which will contain the
purchase order of reference number associated with the invoice where applic-
able.

Level of Detail Select the detail level to be displayed on the report:

l One line per client

l One line per debtor/client

l List invoices by debtor/client

Sort Select the sort option that determines the order in which to sort the report:

l Invoice number

l Invoice date

l Due date

This option is only available if Level of detail is set to List invoices by debt-
or/client.

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Format Select the format for the report:
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Field Description

l 5 column, standard: standard aging format through 90+ days past due

l 6 column, standard: same as 5 column, with additional 120+ past due
column.

l 7 column, standard: same as 6 column, with additional 150+ past due
column.

l Insurance: aging report with additional insurance related info - Buyer#,
Limit, Effective Date and Termination Date.

l 5 column, at risk by name: Generates a report similar to the standard
aging format through 90+ days past due, with additional columns for dol-
lar amount at Lender and Client Risk for each debtor or at Client Risk for
invoice detail. This report is sorted by Customer/Debtor name.

l 5 column, at risk by balance: Generates a report similar to the standard
aging format through 90+ days past due, with additional columns for dol-
lar amount at and Client Risk for each debtor or at Client Risk for invoice
detail. This report is sorted by Customer/Debtor outstanding balance. The
balance sort order is determined by system preference.

l Excel, at risk by name: Generates an Excel spreadsheet with data similar
to the standard aging format, with additional columns for dollar amount
at Client Risk and Lender Risk, sorted by debtor name. This option is not
available for the Level of detail option List invoice by debtor/client.

l Excel, at risk by balance: Generates an Excel spreadsheet with data sim-
ilar to the standard aging format, with additional columns for dollar
amount at Client Risk and Lender Risk, sorted by balance (balance sort
order is determined by system preference). The balance sort order is
determined by system preference. This option is not available for the
Level of detail option List invoice by debtor/client.

Client/Insurer Selection Tab

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.
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Field Description

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Currency Select the currency to which to limit the report results. Currencies are defined in the Cur-
rency Denominations table. Click Clear to remove the selection.

Insurer Select the insurance carrier to which to limit the report. Insurance carriers are defined in the
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Field Description

Insurers table. Click Clear to remove the selection.

Report Sample

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Debtor aging reports folder.

Preference Description

Age based on which
date

Set to determine which date is used as the basis from which to age accounts
receivable:

l Invoice Date

l Purchase Date

Excel spreadsheets
contain how many
columns

Set the desired number of aging columns for the Excel spreadsheet reports:

l Six : six aging columns to 120+ days past due

l Seven: seven aging columns to 150+ days past due

Folder for Excel
Spreadsheets

Set the folder location where the Excel spreadsheet reports will be saved by
FactorSoft. If this is not set, the spreadsheet is written to the Local Set-
tings\Temp folder for the Windows user-name logged into the computer.

Hide due date Set to True to exclude the Due Date column from the report. This is only applic-
able when the List invoices by debtor/client option is selected for Level of
detail.

Select based on
which date

Set to determine the date to which the As of date compares for data selection.

l Invoice date

l Purchase date
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Preference Description

Show invoice type Set to True to print the invoice type code before the invoice number in the Inv#
column. This is only applicable when the List invoices by debtor/client option
is selected for Level of detail.

Sort to at-risk bal-
ance means

Set this option to determine the balance that the report is sorting to for the 5
column, at risk by balance and Excel, at risk by balance formats:

l Balance, high to low

l Lender-risk , high to low

Debtor Availability Report

The Debtor Availability Report provides a look at debtor’s credit information, such as the credit limit, expir-
ation, amount past due, amount available, and whether there is client risk.

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.
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Field Description

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table. Click Clear to remove the selection.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Groups are
defined in the Debtor Group Code Table. Click Clear to remove the selection.

Value Select the specific debtor group value to which to limit the report results from the list.
Debtor Groups are defined in the Debtor Group Code Table. Click Clear to remove the
selection.

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This Report Select a printer from the drop-down list to overwrite the printer default for this report only.

Format Select the report format to generate:

l Standard format

l At risk format

Select Select the debtor/relationship category to which to limit the report:

l Every relationship

l Open balances

l Over credit limit

l With client risk

l With exposure

l Flagged as no-buy with balance

Sort by Select the sort option that determines the order in which to sort the report.
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Field Description

l Client/debtor

l Client/available

l Client/balance

l Client/at-risk

l Client/exposure

l Debtor/client

l Debtor/credit limit

l Debtor/balance

Show Select the option for the debtor demographic data to be displayed:

l Name only

l Name, phone

l Name, address

l Name, phone, address

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help. See the Preference
Printing Appendix for more information.

Sum-
marize to
master

Select this option to group debtors according to their master debtor, if applicable.

Hide expir-
ation date

Select this option to exclude the Credit Expires column from the report.
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Field Description

Convert to
native cur-
rency

Select this option to convert amounts from the base currency to the native currency (the
currency of the transaction). The conversion occurs on a client-by-client basis. If the client
has a currency type set and the currency type is different from the default currency, Fact-
orSoft looks up the conversion rate using the As of date in the currency table for the client's
currency.

For example, if client ABC Company has a currency type of Canadian Dollars and the daily
conversion rate for Canadian dollars is 1.5, the report increases all of the client's amounts
by a factor of 1.5.

Show
debtor
number

Select this option print the debtor number next to the debtor name in the report results.

Show
debtor
warning

Select this option to print beneath the debtor name the warning message entered in the
Warning field of the Debtor Information upper fields beneath the debtor name in the
report, if applicable.

Show cli-
ent ref #

Select this option to include the Client Reference column, which prints the client reference
number for the debtor with each client entry.

Show con-
tacts

Select this option to print the contact names entered in the Contacts panel of the Debtor
Information screen.

Print now Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

Report Sample
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System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Debtor availability report folder.

Preference Description

Do not include neg-
ative balances in
availability

Set to True to prevent negative balances from increasing availability on the
report.

Do not show expir-
ation date if credit
limit is zero

Set to True to prevent the expiration date and indicator from being displayed
for a debtor if the credit limit is zero

Show client number
on clients

Set to True to display the client number with the client name on the report.

Show debtor number
on debtors

Set to True to display the debtor number with the debtor name on the report.

Show exposure
instead of lender risk

Set to True to display exposure (amount over line) in the Lender Risk column. If
set to False, this column displays amount at lender risk. This column only occurs
on the At-risk format of the report.

Show past due
invoices instead of
past due balances

Set to True to display Past Due Invoice column instead of Past Due Balance.

Debtor Credit Limit Warning Report

The Client/Debtor Credit Limit Warning Report displays debt ratios of debtors for selected clients.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

% of Limit Specify the percentage of the credit limit above which to include debtors on the report. For
instance, if you enter 50.00 in this field, only debtors whose balances are 50% or higher of
their limit will be included in the report.

Sequence Indicates the order in which to list clients and/or debtors for each client:
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Field Description

l Name

l % balance to limit

l Client balance

l Total balance

l Credit limit

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help. See the Preference
Printing Appendix for more information.

Print now Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.
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Report Sample

Debtor Invoice Audit Report

The Debtor Invoice Audit report provides a flexible way to report on debtors by activity and balance. Addi-
tionally, this report allows you to specify a selection percentage—meaning that you can select a random
sample of debtors on which to report. Random sampling is a quick and accurate way to see the overall
trends within the entire group of debtors.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.
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Field Description

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Minimum
balance

Enter the minimum balance for debtors to be included in the report.

Selection
%

Enter the percentage of debtors to report as a random sample.

Minimum
days
since last
selection

Enter the number of days since last selection for debtors to include on the report.

Do not
post last
audit
date

Select this option to exclude the Last Audit Date column from the report results.

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Print now Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.
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Report Sample

Debtor List Report

The Customer/Debtor List Report contains—in addition to core reports—numerous options for refining
each report for your specific needs. You can save the report parameters as templates, and schedule the
templates to be periodically generated by the Engine.

While many elements on the report window are the same as those found across the Reports module, the
options in the Selections group are those used to build Customer/Debtor Reports to your specific needs.

This is an Engine-enabled report.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
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Field Description

menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table. Click Clear to remove the selection.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Groups are
defined in the Debtor Group Code Table. Click Clear to remove the selection.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Print
now

Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

Selections Group

The Selections group of the Customer/Debtor List Reports window is used to select the different elements
you want included on a report.

Field Description

Balance Select the balance type to include in the report—all debtors meeting the other
criteria specified for the report and falling into this Balance category are
included on the report.
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Field Description

l All

l Open Balance

l Zero Balance

l Credit Balance

l Debit Balance

No-buy Select the No-Buy category for debtors to be included in the report.

l All

l No no-buy reason

l Any no-buy reason

l Specific no-buy reason

If Specific no-buy reason is selected, select the no-buy reason to limit selec-
tion to from the Specific no buy list in the Actions group.

NOA Select the NOA statuses to which to limit the selection of debtors for reporting.

l All

l Not sent/waived

l Not received/waived

l Waived

Sort Select the sort option that determines the order in which to sort the report.

l Debtor by name

l Debtor by number

l Debtor by balance

l Debtor by name/Client

l Debtor by number/Client

Report Type Select the report format to be printed:
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Field Description

l No-buy list: lists of selected debtors including no-buy description

l Debtor list: lists of selected debtors

l Debtor list with clients: list of selected debtors with client names

l Client/Debtor report: summary of debtors by client

l 3-up labels: Generates mailing labels in a 3-up format

l Mail merge export: creates an export file debtor list

l Credit limit audit report: lists debtors with limits and current balance

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client

Export File Specify the output folder and output file name for the Mail merge export file.
This field is only active if Mail merge export is selected in Report Type.

No Tax ID Select this option to include debtors with no Federal Tax ID number recorded in
the Debtor Information Identity panel in the report results.

Over credit limit Select this option to include debtors who are over their credit limit in the report
results.

Combine to master
debtor

Select this option to combine Member Debtor totals to their Master Debtor.

Minimum total credit
limit

Enter the minimum credit limit for debtors to be included in the report results.

Days since last pur-
chase

Enter the minimum number of days since last purchase for debtors to be
included in the report results.

Balance is restricted
to client selection

Select this option to show the debtor balance for the selected client only in the
report results. If not selected, the Current Balance listed on the report is the
debtor's all-client balance, regardless of client selected.
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Field Description

Exclude flagged do
not mail

Select this option to exclude debtors with return address reasons set defined as
Do not mail from the report.

Show Group

This group provides options for defining the Debtor Information to include on the report

Field Description

Name Only Include the debtor name only in the Debtor List Report.

Name, Phone Include the debtor name and phone number in the Debtor List results.

Name, Address Include the debtor name and address in the Debtor List results.

Name, Phone,
Address

Include the debtor name, phone number, and address in the Debtor List results.

Debtor Number Include the debtor number in the Debtor List results.

Debtor Warning Include the debtor warning text (entered in the upper fields of the Debtor Inform-
ation screen) in the Debtor List results.

Client Reference Include the Client Reference Number on the Debtor List with Clients or Cli-
ent/Debtor Report. This option is only available when Debtor list with client or Cli-
ent/Debtor Report is selected from the Report Type list.

Actions Group

The Actions group contains options used to list no-buys on the report, and set no-buy reasons when the
list is generated.

field Description

Specific no buy Select the no buy reason to which to limit report selection. This option is only
valid if the Specific no-buy reason option is selected in the No-buy option of
the Selections group.

Set to specific no-buy
above

Select this option to set the debtor no-buy to the no-buy reason selected in the
Specific no-by list. This will apply to all debtors that match the selection criteria
for the report. This option is only available if a Specific no-buy reason is selec-
ted.

Change already exist- Select this option to change a previously set debtor no-buy reason to the Spe-
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field Description

ing no-buy cific no-by selected here. This option is only available if a Specific no-buy
reason is selected and the Set to specific no-buy above option is selected.

Set NOA sent date Select this option to set the NOA sent date on the NOA/Rules tab of the Debtor
Aging screen for the selected debtors. This option is only available when the
Mail merge export or 3-up labels option is selected in Report Types field of the
Selection group.

Date Selection Group

The Date Selection group allows you to select a date range to limit selection by first activity or purchases
within a given time period.

Field Description

(Date range type) Select the date range option that determines whether the date range limits by
debtors first used within the range, or with purchases within the range.

l None

l First use in Range

l Purchase in Range

l Debtor created in range

From Enter the beginning date of the date range.

Thru Enter the ending date of the date range.

Report Sample

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Debtor List folder.
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Preference Description

Include client address in export file Set to True to include the client address fields in the Mail
merge export-file.

Include client signed date in export file Set to True to include the client signed date in the Mail merge
export-file.

Include ISO country value on debtor
list

Set to True to include the country as part of the debtor address
in the Debtor List reports.

Include ISO country value on debtor
list

Set to True to include the country as part of the debtor address
on the 3-up labels.

Treat expired credit limit as zero Expired credit limit is treated as zero limit for calculating avail-
ability.

Use debtor expiration if earlier than
override

Set this option to True to report the earlier of debtor or cli-
ent/debtor expiration.

Source for notes on Client/debtor
report

Determines the notes to be printed on the client/debtor report.

l Note Panel

l Special instructions

Crystal Reports module name -
Debtor list with clients

Used to assign the Crystal Reports module name for the Debtor
list with clients report.

Crystal Reports module name - Cli-
ent/debtor report

Used to assign the Crystal Reports module name for the Cli-
ent/Debtor report.

Debtor Master List Report

The Debtor Master List report screen is used to create a report that lists master debtors and the member
debtors assigned to each master. This report is accessed from the Debtor Master List option in the Debtor
Menu of the Reports module.
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Field Description

Options
Template

Lists any report template created to date. Select a template from the list to generate a
report based on its saved display parameters. Type a new Report template name and
click Save to create a new template for this report, then Select the template from the Tem-
plates tab and make any applicable parameter and scheduling selections to complete
the template.

Report Parameters

Field Description

Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.
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Field Description

Print
now

Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

Report Sample

DNBi Spreadsheet

The DNBi Spreadsheet is accessed from the Customer/Debtor Menu of the Reports module. This option
generates a spreadsheet showing the selected data from the DNBi import. See DNBi Data ImportDNBi Data
Import in the FactorSoft Administrator's Guide for details.
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Report Parameters

Field Description

Date From Enter the beginning date of the date range to which to limit the spreadsheet.

Thru Enter the ending date of the date range to which to limit the spreadsheet.

Debtor Group Select the debtor group to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table.

Value Select the specific debtor group value to which to limit the report results from
the list. Debtor Groups are defined in the Debtor Group Code Table.

Analyze Click this button to analyze the imported data and display a list of available
data fields. Click Select for data fields to be included in the generated spread-
sheet.

Exit Click this button to exit the screen.

Process Click this button to generate the DNBi Spreadsheet for the selected data fields
from the imported data.
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Sample Report

Returned Mail Report

The Return Mail Report is accessed from the Customer/Debtor Menu of the Reports module. This option
returns the Return Mail Report screen that is used to select the parameters for the report.

Report Parameters

Field Description

Selection Select the option that determines the returned address records to be included
in the report.

l All reasons: All debtors with a return address reason set.

l OK to mail: All debtors with a return address set where the return address
reason is defined Ok to mail.

l Do not mail: All debtors with a return address set where the return
address reason is defined Do not mail.

l Specific Reason: Only the specific return address reason selected from
the Reason field is included.

Reason Select the specific return address reason to be included in the report. This
option is only available if the Selection field is set to Specific Reason.

With balances only Select this option to exclude debtors with zero balances from the report.
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Field Description

Output Select one of the following print output options from the list:

l Preview: to preview the report on the window before printing it.

l Print: to print the report without previewing it.

Sample Report

Facility Menu

Facility Reports

The Facility report group contains reports that provide details on facilities in bulk collateral lending envir-
onments.

Loan Statement

The Loan Statement provides a financial statement for a specific facility. When run with the Preliminary
option cleared, this statement calculates the interest fee for the period selected. An additional page for
each Available, Eligible, Gross, and/or Net Collateral fee type for the facility is included. Additional state-
ment pages list each day in the period with daily average balance detail for Gross Collateral, Ineligible
Collateral, Eligible Collateral, and Net Collateral, as well as Available balance and Limit Amount. An Aver-
age line displays the period average for each column. Note that the collateral column for which the Fee
Type is calculated is displayed in bold type, and the period and rate on which the fee is calculated is also
displayed.

This report is accessed from the Facility menu of the Reports module.
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Field Description

Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Template
name and click the save button to create a new template for this report, then
select the template from the Templates tab and make any applicable para-
meter and scheduling selections to complete the template.

Click this button to save a report template.

Click this button to close the report screen.

Click this button to generate the report to the selected Output format.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
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Field Description

s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

If you leave this field blank, you cannot make selections in the Facility or Collateral fields.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.

Client Select the client group to which to limit the results in the report.
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Field Description

Group Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is
to be generated.

Facility
Group

Select a facility group code (as defined in the Client Group Code Table) to which to limit
the report, or leave this field blank to include all facility groups.

Statement
to reprint

Select a previously-run statement to reprint. Using this option prints a copy of the report
and does not apply additional charges against the account balance.

Output Select one of the following reprint output option from the drop-down list:

l Preview to preview the report on the window before printing it.

l Print to print the report without previewing it.

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Note: When the Preliminary check box is checked, the Statement output is Preview only.

Date
Range

Select the date range for the report:

l Month to Date: displays the first day of the current FactorSoft processing month in
From date and the current FactorSoft processing date in the Thru date.

l Last Month: displays the first day of the previous FactorSoft processing month in
From date and the last day of the previous FactorSoft processing month in the Thru
date.

l Yesterday: displays the of the previous FactorSoft processing day date in the From
date and Thru date fields.

l Today: displays the of the current FactorSoft processing day date in the From date
and Thru date fields.

From date Enter the beginning date of the date range for records to be selected for the report.

Thru date Enter the ending date of the date range for records to be selected for the report.

Pre- If this box is flagged, the Loan Statement will run only as a report using the Preview Output
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Field Description

liminary option. If this box is not flagged, the Loan Statement will run and post the appropriate fees
to the Loan using the output preference from Facility Information > Statement panel >
Output.

Show float
balance

If this box is flagged, the Loan Statement will include a column to show the Float Balance
based on payments posted to the Loan.

Show daily
interest
amount

Select the option to include the Est. Interest column on the report.

Show Com-
pound Bal-
ance

If this box is flagged, the Loan Statement will show the Compound Balance column.
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Report Samples
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Report Details

Column Description

Statement Format

Address The Loan Statement Address will display the following:
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Column Description

l Lender Name (in bold print) Located in System Preferences > Iden-
tification/system constants > Name & address > Lender name)

l Client Name

l Facility Description

l Client/Facility Address

Date Displays the day of the Month

Begin Balance Displays the beginning Loan Balance on the specific day

Disbursement Displays the amount of the Loan Disbursement on the specific day

Payment Displays the amount of the Loan Payment on the specific day; if there are multiple
Loan Payments posted on the same day, this column will display the total Loan Pay-
ments for the specific day

Other Displays the amount of Other Loan Transactions. This is typically the Accrual Post-
ing transactions on the Loan on the specific day

End Balance Displays the ending Loan Balance on the specific day

Float Balance Displays the Float Balance for the day that is calculated as:

Payment column * Float Days (as defined on the Statement Terms > Fee Type
Interest record) + End Balance column

Compound Bal-
ance

Displays the Compound Balance for the day that is calculated as:

Payment Column * Float Days (as defined on the Statement Terms > Fee Type
Interest record) + End Balance column Plus prior day Interest

Est. Interest Displays the calculated daily interest that is calculated as:

(End Balance column or Float Balance (if applicable)) *Rate% / 360 or 365

Number of Days;
Interest Rate

Displays number of days for the period; displays the interest rate as defined on the
Statement Terms > Fee Type Interest record

Other Charges Displays all Fee Types that are flagged as Active on Facility Statement Terms

Average Daily Bal-
ance

Displays the average of the End Balance for the period

Interest Charge Displays the interest calculated as:
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Column Description

(End Balance or Float Balance total (if applicable) * Rate % / 360 or 365)) * Days in
Period

Other Charges Displays the total of the calculated Other Charges

Total Statement
Charges

Displays the total of the Interest Charge and the Other Charges

Past Due Balance Displays any Interest that has not yet been applied to the Loan

Total Due Displays the total of the Interest Charge, Other Charges and Past Due balance.

Fee Type Calculation Format

Note: This format is for the Fee Type “Maintenance” and Calculate Based on “Out of Formula”

Fee Description Displays the Description of the Maintenance Fee type on Facility Information > State-
ment Terms

Post Date Displays the date that the fee type was analyzed in the date range the statement
was run

Loan Limit Displays the value in the Facility Information > Limits > Loan Limit field

Available Displays the Net Availability

Ending Balance Displays the Loan Balance as of the end of the reported day

Excess Deficit Displays the difference between the Availability and the Loan Balance

Fee Rate Displays the rate set for that fee type on Facility Information > Statement Terms

Fee Amount Displays the calculated value of the Fee Rate column * Excess Deficit column

Security Roles

To generate the Loan Statement Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print loan statement report (preliminary)

l Security Roles > Reports > Facility > Print loan statement report (non-preliminary)

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Facility/Collateral Rules (Formerly Asset Based Lending), Periodic statement generation folder.
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Preference Description

Max days in advance
to allow posting

Maximum number of days prior to the statement through date to allow
advance posting of statement fees.

For example:

l If the Max Days = 5 and the system date is 6/25/20 and the statement
through date is 6/30/20, the system would allow the posting of the fees to
occur.

l If the system date is 6/24/20 and the statement through date is 6/30/20,
the system would not allow the posting of the fees to occur.

Standard Main-
tenance Fee Days in
Month

Standard number of days in month used to calculate daily maintenance fee
amount.

Use control date for
certificate approve
time (T/F)

If True, the Certificate Posting will be posted as of the current date. If False, the
Certificate Posting will be posted as of the date entered.

Use ending date to
determine fee month
(T/F)

If True, the fiscal month the fees will apply to will be determined by the ending
date of the statement. If False, the fees will apply to the date when the state-
ment is run.

Use thru date to
determine statement
post date (T/F)

Determines if the post date for the Loan Statement is the date indicated as the
thru date when running the Loan Statement

For example, if the Thru Date is 6/30/20, this will be the post date of the State-
ment transaction in the system.

Use thru date to
determine accrual
post date (T/F)

Determines if the accrual post date for the Loan Statement is determined by the
thru date when running the Loan Statement. The system will look at the thru
date on the Loan Statement and add the value in the Facility Information >
Statements > Days to wait for posting to determine the date of the accrual
posting.

For example, if the Thru Date is 6/30/20 and the Days to wait for posting = 1, the
accrual posting date will be 7/1/20.

Interest Calculation
Rounding Method

Select the rounding method for periodic generation of loan statements in Fact-
orSoft.
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Preference Description

l No rounding limitation

l Limit rounding to 2 decimal places

l Limit rounding to 3 decimal places

l Limit rounding and truncate after 2 decimal places

Do not calculate
interest float if loan
balance is not pos-
itive (T/F)

Determines if interest on float is calculated on days where the Loan Balance is
negative

Do not calculate
unused line fee if loan
balance is not pos-
itive (T/F)

Determines if the unused line fee (set up in Facility Information > Statement
Terms > Fee Type = Unused Line) is calculated if the Loan Balance is negative

Use effective dates
with the spread rate
when calculating
interest (T/F)

Determines if the effective dates on the spread rate is used when calculating
interest

Use tiered basis
method when cal-
culating interest (T/F)

Determines if the Lender can set up multiple interest rates on the Facility
Information > Statement Terms > Fee type = Interest. The multiple rates can
be set up by clicking the “View” button next to the rate under the Interest Rate
section.

Customize the Statement

To add your logo and footer text to statements set the following in the Administration module, System
Preferences, Facility/Collateral Rules (Formerly Asset Based Lending), Reports, Loan Statement
Reports folder.

Preference Description

Logo Image File
Name

The fully qualified path and file name which the image file is located.

Recommended Logo Size: 1.7” x .8”

Acceptable File Types: .jpg, .tiff, .png

Footer Text drop-down to select the statement text to be used in the footer of the report.
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Preference Description

Statement language options are defined on the Statement Text Table screen in
the Tables module.

Position Summary Report

The Position Summary report provides an overview of each client’s facility information, broken down by cli-
ent, facility, and collateral.

NOTE
The disclaimer “Post dated transactions are not included” appears at the top of these reports to indic-
ate that only transactions from the As Of date to the current FactorSoft processing date are included
on the report.

Field Description

Template Lists any report template created to date. Select a template from the list to gen-
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Field Description

erate a report based on its saved display parameters. Type a new Template
name and click the save button to create a new template for this report, then
select the template from the Templates tab and make any applicable para-
meter and scheduling selections to complete the template.

Click this button to save a report template.

Click this button to close the report screen.

Click this button to generate the report to the selected Output format.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

If you leave this field blank, you cannot make selections in the Facility fields.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
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Field Description

are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.

Client
Group

Select the client group (as defined in the Client Group Code Table) for which this report is to
be generated.

Value Select the client group’s value (as defined in the Client Group Code Table) for which this
report is to be generated.

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Facility
Group

Select a facility group code (as defined in the Client Group Code Table) to which to limit the
report, or leave this field blank to include all facility groups.

Value Select the facility group’s value (as defined in the Client Group Code Table) for which this
report is to be generated.

Format Select the report format to be generated:
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Field Description

l Client Detail

l Client Summary

l Facility Summary

l Loan Status

Report Samples

Client Detail Format

The Position Summary – Client Detail format includes each Facility’s Collateral Description, Currency, Col-
lateral Type, Limits, Adv Rate, Gross Collateral, Total Ineligible, Net Collateral, Eligible Collateral, Availability,
Balance, and Excess/Deficit. A Grand Total line totals the Availability, Balance, and Excess/Deficit columns
for all clients included in the report. The Detail report also includes transaction detail and collateral post-
ing detail for the current day.

Client Summary Format

The Position Summary format includes each Facility’s Collateral Description, Currency, Collateral Type, Lim-
its, Adv Rate, Gross Collateral, Total Ineligible, Net Collateral, Eligible Collateral, Availability, Balance, and
Excess/Deficit. A Grand Total line totals the Availability, Balance, and Excess/Deficit columns for all clients
included in the report.
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Facility Summary Format

The Facility Summary format returns a similar report, but instead of grouping the report by facility within
client, all facilities are listed individually as <client name>/<facility name>.

Loan Status Format

The Loan Status format includes information about loans for each client.
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Facility Trend Card Report

The Facility Trend Card Report provides a 13 month trend analysis and includes Loan Summary, Revenue
Summary, Accounts Receivable Summary, and Inventory Summary reports. The 13 month period includes
the month of the current working date and the 12 months preceding the current working date. This report
is accessed from the Facility menu of the Reports module.

Field Description

Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Template
name and click the save button to create a new template for this report, then
select the template from the Templates tab and make any applicable para-
meter and scheduling selections to complete the template.

Click this button to save a report template.

Click this button to close the report screen.
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Field Description

Click this button to generate the report to the selected Output format.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

If you leave this field blank, you cannot make selections in the Facility fields.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.
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Field Description

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is to
be generated.

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.
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Report Sample

Trial Balance Report

The Trial Balance Report is a summary of daily transactions. This report can display results in a variety of
formats. This report is accessed from the Facility menu of the Reports module.
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Field Description

Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Template
name and click the save button to create a new template for this report, then
select the template from the Templates tab and make any applicable para-
meter and scheduling selections to complete the template.

Click this button to save a report template.

Click this button to close the report screen.

Click this button to generate the report to the selected Output format.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

If you leave this field blank, you cannot make selections in the Facility fields.

Facility Select the facility for the selected client to include in the report or leave blank to include
all facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Par-
ticipation

Select a participant entity to which to limit the report. This list is only populated if you are
using the Participation module.

Member Select a member of the participant entity to which to limit the report. This list is only pop-
ulated if you are using the Participation module.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that

Reports User Guide
Crystal (Legacy) Reports

1061 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm


Field Description

have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report
is to be generated.

G/L Group Select the G/L Account Group to which to limit the report.

Account # Select the G/L Account to which to limit the report.

Format Select the report format to be generated:

l Detail as Account/Check #/Date

l Detail as Account/Date/Check #

l Summarize to Account

l Summarize to Account/Client

l Summarize to Account/Date/Source

l Summarize to Date/Account/Source

Date Range Select the date range for the report:
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Field Description

l Month to Date: displays the first day of the current FactorSoft processing month in
From date and the current FactorSoft processing date in the Thru date.

l Last Month: displays the first day of the previous FactorSoft processing month in
From date and the last day of the previous FactorSoft processing month in the Thru
date.

l Yesterday: displays the of the previous FactorSoft processing day date in the From
date and Thru date fields.

l Today: displays the of the current FactorSoft processing day date in the From date
and Thru date fields.

From date Enter the beginning date of the date range for records to be selected for the report.

Thru date Enter the ending date of the date range for records to be selected for the report.

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Report Samples
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Participation Menu

Participation Reports

The Participation reports are used to generate reports about participation.

Participation Report

The Participation Report provides a summary of Participant’s financial details per batch, for specified cli-
ents within a specified date range.

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Table Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
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Table Description

Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports.
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Table Description

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Date
range

Select the date to use for the report from the list:

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Print
now

Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

Report Sample
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Productivity Menu

Productivity Reports

The Productivity report group contains cash and purchase productivity reports.

Cash Productivity Report

The Cash Productivity Report provides a snapshot of specified client’s cash postings, including checks pos-
ted and invoices paid, over a specified period of time.

This is an Engine-enabled report.

Field Description

Options Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
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Field Description

Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table. Click Clear to remove the selection.

User Select the FactorSoft user login to limit the report to cash postings entered by that user only.

Date Select the date to use for the report from the list:
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Field Description

range l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the adjacent fields.

Format Select the report format to be printed:

l Detail report

l Summarize to client/date within user

l Summarize to client within user

l Summarize to date within user

l Summarize to user

Output Select one of the following print output options from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help. See the Preference
Printing Appendix for more information.

Print
now

Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.
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Report Sample

Collector Response Productivity Report

The Collector Response Productivity Report is accessed from the Productivity Menu of the Reports module.
This report lists, by User Name, the number of collection or verification messages set by each user while
working the Collection/Verification Queue, or by verifying invoices from the Manage Pending Purchases
screen.

This is an Engine-enabled report.
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Field Description

Options Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Group Select the message group to be reported:

l Collections

l Pre-purchase Verification

l Post-purchase Verification

Date range Select the date to use for the report from the list:
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Field Description

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

l Today only

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the adjacent fields.

Output Select one of the following print output option from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Report Sample

Credit Decision Productivity Report

The Credit Decision Productivity Report is accessed from the Productivity Menu of the Reports module. This
report lists the users that have made credit decisions in the specified time period and displays the aver-
age time period for making a decision on the credit request.

This is an Engine-enabled report.

Reports User Guide
Crystal (Legacy) Reports

1072 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

Option Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Option tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.
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Field Description

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table. Click Clear to remove the selection.

User Select the FactorSoft user login to limit the report to cash postings entered by that user only.

Date
range

Select the date to use for the report from the list:

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

l Today only

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the adjacent fields.
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Field Description

Output Select one of the following print output options from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Print
now

Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

Report Sample

Purchase Productivity Report

The Purchase Productivity Report produces a report that lists data entry and approval statistics for users
to assist in evaluating user performance in FactorSoft.

This is an Engine-enabled report.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As of date Select the date to use for the report from the list:

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the adjacent fields.

Output Select one of the following print output option from the drop-down list
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Field Description

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Default Printer Displays the default printer used to generate reports

Change Default Click this button to assign a different printer as the default printer. This will
change the default printer for all reports.

This Report Select a printer from the drop-down list to overwrite the printer default for this
report only.

Print now Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

Report Sample

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Purchase productivity report folder.

Field Description

Only first user gets
credit for data entry
batch and invoices

Set to True to count invoices only once on original entry for the user that cre-
ated the batch, and not count rework
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Statements Menu

Statements Reports

The Statements report group contains a variety of client and debtor statement options.

Activity Statements

Activity Statements provide a summary of financial activity for specified clients during a defined date
range. The results of this statement can be presented in three ways:

l Debtor Assignment Notifications

l Purchases by Debtor

l Purchases then Payments/Credits

Field Description

Date
From

Enter the beginning date of the date range to which to limit the report.

l Click Today to display the current processing date in this field.

l Click L-Month to enter the previous beginning date of the month to date period in Date
Range and previous ending date of the month to date period in Thru.

l Click MTD to enter the current beginning date of the month to date period in Date
Range and current processing date in the Thru.

l Click YTD to enter the current beginning date of the year to date period in Date Range
and current processing date in the Thru.

Thru Enter the ending date of the date range to which to limit the report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
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Field Description

Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive to which to limit the results, or leave this field blank to include all
AE's.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is to
be generated. Click Clear to remove the selection.

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.
>

Format Select the report format to be printed:

l Debtor Assignment Notifications

l Purchases by Debtor

l Purchases then Payments/Credits
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Field Description

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.
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Statement Sample

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Trial balance folder. Default definition is ActStmt0.

Preference Description

Debtor assignment
notification Crystal
Reports module
name

Used to assign the Crystal Reports module name for the Debtor Assignment
Notifications report.

Purchase by debtor
Crystal Reports mod-
ule name

Used to assign the Crystal Reports module name for the Purchase by debtor
report.
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Preference Description

Purchase then pay-
ments/
credits Crystal
Reports module
name

Used to assign the Crystal Reports module name for the Purchases then Pay-
ments/Credits report.

Additional Fee Statements

The Additional Fee Statement window is accessed through the Reports drop-down menu by first selecting
Statements and then selecting Additional Fee Statements.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

Reports User Guide
Crystal (Legacy) Reports

1082 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive to which to limit the results, or leave this field blank to include all
AE's.

Date
Range

Enter the beginning date of the date range to which to limit the report.

Click MTD to enter the current beginning date of the month to date period in Date Range and
current processing date in the Thru. Click L-Month to enter the previous beginning date of the
month to date period in Date Range and previous ending date of the month to date period in
Thru.

Thru Enter the ending date of the date range to which to limit the report.

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Format Select the format of the report to produce:

l Preliminary statement: generates the statement only.

l Statement & post fees: generates the statement and posts the associated fees to the
client account.

Sort Select the sort option that determines the order in which to sort the report.

l Client

l AE

Output Select one of the following print output option from the drop-down list
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Field Description

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client

Show
A/E

Select this option to print the Account Executive name associated with each client on the
report.

Print Click this button to generate the report to the Output method selected.

Exit Click this button to close the screen.

Statement Sample

Client Activity Statements

The Client Activity Statement generates a report based on a specified client’s activity, by specified terms,
within a specified date range. The Client Activity Statements report both factoring detail collateral and
non-detail collateral concurrently for databases that have both types.

An alternate format displays several columns of Load Processor advance activity. To utilize this format, set
System Preference Reports, Client activity Statement, Activity by date Crystal Reports module name to
CLISTMTAC.

To remove unnecessary data and present a useful Client Activity Statement, two func-
tions on the Recalculate Redundant Data option need to be run prior to producing this
report. These can be found on the Administration module, System menu, Database
maintenance, Recalculate Redundant Data option. Run Payment C/B Codes, then
Activity Tables.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Enter the beginning date of the date range to which to limit the report.

Click MTD to enter the current beginning date of the month to date period in Date Range and
current processing date in the Thru. Click L-Month to enter the previous beginning date of
the month to date period in Date Range and previous ending date of the month to date
period in Thru. Click Today to enter the current FactorSoft processing date in the Date and
Thru fields

Thru Enter the ending date of the date range to which to limit the report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
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Field Description

s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.
>

Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is to
be generated. Click Clear to remove the selection.
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Field Description

G/L
Group

Select a G/L Group to which to limit the report, or leave this field blank to include all G/L
Groups.

Account Select the account to which to limit the report. The accounts are defined in the Accounts
table.

Terms
type

Select the terms to use for the statement to be printed:

l None

l Invoice based terms

l Portfolio based terms (A/R finance)

l Portfolio based terms (daily rate)

Sum to Determines the statement format:

l Date: activity by each day in the period

l Activity: activity by individual batch

l Client: activity within client by each day in the period

l Group: activity within group by each day in the period

Sort Select the option that determines the order in which to sort the statement:

l Client

l A/E

l G/L Group

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection.
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Field Description

Include
non-
zero
inactive
clients

Include inactive clients that have cash in A/R or reserves on the report. If this option is not
selected, non-zero inactive clients are excluded form the report.

Convert
native
currency

Select this option to convert the financial data to the client’s native currency.

Report
by facil-
ity
instead
of client

Select this option to print the Client Activity Statement report for facilities instead of clients.
This setting is intended for clients that are using the Bulk Collateral processing capabilities of
FactorSoft.

Show
A/E

Select this option to print the account executive name in the statement results.

Show cli-
ent
name

Select this option to print the client name in the statement results.

Show
yield

Select this checkbox to include yield in the results.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.

Statement Sample
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System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Client activity report folder.

Field Description

Include load
advances and load
settlement columns

Set to True to include load advance data on the Client Activity Statement
Report (both FactorSoft Reporting Service and Crystal Reports versions). Note
that this preference was added due to the fact that the run time for the Client
Activity Statement was negatively impacted for implementations of FactorSoft
that employed the Load Processor module, so by default the columns are
excluded from the reports.

Client Fee Statements

The Client Fee Statement generates a statement of Client Fees for selected clients, within a selected date
range .

Exclude fees for negative NFE days

The Client Fee Statement can be configured to exclude fees from being calculated for negative NFE days.
Set System Preference Reports, Client Fee Statement, Do not calculate fees if funds employed is not pos-
itive to True and Reports, Client fee statement, Calculate fees daily to True to only calculate fees for days
on which the NFE balance is positive.

If Do not calculate fees if funds employed is not positive is set to True and Calculate fees daily is set to
False, fee calculation is based on the NFE balance at the time the statement is generated and does not
consider daily NFE balance.

Exclude Carrier Payments from NFE

The Client Fee Statement can also be configured to allow the Carrier Payments Due account to not
update Net Funds Employed (NFE) for pending carrier payments (that is, funds for carrier payment
invoices purchased but not yet paid out).

Important Note: This feature is only available for the single fee statement format of the Client Fee State-
ment. Therefore, System Preference Reports, Client fee statement, Use multi-fee version must be False to
utilize the exclude carrier payments from NFE functionality.

To configure the system to update held funds instead of NFE for carrier payments purchased but not yet
paid out:
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l Set System Preference Client rules/defaults, Ineligibility/summary calculation, Exclude carrier pay-
ments from NFE to True.

l Set System Preference Reports, Client fee statement, Exclude carrier payments from NFE to True.

l Set System Preference Reports, Funds employed summary, Exclude carrier payments from NFE to
True.

l Recalculate the Calc table one time after setting System Preferences.

The default report definition for this report is CliStmt1.

Field Description

Options
Template

Lists any report template created to date. Select a template from the list to generate a
report based on its saved display parameters. Type a new Report template name and
click Save to create a new template for this report, then Select the template from the Tem-
plates tab and make any applicable parameter and scheduling selections to complete
the template.

Report Parameters

Field Description

Date Enter the beginning date of the date range to which to limit the report.

Click MTD to enter the current beginning date of the month to date period in Date Range
and current processing date in the Thru. Click L-Month to enter the previous beginning
date of the month to date period in Date Range and previous ending date of the month to
date period in Thru.
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Field Description

Thru Enter the ending date of the date range to which to limit the report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
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Field Description

Group Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is
to be generated. Click Clear to remove the selection.

G/L Group Select a G/L Group to which to limit the report, or leave this field blank to include all G/L
Groups.

Sort Select the option that determines the order in which to sort the statement:

l Client

l A/E

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection.

Include
non-zero
inactive cli-
ents

Include inactive clients that have cash in A/R or reserves on the report. If this option is not
selected, non-zero inactive clients are excluded form the report.

Show A/E Select this option to print the account executive name in the statement results.

Show cli-
ent name

Select this option to print the client name in the statement results.

Convert
native cur-
rency

Select this option to convert the financial data to the client’s native currency.

Pre-
liminary

Select this option to generate the statement only. Leave the option unselected to generate
the statement and post the associated fees to the client account.

Print Now Click this button to generate the report.
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Field Description

Exit Click this button to close the screen without printing the report.

Report Sample

System Preferences

The following system preference that affects this report is found in the Administration module, System
Preferences, Fields/screen behavior, Miscellaneous folder.

Preference Description

Calculate earnings
based on account
table flag

Set to True - All accounts flagged as an Earning Account in Tables > Accounting
> Account Table > Standard Tab > Earning Account check box will be included in
the calculation.

The following system preferences used to determine which default report definition is used are located in
System Preferences > Reports > Client Fee Statement folder:

Report Definition Preference

CliStmt1.rpt Fee statement without float days - Set to Blank

CliStmtF.rpt Fee statement with float days - Set to Blank

CliStmtDF1.rpt Calculate Fees Daily - Set to True

CliFeeF-MA.rpt Multi-Fee Version - Set to True and Take Float on Actual Day - Set to True
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Report Definition Preference

CliFeeF-M.rpt Multi-Fee Version - Set to True and Take Float on Actual Day - Set to False

NFEStmtF.rpt Fee statement with float days

CliFee1.rpt Calculate fees Daily - Set to False and Fee statement without float days

Compound Interest Statements

The Compound Interest Statement provides a report of interest earned on a specified interest bearing
account for specified clients through a given date.

Report Parameters

Field Description

Interest
Bearing
Account

Select the account for which to produce the Compound Interest Statement. This is a
required field.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is
to be generated. Click Clear to remove the selection.

Basis Select the fluctuating interest rate on which you are basing the interest rate to apply. The
choices are defined in the Daily Rate Basis table.

Plus/Minus
Rate

The percentage points to be added to or subtracted from the basis rate to determine the
interest rate to apply.

Post
interest
against

Select the account to apply the interest gain or loss to. This only applies if the Preliminary
statement option is not selected.

Calculate
thru date

Enter the date through which to calculate interest for the selected client.

Pre-
liminary
statement

Select this option to generates the statement only. Leave this option unselected to gen-
erate the statement and post the interest to the account indicated in the Post interest
against field.

Detail
statement

Select this option to generate the summary statement, which lists summary information
for each client.

Reports User Guide
Crystal (Legacy) Reports

1095 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Client Group Codes Table.htm


Field Description

Summary
report

Select this option to generate the detail statement, which details daily interest accrual for
each client.

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client

Print Click this button to generate the report to the Output method selected.

Exit Click this button to close the screen.

Report Sample
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Daily Earnings Statements

The Daily Earning Statement screen enables you to create a statement for selected clients that includes
Batch information (date posted, batch number, amount), Total Fees, Total Days, any Previous Fees, Cur-
rent Fees, and Future Fees, if any.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As-of Date Enter the ending date of the date range to which to limit the statement.

Selection Select the option that determines the items to be included in the statement:

l Print items with unpaid fees only

l Print all items from date

From date Enter the beginning date of the date range to which to limit the statement.

Client drop-down to select the client for which to run the report.
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Field Description

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.
>

Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is
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Field Description

to be generated. Click Clear to remove the selection.

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection.

Pre-
liminary

Select this option to generate the statement only. Leave the option unselected to generate
the statement and post the associated fees to the client account. This option is only valid if
Print items for unpaid fees only is selected in the Selection field.

Print Now Click this button to generate the report.

Exit Click this button to close the screen without printing the report.

Daily Fee Statements

The Daily Fee Statement generates a summary by client and date of the transactions that have occurred.
Typically, fee statements are generated at the end of each month and fees are posted the last day of the
month, although Fee Statements can be generated at any time.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As-of Date Enter the beginning date of the date range to which to limit the report.

l Click MTD to enter the current beginning date of the month to date period in Date
Range and current processing date in the Thru.

l Click L-Month to enter the previous beginning date of the month to date period in
Date Range and previous ending date of the month to date period in Thru.

Thru Enter the ending date of the date range to which to limit the report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.
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Field Description

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is
to be generated. Click Clear to remove the selection.

G/L Group Select a G/L Group to which to limit the report, or leave this field blank to include all G/L
Groups.

Fee Type Select the client terms type to limit selection to hose clients with the selected terms type

l All client terms type

l Invoice base terms only

l Daily rate terms only

l A/R finance terms only

Sort Select the option that determines the order in which to sort the statement:

l Client

l A/E

Output Select one of the following print output option from the drop-down list:
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Field Description

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Only if A/R
balance

Include clients that have a current A/R balance. If this option is not selected clients are
included regardless of A/R balance.

Only if
reserve
balance

Include clients that have a reserve balance. If this option is not selected clients are
included regardless of reserve balance.

Hide pay-
ments to
hold
accounts

Select this option to exclude payments to hold accounts from printing on the statement.

Show A/E Select this option to print the account executive name in the statement results.

Show fee
type

Select this option to print fee type in the statement results.

Convert
native cur-
rency

Select this option to convert the financial data to the client’s native currency.

Pre-
liminary

Select this option to generate the statement only. Leave the option unselected to generate
the statement and post the associated fees to the client account. The Post Fees and Gen-
erate Checks screen appears to post the fees to your accounting system and generate
reserve checks

Print Now Click this button to generate the statement.

Exit Click this button to close the screen without printing the report.
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Report Sample

Debtor Statements

The Debtor Statement generates a statement of open invoices for your client in a format that can be
provided for easy viewing and mailing. Your remittance address appears on the statement and, option-
ally you can show your client’s name and address.

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
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Field Description

scheduling selections to complete the template.

Client/Debtor Selection Tab

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client Select the client group to which to limit the results in the report.
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Field Description

Group Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table. Click Clear to remove the selection.

Debtor Select the debtor for which to generate statements.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Groups are
defined in the Debtor Group Code Table. Click Clear to remove the selection.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Code Table. Click Clear to remove the selection.

Alpha
from/thru

Enter an alphabetic range of debtor names for which to generate statements. For instance,
entering a - G would produce statements for all debtors with names starting with the letters
A through G, provided they matched all other selection criteria defined on this tab.

Print now Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

Statement Parameters

Field Description

Select Select the invoice types to be selected for inclusion in the statement.

l Unpaid & Paid This Month: All paid and unpaid invoices.

l Unpaid Only: Only the invoices that remain unpaid.

l Past Due Items Only: Only the invoices that are past due. Enter Days Past
Due for this option.

l Everything on File: Prints all transactions for the debtor.

Select age by Select the date from which to begin aging for selection of invoices for the state-
ment:
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Field Description

l Invoice date

l Purchase date

l Due date

Format Select the report format to be printed:

l Standard: Generates the standard format report, defined by Crystal
Report module specified in System Preference Reports, Debtor State-
ments, Standard Crystal Reports module name.

l Past due: Generates the standard past due format report, defined by
Crystal Report module specified in System Preference Reports, Debtor
Statements, Past due Crystal Reports module name.

l Word Template: Generates a custom statement defined in a Microsoft
Word Template. Select the template to be used in the Word template
field.

l Client w/i debtor: Generates a statement by debtor with invoices listed
by the Client from which they were purchased.

Sort by Select the option that determines the order in which to list invoices for a debtor
on the statements.

l Invoice number

l Invoice date

Invoices were Select the option that determines the invoices to select based on the client cri-
teria selected on the Client/debtor selection tab:

l Purchased from

l Issued by

l Leave blank

l Vendor

Word template Select the Word Template to be used to format the statement. The list contains
the templates defined to FactorSoft in the Word Document Control Table with a
Use of Debtor Letter/Statement. This field is only active in Word Template is
selected in the Format field.
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Field Description

Exclude standard text
at bottom

Select this option to exclude the text defined in System Preference Reports,
Debtor statements, Text at bottom from the generated statement.

Exclude client text at
bottom

Select this option to exclude the client text from the generated statement.

Exclude "Remit All Pay-
ments To"

Select this button to exclude the "Please Remit All Payments To" line from above
the lender address.

Exclude negative
invoice balances

Select this option to exclude invoices with negative balances (credit invoices)
from the statement.

Exclude flagged do
not mail

Select this option to exclude debtors with return address reasons set defined as
Do not mail from statement printing and mailing.

At Least Days Old Enter the minimum number of aging days for invoices to be included in the
statement.

Days past due Enter the minimum days past due for invoices to be included in the statement.
This selection is used with the Past Due Items Only in the Select field

Not older than days Enter the maximum number of aging days for invoices to be included in the
statement.

Minimum statement
amount

Enter the minimum dollar amount for invoices to be included in the statement.

Output Select one of the following print output option from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Cli-
ent Information Preference selection.

l Export to generate the statement as an export file in XML or text BBS
format as determined by system preference.

Introduction Select the Statement Text to print as introductory text for the statement. The
Statement Text are defined in the Statement Text Table.
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Field Description

Conclusion Select the Statement Text to print as concluding text for the statement. The
Statement Text are defined in the Statement Text Table.

Printer Select a printer from the drop-down list to which to print the statements.

Date Selection Tab

This tab allows you to enter a date range for records to be included in the Debtor Statement.

Field Description

Selection Select the option that determines the date that is used to select records to be
included within the date range.

l None

l Only select where post date in range

l Only select where invoice date in range

Range Select the date range to use for the report from the list:

l Last month

l Current month-to-date

l Specific date range

If the Specific date range option is selected, enter the beginning and ending
dates of the date range to which to limit the report in the adjacent fields.
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Report Sample

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Debtor statement folder.

Preference Description

Client w/I debtor Crys-
tal Report module
name

Used to assign the Crystal Reports module name for the Client within Debtor
statement.

Exclude country from
debtor address

Set to True to exclude the country code from the debtor address in the gen-
erated statement.

Include attention in
debtor address

Set to True to include the debtor attention information in the debtor address in
the generated statement.

Include client ref-
erence number in
debtor address

Set to True to include the client reference number for the debtor in the debtor
address in the generated statement.

Include fax number in
debtor address

Set to True to include the debtor FAX phone number in the debtor address in
the generated statement.

Include phone num-
ber in debtor address

Set to True to include the debtor primary telephone number in the debtor
address in the generated statement.

Reports User Guide
Crystal (Legacy) Reports

1109 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Preference Description

Invoice sequence Select the default sort sequence that determines the order in which to list
invoices for a debtor on the statements.

l Invoice number

l Invoice date

Minimum due
includes finance
charges

Set to True to indicate that the amount in Minimum statement amount
includes finance charges for purposes of selecting invoices for the statement.

Past due Crystal
Report module name

Used to assign the Crystal Reports module name for the Past Due format state-
ment.

Remittance Address Select the remittance address option to use on the statement:

l Lender, show invoices purchased from client

l Client, C/O lender at lender's address

l Client, at lender's address (no reference to lender)

Standard Crystal
Report module name

Used to assign the Crystal Reports module name for the standard debtor state-
ment .

Text at bottom Enter free-form text to be printed at the bottom of the statement.

Use activity to cal-
culate balances

Set to True to use activity to calculate balance and generate activity records
for statement.

Use office address Set to True to use the address from the Office record, if available, for the state-
ment.

Use relationship
address for debtor

Set to True to use the address for the relationship, if available, for the statement.

Export format Select the output format for the Export output option:

l XML

l BBS Text

XML export excludes
purchase order-
/description

Set to True to exclude the Description field entered on Invoice Information from
appearing in XML statement export files.
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Debtor Statement Recap

This screen is used to produce the Debtor Statement Recap report, which lists debtor statements gen-
erated for a given statement date.

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Debtor Group Select the debtor group to which to limit the report results from the list. Debtor
Groups are defined in the Debtor Group Table. Click Clear to remove the selec-
tion.

Value Select the specific debtor group value to which to limit the report results from
the list. Click Clear to remove the selection.

Statement Date Enter the statement date for which to print the recap report. To automatically
enter the last month-end date, click L-Mo-End.
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Field Description

Output Select one of the following print output option from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Cli-
ent Information Preference selection.

Flat Fee Adjustment Statement

The Flat Fee Adjustment Statement screen is used to format and generate a flat fee adjustment state-
ment.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
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Field Description

matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Date
Range

Enter the beginning date of the date range to which to limit the report.

Click MTD to enter the current beginning date of the month to date period in Date Range and
current processing date in the Thru.

Click L-Month to enter the previous beginning date of the month to date period in Date
Range and previous ending date of the month to date period in Thru.

Thru Enter the ending date of the date range to which to limit the report.

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Format Select the option to generate the statement only or generate the statement and post fees:

l Preliminary statement: generate the statement only.

l Statement and post fees: generate the statement and post the associated fees to the
client account.

Sort Select the option that determines the order in which the report is generated:
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Field Description

l Client

l A/E

Output Select one of the following print output option from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Show
A/E

Select this option to include the associated Account Executive in the generated statement.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.

Monthly Statements

The Print Monthly Statements screen allows you to set up the format of the monthly statements report.

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
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Field Description

the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

State-
ment Thru

Enter the date through which to print statement records.

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Format Select the option to generate the statement only or generate the statement and post fees:

l Preliminary: generate the statement only.

l Final & Post: generate the statement and post the associated fees to the client
account.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.
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Payout Transaction Statements

The Payout Transactions Report provides a financial transaction summary for individual batches, dis-
playing the Batch #, Date Posted, amount of Invoices Purchased, Escrow Held, Accrued Fees, the Payout
Amount, any Amount Received, Additional Required amount, and any amount Moved to Reserves.

This is an Engine-enabled report.

Field Description

Options Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.
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Field Description

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Client Group Code Table. Click Clear to remove the selection.

Batch# Enter a batch number to produce the statement for a single batch, or leave this field blank
to generate the statement for all batches.

Report Select the report format to be printed:
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Field Description

l Transaction Payout Report

l Detail Payout Report

Output Select one of the following print output option from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection.

Pre-
liminary

Select this option to generate the statement only. Leave the option unselected to generate
the statement and post the associated fees to the client account.

Print now Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences,

Preference Description

Crystal Report mod-
ule name

Used to assign the Crystal Reports module name for the Payout Transaction
statement.

Position Statements

The Position report provides an overall view of selected client’s financial position, including the currency
type and conversion rate, A/R balance, Total Ineligible & Eligible A/R, Maximum Advance, Expected Dilu-
tion, Accrued Fees, Non-A/R Reserves, Funds Employed, and Amount Available.
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Field Description

Date
Thru

Allows a period ending date to be entered. Click Today to display the current FactorSoft pro-
cessing date or L-Month to display the last day of the previous month in this field.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

Client
Croup

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
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Field Description

able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Convert
to native
currency

Select this option to convert amounts from the base currency to the native currency (the
currency of the transaction). The conversion occurs on a client-by-client basis. If the client
has a currency type set and the currency type is different from the default currency, Fact-
orSoft looks up the conversion rate using the As of date in the currency table for the client's
currency. For example, if client ABC Company has a currency type of Canadian Dollars and
the daily conversion rate for Canadian dollars is 1.5, the report increases all of the client's
amounts by a factor of 1.5.

Include
non-Fact-
oring cli-
ents

Select this option to include non-factoring clients in the report results. If this option is not
selected, non-factoring clients are excluded from the report.

Include
non-zero
inactive
clients

Include inactive clients that have cash in A/R or reserves on the report. If this option is not
selected, non-zero inactive clients are excluded form the report.

Format Select the report format to be printed:

l Report

l Statement

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Output Select one of the following print output option from the drop-down list:
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Field Description

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.

Report Sample

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Debtor availability report folder.

Field Description

Do not calculate
accrued fees

Set to True to prevent accrued fees from being calculated for the report.

Include inactive cli-
ents in drop-down list

Set to True to display inactive clients in the Client list.

Position report Crystal
Report module

Used to assign the Crystal Reports module name for the Position Report format.

Position statement Used to assign the Crystal Reports module name for the Position Statement
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Field Description

Crystal Report mod-
ule

format.

Type field is Select the data to be printed in the Type column of the report:

l Currency Type

l G/L Account Group

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Client Rules/defaults, Ineligibility/Summary Calculation folder.

Field Description

Calculate hold bal-
ances for reports

Set to True to reduce the Fund Employed amount by the hold balance on the
report.

Volume Rebate Statements

The Volume Rebate Statement provides a detailed summary of volume rebates given to specified clients
within a defined date range.

Report Parameters

Field Description

Date From Enter the beginning date of the date range to which to limit the report.
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Field Description

l Click Today to display the current processing date in this field.

l Click L-Month to enter the previous beginning date of the month to date period in
Date Range and previous ending date of the month to date period in Thru.

l Click MTD to enter the current beginning date of the month to date period in Date
Range and current processing date in the Thru.

l Click YTD to enter the current beginning date of the year to date period in Date
Range and current processing date in the Thru.

Thru Enter the ending date of the date range to which to limit the report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
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Field Description

this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is
to be generated. Click Clear to remove the selection.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.
>

Pre-
liminary

Select this option to generate the statement only. Leave the option unselected to generate
the statement and post the associated fees to the client account.

Format Select the report format to be printed:

l Detail Report

l Summary Report

Sort Select the sort option that determines the order in which to sort the report.

l By account exec/client name

l By client name

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Output Select one of the following print output option from the drop-down list:
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Field Description

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.

Report Sample

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Volume rebate folder.

Preference Description

Text on detail state-
ment

Enter the user-defined comment to print on the Detail format of the Volume
Rebate Statement. When the report is produced, the note is produced for clients
on which a rebate greater than zero is reported.

Parameters can be included in the text sting to print calculated values specific
to the client’s rebate:
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Preference Description

l %Rebate: Dollar amount of the rebate reported.

l %Fees: Dollar amount of fees charged on the invoices reported.

l %Rper: Percentage of rebate to fees (% Rebate / % Fees) for the rebate
reported.

Transactions Menu

Transactions Reports

The Transaction reports group contains a variety of transaction report options.

Collection/Adjustment Summaries

The Print Collection Summary Report screen allows you to choose a variety of formats for the collection
and adjustment summary reports.

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
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Field Description

plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date From Enter the beginning date of the date range to which to limit the report.

l Click MTD to enter the current beginning date of the month to date period in
Date Range and current processing date in the Thru.

l Click Today to enter the current processing date in Date Range and in the Thru.

l Click L-Mo to enter the previous beginning date of the month to date period in
Date Range and previous ending date of the month to date period in Thru.

Thru Enter the ending date of the date range to which to limit the report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set
to True.

Select the magnifying glass icon to open the Search window and begin typ-
ing the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report,
or leave blank to include all users. When a user is selected, the report is limited to cli-
ents that have that user selected in the A/E field on the Control panel of the Client
Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the
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Field Description

following System Preference:

l Terminology > Select account executive based on check box: TRUE

Group/Value Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To
access this table, on the File menu, click Tables. Then, on the Client & Debtor menu,
click Client Group Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this
report is to be generated. Click Clear to remove the selection.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Default Printer Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This Report Select a printer from the drop-down list to overwrite the printer default for this report
only.

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client
Information Preference selection. Click here for Preference Printing help. See the
Preference Printing Appendix for more information.

Clients Select the clients to be included in the report, based on the Client Terms type:
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Field Description

l All

l Fee Based

l Daily Rate

l A/R Finance

Report Select the report format to be produced:

l Collection summary

l Adjustment summary

l Return check summary

l Remittance summary

l Remittance statement

l Cash receipts register

Sort Select the sort option that determines the order in which to sort the report. These
options are only available if the select Report is Remittance summary or Remittance
Statement.

Show extra
totals

Select this option to print additional totals on the report for total Collected, Advanced,
and Fees, and a summation of these as Total Due. This option is only available if the
selected Report is Remittance Summary or Remittance Statement.

Show adjust-
ment type
recap

Select this option to show total adjustment amounts by adjustment type at the end of
the report. This option is only available if the selected Report is Collection summary or
Adjustment summary.

Ratio
invoice/ad-
vance

This option is only available if the selected Report is Remittance Summary or Remit-
tance Statement.

Hide pay-
ments to hold
accounts

Select this option to not print payments to hold accounts on the report. This option is
only available if the selected Report is Remittance Summary or Remittance State-
ment.

Do not show
rate

Select this option to not print the Discount Rate on the report. This option is only avail-
able if the selected Report is Remittance Summary or Remittance Statement.
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Field Description

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.

Report Sample

System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Reports, Trial balance folder.

Preference Description

Adjustment Report Set to ADJDOC05 to display the debtor code along with the name in the Debtor
column.

Payment History Report

The Payment History Report shows the payment activity and performance for a selected debtor or for all
debtors of a selected client.
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Report Parameters

Field Description

Date
Range

Enter the beginning date of the report date range. Click Today to display the current Fact-
orSoft processing date or MTD to display the beginning day of the previous month in this
field.

Thru Enter the ending date of the report date range. Click Today to display the current FactorSoft
processing date or MTD to display the ending day of the previous month in this field.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
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Field Description

erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not be
able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Debtor Select the debtor to which to limit the report results.

Report Select the report format to produce:

l Earnings style

l Activity style

l Payment style by client

l Payment style by debtor

Format Select the report type to produce. This option is not available when the Activity style format
is selected in Report.

l Detail

l Summary

l Total (all clients only)

Select Select the invoices to be selected for reporting. This option is only available if the selected
Report is Earnings style or Activity style.

l All invoices

l Payment only

Sort Select the sort option that determines the order in which report is presented. This option is
only available if the selected Report is Activity style.

l Invoice number

l Payment date

Output Select one of the following print output option from the drop-down list.

Reports User Guide
Crystal (Legacy) Reports

1132 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm


Field Description

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Calculate
Late Fees

Select this option to calculate late fees on all selected entries

Include
Non-
Factored

Select this option to include non-factoring clients in the report results. If this option is not
selected, non-factoring clients are excluded for the report.

All clients
includes
inactive

Select this option to include inactive clients in the report results. If this option is not selected,
inactive clients are excluded form the report.

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.

Report Sample
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System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Payment history report folder.

Field Description

Use over due activity
format

Set to True to generate the alternate overdue activity format of the Payment His-
tory Report, which lists the Invoice Due Date, Dilution percentage, and Invoice
Age (calculated from invoice due date to payment date).

Purchase Summary Report

The Purchase Summary Report allows a Client selection, a Date Range selection, and a Report Type selec-
tion .

This is an Engine-enabled report.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
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Field Description

Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Report
Type

Select the report to be generated:

l Purchases without fees: summary of purchases, grouped by client.

l Debtor purchase detail: detail of purchases for a customer/debtor.

l Debtor purchase summary by client: summary of purchases by debtor, grouped by
client.

l Debtor purchase summary by Debtor: summary of purchases by debtor, grouped by
debtor.

l Purchases with fees:- summary of purchases showing fees, grouped by client.

l Negative invoices by Debtor: lists negative invoices, sorted by customer/debtor within
client.

l Negative invoices by invoice#: lists negative invoices, sorted by invoice number
within client.

Debtor Select the debtor to which to limit the report results from the list. Click Clear to remove the
selection. Leaving this field blank will include all debtors in the results.

Debtor
Group

Select the debtor group to which to limit the report results from the list. Debtor Groups are
defined in the Debtor Code Table. Click Clear to remove the selection.

Value Select the specific debtor group value to which to limit the report results from the list. Debtor
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Date
Range

Select the date to use for the report from the list:
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Field Description

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

l Today only

l Yesterday

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Output Select one of the following print output option from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help. See the Preference
Printing Appendix for more information.

Print
now

Click this button to generate the report to the Output method selected.

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.
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Report Sample

Reprint Data Entry Reports

The Reprint Data Entry Reports screen allows the transaction reports generated during the purchases, col-
lections, adjustments, etc. data entry to be re-printed.

Note that if System Preference Identification/system constants, Reporting Services, Transaction Reports,
Transaction reports use SQL reporting services where ready is set to True, the Data Entry Reports are
Reporting Services reports as available, and the "Crystal Reports module name" for the corresponding
transaction report is the .rd name of the SQL report.
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Report Parameters

Field Description

Date Range Enter the beginning date of the date range to which to limit the report.

Click Last to enter the previous beginning date of the month to date period in Date
Range and previous ending date of the month to date period in Thru.

Click MTD to enter the current beginning date of the month to date period in Date Range
and current processing date in the Thru.

Thru Enter the ending date of the date range to which to limit the report.

Client
(from/only)

Select a Client to which to limit the report, or to use as the beginning client in a client
range to print. Leave this field blank to include all clients.

Client (thru) Select a Client to use as the ending client in a client range to print.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report,
or leave blank to include all users. When a user is selected, the report is limited to clients
that have that user selected in the A/E field on the Control panel of the Client Inform-
ation screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE
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Field Description

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report
is to be generated. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports.

Change
Default

Click this button to assign a different printer as the default printer. This will change the
default printer for all reports.

This Report Select a printer from the drop-down list to overwrite the printer default for this report
only.

Select Select the report types to be reprinted for the selected clients:

l Purchases

l Collections

l Adjustments

l Reserve release

l Reserve transfers

l Client fee statements

l Orders

Sequence Select the sort option that determines the order in which to sort the reports.
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Field Description

l Client, Batch

l AE, Client, Batch

Clients Select the clients to be included in the report, based on the Client Terms type:

l All

l Fee Based

l Daily Rate

l A/R Finance

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client
Information Preference selection. Click here for Preference Printing help. See the
Preference Printing Appendix for more information.

Translate to
language
specified for
client

Select this option to generate data entry reports in the language selected for each client
on the Identity panel of the Client Information screen. This option only applies if Multi-
Ligual ClientWeb is enabled for the database.

(Grid) Displays the reports that match the selection criteria entered on the screen. Double-
click any individual line-item to print that report only.

Print All Click this button to generate all reports that match the selection criteria entered on the
screen.

Exit Click this button to close the screen without printing the report.

Summary Report

The Summary Report creates a report or summary of all open batches for the selected client/period.
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Report Parameters

Field Descriptions

Date Range Enter the beginning date of the date range to which to limit the report.

Click Today to enter the current FactorSoft processing in Date Range and Thru.

Click MTD to enter the current beginning date of the month to date period in
Date Range and current processing date in the Thru.

Thru Enter the ending date of the date range to which to limit the report.

Client (from/only) Select a Client to which to limit the report, or to use as the beginning client in a
client range to print. Leave this field blank to include all clients.

Format Select the report to be generated:

l Open Batch Detail

l Open Batch Summary

Output Select one of the following print output option from the drop-down list

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Print Click this button to generate the report.

Exit Click this button to close the screen without printing the report.
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Report Sample

Transactions Report

The Transaction Report allows you to generate transaction reports in summary or detail formats for spe-
cific or all clients within a specified date range.

This is an Engine-enabled report.

Field Description

Report
Template

Lists any report template created to date. Select a template from the list to generate a
report based on its saved display parameters. Type a new Report template name and
click Save to create a new template for this report, then Select the template from the Tem-
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Field Description

plates tab and make any applicable parameter and scheduling selections to complete
the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client Select the client group to which to limit the results in the report.
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Field Description

Group Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table. Click Clear to remove the selection.

Default
Printer

Displays the default printer used to generate reports

Change
Default

Click this button to assign a different printer as the default printer. This will change the default
printer for all reports.

This
Report

Select a printer from the drop-down list to overwrite the printer default for this report only.

Date
Range

Select the date to use for the report from the list:

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date range

l Today

l Yesterday

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the adjacent fields.

Output Select one of the following print output option from the drop-down list
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Field Description

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

l Preference to generate the report to the output option specified in the Client Inform-
ation Preference selection. Click here for Preference Printing help. See the Preference
Printing Appendix for more information.

Report Select the report to be generated:

l Purchases & Collections

l Purchases Only

l Collections Only or Collections/Adjustments Only

l Client Ledger (include Non-factored column)

l Client Ledger (include fees taken column)

l Client Ledger (include fees & tax columns)

l Purchase Summary

l Transaction activity

l Posted off-date report

Format Select the format for the selected report. This field is only available when the selected Report
is Purchase & Collections, Purchase Only, or Collections/Adjustments Only.

Other Select the option for additional formatting. These options are only available when the selec-
ted Report is Purchase & Collections, Purchase Only, Collections/Adjustments Only (both
options available) or Transaction Activity (Each client only).

l Include expense summary

l Each client on a separate page

Print
now

Click this button to generate the report to the Output method selected.
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Field Description

Save Click this button to save updates to the currently selected Report template.

Exit Click this button to close the screen.

Report Sample

System Preferences

The following system preference that affects this report is found in the Administration module, System
Preferences, Fields/screen behavior, Miscellaneous folder.

Preference Description

Calculate earnings
based on account
table flag

Set to True - All accounts flagged as an Earning Account in Tables > Accounting
> Account Table > Standard Tab > Earning Account check box will be included in
the calculation.

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Transaction report folder.

Preference Description

Collections only Crys-
tal Report module
name

Used to assign the Crystal Reports module name for the Collections Only report.

Collections selection
included adjustments

Set to True to include adjustments in Collections Only report.

Combined Crystal
Reports module
name

Used to assign the Crystal Reports module name for the Purchases and Col-
lections Only report.

Reports User Guide
Crystal (Legacy) Reports

1147 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Preference Description

Include medical
receivable balance

Set to True to display the last medical receivables balance on certain reports if
balance forward is also shown.

Place recourse fee in
fee column on pur-
chase summary

Set to True to include the recourse fee on the Purchase Summary report in the
Fee Amount column instead of the Recourse Amount column.

Purchase only Crystal
Reports module
name

Used to assign the Crystal Reports module name for the Purchases Only report.

Show balance for-
ward on purchases
and collections report

Set to True to display balance forward on the Purchases & Collections report.
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Using the Report Queue

The Report Queue screen lists all scheduled SQL reports that have been generated through the Engine.
From this screen you can open and reprint any previously run report that has not yet been deleted or
purged (deleted reports can be seen in the list, they just cannot be reprinted).

The following appears for each report in the queue:

l Report – Name given to the report when it was defined.

l Requested – Date and time when the report request was queued to the Engine

l Created – Date and time that the Engine generated the report.

l Deleted – Date and time that the report was manually deleted from the Report Queue.

l Description – The report status message - generally only exists if there was an issue with gen-
erating the report.

l To refresh the list of reports, click the Refresh button.

l To view a report, select the item in the list and click the View Report button.

l To delete a report from the queue, select the item in the list and click the Delete button.

l Reports that have been deleted can be viewed in the list by selecting the Show Deleted Reports
check box.
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Database Replication for SQL Reports

To aid in very large implementations of FactorSoft, in which processing of scheduled SQL reports impacts
FactorSoft daily operations, support for Microsoft SQL Server Replication has been added in version 3.0.04
and later. Replication in FactorSoft utilizes SQL Server Replication to create a copy of a production Fact-
orSoft database on a separate server and maintain synchronization of the production and replication
databases. The replication database is then used to generate the scheduled FactorSoft SQL reports.

Note that Replication applies only to scheduled SQL reports generated through the Engine – SQL reports
generated ad hoc and all Crystal Reporting reports will continue to be generated from the production
database.

SQL Server Replication is complex and requires expert database administration to be successfully imple-
mented. If you are interested in using the Replication feature in FactorSoft, please contact your Jack
Henry™ representative at 205-972-8900 for an evaluation.

Setting Up Replication

Once the Replication database is set up in SQL, add the database to the FactorSoft Control File with the
same options as the Production database. Replication is enabled in the Control File of the Replication
database only. The Replication Control File option is not selected in the Production database.

Note that the Replication database must be set up on a separate server instance from
the Production database.

System Preferences

The following System Preferences in the Identification/system constants, Engine, Replication folder must
be defined in the Production database - the settings will be copied to the Replication database:

Preference Description

Replicate To Enter the name of the Replication data-
base.

Replicated
From

Enter the name of the Production data-
base.
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Upgrade Considerations for Replication

When upgrading FactorSoft in environments with replicated databases, replication services must first be
turned off. After the replication services are turned off, perform the FactorSoft upgrade and run schema
normally on the Production database. Once the Production database is upgraded, perform the replication
set-up just as if this were a new replication setup.
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